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 Safety precautions 
The following safety precautions should be observed before using this product and any associated instrumentation. Although 
some instruments and accessories would normally be used with nonhazardous voltages, there are situations where hazardous 
conditions may be present. 

This product is intended for use by qualified personnel who recognize shock hazards and are familiar with the safety precautions 
required to avoid possible injury. Read and follow all installation, operation, and maintenance information carefully before using 
the product. Refer to the user documentation for complete product specifications. 

If the product is used in a manner not specified, the protection provided by the product warranty may be impaired. 
 

The types of product users are: 

Responsible body is the individual or group responsible for the use and maintenance of equipment, for ensuring that the 
equipment is operated within its specifications and operating limits, and for ensuring that operators are adequately trained. 

Operators use the product for its intended function. They must be trained in electrical safety procedures and proper use of the 
instrument. They must be protected from electric shock and contact with hazardous live circuits. 

Maintenance personnel perform routine procedures on the product to keep it operating properly, for example, setting the line 
voltage or replacing consumable materials. Maintenance procedures are described in the user documentation. The procedures 
explicitly state if the operator may perform them. Otherwise, they should be performed only by service personnel. 

Service personnel are trained to work on live circuits, perform safe installations, and repair products. Only properly trained 
service personnel may perform installation and service procedures. 
 

Keithley Instruments products are designed for use with electrical signals that are measurement, control, and data I/O 
connections, with low transient overvoltages, and must not be directly connected to mains voltage or to voltage sources with high 
transient overvoltages. Measurement Category II (as referenced in IEC 60664) connections require protection for high transient 
overvoltages often associated with local AC mains connections. Certain Keithley measuring instruments may be connected to 
mains. These instruments will be marked as category II or higher. 

Unless explicitly allowed in the specifications, operating manual, and instrument labels, do not connect any instrument to mains. 

Exercise extreme caution when a shock hazard is present. Lethal voltage may be present on cable connector jacks or test 
fixtures. The American National Standards Institute (ANSI) states that a shock hazard exists when voltage levels greater than 
30 V RMS, 42.4 V peak, or 60 VDC are present. A good safety practice is to expect that hazardous voltage is present in any 
unknown circuit before measuring. 

Operators of this product must be protected from electric shock at all times. The responsible body must ensure that operators 
are prevented access and/or insulated from every connection point. In some cases, connections must be exposed to potential 
human contact. Product operators in these circumstances must be trained to protect themselves from the risk of electric shock. If 
the circuit is capable of operating at or above 1000 V, no conductive part of the circuit may be exposed. 
 

Do not connect switching cards directly to unlimited power circuits. They are intended to be used with impedance-limited 
sources. NEVER connect switching cards directly to AC mains. When connecting sources to switching cards, install protective 
devices to limit fault current and voltage to the card. 

Before operating an instrument, ensure that the line cord is connected to a properly-grounded power receptacle. Inspect the 
connecting cables, test leads, and jumpers for possible wear, cracks, or breaks before each use. 

When installing equipment where access to the main power cord is restricted, such as rack mounting, a separate main input 
power disconnect device must be provided in close proximity to the equipment and within easy reach of the operator. 

For maximum safety, do not touch the product, test cables, or any other instruments while power is applied to the circuit under 
test. ALWAYS remove power from the entire test system and discharge any capacitors before: connecting or disconnecting 
cables or jumpers, installing or removing switching cards, or making internal changes, such as installing or removing jumpers. 
 

Do not touch any object that could provide a current path to the common side of the circuit under test or power line (earth) 
ground. Always make measurements with dry hands while standing on a dry, insulated surface capable of withstanding the 
voltage being measured. 
 



 

 

For safety, instruments and accessories must be used in accordance with the operating instructions. If the instruments or 
accessories are used in a manner not specified in the operating instructions, the protection provided by the equipment may be 
impaired. 

Do not exceed the maximum signal levels of the instruments and accessories, as defined in the specifications and operating 
information, and as shown on the instrument or test fixture panels, or switching card. 

When fuses are used in a product, replace with the same type and rating for continued protection against fire hazard. 

Chassis connections must only be used as shield connections for measuring circuits, NOT as protective earth (safety ground) 
connections. 

If you are using a test fixture, keep the lid closed while power is applied to the device under test. Safe operation requires the use 
of a lid interlock. 

If a  screw is present, connect it to protective earth (safety ground) using the wire recommended in the user documentation. 

The  symbol on an instrument means caution, risk of danger. The user must refer to the operating instructions located in the 
user documentation in all cases where the symbol is marked on the instrument. 

The  symbol on an instrument means caution, risk of electric shock. Use standard safety precautions to avoid personal 
contact with these voltages. 

The   symbol on an instrument shows that the surface may be hot. Avoid personal contact to prevent burns. 

The  symbol indicates a connection terminal to the equipment frame. 

If this  symbol is on a product, it indicates that mercury is present in the display lamp. Please note that the lamp must be 
properly disposed of according to federal, state, and local laws. 

The WARNING heading in the user documentation explains dangers that might result in personal injury or death. Always read 
the associated information very carefully before performing the indicated procedure. 

The CAUTION heading in the user documentation explains hazards that could damage the instrument. Such damage may 
invalidate the warranty. 

Instrumentation and accessories shall not be connected to humans. 

Before performing any maintenance, disconnect the line cord and all test cables. 

To maintain protection from electric shock and fire, replacement components in mains circuits — including the power 
transformer, test leads, and input jacks — must be purchased from Keithley Instruments. Standard fuses with applicable national 
safety approvals may be used if the rating and type are the same. Other components that are not safety-related may be 
purchased from other suppliers as long as they are equivalent to the original component (note that selected parts should be 
purchased only through Keithley Instruments to maintain accuracy and functionality of the product). If you are unsure about the 
applicability of a replacement component, call a Keithley Instruments office for information. 

To clean an instrument, use a damp cloth or mild, water-based cleaner. Clean the exterior of the instrument only. Do not apply 
cleaner directly to the instrument or allow liquids to enter or spill on the instrument. Products that consist of a circuit board with 
no case or chassis (e.g., a data acquisition board for installation into a computer) should never require cleaning if handled 
according to instructions. If the board becomes contaminated and operation is affected, the board should be returned to the 
factory for proper cleaning/servicing. 

Safety precaution revision as of January 2013. 
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ACS Software 
If you have any questions after reviewing this information, contact your local Keithley Instruments 
representative or call one of our applications engineers at 1-888-KEITHLEY (1-888-534-8453) within 
the U.S. and Canada. You can also visit the Keithley Instruments website at www.keithley.com for 
updated worldwide contact information. 

When the Series 2600B System SourceMeter® instruments are referenced, it also includes the 
Series 2600A System SourceMeter instruments, since these two series of instruments are fully 
interchangeable. However, the following instruments are not supported in ACS Basic: Model 2604B, 
Model 2614B, and Model 2634B. 

 

Reference manual content 
This manual contains information about the ACS software only. It includes information about how to 
install, configure, and operate the ACS software, as well as full details of software features such as 
prober control, wafer setup, summary reports, and building, loading, and executing test projects. 

For more information about instruments that can be used with the ACS software, refer to the 
documentation for each specific Keithley Instruments model: 

• S530 Integrated Test System 
• Model 707A/707B Switching Matrix  
• Model 708A/708B Switching Matrix  
• Series 2400 SourceMeter  
• Series 2600B System SourceMeter  
• Series 3700 System Switch/Multimeter  
• Model 4200-SCS Semiconductor Characterization Suite 

Also, refer to the supplied documentation that is located on the Keithley Instruments Complete 
Reference CD-ROM that was shipped with your purchase. You can also visit the Keithley Instruments 
website at www.keithley.com to search for updated information by model number. 

 

Section 1 

Introduction 
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ACS software overview 
The Keithley Instruments Automated Characterization Suite (ACS) software supports semiconductor 
characterization at the cassette, wafer, and device level, using multiple test instruments and 
automatic parametric testing with semiautomatic and automatic probe stations. 

ACS software controls hardware on the Keithley Instruments Model 4200-SCS Semiconductor 
Characterization System and supports other external instruments controlled through the GPIB, such 
as the Keithley Instruments Series 2600B System SourceMeter® instruments. It also provides a 
combined test-execution engine that supports Model 4200-SCS and Series 2600B group testing. 

ACS can perform multisite parallel I-V testing using a Series 2600B as the primary instrument. You 
can have as many as 16 groups of source-measure units (SMUs) on a single GPIB card, for a total of 
16 parallel test sites (contact Keithley Instruments if you need more than 16 parallel sites). Each 
group can support up to 64 Series 2600B instruments, or 128 channels. 

ACS supports the following probers: 

• Micromanipulator 8860/P300A Prober  
• Suss Micro Tec PA200/PA300 Prober  
• Cascade 12000/S300/R19S Prober  
• Tokyo Semitsu (TSK) UF200/UF3000/APM60/70/80/90 Prober  
• Electroglas EG2X/EG4X Prober  

Only the the EG4X prober supports post inking in ACS 

• TEL P8/P12/19S Prober  
• Wentworth Pegasus 300S Prober with SRQ check 
• Yang Sagi3 Prober with SRQ check 
• Singatone CM500 Prober (WL250) 

 

ACS software utilities 
The following Keithley Instruments software utilities are included in the ACS software installation: 

 

KITE 
Keithley Interactive Test Environment (KITE) is the main Model 4200-SCS device characterization 
application. KITE is a versatile tool that facilitates both interactive characterization of an individual 
device and automated testing of an entire semiconductor wafer. Tests are organized into individual 
projects, which are managed and executed by KITE. 

 

KTEI 
The Keithley Test Environment Interactive (KTEI) is a suite of software utilities that control the Model 
4200-SCS. KTEI increases throughput for leading-edge circuit materials testing and incorporates 
improvements in parallel test routines used for lab and production applications. 
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KULT 
The Keithley User Library Tool (KULT) allows test engineers to integrate custom algorithms (user 
modules) into KITE. KULT is used to create and manage libraries of user modules for both KITE and 
ACS. 

 

KCON 
The Keithley CONfiguration (KCON) utility allows test engineers to define the configuration of external 
GPIB instruments, switch matrices, and analytical probers connected to the Model 4200-SCS. KCON 
also provides basic diagnostic and troubleshooting functions. 

 

KXCI 
The Keithley External Control Interface (KXCI) allows the use of an external computer to remotely 
control the SMUs, pulse generator cards, and a scope card over the GPIB (IEEE-488) or Ethernet. 
You can do this in either of two modes: the full-featured Model 4200 extended mode, which provides 
access to most of the Model 4200-SCS commands and ranges, or the Model 4145 emulation mode. 
KXCI also provides a command set that executes user modules created in KULT. 

 

ACS testing hierarchy 
ACS provides a combined test execution engine that supports Series 2600B and Model 4200 SMUs 
through Interactive Test Modules (ITMs). An ITM allows you to define a test interactively using a 
graphical user interface(GUI).  

An STM supports Test Script Processor (TSP®) files. A TSP file is written to customize tests for a 
Series 2600B instrument or Model 3706 Switch/Multimeter instrument. Also, Python programming 
language test modules (PTMs) can be written to control any GPIB instrument. A script editor is 
included with ACS for editing script test modules (STMs) and PTMs. 

ACS supports semiautomatic and automatic testing, multi-pattern wafer maps, and Series 2600B 
multi-group tests. Common transistor parameter testing (for example, Vds-Id, Vgs-Id, Vg-Ig) and life 
testing (TDDB, NBTI, HCI) are supported using various procedures. 

ACS organizes tests in the hierarchy below (from the cassette-level down), consistent with 
semiconductor-wafer organization, allowing for a one-time setup when managing cassette-level tests: 

• Cassette: Automate multiple wafers tests 
• Wafer: Define test patterns 
• Pattern: Multiple sites (nonexclusive) for each pattern 
• Device: Perform one or more tests (single or multi-group) can be performed 
• Subsite: Perform one or more tests on devices 
• Test: Four types: ITM, STM, PTM, and CTM 
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ACS software introduction 
The Keithley Instruments Automated Characterization Suite (ACS) software is distributed on a CD-
ROM and can be installed on any computer or Keithley Instruments Model 4200 Semiconductor 
Characterization System (SCS) with a Microsoft® Windows® XP Professional operating system.  

The Automated Characterization Suite (ACS) software supports these system configuration 
arrangements: 

• ACS software on a system computer/laptop for the Series 2600B System SourceMeter® units. 
• ACS software on Model 4200-SCS for Model 4200-SCS system (includes all instruments and 

equipment that are supported by KITE). 
• ACS software on Model 4200-SCS for the Model 4200-SCS system and the Series 2600B 

System SourceMeter units. 

For detailed configuration information, refer to ACS Hardware examples (on page 17-1). 

ACS software starts in one of three modes (see License key modes (on page 2-18)). If you want to 
start in online (standard) mode, a USB license key file is needed (see ACS USB license key (on 
page 2-13)). 

 

Section 2 

ACS Software Installation 
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ACS pre-installation 

It is recommended that you back up your system before installing new software. 

If you are installing the Automated Characterization Suite (ACS) software on a computer, the 
following system requirements apply: 

Minimum computer configuration: 

• Operating System: Microsoft Windows XP Professional Service Pack 3 (SP3) or Windows 7 x 86 
(32 bit) and Windows 7 x 64 (64 bit) 

• CPU: Pentium 4, 2.4GHz+ or equivalent  
• System Memory (RAM): 1GB 
• Hard Disk: 700MB free space  
• Graphics Card: 16MB of VRAM  
• Screen: 1024 x 768, 32-bit True Color  

Recommended computer configuration computer: 

• Operating System: Microsoft Windows XP Professional Service Pack 3 (SP3) or Windows 7 x 86 
(32 bit) and Windows 7 x 64 (64 bit) 

• CPU: Intel® dual core class or AMD Athlon® class or higher 
• System Memory (RAM): 2GB 
• Hard Disk: 1GB free space 
• Graphics Card: 64MB of VRAM 
• Screen: 1280 x 1024, 32-bit True Color 

If you install ACS directly onto your computer without KITE, the elements related to KITE will not be 
available for you to use with ACS. 
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ACS installation 

Before installing ACS software on a computer, make sure you have read and completed all the pre-
installation requirements (see Pre-installation). 

To install ACS software: 

1. Restart your computer or Model 4200-SCS.  
2. Log on as an administrator.  
3. Insert the ACS software setup disk into the CD-ROM drive.  
4. The setup process should start automatically. If setup does not start automatically, click My 

Computer and then open the CD-ROM device folder.  
5. Click setup.exe to start the process. 

During the setup process, you can click Cancel to end the installation. 

6. In the ACS software Setup Wizard dialog box, click the Next function (see next figure): 

Figure 1: Setup wizard 
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7. In the License Agreement dialog box, click I accept the agreement (see next figure). 

Figure 2: License Agreement 
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8. Click Next to continue.  
9. In the Select Start Menu Folder dialog box, you can create ACS program shortcuts in the Start 

Menu folder, or you can Browse to a different location to install the shortcuts (see next figure). 

Figure 3: Select Start Menu Folder 
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10. Click Next to continue.  
11. The Select Additional Tasks dialog box (see next figure) will allow you to Create a desktop icon 

and Create a Quick Launch icon. 

Figure 4: Select Additional Tasks 
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12. Click Next to continue.  
13. The Ready to Install dialog box opens. You must click the Install function to continue the 

installation process (see next figure). 

Figure 5: Ready to Install 
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14. Click Next to continue.  
15. After clicking Install, the Installing dialog box opens (see next figure). 

Figure 6: Installing 
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You can cancel the installation of the ACS software by clicking Cancel in the Installing dialog box. 

16. Once the installation process is completed, the Temp License Generation Setup Wizard dialog 
box opens (see next figure). 

Figure 7: Temporary License Generation 
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Once you choose the type of license you desire, and you click Next, the Completing the ACS V5.2 
Setup Wizard dialog box opens (see next figure). 

Figure 8: Completing the ACS Setup Wizard 
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To complete the ACS software installation process, click Yes, restart the computer now, then click 
Finish. If you want to restart your computer later, click No, I will restart the computer later. 

After you have installed your version of ACS software, and before you set up any projects or run any 
tests, it is recommended that you review the Release Notes. The Release Notes contain valuable 
information about known issues and provide guidance on how to handle issues that you may 
encounter. The Release Notes can be found by clicking on your Windows® Start icon > All Programs 
> ACS Reference > Release Notes, or from the Help menu in the ACS menu toolbar.  

Figure 9: Release Notes location 
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ACS post-installation 
If ACS software is controlling a Series 2600B or Model 3706, you can determine the instrument 
configuration by running a scan in the ACS hardware configuration module. 

If you have other GPIB instruments that you want configured in the ACS software, you will need to 
use the Keithley Configuration (KCON) utility. This can be accomplished by running the ACS 
hardware configuration module. 

You can also add the prober station to the configuration and it is preferred that you use the ACS 
hardware configuration module. Although, you can use the KCON utility. 

If you want to use the KCON utility to add the prober station: 

1. Locate the Model 4200-SCS base directory (typically C:\S4200), and go to the “sys\dat” 
subfolder.  

2. Locate the prbcnfg_XXX.dat files.  
3. Depending on the prober Model, edit and save the appropriate prbcnfg_XXXX.dat file. 
4. Run the KCON utility on the Model 4200-SCS. 
5. If the probe station PRBR1 does not exist, then click Tools and then click Add External Instrument 

and Prober Station. 
6. Click Prober Station PRBR1 and click the appropriate prober Model in the Prober Properties area. 
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ACS USB license key 

You must obtain an ACS USB license key in order to use the ACS software in online (standard) 
mode. If you have not obtained a license key, you will only have access to the ACS software in demo 
mode, and you will not have full functionality, such as using the hardware configuration option. 

The ACS SafeNet Sentinel USB license key is similar to a standard flash drive (see next figure). The 
USB license key is included with the ACS software and shipped with the S530 Integrated Test 
System. The USB license key allows you to operate ACS in the standard mode, and can be moved 
from computer to another (multiple installations) without buying additional licenses. 

There are two types of USB Keys. One is a permanent key that you can use repeatedly. The other is 
a temporary key that you can use for 30 days. 

Figure 10: USB SafeNet Sentinel license key 

 

Figure 11: ACS in DEMO mode 

 

Before you start running the ACS software, insert your USB license key into the computer’s USB 
interface. The computer and ACS software will automatically detect the USB key. If you have the 
permanent key, ACS will start in the standard mode (see next figure). 

Figure 12: ACS in STANDARD mode 

 

If you have the temporary key, ACS will start in the standard mode. However, you will have a limited 
number of days to use the temporary key (see next figure). If you are using the temporary USB key, 
the amount of days that you have available is displayed while running ACS. 

Figure 13: ACS in STANDARD mode with 30 Day evaluation license 
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DO NOT remove the USB key from the computer while you are using the ACS software in the 
standard mode. If the key is removed, you will receive a warning message that indicates you have 30 
seconds to insert the USB key back in the computer (see next figure). After the key is reinserted in 
the computer, you must click Continue in order to keep the ACS software functioning. If the key is not 
inserted in the computer before the time has elapsed, the software will close and you will lose all 
data from your current session. 

Figure 14: USB Warning message 
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Updating a temporary USB key 
If your temporary USB license key has expired, you can request an update from Keithley Instruments.  

To avoid an interruption in your operations and continue using the ACS software in standard mode, 
perform the following steps to obtain an updated license key file. 

To update a USB key: 

1. In the ACS Help menu, click Update License (see next figure). 

Figure 15: ACS Update License 

 

2. After you select Update License, the Secure Update Utility dialog box opens (see next figure). 

Figure 16: Generate Request Code 
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3. In the Secure Update Utility dialog box, click the Generate Request Code button to generate a file 
and save it to your computer (see next figure). 

Figure 17: Save generated file 

 

4. E-mail the generated file to the following address: acs.license@keithley.com.  
5. After you send the generated file to Keithley Instruments, an updated file will be generated and 

returned to you by e-mail. 
6. The newly generated file will be named ACS_4.3 update.upw, or something similar.  
7. After you receive the updated file for your USB key, save it to a location on the computer.  
8. In the ACS Help menu, click Update License.  
9. In the Secure Update Utility dialog box, click the folder icon to Browse and locate the file you 

received. Select the file and click Open to upload it.  

Figure 18: Browse update file 
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10. In the Secure Update Utility dialog box, click the Apply Code button (see next figure). 

Figure 19: Success update 

 

After your temporary USB license key expires, you will need to request another update. 
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License key modes 
The ACS software starts in one of three different modes, depending on your USB license key status 
and the hardware setup. The three possible operating modes are: 

• Demo 
• Evaluation 
• Standard 

Demo mode 
If ACS software starts in demonstration mode, then the USB license key is not correctly installed or 
has expired (see the Updating a temporary USB key topic). 

Demo mode is suitable for developing test projects and for reviewing results.  

In Demo mode, ACS software cannot communicate with the test and measurement hardware. 

Evaluation mode 
If the ACS software starts in evaluation mode, the USB license key is correct, but the physical 
hardware configuration does not match the configuration on file. The physical instruments, 
communications interconnect, and grouping must be identical to the configuration on file to enter 
standard mode. Any detected difference will result in an evaluation condition. In the evaluation mode, 
you can set up a test process and control prober stations, and the test modules will be executed in 
Demo mode. 

If the ACS software detects a different hardware configuration compared to the currently saved 
configuration, a verification dialog box will open. In the verification dialog box, you can click standard 
mode to set the new hardware configuration, or you can click evaluation mode to maintain the original 
configuration on file. Test modules will run in evaluation mode, however, evaluation mode does not 
allow for live instrument connection.  

Standard mode 
When the ACS software starts in standard mode, it is an indication that the software has a valid USB 
license key and is able to communicate with the test and measurement hardware. ACS software may 
indicate that the default project requires hardware that is not available when starting in standard 
mode. In the standard mode, you can set up a testing process to control the prober station. 

The next figure shows the ACS software startup flow. The software modes are based on the USB 
license key.  
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Figure 20: ACS license key software modes 
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Once the scan has completed, the software determines the state of the configured hardware. If 
nothing has changed, ACS will automatically go to standard or evaluation mode depending on your 
license key. However, if the configuration has changed, you will see a dialog box where you are 
presented with three different options:  

1. You can choose to click Exit, which will close ACS. 

2. You can choose to click on Re-scan, which will cause ACS to scan the hardware again and check 
the configuration. 

3. You can choose to click on Continue and ACS will determine the next action depending on your 
license key. 

If you change your hardware configuration and you decide to Re-scan, the software will give you a 
visual presentation of the changes (see next figure). 

Figure 21: Hardware Change Info 
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S530 equipment and system 

Equipment startup 
If you have a Keithley Instruments S530 Integrated Test System, the following information will provide 
the necessary instructions needed to startup and shutdown your instrument-based system.  

All of the S530 system instruments in the equipment rack are connected to one power distribution unit 
(PDU), which is located at the back of system cabinet (see next figure)(the LO patch panel and the 
interlock are shown for reference only; they are located behind the SMUs). For more information 
regarding the S530 system, refer to the S530 Administrative Guide (part number PA-992; this guide is 
located on the Keithley Instruments CD-ROM that was shipped with your purchase). You can also 
visit the Keithley Instruments website at www.keithley.com to search for updated information by 
model number. 

Figure 22: S530 system cabinet rear view 
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Make sure that all line cords for the system cabinet are connected to the AC power line receptacles. 
Make sure that the PDU unit circuit breaker is in the ON position. Also, make sure the computer and 
monitor are turned ON. 

On the front of the system, turn the POWER switch to the ON position. The POWER switch is located 
on the front door of the cabinet (see next figure). Make sure the system computer and monitor are 
also turned on before attempting to use the S530 system and any software. 

Initial equipment startup 
All of the instruments in the equipment rack are connected to one PDU, which is located at the back 
of the cabinet. 

1. Check that all the line cords for the system cabinet are connected to AC power. 
2. Make sure that the circuit breaker on the PDU is in the ON position. 
3. Press the power/standby button on the computer and monitor. 
4. Set the power button on the front door of the system to the ON position. 
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System shut down 

You must have administrator rights in ACS software in order to shut down the S530 system. 

1. Double-click the Shutdown icon on the computer desktop. On the dialog box that opens, click Yes 
in order to Shutdown the S530 Tester. 

The following message opens after you click Yes to Shutdown the S530 (see next figure). You must 
wait until the Model 4200-SCS and the system computer shut down before you press the power 
button on the system cabinet. It may take several minutes for the system to shut down 

  

2. Once the ACS host computer has shut down, or the shut down message opens, press the power 
button on the front door of the system cabinet. 

System startup 
1. Make sure that the power switch on the PDU is set to on. 
2. Set the power button on the front door of the system to the ON position. 
3. Open the front cabinet door and press the Power/STANDBY switch on the ACS host computer. 
4. Wait for all the instruments to power up. 
5. Login to your computer and start the ACS software. 

Emergency Off (EMO) button 
An Emergency Off (EMO) button is located on the system cabinet door (see previous figure). If you 
push the Emergency Off button, it removes power to all system instruments. However, it will not 
remove power to the ACS host computer. 

The EMO TRIPPED indicator light (located on the cabinet door) turns on when the system has 
undergone an emergency shut down. 

Emergency shut down procedure 
Press the red Emergency Off Button on the front of the system cabinet. The instruments will power 
down and a red Emergency Off indicator will illuminate. 

Recovering from an emergency shut down 
1. Verify that a hazardous condition or emergency situation is no longer present. 
2. Rotate the Emergency Off button to release it. 
3. Toggle the power switch from ON to OFF, and then back to ON again. All of the system 

instruments should power up. 
4. Open the front cabinet door and press the power/standby switch on the ACS host computer. 
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Before starting the ACS software 
1. Make sure that all of the instruments are connected with a GPIB cable (instrument to system 

computer or Model 4200-SCS) and have a TSP-Link® connection between any Series 2600B 
SourceMeter® instruments. For more information about setting up the hardware, refer to ACS 
Hardware examples (on page 17-1). 

2. Assign GPIB addresses and node numbers (see ACS Hardware examples (on page 17-1)). 
3. Make sure that all the instruments are turned on and self-testing is finished. 

Always start the “child” machines first, and then the “master” machine. Because the master scans 
through all the linked child machines, it must be started after all the child machines are turned on, or 
errors may occur when you start the ACS software. 

4. Start ACS on a system computer or a Model 4200-SCS. 

POSSIBLE ERROR - To avoid fatal errors to instruments, never start the ACS software until all 
instruments finish self-testing. 

 

Section 3 

ACS Software Overview 
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Starting the ACS software 
Before opening the ACS software, make sure that all instruments are turned on and all self-tests have 
completed. You must establish a new user account when you open the ACS software for the first 
time.  

You must get an ACS software USB license key in order to start the software in professional mode. If 
you have not gotten a USB license key, you must select the Login In Demo Mode option. This allows 
you to start the ACS software without a software license. 

To start the ACS software: 
1. Select the ACS software icon on your computer’s desktop. The User Login dialog box opens (see 

next Figure).  

Figure 23: User login 
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2. Type a user name and password in the User Name and Password fields. The default user name 
is ACSADMIN; however, there is no default password. 

More than one new user account can be established at this time. You can establish new accounts by 
clicking the New User button. To change the password, click the Change Password button. 

3. Click OK. The ACS software start window opens (see next figure). 

Figure 24: ACS software start window 

 



Section 3: ACS Software Overview ACS Automated Characterization Suite (ACS) Reference Manual 
 

3-4 ACS-901-01 Rev. H / December 2014 

 

ACS software starts in one of three different modes (demo, evaluation, standard), depending on the 
USB license key file and hardware setup. Refer to ACS USB license key in Section 2 for more startup 
modes and licensing information. 

The following flowchart (see next figure) gives an example of the software’s internal process flow 
during the ACS software startup sequence. 

Figure 25: ACS license key software modes 

 

If you change your hardware configuration and you decide to Re-scan, the software will give you a 
visual presentation of the changes. Also, note that you can skip the Re-scan and go straight to 
Continue in order to enter standard or evaluation mode. 

 

If you have not obtained an ACS software USB license key, then ACS will start in Demo mode. 
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Creating new user accounts 
1. Click the New User icon in the User Login dialog box and the Administrator Login dialog box 

appears (see next figure). 

Figure 26: ACS Administrator login 

 

2. Enter a password for the administrator (default account user name is ACSADMIN, however, there 
is no password). 

3. Click OK: the New User dialog box appears (see next figure). 

Figure 27: ACS New user account 
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4. Click the type of account desired: Operator or Engineer (see previous figure). 
• Operator: This account allows loading and running test projects.  
• Engineer: This account allows access to all the ACS software functions. 
• Type an account name and password in the Account name and Password fields. 
• Type the password again in the Confirm field. 
• Click OK. The new user account process is complete. 

Initialize multiple user accounts in Windows® environment 

If you try to run ACS on a computer that has more than one Windows user account and you have not 
initialized all of the accounts to run ACS, you will receive an error and you will not be able to use 
ACS software with all of the user accounts. Refer to the following information in order to establish 
multiple user accounts in a Windows environment. 

This information is for those who have more than one user account when logging in to a Windows 
account (see next figure). If you have more than one user account on your computer, make sure that 
you have logged off the previous user account and have logged on the correct user account. If you 
do not have multiple user accounts, you do not need to know this information. 

Figure 28: Windows User Accounts 
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If one of the user accounts (Admin1, User1, or User2) has already installed ACS software, none of 
the other users need to install the software, however you do need to initialize the user account to 
access and use the ACS software. Additionally, if the Admin1 account is the user who installed ACS 
software on the computer, then Admin1 will not have to follow this procedure to access and use 
ACS.  

After selecting a user account (in this example, User1) and your desktop is loaded, click on your 
Windows Start button and find ACS in All Programs (see next figure). 

Figure 29: Windows Start function 

 

Click the Initialize User function (see next figure). 

Figure 30: Initialize User account 

 

After you click the Initialize User function, you will receive a dialog box that states you must restart 
your computer (see next figure). 

Figure 31: Restart your computer to Initialize User account 

 



Section 3: ACS Software Overview ACS Automated Characterization Suite (ACS) Reference Manual 
 

3-8 ACS-901-01 Rev. H / December 2014 

 

Once your computer reboots, you can log in to your account and run ACS software. 

If you have other user accounts in your Windows environment who need to access and use ACS 
software, you will need to initialize the account for each user. 

 

User accounts security 
ACS software provides three types of user accounts (or operating modes) and each has different 
rights and security features. 

1. Engineer: The engineer (or administrator) user type account has unrestricted rights to create and 
edit test projects, including test parameters within ACS. It can also edit or delete operator 
accounts. The default administrator account user name is ACSADMIN. 

There can be other engineer user accounts; however, there is only one engineer administrator. 

2. Engineer: The engineer user type account has unrestricted rights to create and edit test projects, 
including test parameters within ACS. However, this engineer account cannot edit or delete 
operator accounts.  

3. Operator: The operator user type account can open and run available test projects that were 
created by either the engineer or administrator.  

 Account management 

Click Tools on the standard toolbar. On the drop-down menu select User Accounts (see next figure).  

Only engineer accounts can access the User Accounts in the Tools drop-down menu. Further, only 
the engineer administrator account ACSADMIN will see the complete list of user accounts. Other 
engineer accounts will only see their own account. Operators do not have access to this feature. 
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Figure 32: User Accounts location 

 

The dialog box that opens for both the engineer default administrator account ACSADMIN and 
another engineer account is in the next figure. The User Type column lists whether the user is an 
Engineer or Operator. Notice that the ACSADMIN User Name account shows all of the user 
accounts. 

Figure 33: User Accounts information 
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Add new user 

Only the engineer default administrator account ACSADMIN has the necessary rights to add a new 
operator or engineer account. 

When logged in to ACS in the ACSADMIN account, select the Add function in the User Accounts 
dialog box in order to create a new account (see previous figure). Once you click Add, you will see 
the New User dialog box (see next figure). 

Figure 34: New User account 

 

Click the type of account desired: operator or engineer (see previous figure). 

• Type an account name and password in the Account name and Password fields. 
• Type the password again in the Confirm field. 
• Click OK; the new user account process is complete. 
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Change password 

Only the engineer default administrator account ACSADMIN has the necessary rights to change a 
password for all of the user accounts. An engineer account can change its own password, but not 
any other accounts. An operator does not have access to this function. 

When logged in to ACS in the ACSADMIN account, or an engineer account, select the account that 
will have the password changed (see next figure). 

Figure 35: Select a user account 

 

Click the Edit function to open the Change password dialog box. Enter the current password of the 
account, enter a new password, and then confirm in the appropriate fields (see next figure) 

Figure 36: Change user account password 

 

Click Ok to complete the process. 
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Delete user account 

Only the engineer default administrator account ACSADMIN has the necessary rights to delete user 
accounts. The engineer and operator account do not have access to this function 

Select the account you want to delete and click the Delete function. To complete the process click 
Yes when asked if you want to delete the account (see next figure). 

Figure 37: Select user account to delete 
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Scanning the hardware configuration 
The first time you log in to the ACS software, it will be necessary to scan the current hardware 
configuration, which is accomplished in the evaluation mode. When starting the ACS software, if the 
hardware in the current system is different from the previous system, the hardware change 
information dialog box opens (see next figure). This dialog box shows the hardware information of 
both the current and previous systems. 

Figure 38: Hardware change information 

 

Once you have the hardware configuration established in the evaluation mode, make sure the 
configuration has been saved. Once saved, you should close the ACS software. Once closed, you will 
need to open the ACS software and the saved hardware configuration will be available and the 
standard mode operation will also be available. 

For more information on scanning and saving the hardware configuration in the ACS software, refer 
to the following section: ACS Hardware examples (on page 17-1). 

When the ACS software is started in the standard mode, the startup time depends on the number of 
instruments in the hardware configuration group. For example, if there are several instruments, the 
startup time is longer. 

• The Re-scan function will scan the hardware again. 
• The Continue function will continue to start ACS  
• The Exit function will exit the current process  
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ACS software GUI 
Once the ACS software has started, the ACS software graphical user interface (GUI) opens. The next 
figure shows the GUI in engineer mode and the following figure shows the operator mode: 

Figure 39: ACS software in engineer mode 

 

Figure 40: ACS software in operator mode 

 
 

Operation toolbar 
The Operation toolbar is located at the top of the ACS software Main dialog box and contains a set of 
project file management functions that allow you to perform various tasks (see the next three figures). 

Figure 41: Operation toolbar 
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Project file management functions 

Figure 42: New, Open, Save, and Save All functions 

 

The New, Open, Save, and Save All functions allow you to create and manage project files. New 
opens a new project; Open opens an existing project; and Save saves an operation to the Test Tree. 
Save All saves all project settings and all test results data. 

In order to make sure that all test results are saved for later use, viewing, etc., the Save All function 
must be used when testing is completed. This will ensure that the test results are saved and 
available in the data file. 

Test control functions 

Figure 43: Run, Repeat, Append, Pause, Stop, and Clear Append functions 

 

The Run, Repeat, Pause, and Stop functions allow you to actively work with tests. Run initiates the 
test procedure. Repeat continues test execution until Stop is selected. Append allows manual testing 
of a test module in append data mode. Pause allows a temporary stop of the test flow (the test will 
pause right after the current operation is finished; the next test will not execute). When utilized, the 
Stop function will immediately end testing. Clear Append will delete all appended data. 
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Vertical toolbar 
On the vertical edit toolbar, when you make a selection in the edit panel and the tabs of each will 
change in the vertical toolbar based on your selection (see the next five figures for examples of the 
edit toolbar and the vertical toolbar). 

You will need to fully expand the test setup panel to view the vertical tool bar. 

Figure 44: Recipe Level with tabs available 

 

Figure 45: Pattern Level with tabs available 

 

Figure 46: Subsite Level with tabs available 
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Figure 47: Device Level with tabs available 

 

Figure 48: Test Level with tabs available 
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Test setup functions 

Project management functions: 

Rename icon: You can rename function your pattern, subsite, device, or test modules. 

Delete icon: You can delete a selected pattern, subsite, device, or test module. 

Copy icon: You can copy a pattern, subsite, device, or test module. 

Cut icon: You can cut a pattern, subsite, device, or test module. 

Up and Down icon: You can move a pattern, subsite, device, or test module up or down which will 
also change the test and device node sequence. These two functions can be displayed or hidden 
depending on the current node location (for examples of the Project management functions, see the 
following graphics). 

Not all of the test setup and project management function components will be available for all node 
levels (such as, Pattern (Site), Subsite, Device and Test) found in the Test Tree, but will be added or 
removed as you click on the items that are present. 

PATTERN, SUBSITE, DEVICE, ITM, STM, CTM, and PTM 

These functions are enabled or disabled depending on the active test functions. The following text 
also includes the graphic of the function. 

Pattern icon: Pattern function allows wafer test set up site patterns (see next figure). 

Figure 49: Pattern Edit toolbar icons 
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Subsite icon: Subsite function allows wafer subsites definition (see next figure). 

Figure 50: Subsite Edit toolbar icons 

 

Device icon: Device function allows a choice of devices to be tested (see next figure). 

Figure 51: Device Edit toolbar icons 

 



Section 3: ACS Software Overview ACS Automated Characterization Suite (ACS) Reference Manual 
 

3-20 ACS-901-01 Rev. H / December 2014 

 

ITM, CTM, STM, and PTM icons (in this order): ITM, CTM, STM, and PTM functions allow the classes 
of tests or test modules definition (see next figure). 

Figure 52: Subdevice Edit toolbar icons 

 

Hardware configuration function  

Configure Hardware icon: Configure Hardware function configures the hardware (see next figure): 

Figure 53: Configure hardware icon 

 

Scan Hardware icon: Scan hardware function scans and updates the hardware information (see next 
figure): 

Figure 54: Scan hardware icon 
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Menu bar elements 

The New, Open, Save, and Save All functions in the Operation toolbar are identical to the Menu Bar 
in the File menu drop-down list (see next figure). 

Figure 55: File drop-down menu 

 

The Copy, Cut, and Delete functions in the Operation toolbar are identical to the Menu Bar in the Edit 
menu drop-down list (see next figure). 

Figure 56: Edit drop-down list 
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The Run, Repeat, Append, Pause, Stop, and Clear Append functions in the Operation toolbar are 
identical to the Menu Bar in the Operation menu drop-down list (see next figure). 

Figure 57: Operation drop-down list 

 

Tools menu 

Figure 58: Tools drop-down list 
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You can use the Tools menu to access many different functions that are related to the ACS software. 

KULT: You can click KULT to integrate custom algorithms (user modules) into KITE. 

KCON: You can click KCON to define the configuration of external GPIB instruments, switch matrices, 
and analytical probers connected to the Model 4200-SCS. KCON also provides basic diagnostic and 
troubleshooting functions. 

Test Script Builder: You can click Test Script Builder to orchestrate a sequence of events and 
program the language for scripting. 

Preferences: You can click Preferences to open the advanced Preferences dialog (see Log message 
dialog box (on page 3-32) for more information). 

User Accounts: You can click User Accounts to view the dialog box that contains all of the configured 
user information. 

Configure Hardware: You can click Config Hardware to access the hardware configuration utility (see 
ACS Hardware examples (on page 17-1) for more information). 

Firmware Refresh Kit: You can click Firmware Refresh Kit to refresh the 2600B SourceMeter 
instruments firmware. This utility verifies the firmware on your Series 2600B instruments connected to 
the ACS software, and allows you to update the firmware with the latest files from www.keithley.com. 

Offline Data Plotting: You can click Offline Data Plotting to access the data plot tool (see Data plot (on 
page 5-203) for more information).  

Custom Test GUI Designer (.xrc): You can click the Custom Test GUI Designer (.xrc) to access the 
graphical user interface (GUI) builder (see Create a TSP GUI file (on page 5-109)  for more 
information). 

Script Editor: You can click the Script Editor to access the script editor tool (see Script editor tutorials 
(on page 5-180) for more information). 

Convert Data: Selecting this option displays the dialog box which facilitates the conversion from a 
KDF file to either a NDF or NBF file format. 

Graphically Define a New Device: You can click Graphically Define a New Device to access the 
device editor tool.  

Help menu 

There are many items that you can access from the Help drop-down list, such as documentation of 
the ACS software and instrument documentation (see next figure). 
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Figure 59: Help drop-down list 

 
 

Edit panel 
The left-side of the ACS Main dialog box contains the edit panel. The following functions are on the 
edit panel: 

• Wafer description 
• Test setup 
• Prober control 
• Automation 
• Summary report 
• Statistics 

The test setup flow and details of each step are discussed in the following Sections of this manual. 
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Wafer description 
Click the Wafer Description function on the edit panel and the Wafer Description panel opens (see 
next figure). 

Figure 60: Wafer Description panel 

 

The wafer description panel is where you edit wafer information; the results immediately display in the 
work area to the right of the ACS Main dialog box (see next Table for a description of editable wafer 
characteristics).  

Description of wafer characteristics 

Wafer Description Elements Description 

Dia 
Clicks the diameter of the wafer (inches or millimeters) from a drop-down list. 
When Dia is changed, the wafer map is redrawn and all dies previously selected 
are cleared. 

Dia Unit  Clicks the unit of diameter (inches or millimeters). When Dia Unit is changed, the 
content of Dia is automatically converted. 

Die X Enters the X die size (millimeters or mils). When Die X is changed, the wafer 
map is automatically redrawn and all dies selected previously are cleared. 

Die Y Enters the Y die size (millimeters or mils). When Die Y is changed, the wafer 
map is redrawn automatically and all dies selected previously are cleared. 

Die Unit 
Clicks the unit of die (millimeters or mils). When Die Unit is changed, the X and 
Y die size values are converted automatically, as well as the X and Y of the 
subsite. 

Axis Sets the direction in which the X and Y coordinates increase. 
Flat Sets whether the wafer has a flat or notch edge. 

Orient Specifies the flat or notch position to be 0, 45, 90, 135, 180, 225, 270, or 315 
degrees on the wafer. 

Margin Size (mm) Enters the width of the wafer margin (millimeter). 

Offset Setting There are four direction functions: left, up, down, right. When an offset function is 
selected, the wafer moves to the corresponding direction. 
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Test setup 
Click the Test Setup function on the Edit Panel and your test tree appears in the edit panel (see next 
figure). 

Figure 61: Test Tree panel 

 

The test tree panel displays your test flow characteristics. For example, it shows what kind of device 
is going to be tested and what test is to be performed.  

General editing  

With the Test Setup panel active, you can make general edits to test patterns, subsites, devices, and 
test modules using the Copy, Paste, Cut and Rename commands (see next Table). To make 
modifications, click the desired node in the Test Setup panel, and then click the node to choose the 
desired editing command. For example, to make edits to a Subsite, click on the Subsite node, then 
click your desired command (see next figure). 

You must click the node to get the correct operation. 
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Figure 62: Subsite right-click edit drop-down list 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Test setup panel: available editing commands 

Edit command Description 
Copy Click and Copy the desired pattern, subsite, device, or test modules.  
Cut Click and Cut the desired pattern, subsite, device, or test module.  

Paste After you copy or cut the desired pattern, subsite, device, or test module, click the place 
where you want to paste it. Click the desired location then click the Paste command.  

Rename 
Click the desired pattern, subsite, device, or test module, then click Rename to change the 
name of the selected node. Available characters for naming are A-Z, a-z, 0-9, and the “_”. 
The first character must be A-Z or a-z. 

 
 



Section 3: ACS Software Overview ACS Automated Characterization Suite (ACS) Reference Manual 
 

3-28 ACS-901-01 Rev. H / December 2014 

 

Prober control 
Click the Prober Control function on the edit panel, and the Prober Control panel appears in the edit 
panel (see next figure).  

Figure 63: Prober Control panel 

 

Prober Control is used for semiautomatic tests where you control the probers manually. The next 
table gives a description of the commands available to control probers. 

Commands available 

Prober command Description 
Initialize  Establishes communication with the chosen prober.  
Home  Moves to the target site. 
Load Loads a new wafer, but unloads the currently loaded wafer first. 
Unload Unloads a wafer. If no wafer is loaded, no action is taken. 

Step Move Moves to the next site in the corresponding direction. The function in the middle 
controls the chuck to be moved up and down. 

Probe Sites Moves to and touches all sites in every pattern to be tested and verifies that the  
wafer is correctly loaded, but does not run the test(s). 

Interval Time delay between every prober movement. 
Move To Subsite Moves to desired subsite. 
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Automation panel 
Click the Automation function on the edit panel, and the Automation panel appears in the edit panel.  

The automation panel allows you to run automation tests on an entire cassette. To run an automation 
test, click the Automation function, then click the Run function. The progress of the test appears, and 
is refreshed, in realtime in the autotest information table (see next figure). 

Figure 64: Automation panel 
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Statistics panel 
The Automated Characterization Suite (ACS) software provides statistical features for you in order to 
view data trends and plot distribution curves. You can do simple analysis and make necessary 
adjustments in order to modify test conditions, if needed (see next figure). 

You can create an output file with a Keithley data file (KDF) which also supports multi-KDF files, if 
desired, for analysis. Additionally, you can view the online data plot result while ACS testing is in 
progress (see the Statistical features section for more information). 

Figure 65: Statistics panel 
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Summary report 
You can display a Summary Report by clicking the Summary Report function on the edit panel. After 
clicking the Summary Report function, the Summary Report appears in the edit panel.  

When the data file and limits file (optional) are imported, a report of the entire test can be generated. 
To generate a report of the entire test, click the Generate Report function (see next figure). The report 
appears in the ACS work area. If sorting by limits, your limit inputs will be compared to the results. 
The results that exceed your limits will be indicated in the report. 

Figure 66: Summary Report panel 
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Log message dialog box 
The log dialog box is located below the main ACS GUI (see next figure). The log message is 
displayed in the log dialog box in realtime. 

You can configure the information of the log message dialog box by clicking Tools in the Menu Bar 
where you will see a drop-down list. Make sure you choose Preferences, then Advanced, where you 
will see three choices: INFO, WARNING, or ERROR. This is where you can choose the type of log 
message you desire to view. 

Figure 67: Log message window 
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To access the Log dialog box Display Level setup function, use the following directions in order: 

1. Click Tools in the Menu Bar where you will see a drop-down list. 
2. Click Preference from the list and the Preferences dialog box appears (see next figure). 

Figure 68: Preferences Advanced tab 

 

3. Choose the Advanced tab. 
4. In the Log dialog box Display Level section, click either INFO, WARNING, or ERROR. 

Additionally, you can click View in the Menu Bar where you will see a drop-down list and where you 
can select or deselect the Show Log dialog box (see next figure). 
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You can select the Show Log Window by clicking the item and you can deselect by clicking again. 
When selected you will see a checkmark and when deselected, the item will not have a checkmark. 

Figure 69: View drop-down list 
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Wafer introduction 
The Keithley Instruments Automated Characterization Suite (ACS) software supports two kinds of 
wafers: circle-shaped and square-shaped. The circle-shaped wafer is the most common while the 
square-shaped wafer is used for special cases. 

Select a wafer shape for a new project: 
1. Click the Preferences item in the Tool menu and the Preferences dialog box opens (see the next 

two Figures). 

Figure 70: Preferences in Tools drop-down 

 

Section 4 

Wafer Description 
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Figure 71: Preferences Misc tab 

 

2. In the Preference miscellaneous tab dialog box, you will need to click the Wafer Shape (the 
shape will take affect once you create your new project). 

3. Click OK. 
4. In the Preferences dialog box within the Misc tab, there is a choice to Clear old scripts in Series 

2600B SourceMeter instruments when you open a project and run automation. You will need to 
click this option to eliminate previous scripts from the system. 

Figure 72: Square and Circle wafer shapes 
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Circle-shaped wafer description panel 
The Wafer Description panel allows you to define wafers. It activates once you click the Wafer 
Description tab (see next figure). You can edit the wafer information in this panel and the results 
immediately display in the ACS main dialog box work area. You can review the next table for wafer 
description editing elements and their corresponding descriptions. 

When you change the Orient of the wafer, the sites that you defined in the wafer map will also 
change in order to keep consistent with the flat or notch orientation. However, the Axis will not 
change. Therefore, this may cause an incorrect operation of the prober to your sites and subsites. It 
is highly recommended that you define the Orient before you define any sites or subsites. 

Figure 73: Wafer Description panel activated 

 

  

Wafer Description 
Elements 

Description 

Dia Changes the intended diameter of the wafer to be tested from a drop-down list. When 
Dia is changed, the wafer map is redrawn and all dies previously selected are cleared 
. 

Dia Unit Changes the unit of diameter (inches or millimeters). When Dia Unit is changed, the 
content of Dia is automatically converted. 

Die X Sets the X die size (millimeters or mils). When Die X is changed, the wafer map is 
automatically redrawn and part of selected image previously is cleared1. 

Die Y Sets the Y die size (millimeters or mils). When Die Y is changed, the wafer map is 
redrawn automatically and part of selected image is cleared1. 

Die Unit Changes the unit of die (millimeters or mils). When Die Unit is changed, the X and Y 
die size values are converted automatically, as well as the X and Y of the subsite. 

Axis Sets the direction in which the X and Y coordinates increase. 
Flat Sets whether the wafer has a flat or notched edge. 
Orient Specifies the flat or notch position to be 0, 45, 90, 135, 180, 225, 270, or 315 degrees 

on the wafer. 
Wafer Edge Margin (mm) Sets the width of the wafer margin in millimeters. 
Offset Settings There are four direction arrows: left, up, down, right. When an offset function/button is 

selected, the wafer moves in the corresponding direction. 
 

1 There is a wafer setting in the miscellaneous tab of the Preference Setting that you can click in order to clear all previous scripts that were 
generated for the Series 2600B instruments.   
 



Section 4: Wafer Description ACS Automated Characterization Suite (ACS) Reference Manual 
 

4-4 ACS-901-01 Rev. H / December 2014 

 

Wafer pattern 
At the macroscopic level, one or more semiconductor dies are built-up at a given wafer location. 

This location is comprised not only of end-product dies, but usually one or more parametric test 
structures or subsites. ACS refers to such a repeating pattern of dies and test structures as a Pattern. 

Once you have inserted the necessary wafer description information, the wafer map opens in the 
ACS GUI work area (see next figure). You are now ready to define the pattern information. 

Figure 74: Wafer Map Description 

 

ACS supports multiple patterns in a single wafer. All patterns share the same wafer map, but they can 
have their own test plan, including different sites, subsites, devices, and test modules. In addition, 
different colors can be used to distinguish patterns. 

To select a pattern: 
1. Double-click the desired Pattern item in the configuration navigator. 
2. Click the Color function (located to the right of the pattern name), and the Color Choice dialog box 

opens (see next figure). You can choose either a basic color or customize your own color. 

Figure 75: Color choice pointer 
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3. To choose a basic color, click on one of the square colors. To choose a custom color, click on the 
desired color by left-clicking and dragging the crosshair pointer onto the desired color. The 
selected color is displayed in a Custom Colors area that is located below the Basic colors area. 

4. Click OK when finished. The color is assigned to the selected pattern. 
 

Display wafer pattern 
One wafer can display the selected sites of a pattern, of several patterns, or all patterns. Every 
pattern has a single color; however, you can choose the pattern color in order to distinguish between 
different patterns. If you deselect a pattern item in the Test Setup configuration navigator, the pattern 
will not display in the Wafer Map and may not be available for testing. 

As shown in the next figure, Pattern_2 is not selected, which means the sites are not displayed in the 
Wafer Map, however, the Wafer Map of Pattern_1 is selected and it’s sites are displayed. 

Figure 76: Wafer display Pattern_1 
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It is possible to click both Pattern_1 and Pattern_2. If both patterns are selected, the sites of both 
patterns will be displayed (see next figure). 

Figure 77: Display Pattern_1 and Pattern_2 sites 

 
 

Circle-shaped wafer map 
After a pattern is selected, the displayed Wafer Map is displayed in the work area in the ACS main 
dialog box. It is used to display the customized wafer in the Wafer Description panel, and to capture 
and set the size and location information where the test structures are to be probed. 

Keep in mind that all the information contained in the Wafer Map is in accordance with the current 
pattern you have selected. 

You can select a site that is under test by clicking the Wafer Map; you can deselect a site by clicking 
it. Multisites (or blocks of sites) may be selected or not selected by clicking and dragging, then you 
must choose from the options displayed in the drop-down menu (Select Sites, Clear Sites, Erase 
Sites, or Recover Sites). 
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If you right-click on the Wafer Map work area, a drop-down menu displays (see next figure). 

Figure 78: Wafer Map drop-down list 

 

  

Wafer Map Menu Item Description 
Select All Selects all possible sites of the wafer. 
Clear All Clears all selected sites of the wafer. 
Set As Target Sets the selected site as the target site, which defines the first stopping point after 

alignment. 
Set As Reference Sets the selected site as the reference site, which defines the origin of site 

coordinates. 
Set As Target With (X, Y) Sets the selected site as the target site, which defines the target site’s position (X,Y).  
Set As Erased Site Sometimes you do not want to perform a test on certain sites, but still mark them as 

bad (erased) for further operations such as binning. The selected site will be set as 
erased and displayed as gray in the wafer map. ACS will not run a test on this site. 

Recover the Erased Site Recovers and brings the erased site back to normal. 
Recover all Erased Sites Recovers and brings all erased sites back to normal. 
Allow Partial Allows the collection of sites that do not fall completely within the usable wafer 

boundaries to be selectable. 
Disallow Partial Only allows the collection of those sites which are fully within the usable wafer 

boundaries to be selectable. 
Define Logical Site Allows you to define the attributes of a predetermined logical site (for applications 

such as parallel testing).  
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Allow Partial and Disallow Partial 

Choosing Allow Partial enables you to test all the dies that are both whole and partial (this means 
dies that fall within the outline of the proposed wafer shape)(see next figure).  

Figure 79: Allow Partial and Disallow Partial items 
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When Disallow Partial is selected, you are prevented from testing the partial dies. However, the full 
dies within the wafer shape can still be tested. Also, when Disallow Partial is selected, the wafer will 
show all the full dies in the color cyan and the partial dies in in gray color (see next figure). 

Figure 80: Disallow Partial dies 

 

Figure 81: Selected partial dies 
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Erased sites 
You can erase multiple sites from the wafer map so that they cannot be selected for testing. After you 
run automation, you can choose to mark those sites as erased. 

To mark a site erased, right-click on the site you want to erase, then choose Set As Erased Site. The 
selected site will be set as erased and displayed in gray in the wafer map. ACS will not run tests on 
this site because it is marked erased. To recover an erased site, click Recover the Erased Site. To 
recover all erased sites, click Recover all Erased Sites (see next figure). 

Figure 82: Wafer Map with erased sites 
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Logical sites 
Understanding logical sites 
To begin to understand logical sites, you first understand the difference between two concepts:  

• Physical site  
• Logical site 

Physical sites are the sites on the wafer, the size and position of which are exactly the same as the 
real wafer. 

Logical sites are defined to run parallel tests on the wafer with several physical sites grouped together 
(the number will depend on how many groups of Series 2600B instruments you have) to 
simultaneously perform the same tests during the automation test process. Such a group of physical 
sites is called a logical site. Logical sites allow testing of a group of physical sites with only one prober 
card touch, which sharply decreases the number of prober movements, thus shortening the 
automation test time. 

Defining a logical site 
1. Right-click on the wafer map to activate the drop-down menu, then click the Define Logical Site 

function.  
2. Enter the following logical site characteristics:  
A. Site Dimension: you can determine how many physical sites are in the row and column of a 

logical site (see next figure). 

Figure 83: Define Logical Site 

 

B. Dies to Groups Mapping: you can determine the mapping of physical sites and Series 2600B 
groups.  

If you do not assign a physical site, the site will not be chosen and no test will be run. 

3. Click OK. 
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If the row is set to 1 and the column is set to 1, the logical site will be disabled. 

Defining wafer map with logical site 
The collection of logical sites on the wafer map is similar to the physical sites. 

When you click a die on the wafer map, it will display a logical site with an icon on the upper left site. 
The marked site is the reference site (0, 0) in this logical site. In the Define Logical Site dialog, if you 
move and hover your cursor over the defined sites, the reference position numbers and coordinates 
will appear. 

The next figure shows an example of a two-row, two-column logical site definition. 

Figure 84: Logical site, two-row, two-column position example 

 

The next figure shows an example of a one-row, two-column logical site definition that has been 
applied to a wafer map.  

Figure 85: Logical site, one-row, two-column example 

 

• If you click on the upper left site (marked) of a selected logical site, it will not be selected.  
• If you click on unmarked sites, another logical site will be selected, with a new marked upper-left 

site.  
• When you apply the drag and click method, it is the typical way to create a collection of selected 

logical sites.  
• If you choose Select All, the software will calculate and cover as many physical sites as possible 

with logical sites (see next figure).  
• If you want to cover all the sites on the wafer, left-click on the wafer map to click all of them.  
• After defining the wafer map with logical sites, you can run a parallel test in automation, which 

tests several sites at the same time with different Series 2600B groups. 



ACS Automated Characterization Suite (ACS) Reference Manual Section 4: Wafer Description 
 

ACS-901-01 Rev. H / December 2014 4-13 

 

Figure 86: Logical site, Click All command example 

 
 

Site collection by dragging 
Site collection by dragging allows you to choose (or clear) several sites on the wafer map by clicking 
the left mouse button on the site, holding, and then dragging a box around the sites you want 
selected. There are four choices in the Site Selection pop-up menu: 

• Select Sites: chooses all sites inside the rectangular area.  
• Clear Sites: deselects all sites inside the rectangular area.  
• Erase Sites: marks all sites inside the rectangular area as invalid.  
• Recover Sites: recovers all previously-marked invalid sites inside the rectangular area. 

Figure 87: Clear Sites collection example 
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Circle-shaped wafer map advanced settings 
The advanced wafer map settings are found in the right-side panel of the wafer map and include: 

• Wafer Map Scale (100% - 500%) 
• Wafer Map Style (Wafer View or Grid View) 
• [Site Sequence] Optimization (click for several options) 
• Current Site Indicator (Current Site and Selected Sites) 
• Wafer Map Color Editor (six color choices) 

Wafer Map Scale 
Using the Wafer Map Scale setting, the wafer map view can be enlarged by increasing the wafer map 
scale input (see next figure).  

The wafer map’s axis direction can be changed using the Axis element under Wafer Description. 

Figure 88: Wafer Map scale 
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For instance, if the Scale is set to 200%, the wafer map view will be displayed at 200% of the original, 
with only part of the wafer being displayed (see next figure). 

Figure 89: Wafer Map scale close view 

 

Wafer Map Style 
The default style of the wafer map is the Wafer View; however, it can be changed to Grid View in the 
Style setting. Choosing Grid View displays all the grids in the background (see next figure). The 
difference between Wafer View and Grid View is that you can set a reference site outside the wafer 
boundary by referencing the grid beyond the edge of the wafer.  

Figure 90: Wafer Map style grid view 
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Sites Sequence Optimization 
The Sites Sequence Optimization feature is accessed by clicking the Optimization function (see next 
figure).  

Figure 91: Optimization function 

 

After clicking Optimization, a dialog box displays that allows you to set the sites sequence 
characteristics for automation tests (see next figure).  

Figure 92: Sites Sequence Optimization 
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When a sequence is selected, the test initiates, following the directional sequence of the selected 
pattern.  

For example, if the icon is selected, the test starts from the lower left corner site and sweeps left to 
right in an upwards direction. Click OK to confirm the sequence. 

In the sequence priority area, you can click site first or pattern first. These two modes are used when 
more than two patterns are selected in the test plan. Site first means that the prober will not move to 
the next site until all patterns in a selected site have been finished. Pattern first means that the prober 
will not move to Pattern2 until all sites within Pattern1 are finished (see next figure). 

Figure 93: Sites Sequence left image first, right image pattern first 

 

Sites Indicator 
Below the Optimization function is the Current Site indicator. The Current Site indicator displays the 
coordinates of the site where the last mouse click or drag action was performed on the wafer map. 
The Selected Sites indicator shows the total number of presently selected sites on the viewable wafer 
map (see next figure). 

Figure 94: Sites indicator 
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Wafer Map Color Editor 
The color editor is used to change the color settings of a wafer map (see next figure). 

• Default Site: This function is used to set and show the color of the wafer background. Once selected, a 
Color Choice dialog box displays that allows you to change the color selection. This is the same dialog 
box where you choose a color for a selected pattern. 

• Target Site: This function is used to set and show the color of the target site. Once selected, a Color 
Choice dialog box displays, allowing you to change the Target Site’s color selections.  

• Selected Target: This function is used to set and show the color of the selected target site, indicating 
whether the target site is selected or not. Once selected, a Color Choice dialog box displays, allowing 
you to change the color selection.  

• Wafer Margin: This function is used to show and set the color of the wafer margin. Once selected, a 
Color Choice dialog box displays, allowing you to change the color selection.  

• Grid Line: This function is used to show and set the color of the lines dividing grids. Once selected, a 
Color Choice dialog box displays, allowing you to change the color selection.  

• Invalid Site: This function is used to show and set the color of the invalid sites. Once selected, a Color 
Choice dialog box displays, allowing you to change the color selection (see next two figures). 

Figure 95: Wafer Map Colors editor 
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Figure 96: Color choice 

 
 

Square-shaped wafer description 

Square-shaped wafer description panel 
If you want to use a square-shaped wafer (selected through the Tools drop-down menu, then 
Preferences, Misc tab), the Wafer Description panel will be modified to allow for defining its’ specific 
attributes. For information about how to define a square-shaped wafer, refer to Click a wafer shape 
for a new project: 

The Wafer Description functions are found on the edit panel in the ACS GUI (see next figure). You 
can edit the wafer information in this panel and the results immediately display in the ACS GUI work 
area. You can review the next table for wafer description editing elements and their corresponding 
descriptions.  

The Orient operation will not change the sites or subsites; it only marks the orientation of the 
alignment. 
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Figure 97: Square-shaped Wafer Description 

 

  

Wafer Description Elements Description 
Height Height of the square-shaped wafer. 
Width Width of the square-shaped wafer. 
Num X Site number in the X direction. 
Num Y Site number in the Y direction. 
Unit Unit of length, in inch or millimeter. 
Axis The axis direction of the squared-shaped wafer. 
Orient The direction of the alignment. 

Wafer pattern and display pattern  
For square-shaped wafer, operations on the wafer pattern and display pattern are the same as that of 
the circle-shaped wafer. For more information about Pattern and Display pattern, refer to the Pattern 
and Display pattern information. 
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Square-shaped wafer map 
After a pattern is selected, the desired Wafer Map is displayed in the work area of the ACS GUI (see 
next figure). It can be used to capture and set the size and location information where the test 
structures are to be probed. 

Figure 98: Square-shaped Wafer Map 

 

You can select a site that is under test by clicking the wafer map; you can deselect a site by re-
clicking it. Also, you can select or deselect multi-sites (or blocks of sites) by holding down the left 
mouse button and dragging over the desired area. Then, choose one of the options that appear in the 
pop-up menu that accompanies this action. If you right-click on the Wafer Map, the Wafer Map menu 
displays (see next figure). You can review the next table regarding the wafer map menu item 
descriptions. 

Figure 99: Square-shaped Wafer Map items 

 

Wafer Map items 

Wafer Map Menu Item Description 
Click All Selects all possible sites of the wafer. 
Clear All Clears all selected sites of the wafer. 
Set As Target Sets the selected site as the target site, which defines the first stopping point 

after alignment. 
Set As Reference Sets the selected site as the reference site, which defines the origin of site 

coordinates. 
Set As Target With (X, Y) Sets the selected site as the target site, which defines the target site’s position 

(X,Y).  
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Site selection by dragging 
Site Selection by dragging allows you to choose (or clear) several sites on the wafer map by clicking 
the left mouse button on the site, holding down the mouse function, and dragging a box around the 
sites you want selected. There are two choices in the Site Selection pop-up menu: 

• Select Sites: select the sites inside the rectangular area. 
• Clear Sites: clear the selected sites inside the rectangular area. 

Figure 100: Clear Sites selection example 
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Square-shaped wafer map advanced settings 
The advanced wafer map settings are found on the right panel of the wafer map, and include: 

• Wafer Map Scale  
• Sites Sequence Optimization  
• Sites Indicator  
• Wafer Map Color Editor 

Wafer map scale 
Using the wafer map scale setting, the wafer map view can be enlarged by increasing the wafer map 
scale input (see next figure). For instance, if the Scale is set to 200%, the wafer map view will be 
displayed at 200% of the original, with only part of the wafer being displayed. 

The wafer map’s axis direction can be changed using the Axis element under Wafer Description. 

Figure 101: Square-shaped Wafer Map Scale 

 

Sites sequence optimization and sites indicator  
The sites sequence optimization feature is same as the circle wafer. The optimization function is the 
sites indicator. It is also the same as the circle wafer. 

 

Wafer description limits and status tab 

Wafer limits tab 
Limits refers to the limits data entry area. The limits data associated with one parameter is arranged 
as one row (see next figure). 

Figure 102: Limits tab 
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The limits tab fields are as follows: 

• Subsite: The subsite name defined in configuration navigator. This field cannot be modified.  
• Device: The device name defined in configuration navigator. This field cannot be modified.  
• ID: The ID uniquely identifies each test parameter. This field cannot be modified.  
• Name: The name field provides for a “friendly” name, perhaps describing the parameter more clearly 

than the ID. This field cannot be modified. 
• Units: The Units field defines the units for the limits test results. This field may contain non-

alphanumeric characters (including spaces) and need not be a “C” language name. The only constraint 
is that it must not include commas. The string may contain a maximum of 13 characters. Examples of 
entries for this field are volts, amps, etc. The default value is “A.” 

• Report: Report determines whether or not the limit is included in the summary report. The entry of this 
field is set by checking or not selecting. 

• Critical: Critical allows parameters to be tagged as not critical (0), or as critical with one of nine different 
critical flags (1, 2, 3, 4, 5, 6, 7, 8, and 9). 

• Exit condition: You can define what Exit action will be taken when a failure of the corresponding 
parameter is found.  

• Target: The Target field identifies the ideal result expected for the specified result ID. The entry for this 
field is a numeric value. 

• Valid Low, Valid High: This pair of limits can be used to check for Exit condition within the testing 
system. Numbers outside of this range indicate that the data being produced by the system are invalid. 
Invalid data triggers the specified Exit Condition. 

• Spec Low, Spec High: This pair of limits can be used to check for manufacturing standards. Numbers 
outside the Spec range indicate that the device being tested does not meet manufacturing 
specifications. Results of the Spec Low, Spec High limits tests display in the color indicator with either a 
pass site or fail site, when run in automation mode. 

• Sigma: Parameter used in statistic 

Exit condition 
The exit condition column allows you to set the action to take when a failure of the corresponding 
parameter is found. There are several exit actions: 

• None (default) 
• Skip Device  
• Skip Subsite  
• Skip Site   
• Skip Wafer  
• Skip Project 

In the Limits tab under Wafer Description is the Exit Condition column (see next figure). You can set 
the parameter range for judgment in the Valid High and Valid Low field on the same page. 

There is no Skip Test, because the tests are all run in the LUA engine of the Series 2600B 
instrument; so on the software level, test flow cannot be controlled. 

Figure 103: Limits tab Exit Condition 
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Limits file 
Exporting limits files 

There are two ways to export the limits file (.klf file): 

• Click the Export function located at the bottom of Limits tab in Wafer Description.  
• Click the export limits file item under the File menu (see next figure). 

Figure 104: Export Limits File 

 

Using external limits files 

The external limits files function is used for reporting generation and being accessed under exit limits 
file of summary report (see next figure). 

Figure 105: Exit Limits File 
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Wafer description tab 
This tab displays the wafer description file (see next figure). 

Figure 106: Wafer Description tab 

 

Exporting wafer description files 

There are two ways to export the wafer description file (.wdf file): 

Click the Export function located at the bottom of the Wafer Description tab. Click the Wafer 
Description file item under the File menu (see next figure). 

Figure 107: Export .wdf or .klf files 
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After you export a .wdf file and save to a specified folder, you can import this file for use in other tests, 
eliminating the need to define a wafer every time you build test plan. 

Importing Wafer Description file files 

There are two ways to import the Wafer Description file (.wdf file): 

Click the Import function located at the bottom of Wafer Description tab in Wafer Description.  

Click the Wafer Description file item under the File menu (see next figure). 

Figure 108: Import .kpr, .wdf, .csv, .tpl files 

 

You can also change the content of Wafer Description, and click the Apply Change function, then the 
Wafer Map is changed as your new wafer Description. 
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Configuration navigator introduction 
ACS organizes tests in the hierarchy below, consistent with the semiconductor-wafer organization. 
The configuration navigator is in the following logical hierarchy: 

• Pattern (multipattern)  
• Subsite 
• Device (multigroup) 
• 2600B Graphical Interactive Test Module (ITM) 
• Model 4200 Graphical Interactive Test Module (ITM) 
• Script Test Module (STM) 
• C Language Test Module (CTM) 
• Python Language Test Module (PTM) 

Pattern 
At the macroscopic level, one or more semiconductor sites are built up at a given wafer location. This 
location is comprised not only of a product site, but usually has one or more parametric test structures 
or subsites. ACS supports multiple patterns of sites on a single wafer. All patterns share the same 
wafer map, but they can have their own test plan, which includes different site locations, different 
subsite locations, and test modules. You can use different colors to distinguish different patterns. 
ACS supports up to eight patterns in total. 

Subsites 
The terminals of each device on a test structure are connected to a uniformly-spaced series of 
contact pads. These pads are used to connect the devices to the probes of a prober. Every wafer 
location that the probe moves to and contacts at any time is called a subsite. Sometimes ACS refers 
to each such test structure (the combination of test devices that are tested as a group) as a subsite.  

Section 5 

Test Setup 
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Devices 
Each subsite contains a series of devices to be characterized - transistors, diodes, resistors, 
capacitors, etc. A multigroup test is supported on a device. All selected groups of devices will be 
tested simultaneously by a different Series 2600B group. 

Test Modules 
There are four classes of tests or test modules in ACS: Graphical Interactive Test Module (ITM), 
Script Test Module (STM), C Language Test Module (CTM) and Python Test Module (PTM). All test 
modules share common data sheet and data plot analysis functions. Key differences between an 
ITM, STM, CTM and PTM include the following: 

Graphical Interactive Test Module (ITM) 

An ITM allows you to define a test interactively using a graphical user interface (GUI). 

Script Test Module (STM) 

STM supports TSP™ and Keithley Test Macro (KTM) files. A TSP file (Test Script Processor) is 
written for testing a device with a Series 2600B System SourceMeter® Device and Wafer Library 
(WLR) scripts in ACS can be imported and modified in the STM module. STM also supports 
customers’ test scripts for the Series 2600B. A KTM file is produced by the User Test Module of KITE 
on the Model 4200 or CTM in ACS. 

C Language Test Module (CTM) 

A CTM is defined using the programming of its connected KULT-created user module. Configuring 
key test parameters is performed using a graphical user interface (GUI). 

Python Language Test Module (PTM) 

A PTM is defined by the programming of Python language. These Python programs can be imported 
or compiled in PTM interface. 

 

Test process flow summary 
There are two types of ACS test process flows: 

1. Perform tests on only a few devices with no automated flow involved. 
2. Perform tests throughout the cassette. When testing throughout the cassette, an auto-prober is 

required.  
 

Working with projects 
This section describes how to use an existing project from the standard ACS library and how to 
create a new project.  

This section assumes that hardware configuration is set and that all hardware is turned on. The 
software connections must accurately reflect the physical hardware connections at the time the test 
is executed. Incorrect terminal configurations result in anomalous test results at best, or device 
damage at worst. At every test startup, you must check whether the connections are matched 
correctly.  
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Using an existing project 
Once launched, ACS will automatically open the existing default project. If you would like to open a 
project rather than the default, perform the following steps: 

1. Click the Open Project icon on the toolbar; you can also click File and in the drop-down box click 
Open.  

2. Click the project file you want to open (a .xml file). 

If SMUs are required in the project you are trying to open, the ACS software will try to detect them in 
the current physical connection. Once the SMUs are found, the project will then load in the 
configuration navigator in the Test Setup panel. 

If the SMU connections in this project do not match the current physical connection, the 26xx SMUs 
Missing dialog box opens (see next Figure). 

Figure 109: SMUs Missing 

 

The 26xx SMUs Missing dialog box opens to inform you that some of the Series 2600B SMUs in the 
ITM-based project(s) cannot be found. To fix this, check all module settings in the project and 
reassign them where necessary until the SMUs Missing dialog box no longer opens when opening an 
existing project.  

Creating a new project using the configuration navigator 

1. Click the New function on the toolbar from the ACS Main dialog box (you can also click the New 
command from the File menu). The New Project dialog box opens (see next figure).  

2. In the Project Structure field, click the configuration navigator. 
3. In the Template field, type the storage folder or use the Browse function to browse for a directory. 
4. Enter the following information in the New Project dialog box. 

• Project Name: Enter the new project name.  

If you choose a name that has more than one word, the standard naming convention must have an 
underscore between the words or numbers, etc. For example, if you name your project 
CVU_CpGp_Compensation, the name must include an underscore rather a blank space (see next 
figure). 
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• Project Directory: Click storage folder for the Project, or use the default directory. Use the Browse 
function to browse for a directory.  

• Technology: Optional device information.  
• Product: Optional device information. 

Figure 110: Tree Style define new test project 

 

1. Click OK. The project is displayed in the Test Setup edit panel (see next figure). 

Figure 111: Tree Style test setup panel 
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2. The default Test Setup information displays, and includes:  
• Pattern_1: Default pattern name. The default pattern name can be changed to any string or color. 
• HOME: Default subsite name. The Home default subsite name can be changed to any string.  

The allowable characters for the name are: A - Z, a - z, 0 - 9, and the underscore ' _ '; the first 
character must be A - Z or a - z. 

3. Click the Device function icon on the toolbar (or right-click on the HOME or the subsite to choose 
the Insert Device function). The SMU type dialog box opens. 

Figure 112: SMU Type 

 

4. In the SMU Type dialog box, click 26** SMU or Model 4200 SMU. Click OK. The Select Device 
Type dialog box opens (see next figure). 

Figure 113: Select Device Type 
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If you choose the 26xx SMU, the new device will be named device_26. If you choose the Model 4200 
SMU, the new device will be named device_42. 

5. Select the device type to be tested. Click OK. The Image Browser dialog box opens (see next 
figure). 

6. Choose the device image that has a terminal connecting to the SMU. Later, these images appear 
in the test ITM, STM, PTM, or CTM work area. 

7. Click the Select button, and the new device is added to the configuration navigator. 

Figure 114: Device images 

 

8. Insert a Test Module by clicking the ITM, STM, PTM, or CTM button on the vertical toolbar. You 
can also right-click the device name and click Insert ITM, Insert STM, Insert PTM, or Insert CTM 
options to click required test module. 

9. Check the desired Group Number in the Groups area within the ITM Definition tab, or on the STM 
Script tab. 

10. Save the test project by clicking the SAVE function located on the toolbar. You can also use the 
Save command from the File menu. 
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Figure 115: Tree style project tree 

 
 

Create a new project using the map style 
1. Click the New function icon on the toolbar (you can also choose New from the File menu). The 

New Test Project dialog box opens (see next figure).  
2. In the Project Structure field, click Map Style.  
3. In the Template field, type the storage folder or use the Browse function to browse for a directory.  
4. Enter the following information in the New Project dialog box. 

• Project Name: Enter the new project name. 

If you choose a name that has more than one word, the standard naming convention must have an 
underscore between the words or numbers, etc. For example, if you name your project 
CVU_CpGp_Compensation, the name must include an underscore rather a blank space (see next 
figure). 

• Project Directory: Click storage folder for the Project, or use the default directory. Use the Browse 
function to browse for a directory. 

• Technology: Optional device information. 
• Product: Optional device information. 
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5. Click OK. The project is displayed in the Test Setup edit panel (see next figure). 

Figure 116: Map Style define new test project 

 

6. The default Test Setup information displays and includes:  
• Pattern_1: Default pattern name. The default pattern name can be changed to any string or color. 
• HOME: Default subsite name. The Home default subsite name can be changed to any string. 
• Devices: Device nodes and test modules can be added to the Devices. 

Figure 117: Map Style test setup panel 
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Create a new project 
For each .csv file, it is better to create a new project. From the ACS menu, click File->New. The 
software will open a dialog box where you need to enter a Project Name (see next figure). 

  
 

Import the SourceMeter .csv setting file 
1. From the ACS File menu, click Import > Test Plan File (*.csv)(see next figure). 

Figure 118: Import the stress migration .cvs file 
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2.  Confirm the .csv data: 

After the .csv file is selected, you will see next figure the Import Data Confirm dialog box (see next 
figure). Verify that the displayed data file is selected and then click OK. 

There are two import modes: 

A. Refresh: replaces an existing test, if it is the same in the test setup configuration navigator.  
B. Append: adds to the test setup configuration navigator. 

Figure 119: Import Data Confirmed 

 

After importing the .csv data file, a test is created, including the automatically generated stress 
migration script test modules  (see next figure). 

Figure 120: Automatically generated test setup tree 
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3. Set the wafer map and select the sites to be tested in the wafer map. 
4. Save the project (see next figure). 

Figure 121: Set the wafer map and select the site to be tested 

 
 

Import a Model 4200 project file 
You can import a Model 4200 project file to ACS. The project configuration navigator may include 
various types of test modules; however, ACS can only accept CTMs (C Language Test Modules; .kpr 
files). When you import the .kpr test module, it appends to the ACS configuration navigator in a 
subsite level: 

Select File > Import to import a file with a .kpr file extension (see next figure). 

Figure 122: Import a Model 4200 project file 
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After selecting the .kpr file, the import project dialog box opens. The default path 
is:…//SA200/kIUSER/projects (see next figure). 

Figure 123: Projects file import dialog 

 

Select the desired project folder, then click the Open button (see next figure). 

When the selected project folder opens, select the .kpr file and click Open. 

Figure 124: Project file import dialog box 
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After completing the previous steps, the subsite of the Model 4200 project you imported will append 
to the configuration navigator of ACS. 

The next figure shows the before and after configuration navigator images when importing a Model 
4200 project file. The left image shows the configuration navigator before importing the project file; 
the right image shows how the configuration navigator looks after you import the project file (see next 
figure). 

Figure 125: Test tree importing a project before and after views 
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Add a pattern 
1. Click the New Pattern icon in the vertical edit toolbar (or right-click Pattern/Insert Pattern). A new 

pattern is created with the default name of Pattern_2 (sequential number of patterns created).  
2. Use the vertical toolbar to rename, delete, copy, or cut the new pattern (see next figure). 

Repeat step 1 to add extra patterns as needed. 

Figure 126: Selected Pattern_1 
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Add a new subsite 
1. Click the Pattern you want to add a subsite to. 
2. Click the New Subsite icon in the vertical edit toolbar (or right-click Pattern/Insert Subsite). A new 

subsite is created with the default name of subsite. 
3. Repeat steps 1 - 2 to add extra subsites as needed. 
4. Use the vertical toolbar to rename, delete, copy or cut the new subsite (see next figure). 

Figure 127: Selected subsites 

 

Figure 128: Additional subsites 
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Add a new device 
1. Select Devices from the Test Setup configuration navigator (see next figure). 

Figure 129: Selected Devices tree item 

 

2. Click the New Device icon in the Vertical edit toolbar (or right-click Device/Test Setup panel).  
3. In the SMU Type dialog box, click 26xx SMU or Model 4200 SMU (see next figure). 

If you select the Model 26xx SMU, the new device name will be appended with _26. If you select the 
Model 4200 SMU, the new device name is appended with _42. 

Figure 130: SMU Type 
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4. Click OK. A dialog box opens allowing you to choose the type of device to test. 
5. Choose one of the eleven devices. 
6. Click OK. A new device is created. 
7. Use the vertical toolbar to rename, delete, copy or cut the new device. 

Repeat steps 1 - 6 to add new devices as needed. 

Figure 131: New Device 

 

Figure 132: New Devices created 
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Add a new test module 
1. Click the device that you want to add a new test module to.  
2. From the vertical edit toolbar, click the desired test module icon (ITM,CTM,STM, or PTM). A test 

module is created for the selected device (see next figure). 
3. Use the vertical toolbar to rename, delete, copy or cut the new test module. 

Figure 133: Created test modules 

 
 

Map subsites and test modules 
You can map any devices and test modules under the Devices to the subsites under the Patterns. For 
example, map devices and test modules to the subsite Home (Home is the default subsite of a 
project). This means that you should assign the devices and test modules to the subsite. 

1. Click the subsite of the pattern you want to map. The definitions tab will display the devices and 
test settings (see next figure). There are four parts in the Devices and Test Settings: Available 
Devices, Devices, Test, and Groups. 

Figure 134: Devices and test settings 
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2.  In the Available Devices box check the corresponding devices you want to include. You can click 
the Select All function to click all the devices or click UnSelect All function to cancel all devices 
(see next figure). 

Figure 135: Available devices 

 

3. The Tests box will show all the test modules for a selected device (the highlighted item in the 
Available Devices box)(see next figure). All test modules are checked by default, click the 
deselect All function to cancel them all. Click the check box before each test module you want to 
select. 

Figure 136: Test Settings 

 

4. In the Groups box, all the Groups are checked by default. Click the deselect All function to cancel 
all selections and click the check box before the GROUP you want to click (see next figure). 

Figure 137: Group settings 
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5.  The Devices section shows all Tests and Groups you have selected. For example, the device_26 
contains the ‘itm’ and ‘HCI’ test modules, and GROUP1 is selected (see next figure). 

Figure 138: Devices 

 

6.  To change the test sequence, use the scrollbar up or down functions. For example, if device_42 
should be tested first, then device_26_1, and the last device_26. You can operate like this: first 
select device_42, and click the up arrow function twice, select device_26 and click the down 
arrow once. The test will sequence in the order that you selected (see next figure). 

Figure 139: Devices sequence after change 

 

7. Change the subsite name by typing the new name in the Name field, then set the Loop Num. You 
can also change the Position by typing specific X and Y axis values. Then click the Apply function 
to update the project with the settings that you have made (see next figure). 

8. Set devices and tests settings in the same way for other subsites. 

Figure 140: Name, loop number, and position settings 

 

After mapping all the subsites, save the settings, then click the Automation to run this project. 

In the Map style, if you want to delete one device or one test module, you need not delete it in all the 
subsites containing this device or module. You can just click the Test Setup, and delete it in the 
device. It is very convenient for the large project containing a large number of subsites. 
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Save as a template and import a project template 
The Save As Template function was created to make the test as convenient as possible. After the 
project template is saved, you can import a project into the main menu by choosing the Import Test 
Plan (.tpl) item from the file menu (see next figure). 

Step 1: Save as a template    
1. Open the existing project file or folder you want to save as a template. For example, the default 

file in projects in the next figure.  

Figure 141: Open existing project 

 

2. From ACS File menu, click Save As Template; the Save project As Template dialog box opens 
(see next figure). 

Figure 142: Save As Template in File menu 
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3. Enter a name in Template Name box and click the ellipsis function to choose a Location. 
4. Click OK to save the project as a template. 

Figure 143: Save project As Template 

 

Step 2: Use a template    

Use the project template to create a new project. 

Figure 144: Use the template to add a new project 
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Import Test Plan 
1. From the File drop-down menu, choose Import and select Test Plan (*.tpl)(see next figure). 

Figure 145: Import test plan (.tpl) 

 

2. The Convert Test Plan To ACS Project dialog box opens (see next figure). 
3. There are three paths to choose: Test Plan, UAP Files, ACS Test Project. For every item, click 

Browse to choose the path.  
4. Enter a name in the Project Name edit box.  
5. Click OK. 

Figure 146: Convert Test Plan to ACS Project 

 
 

Building a test plan 
After you create a new project, you will be able to build and configure a test plan according to your 
preferences. 
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Add a new pattern 
Click the New Pattern icon on the toolbar to add a new pattern for the current project. (You can also 
right-click a pattern name, then click Insert Pattern to add a new pattern.) The Pattern work area 
opens (see next figure). 

Figure 147: Pattern work area 

 

There are three tabs in the Pattern work area:  

1. Wafer Map  
2. Limits   
3. Wafer Description 

 
Wafer Map tab 
All settings on the Wafer Map are the same as the Wafer Description panel. All patterns share the 
same wafer map. 

Limits tab 
The limits data associated with one parameter are arranged as one row. The fields of the Limits tab 
are shown in the next figure.  

Figure 148: Limits tab 
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• ID: Uniquely identifies each test parameter. This field cannot be modified. 
• Name: Can be modified. 
• Units: Defines the unit for the limits test results. This field may contain non-alphanumeric characters 

(including spaces) and need not be a legal “C language” name. The only constraint is that it must not 
include commas. The string may contain a maximum of 13 characters. Examples of entries for this field 
are volts or amps. 

• Report: Determines whether or not the limit is included in the summary report. If you want to include the 
report, make sure to select this option. To remove from the report, make sure you do not select or 
deselect as necessary. 

• Critical: Allows parameters to be tagged as not critical (0), or as critical with one of nine different critical 
flags (1, 2, 3, 4, 5, 6, 7, 8, and 9). 

• Target: Identifies the ideal result expected for the specified ID. The entry for this field is a numeric value. 
• Valid Low, Valid High: This limit pair can be used to check for device failures or faults within the testing 

system. Numbers outside of this range indicate that the data being produced by the system are invalid 
usually due to an equipment malfunction..  

• Spec Low, Spec High: This limit pair is used to check for manufacturing standards. Numbers outside of 
this range indicate that the device being tested does not meet manufacturing specifications.  

Limits tab Formulator function 
The Limits tab contains the Formulator function. The Formulator function is active once you click a 
Pattern on the configuration navigator (see next figure). 

Figure 149: Limits tab functions 
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Click the Formulator function and the Formulator Setting displays (see next figure). 

Figure 150: Formulator Settings dialog box 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 5: Test Setup 
 

ACS-901-01 Rev. H / December 2014 5-27 

 

The Formula box is used to create new formulas or edit existing formulas.  

An Add formula function is part of the Formula function. 

When you select the Add function for the Formula, the following will occur: 

• Starts a calculation execution of the formula. 
• Moves a formula to the Formula List box. 

The Formula List displays formulas that have been created. The Del function deletes a formula that is 
selected in the Formula List box. The Edit function moves a formula from the Formula List to the 
Formula box to edit.  

Variables is a list of all in the pattern. 

The Constants indicates each Constant that you can insert by name. When you click the constant in 
the list it is added to the Formula equation, at the cursor position. Selecting the Add function opens a 
dialog box that allows you to add a new constant to the list. After inputting the name and value, click 
OK. To delete a constant, select the constant then the Del function. 

The Parameter Extraction Functions — List 6 parameter extraction functions. Including GMMAX, SS, 
SSVTCI, VTCI, VTLINGM, VTSATGM. 

The Math/Statistic Functions lists 26 different functions: ABS, AT, AVG, DELTA, DIFF, DIMENSION, 
FINDD, FINDLIN, FINDU, FIRSTPOS, JOIN, LASTPOS, LN, LOG, LOG10, MAX, MAXPOS, MIN, 
MINPOS, POW, RES, RES_4WIRE, RES_4WIRE_AVG, SMOOTH, SUBARRAY1, SUBARRAY2. 

The Line Fitting and Modeling Functions lists 23 different functions: EXP, EXPFIT, EXFITA, EXPFITB, 
LINEFIT, LINFITSLP, LINEFITXINT, LINEFITYINT, LOGFIT, REGFIT, REGFITSLP, REGFITXINT, 
REGFITYINT, REGFIT_LGX_LGY, REGFIT_LGX_Y, REGFIT_X_LGY, RSQUAR, TANFIT, 
TANFITSLP, TANFITXINT, TANFITYINT, TARGERX, TARGETY. 

For more information, refer to the Formulator function reference topic in this section. Here you will 
find an all-inclusive list of all functions. 

 
Wafer Description tab   
The Wafer Description tab displays the content of the file (see next figure). The description tab can be 
edited. 

Figure 151: Status tab of pattern work area 
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Add a new subsite 
Click the New Subsite function icon on the toolbar to add a new subsite to the current project. The 
Subsite dialog box opens (see next figure). 

Figure 152: Add a new subsite icon 

 
 
 
 

 
 

Definition tab 
When you click the New Subsite icon, you will see three tabs in the dialog box: Definition, Subsite 
Loop, and Status (see next figure).  

• Add a name to the subsite in the Name edit box.  
• In the X and Y axis cells, you set the subsite position relative to the site so that the probe is 

moved to the correct position. The axis direction is the same as in the Wafer Description. The X 
axis defines the horizontal position, and the Y axis defines the vertical position.  

• The Loop Number displays the Number of cycles in Cycle Mode or total cycles in Stress/Measure 
Mode (this is set in the Subsite Loop tab).  

• You can add multiple subsites and configure as appropriate. This function will save time in 
instances where you have the same device and test modules for a subsite. 

• Click the add icon  to add subsite parameters to the new subsite (in the Definition tab). 
• Click the delete icon  to delete selected subsites. 
• Click the broom icon  to clear all subsites and all data (note that one default row remains). 
• Click the up arrow icon  to move selected subsites up.  
• Click the down arrow icon  to move selected subsites down. 
• Click the import icon  to import a subsite list from a .csv file. 
• Click the export icon  to export a subsite list to a .csv file. 
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Figure 153: Subsite Definition tab 

 

Subsite Loop tab 
You can select the Subsite Loop Mode: Cycle Mode or Stress/Measure Mode (see next figure). 

• Cycle Mode executes the subsite based on the Number of cycles desired. 

Figure 154: Subsite Loop tab 

 
 
 
 
 
 
 

Stress/Measure Mode controls the stress/measure loop reliability and sets Stress Times/Values. Note 
that time is not a limitation and that there are three Stress/Measure Mode Setup choices: Linear, Log, 
and List (see next figure).  

• Linear - ensures all Stress Times/Values are the same.  
• Log - ensures all Stress Times/Values increase logarithmically with each cycle.  
• List - allows you to specify the Stress Times/Values (note that the Add, Remove, Clear, and 

Import buttons are available). 
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• First Stress Time/Value - enter the amount of time (seconds) your devices are stressed during 
first cycle.  

• Total Stress Time/Value - enter the total stress time.  
• Stresses/Decade - enter the number of cycles that you want performed.  
• Total Cycles - Automatically calculated based on how many Stress Times/Values are entered 

when using the List function. 

Figure 155: Stress Measure Mode setting 
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If you select List, the Stress Times/Values options (Add, Remove, Clear and Import) will be active:  

• Add - add a stress value to the list.  
• Remove - select one of the list items and click Remove.  
• Clear - click and the entire stress list is removed.  
• Import - import a .csv stress list file. 

Figure 156: Import a .csv file 

 
 
 
 
 
 

Status tab 
This tab shows the Subsite Definition information. 

Figure 157: Status tab 
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Run a subsite loop 
1. Click the add icon  to add additional subsite parameters to the subsite (the row will append to 

the subsite list).  
2. Set the X axis (horizontal position) and Y axis (vertical postion) for every subsite. 

Figure 158: Add a new subsite 

 
 
 
 
 
 

3. Set the Subsite Loop information and click Apply Settings. 

Figure 159: Subsite Loop information 
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4. Click the Run icon  (refer to Executing individual subsite plans for more information, if needed). 
Based on the previous graphic, the subsite modules will cycle three times. You will see groups of 
data in the Data tab. 

Figure 160: Subsite Loop Data tab results 

 
 
 
 
 

If you want to see real-time parametric curve information, select the Automation tab. The Automation 
tab allows you to see results in real time (refer to Real-Time Plot Settings for more information, if 
needed. 
For more information about performing a stress test for device reliability analysis, refer to DC stress-
measure loop project or Pulse stress-measure loop project. 
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Add a new device 
Each device is associated with a specific device work area. The device work area is the interface 
used to connect every device. 

Add a new device for the current project: 

1. Click the New Device function on the vertical toolbar. The SMU Type dialog box opens. 

If the current hardware configuration includes the Model 4200 SMU and a Series 2600B SMU, the 
SMU type dialog box opens. If you are including only one type of SMU, the dialog box will not open 
and the SMU type is used by default (see next figure). 

Figure 161: SMU Type 

 

Figure 162: Select new device 
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2. Click 4200 SMU to create a new device testing under 4200 SMU or click 2600B SMU to create a 
new Series 2600B SourceMeter instruments one.  

3. Click the desired device (see next figure). 

Figure 163: Device images 

 

4. Click OK. The Image Browser dialog box opens (see next figure). 
5. Select the device image that has a terminal connecting to the SMU. (Later, these images appear 

in the test ITM work area.) 
6. Click the Select button. The new device is added to the configuration navigator named with the 

device type chosen and appended with either _42 or _26, according to the selected SMU type. 
The indicator area (the black area at the upper right of the ACS dialog box) of the device work 
area is displayed (see next figure). 

Figure 164: Device work area 
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Load and save device 
There are two tabs in the device work area:  

• Device Settings  
• Status 

The Device Setting tab opens by default. The column labels of the device Status tab are also 
displayed. In the Device Setting tab, you can assign the device setting according to the physical 
connection of the device. The device information can then be seen in the next figure in the device 
Status tab.  

There are four functions in the Device setting panel: Load Device, Load SMU Mapping, Save SMU 
Mapping, and Save SubDev Info (see next figure). 

Figure 165: Functions on Device Setting tab 

 

Load Device is used to change the devices image or type for an exiting device: 

1. Click the Load Device function. The Select Device Type dialog box opens (see next figure). 

Figure 166: Select Device Type 
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2. Click on the desired device type.  
3. Click OK to load the device. The Image Browser dialog box opens (see next figure). 

Figure 167: Image browser 

 

4. Choose a desired image by clicking the Device name, and then click OK. 
5. Click Open to finish loading the device. 

After loading the device, an image will appear in the device work area (see next figure). With the 
device loaded, you can adjust the settings as needed. 

Figure 168: Device Setting work area 
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To load an existing SMU mapping file for special devices: 
1. Click Load SMU Mapping function, the Import SMU Mapping File dialog box opens.  
2. Select an existing comma separated value (.csv) file which has Pin No. and SMU No. matched 

respectively. For example, in the next figure, 11.csv file is an available SMU Mapping file. 

Figure 169: Import SMU Mapping File 

 

3. Click the Open function. 

To save SMU mapping:  
1. Click the Save SMU Mapping function. The Save SMU Mapping File dialog box opens. Click the 

path for the .csv file to save the changes. 
2. Click Save to finish saving. 

Figure 170: Save SMU Mapping File 
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Save Sub-Device information 

Under the device work area, in Pads-SMU Mapping item, there are four columns: Pad No., Sub-
Device, SMU No., Pad Name see next figure). 

Figure 171: Load SMU mapping 

 

• Pad No. is the number of each pad which is preset and fixed.  
• Sub-Device indicates where each pad belongs. 
• SMU No. is listed according to the SMU Mapping, which is loaded in Load SMU Mapping step.  
• Pad Name is the name of a pad. 

1. Edit the sub-device field by entering numbers within the limits of SubDev No. which has been 
chosen previously. For example if the SubDev No. is 2 (see next figure), the most numbers 
entered in Sub-Device editing box is 1, 2). 

2. To finish editing the Sub-Device, click the Save SubDev Info function. 

Figure 172: Device Setting; SubDev Num 
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Device Settings tab 
After inserting a new device into the Project Plan, it must be configured to match the physical 
connection. ACS supports single device test, multidevice test, and multi group test. 

Setting single device 
1. From the Device Setting tab of the device work area, click the SMU Terminal. The pads setting 

dialog box opens (see next figure). 

Figure 173: SMU Setting 

 

2. Click the connection in the instrument SMU list box that matches the physical connection of the 
device terminal. If the device Pad is not connected (open circuit), or is connected to a particular 
SMU, you can click NONE (or choose not to set this SMU terminal). If the device Pad is 
connected to Ground, click GND. 

3. Click OK. 

You can also set the SMU number in the SMU No. status column (see next figure). 

Figure 174: SMU Setting_ using the SMU No. list box 
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4. Repeat the above steps to set every SMU Terminal .Edit the Pad Name (optional). You cannot 
name two pads the same name. If named the same, an Invalid Pad Name dialog box opens (see 
next figure). 

5. Set the Attribute box. Input the device information in the Attribute box. 
• L(um): the length of device under test  
• W(um): the width of device under test 
• T(cen): the test temperature 

Figure 175: Invalid pad name 

 

1. Click the Save function   on the toolbar to save the settings. 
2. If you are setting up a multigroup test, you do not need to configure every device one at a time; 

you can just check the group number to be tested in the appropriate area.  

Select a multidevice 

Select the multidevice from the Image Browser dialog box. 

Figure 176: Select multi-device image 
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The settings for the multidevice are almost the same as those used the single device, except you 
choose the device number and matching sub-device number to the device terminals. 

Define a multidevice: 
1. Define the type of sub-device using the Select Device Type drop-down list box (using the Load 

Device button). The created sub-device will be listed in the Subdevices Included In box (see next 
figure).  

Figure 177: Setting two sub-devices 

 

2. Select any row in the Pad-SMUs Mapping area and it will highlight. Set the SMU as instructed in 
step 1. Check the sub-device in Sub-devices Included In box to set the sub-device. 

3. Match SMU, Pads, and Sub-device to complete the test device structure definition.  

If a Pad is set as NONE or GND, it will not appear in test set up page (you will need to make the 
GND connection yourself). If a Pad is Set As Common, it will be shared by all sub-devices. 

Set up a multigroup test 

If you set up a multigroup test, it will not be necessary to configure every device one-by-one. All you 
need to do is check the group number needed to be tested in the right area. 

The software connections must accurately reflect the physical hardware connections at the time the 
test is executed. Incorrect terminal configurations result in anomalous test results and/or damage to 
the device. At every test startup, you must check whether the SMU terminal connected to the device 
Pad is matched correctly.  

At the test startup, you must check whether the SMU terminal connected to the device Pad is 
correctly matched. Perform the following steps (refer to ACS Hardware examples (on page 17-1)). 

1. Check the physical connection of each test device terminal shown. Verify that it is not connected 
(open circuit), connected to the Ground Unit (KI_GND), or connected to a particular SMU. 

2. Check the SMU No. list box to ensure that they are properly matched to the physical connection. 
3. For each SMU in the Definition tab that is improperly matched, or not yet matched to a physical 

connection, assign/reassign the terminal connection as discussed in this section. 
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Graphically define a new device 

Edit a device: 

From the Tools menu, click Graphically Define a New Device (see next figure).  

Figure 178: Graphically Define a New Device in Tools menu 
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The Device Map Editor dialog box opens (see next figure). 

Figure 179: Blank Device Map editor 
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Choose the device bitmap by clicking the ellipsis to browse the bitmap (Select the Bitmap) save path. 
The selected bitmap will load in the Device Editor dialog box. The bitmap’s name will appear in the 
Device Name box as the default name of this device (see next figure). 

Figure 180: Select device bitmap 

 



Section 5: Test Setup ACS Automated Characterization Suite (ACS) Reference Manual 
 

5-46 ACS-901-01 Rev. H / December 2014 

 

Click the Device Type using the drop-down arrow in the Device Info area (see next figure). If needed, 
select the New function icon to input a new device type. Edit the device name in Device Name edit 
box (see next figure). 

Figure 181: Graphically Define the device type 
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Enter the Pin Settings 

The bitmap of the device is defined as North, South, West, East, NE (Northeast), SE (Southeast), NW 
(Northwest), and SW (Southwest).  

• Input the pad number in the North, South, West, and East according to the device bitmap. For 
example, in the next figure, the number 4 is entered in the West box.  

• When you select the Enter key or you move to another control, the pad boxes will be added in the 
specified display areas corresponding to the counts entered in the Pin Settings. 

Figure 182: Enter Pin Settings 
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To set the Pad Name, click on a check box in the Device Map and Layout area. The Set Pad Name 
dialog box opens (see next figure). 

Figure 183: Set Pad Name 
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Enter a unique pad name into the Set Pad Name box.  

Click OK. 

Click the Save button to save this device to the loaded path.  

The next figure shows the device MyRESISTOR_2T_3D is saved and ready for use by ACS. 

Figure 184: Save the device to loaded path 

 
 

Configure a graphical interactive test module (ITM) 
An ITM allows you to define a test interactively using a graphical user interface (GUI). ITMs are 
available for the Model 4200-SCS SMUs or Series 2600B (except 26x4B) System SourceMeter 
instruments. 

After inserting an ITM into the configuration navigator, it must be configured to meet your test 
requirements. 
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ITM 
This ITM is based on the Series 2600B trigger model, and it supports both DC and pulse 
measurement. This ITM also supports high-power SMUs, such as models 265xA in a safe 
configuration. 

Each ITM is associated with a specific ITM work area. An ITM work area displays the ITM’s definition 
(configuration), test data, and status information (see next figure). 

Figure 185: Definition tab of the Model 26XXB SMU ITM 

 

The Definition tab contains the following elements: 

Mode:  

• DC Only: Select if you want all SMUs to only operate in DC mode. 
• Pulse Available: Select if you want SMUs to operate in DC or Pulse Mode. Pulse timings for each 

SMU may be assigned to one of two Pulse Timing configurations. Because accurate timing is 
required for pulsing, some features, such as auto ranging, are disabled when you select Pulse 
Available. 

Timing: Click this button to open the ITM timing dialog box where you can set detailed timing settings 
for pulse and synchronization between SMUs (refer to the Timing dialog box for more information). 

Stop on Compliance: Select if you want to abort the test and turn off the SMU output when the test 
reaches compliance. 

Device schematic: Shows the device image and pad settings according to the device level settings 
in the configuration navigator. 

Groups: Select the group or groups where you want to run the test. The group is determined by the 
GPIB or Ethernet address. Make sure that all the groups you select have the same hardware 
configurations as your ITM. 

SMU_PARAMETERS_TABLE_NAME: Use the  to set the SMU_PARAMETERS_TABLE_NAME 
parameters for testing. 
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Model 26XXB SMU parameters 
The following figure displays the items to set up testing for forcing and measuring functions for each 
SMU. 

Figure 186: SMU parameters table 

 
 

Device Num: Sub-device number defined in the Device work area. 

SMU: SMU number defined in the Device work area. 

Pad: Pad name defined in the Device work area. 

Function: Force function type.  

Force Mode: DC for DC Only. DC, Pulse Timing 1, or Pulse Timing 2 for Pulse Available. 

Source: The source value of SMU. 

Measure: Selects the measurement function. All options are: 

• I: Actual measured current values. 
• V: Actual measured voltage values.  
• V(prog): Reports the programmed voltage. No measurement is taken. 
• I(prog): Reports the programmed current. No measurement is taken 
• I+V: Measures both I and V.  
• I+V(prog): Measures I and returns V(prog). 
• V+I(prog): Measures V and returns I(prog).  

Compliance: Sets current limit for voltage source or voltage limit for current source. 

Meas. Range: Specifies the SMU range used. The current measure range is listed for voltage forcing 
functions, and the voltage measure range is present for current forcing functions only. If I is selected 
in the Measure cell, ACS enforces the Force range first, and ignores the measure range. You can 
specify the range used by the SMU using the following options: 

• Auto option commands the SMU to automatically optimize the measurement range. This option 
provides the best resolution. 

• Numerical range options allow you to manually select a fixed measurement range to suit your 
needs. 

Advanced: Double-click the cell to display a window for advanced settings for this SMU. 
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Figure 187: The SMU Advanced settings dialog box 

 

Range Parameters: 

• Force Range: Specifies the SMU force range used to force voltage or current, including auto, 
Best Fixed, and numerical range options. 

• Meas. Limits Auto: When measuring current with Meas.Range set to auto, the application 
enables this option. This parameter is used with autoranging to put a lower bound on the range 
used. Since lower ranges generally require greater settling times, setting the lowest range limit 
might make measurements require less settling time. This option is a compromise between the 
full Auto option and a fixed range option. You can specify the minimum range that the SMU uses 
when automatically optimizing the current measurements. This option saves time when maximum 
resolution at minimum currents is not needed. 

Power Compliance: Set the power compliance value (watts) for a 2600B SMU. The firmware version 
of the 2600B SMU must be at least higher than 2.2.1. 

Soft Bias: Apply Soft Ramp at the beginning of the Bias or first Sweep/List point and at the end of the 
Bias or last Sweep/List point. Typical use cases are for high power MOSFET measurements. For 
more information about using Soft Ramp, refer to the following topics: 

• SMU forcing functions 
• Configure the general purpose PTM 

Misc:  

• High Capacitance Mode: Sets the SMU to high capacitance mode. This is only available for the 
Series 2600B SMU. 
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SMU forcing functions 
The SMU forcing functions are selected in SMU_PARAMETER_TABLE_NAME.The functions are: 
Bias V, Bias I, Sweep V, Sweep I, List V, List I, Step V, Step I, V Meter, GND, and Open. In DC Only 
mode there are two more functions: Sweep2 V and Sweep2 I. 

Bias V 

The Bias forcing function maintains a defined constant voltage, subject to the specified compliance 
value of the connected SMU. If you select Bias V, you can set a valid value in the Source cell. 

Bias I 

The Bias forcing function maintains a defined constant current, subject to the specified compliance 
value of the connected SMU. If you select Bias I, you can set a valid value in the Source cell. 

Sweep V, Sweep I 

A sweep increments or decrements the current or voltage in a series of steps at a speed that is 
determined by the Speed and Timing settings. If you select Sweep V or Sweep I, you can set the 
sweep settings by double clicking the Source cell and making the necessary changes in the dialog 
box. 

Figure 188: Source settings for SMU sweep functions 
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Dual Sweep: With Dual Sweep enabled, the SMU will essentially perform two sweeps. The first 
sweep steps from the start level to the stop level. The behavior of the second sweep is determined by 
the Forward/Reverse radio buttons. 

Figure 189: Single and dual sweep examples 

 

Forward: First sweep steps from the start level to the stop level. The SMU continues with the second 
sweep and proceeds in the same manner as the first sweep. 

Reverse: First sweep steps from the start level to the stop level. The SMU continues with the second 
sweep and steps from the stop level back to the start level. 

Figure 190: Dual sweep mode - forward and reverse 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 5: Test Setup 
 

ACS-901-01 Rev. H / December 2014 5-55 

 

Mode: 

• Linear: sweep mode based on the linear scale. 
• Log: sweep mode based on the logarithm scale.  

Settings: 

• Start: specifies a starting point for a sweep for any valid SMU voltage or current depending on the 
source function. 

• Stop: specifies a stopping point for a sweep for any valid SMU voltage or current depending on 
the source function. 

• Step: specifies the incremental value between every two points. You can edit the step and it will 
be automatically calculated depending on the Start, Stop, and Points values. 

Points: When a sweep is executed, shows the number of data points. 

Base: When Pulse Available is selected, this function sets the Pulse base level. 

Figure 191: Example sweep drain voltage on a MOSFET 

 

Step V, Step I 

The Step X function always works in concert with a Sweep X function.  For each step in Step X, a 
complete Sweep X is performed.  Measurement data is arranged by step number in the Data tab. 

A typical voltage step forcing functions example is shown in the next figure. This figure illustrates how 
one Definition tab (for the Vds-Id ITM) specifies both Step and Sweep forcing functions. 

Figure 192: Typical step forcing parameters 
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The next figure graphically illustrates the combined Step and Sweep forcing functions specified in the 
previous figure. 

Figure 193: Example MOSFET step gate and sweep drain voltage 

 

The next figure shows a data plot of the graph from the typical forcing parameters figure. 

Figure 194: Vds-Id graph 
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If you double-click the Source cell of the SMU that set as Step V/Step I, it will display the step settings 
window. 

Figure 195: Source settings for SMU step functions 

 
 

Settings: 

• Start: Specifies the initial SMU output level. 
• Stop: Specifies the final SMU output level.  
• Points: Specifies the number of data points that are input when a step is executed. It also 

specifies the value of the voltage increments of every step value. At least two points muse be 
entered in the Data Points cell. For example: If Start = 0V, Stop = 4V, and Points = 5, Step value 
= (4V-0V)/(5-1)=1V Five values are forced 0V, 1V, 2V, 3V, 4V. 

• Base: Set the Pulse base level when Pulse Available is selected. 
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Sweep2 V, Sweep2 I 

Sweep2 is a special sweep test when used in DC Only mode. When the forced value is greater than 
the desired value, a monitor test will add to each sweep step, thus the test can generate two test 
results: measured results and monitored results. More specifically, when each sweep interval 
increases, it will equal the value of the sweep delay and monitor delay (see next figure; the sweep 2V 
waveform has a 0.45V as the monitor source voltage). 

Figure 196: Sweep 2V waveform 

 

Click the Function cell and in the drop-down list choose Sweep2 V or Sweep2 I. The monitor items 
will append to the Force and Meas cell (see next figure) 

Figure 197: The SMU monitor items 
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Also, the monitor delay in Time dialog will be enabled (see next figure). 

Figure 198: Enable monitor delay 
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List V, List I 

List V and List I are used to define a voltage or current list according to the test’s requirements. The 
SMU will force the input values one by one like a sweep. 

List Sweeps allow you to make measurements only at selected forced voltages and currents. For 
example, they allow you to skip measurement points or to synthesize a custom sweep that is based 
on a mathematical equation.  

Figure 199: List sweep general illustration 

 

Double-click the Source cell of the SMU and the List Sweep Settings dialog box opens (see next 
figure). 

Figure 200: List Sweep Settings dialog box 
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Points: the number of points for the forcing values. 

You can import (and then save) a .csv file by clicking the Import Settings From CSV File button (see 
previous figure). 

• Edit item : the default number can be changed to a different value. 
• New item : a new item is added when you click this icon. 
• Delete item : a selected item is deleted when you click this icon. 
• Move up : a selected item moves up when you click this icon. 
• Move down : a selected item moves down when you click this icon. 
• Base Level: When Pulse Available is selected, will display the Pulse base level. 

Soft Ramp Bias 

The DC Only mode enables you to apply incremental test levels at the beginning of the bias or first 
sweep/list point tests, and at the end of the bias or last sweep/list point tests. This function allows the 
forced voltage or current to achieve the desired value after a certain number of steps. 

The Soft Ramp is from 0 to the desired value (bias value or first and last sweep/list value). If the bias 
or first or last sweep/list point is 0, no soft ramp is necessary. In the "No Soft Ramp" example, the 
gate breakdown occurs because of the 200V stress applied. However, with the "Soft Ramp function," 
you can keep the voltage differences at smaller levels until the desired voltage is applied (see next 
figure). 

Figure 201: Comparison of Soft Ramp and without Soft Ramp 
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Soft Ramp is enabled in the Advanced settings in SMU_PARAMETERS_TABLE_NAME. The 
Soft Ramp timing is set in the timing settings window (see next figures). 

Figure 202: Advanced Soft Bias settings 

 

Figure 203: ITM General Timing tab settings 
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If the Start Ramp and End Ramp are selected, the test will apply a Soft Ramp before and after the 
Bias or Sweep. The Soft Ramp is from 0 to the desired value (Bias value or first and last Sweep, List 
value). If the Bias or first or last Sweep, List point is 0, no Soft Ramp is necessary.  

In the Advanced settings dialog box, setting the Ramp Step, the Num of Steps will be automatically 
calculated. 

Start Ramp Step: Sets the step size for the start ramp. 
Stop Ramp Step: Sets the step size for the stop ramp. 
Num of Steps: The number of steps defined for all of the SMUs, however, the start and stop 
steps are defined separately. The default value for Num of steps is 1. The actual value depends 
on the Force Value and the Start/Stop Ramp Steps. 

In the ITM Timing settings dialog box, the Start Ramp Delay and End Ramp Delay will determine the 
step time of the Soft Ramp. 

 

ITM timing settings 
When you click the ITM Timing icon in the ITM Definition tab, the ITM Timing GUI opens (see next 
figure). The ITM Timing GUI is used to configure ITM timing settings. 

Figure 204: ITM Timing GUI 
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Speed 

The Speed area of the ITM Timing GUI allows you to: 

• Locally select the Fast, Normal, Quiet, or Custom measurement speed modes.  
• Configure Custom speed settings in the Custom measurement speed mode. 

Fast, Normal, Quiet, and Custom modes are defined as follows: 

• Fast: Optimizes speed at the expense of noise performance. It is a good choice for fast 
measurements where noise and settling time are not concerns. 

• Normal: The default and most commonly used setting. It provides a good combination of speed 
and low noise, and is the best setting for most cases. 

• Slow: Optimizes the low-noise measurements at the expense of speed. If speed is not a critical 
consideration, it is a good choice when you need the lowest noise and most accurate 
measurements. 

• Custom: Allows you to fine-tune the timing parameters to meet a particular need. With Custom, 
you can configure the integration time and the number of readings to produce a composite 
setting. The entries in the PLC and # Average edit fields control the A/D (analog-to-digital) 
converter integration time used to measure a signal. A short integration time for each A/D 
conversion results in a relatively fast measurement speed, at the expense of noise. A long 
integration time results in a relatively low noise reading, at the expense of speed. The integration 
time setting is based on the number of power line cycles (NPLCs): 
For 60 Hz line power, 1.0 PLC = 16.67 msec (1/60 of a second).  
For 50 Hz line power, 1.0 PLC = 20 msec (1/50 of a second 

Figure 205: Speed settings for an ITM 
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If you selected the Custom measurement Speed mode, any value between 0.001 and 25 NPLC can 
be entered. If you selected the Fast, Normal, or Quiet measurement Speed mode, ACS sets the A/D 
Integration Time correspondingly. The next table summarizes the allowed A/D Integration Time 
settings for various measurement Speed modes. 

Speed mode NPLC # Average 
Fast 0.001 1 
Normal 1 1 
Slow 10 1 
Custom 0.001 to 25 ≥ 1 

 

General parameters 

Timestamp Enabled: If selected, an additional data column (Time) in the Data tab will be added to 
record the measurement time. 

Pulse Transient Mode: if checked, enable transient measurement of pulse mode. Utilizes fast ADC 
of the Models 265xA.  

Period(s): The pulse period, in seconds, that is applied to Pulse Timing 1 and Pulse Timing 2. 

Measure Delay(s): delay time before measurement. 

#Num of Pulses: the number of pulses when all the SMUs are set to Bias in Pulse Available.  

Figure 206: General Parameters ITM timing settings 
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DC Parameters 

Hold Time(s): DC Only. When the test is started, the Hold Time (HT) provides extra settling time for 
the initial step change of the source. The Hold Time is a global setting. Therefore, it is the same for all 
SMUs in the test system. Note that the Hold Time is applied at the start (only) of each sweep. 

Monitor Delay(s): Sets the monitor delay time in the second sweep phase in of the Sweep2 function. 

DC Step Delay(s): Sets the time in seconds from the start of the period to the start of the transition 
for DC signals. 

Start Ramp Delay(s): Sets the delay time of steps in the start ramp of the soft ramp bias. 

End Ramp Delay(s): Sets the delay time of steps in the end ramp of the soft ramp bias 

Figure 207: DC Parameters ITM timing settings 

 

Pulse Timing Parameters 

ACS allows you to configure a total of two pulse timing configurations. 

Pulse Delay(s): Sets the time in seconds from the start of the period to the start of the rising edge for 
pulse signals assigned to the Force Mode Pulse Timing 2 Parameters. 

Pulse Width(s): Sets the width of the pulse in seconds for pulse signals assigned to the Force Mode 
Pulse Timing 2 Parameters. 

Duty Cycle: Displays the duty cycle for pulse signals assigned to the Force Mode Pulse Timing 2 
Parameters. Duty cycle is calculated by dividing the pulse width by the period. Duty cycle = Pulse 
width / period. 

Figure 208: Pulse Timing Parameters for an ITM 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 5: Test Setup 
 

ACS-901-01 Rev. H / December 2014 5-67 

 

Force Mode Assignments 

The force mode assignments section displays each pad (SMU). It is recommended to assign Force 
Mode to Pads (SMUs) in SMU_PARAMETERS_TABLE_NAME before changing timing settings. 

DC: Displays the SMUs by Pad Name that have their Force Mode assigned to DC. 

Pulse Timing 1: Displays the SMUs by Pad Name that have their Force Mode assigned to Pulse 
Timing 1. 

Pulse Timing 2: Displays the SMUs by Pad Name that have their Force Mode assigned to Pulse 
Timing 2. 

Figure 209: Force Mode Assignments for an ITM 

 

Timing schematic diagram 

The timing schematic diagram window is displayed according to the settings and is only visible in 
Pulse Available mode. DC only mode has no timing schematic diagram. 

Figure 210: Timing schematic diagram for an ITM 
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Info 

Information about any problems concerned related to the timing settings will be displayed in the Info. 

Figure 211: Info in the ITM timing settings 

 

DC Only Timing settings 

In DC Only, two types of tests can be implemented: Sweep or Sampling. 

#Sample: when all the SMUs are set to Bias, sets the number of samples for the sampling 
measurement. # Samples is only available when all the SMUs are set to the Bias forcing function. 

Sweep: If any terminal of the device under test is configured for a dynamic forcing function (step or 
sweep forcing function), the Sweeping mode is automatically enabled. 

Figure 212: ITM Timing for DC only 
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Measure Delay: If you are using a sweep forcing function and want additional settling time before 
each measurement, you can specify an additional delay in the Sweep Delay edit box. You can specify 
a Measure Delay from 0 to 1000 seconds. The default Measure Delay is 0s. Setting measure delay to 
0 does not disable Model 26xx auto delay. That setting is in Preferences > Misc under 26xx Settings 

Hold Time: The starting voltage or current of a sweep may be substantially larger than the 
voltage/current increments of the sweep. Accordingly, the source settling time required to reach the 
starting voltage or current of a sweep may be substantially larger than the settling times required to 
increment the sweep. To compensate, you can specify a Hold Time delay to be applied only at the 
beginning of the sweep. You can specify a Hold Time delay of 0 to 1000 seconds. The default Hold 
Time is 0s. 

Figure 213: Sweep timing diagram in DC only 
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Sampling 

The Sampling mode measures voltage and current as a function of time while forcing constant 
voltages/currents (Bias I or Bias V). For example, the sampling mode would be used to measure 
voltage while forcing a constant current. Time is measured relative to when the SMU(s) apply the 
forced voltage or current (that is, t = 0 at the step change from 0.0V/0.0A to the applied 
voltage/current). 

ACS enables the sampling mode option only when all terminals of the device under test are 
configured for static forcing functions: Voltage Bias or Current Bias, and the mode must be DC Only. 

Figure 214: Sampling timing diagram in DC only 
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Pulse Available Timing settings 

When the Pulse Available mode is selected, the ITM will allow DC timing and two pulse timing 
settings for the SMUs. All of the SMUs will have the same measure speed, period, and measure 
delay. However, they have separate transition delays (DC step delay, pulse delay), and the two pulse 
timings have their own pulse width. 

The next figure indicates the settings for the pulse timing: 

1. Measure speed: Measurement acquisition time (in PLC) and number of individual measurements 
to average together for the final result.  

2. Delay time for DC bias SMU. 
3. Pulse period and measure delay. 
4. Pulse delay and pulse width for each pulse timing. The Duty Cycle is calculated according to 

pulse period and width. 
5. Force mode assignments for each pad. 
6. Timing diagram according to the settings. 
7. Description of any problems with settings. 

Figure 215: Pulse timing settings 

 

Figure 216: Pulse timing diagram 
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Pulse Transient 

Pulse Transient mode uses the Fast ADC that is available on certain SMU models (details about Fast 
ADC, please refer to the reference manual of 265xA SMU) to capture the waveform for a single point 
in the step/sweep sequence. It is useful for determining the proper measurement delay setting for the 
step/sweep sequence by capturing the settling time of the SMU outputs. It is also useful for 
debugging troublesome data points in the step/sweep sequence without the need for an oscilloscope. 
It is only available for 265xA SMUs in Pulse Available mode. The Pulse Transient mode timing 
settings are in the ITM Timing setting window on the Pulse Transient tab (see next figure). 

Figure 217: Pulse Transient mode settings 

 



Section 5: Test Setup ACS Automated Characterization Suite (ACS) Reference Manual 
 

5-74 ACS-901-01 Rev. H / December 2014 

 

Single Point or Entire step/sweep: Selects whether to source a single point from the step/sweep 
sequence or the entire step/sweep sequence to perform the pulse transient capture. Single Point only 
sources the selected point of the step/sweep sequence. The test does not have to run through the 
entire sequence. Entire step/sweep outputs the entire step/sweep sequence, and makes the transient 
measurement on the selected point. Entire step/sweep is useful when the measurement on the 
device changes due to effects like device self-heating. By outputting the entire step/sweep sequence, 
the captured waveform will be a more true representation of what is happening during that point in the 
step/sweep sequence. 

Transient Start(s): Sets the time in seconds from the start of the period to the start of the acquisition. 

Transient End(s): Sets the time in seconds from the start of the period to the end of the acquisition. 

Sweep Point: Sets the point in the sweep that will be captured. 

Step Point: Sets the step point that will be captured. 

The Sweep Point and the Step Point together appoint a certain period for waveform capture. The 
SMU info table lists the Pad name, force value and force function of the selected period. 

 

Model 42XX SMU ITM 
This ITM is based on the Model 42XX SMU device, and it supports DC measurements. Each ITM is 
associated with a specific ITM work area. An ITM work area displays the ITM’s definition 
(configuration), test data, and status information (see next figure). 

Note that Model 42xx ITMs return a test status code in the Data sheet, in addition to the other results. 

Figure 218: Definition tab of the Model 42XX SMU ITM 

 

Timing: This button opens the ITM timing dialog box where you can set detailed timing settings for 
pulse and synchronization between SMUs (refer to the Timing dialog box for more information). 

Stop on Compliance: Enables the test to abort and turn off the SMU output when it reaches 
compliance. 

Device schematic: Shows the device image and pad settings according to the device level settings 
in the configuration navigator. 

Groups: Select the group or groups where you want to run the test. The group is determined by the 
GPIB or Ethernet address. Make sure that all the groups you select have the same hardware 
configurations as your ITM. 

SMU parameters: SMU_PARAMETERS_TABLE_NAME is where you can set your parameters for 
testing. 
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Model 42XX SMU ITM 
The following figure displays the items to set up your testing for forcing and measuring functions for 
each SMU. 

Figure 219: Model 42XX SMU parameters table 

 
 

Device Num: Sub-device number defined in the Device work area. 

SMU: SMU number defined in the Device work area. 

Pad: Pad name defined in the Device work area. 

Function: Force function type.  

Force Range: Specifies the SMU range used to force on all functions (except V-meter and GNDU): 

• Auto option commands the SMU to automatically optimize the force range as the sweep 
progresses. This option provides the best resolution and control when sweeping several decades. 

• Numerical range options allow you to manually select a SMU range to meet your needs (the drop 
list contains all the supported ranges according to the SMU and force function). This range must 
accommodate the stop or start value, whichever is greater. For example, when forcing stop 
1.5 mA, you should choose the 10 mA SMU range or the Auto SMU range. The Auto SMU range 
allows the SMU to select the most appropriate range. 

Source: Allows you to set the source value according to the selected Function. When the Function is 
Bias V or Bias I, it sets the force value in this cell. When the Function is Sweep V, Sweep I, Step V, or 
Step I, the Source settings are similar to the Model 26XX SMU parameters. 

Measure: Selects the measurement function. All options are: 

• I: Actual measured current values. 
• V: Actual measured voltage values.  
• V(prog): Reports the programmed voltage. No measurement is taken. 
• I(prog): Reports the programmed current. No measurement is taken 
• I+V: Measures both I and V.  
• I+V(prog): Measures I and returns V(prog). 
• V+I(prog): Measures V and returns I(prog).  

Compliance: Specifies any valid SMU current or voltage compliance limit. The current compliance is 
present for voltage forcing functions and the voltage compliance is used for current forcing functions. 
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Meas. Range: Specifies the SMU range used. The current measure range is present for voltage 
forcing functions, and the voltage measure range is present for current forcing functions only. If I is 
selected in the Measure cell, ACS enforces the Force range first, and ignores the measure range. 
You can specify the range used by the SMU for current using the following options: 

• Auto option commands the SMU to automatically optimize the current measurement range. This 
option provides the best resolution 

• Limits Auto is only enabled when the force function is voltage and there is current measurement. 
This option is a compromise between the full Auto option and a fixed range option. You can 
specify the minimum range that the SMU uses when automatically optimizing the current 
measurements. This option saves time when maximum resolution at minimum currents is not 
needed. 

• Numerical range options allow you to manually select a fixed current measurement range to suit 
your needs. It selects current ranges when the source function is voltage, and selects voltage 
ranges when the source function is current. All of the supported measurement ranges are listed 
according to the SMU type 

Limits Auto: Will be enabled after selecting Limits Auto in the Meas Range cell.  

Timing 

When you click the ITM Timing icon in the ITM Definition tab, the ITM Timing GUI opens. The ITM 
Timing GUI is where you set the measurement speed and delay time of the test.  

Figure 220: 42XX SMU ITM Timing settings 
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Speed 

The Speed area of the ITM Timing GUI allows you to: 

• Locally select the Fast, Normal, Quiet, or Custom measurement speed modes.  
• Configure Custom speed settings in the Custom measurement speed mode. 

Fast, Normal, Quiet, and Custom modes are defined as follows: 

• Fast: Optimizes speed at the expense of noise performance. It is a good choice for fast 
measurements where noise and settling time are not concerns. 

• Normal: The default and most commonly used setting. It provides a good combination of speed 
and low noise, and is the best setting for most cases. 

• Slow: Optimizes the low-noise measurements at the expense of speed. If speed is not a critical 
consideration, it is a good choice when you need the lowest noise and most accurate 
measurements. 

• Custom: Allows you to fine-tune the timing parameters to meet a particular need. With Custom, 
you can configure the integration time and the number of readings to produce a composite 
setting. The entries in the PLC and # Average edit fields control the A/D (analog-to-digital) 
converter integration time used to measure a signal. A short integration time for each A/D 
conversion results in a relatively fast measurement speed, at the expense of noise. A long 
integration time results in a relatively low noise reading, at the expense of speed. The integration 
time setting is based on the number of power line cycles (NPLCs): 
For 60 Hz line power, 1.0 PLC = 16.67 msec (1/60 of a second).  
For 50 Hz line power, 1.0 PLC = 20 msec (1/50 of a second 

Mode area 

There are two test modes you can select in the Mode area of the ITM Timing GUI: Sweeping and 
Sampling.  

Sweeping: Applies to any ITM where one or more forced voltages/currents vary with time.  
Sampling: Applies to any ITM where all forced voltages or currents are static (Bias I or Bias V), 
with measurements typically made at timed intervals. For example, sampling mode is used to 
record a few static measurements, or to time-profile the charging voltage of a capacitor while 
forcing a constant current. 

The Mode is used to observe and/or change the test mode as follows: 

For a new ITM, the Mode allows you to select the Sweeping or Sampling test mode. Selecting the 
appropriate test mode simplifies configuration options and helps to avoid errors: 

1. Only the static forcing functions are configurable in the Sampling mode. 
2. Only mode-appropriate timing options are configurable. 

For an existing library ITM that is in the Sampling mode, the Mode area allows you to change to the 
Sweeping mode if you want to change some of the static forcing functions to dynamic forcing 
functions. 

Sweeping mode 

If any terminal of the device under test is configured for a dynamic forcing function (step or sweep 
forcing function), the Sweeping mode is automatically enabled. You can configure two Sweeping 
mode settings in the ITM Timing GUI (Sweep Delay and Hold Time). You can configure these settings 
for all measurement Speed modes: Fast, Normal, Quiet, and Custom. 
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Figure 221: ITM Sweep timing GUI 

 

Sweep Delay: If you are using a sweep forcing function and want additional settling time before each 
measurement, you can specify an additional delay in the Sweep Delay edit box. You can specify a 
Sweep Delay from 0 to 1000 seconds. The default Sweep Delay is 0s. 

Hold Time: The starting voltage or current of a sweep may be substantially larger than the 
voltage/current increments of the sweep. Accordingly, the source settling time required to reach the 
starting voltage or current of a sweep may be substantially larger than the settling times required to 
increment the sweep. To compensate, you can specify a Hold Time (HT) delay to be applied only at 
the beginning of each sweep. You can specify a Hold Time delay of 0 to 1000 seconds. The default 
Hold Time is 0s (see next figure). 

When the test is started, Hold Time provides extra settling time for the initial step change of the 
source. Hold Time is a global setting; therefore, it is the same for all SMUs in the test system. Note 
that hold time is applied at the start (only) of each sweep. 
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Figure 222: 42XX sweep mode timing diagram 
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Sweep Delay: Provides additional settling time for each step in the sweep. It is a global setting 
and is applied identically to all SMUs in the test system. 
Measure Time: Determined by the # Average and the A/D Integration Time (NPLC). All SMUs in 
the test system are synchronized. The measure time for the SMU requiring the longest measure 
time is the same for all SMUs in the test system. 

Sampling mode 

The Sampling mode measures voltage and current as a function of time while forcing constant 
voltages/currents (Bias I or Bias V). For example, sampling mode is used to measure voltage while 
forcing a constant current. Time is measured relative to when the SMU(s) apply the forced voltage or 
current (that is, t = 0 at the step change from 0.0V/0.0A to the applied voltage/current). 

ACS enables the sampling mode option only when all terminals of the device under test are 
configured for static forcing functions: Voltage Bias or Current Bias. If any terminal of the device 
under test is configured for a step or sweep forcing function, the Sampling mode option is 
unavailable. 

Figure 223: ITM sample timing settings 
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If an ITM is configured for the Sampling mode, you can configure three Sampling mode settings: 
Interval, #Sample, and Hold Time. 

Interval(s): Specifies the time between measurements (also known as data points). Intervals can be 
set from 0 to 1000 seconds. 

#Sample: Specifies the number of data points to be acquired. #Samples can be set from 1 to 4096.  

Hold Time(s): After initial application of voltage or current by the SMU(s), the source settling time(s) 
can be substantial. To allow for settling, you can specify extra hold time (delay) to be applied before 
making the first measurement. You can specify a hold time from 0 to 1000 seconds (see next figure). 
If needed, Hold Time can be used to allow for extra source settling after the initial application of 
voltage or current from the SMU. Hold Time is a global setting, and is the same for all SMUs in the 
test system. 

Figure 224: 42XX sampling mode timing diagram 

 

Interval: Specifies the time between measurements (also known as data points). Interval (INT) 
can be set from 0 to 1000 seconds. 
Measure Time: Determined by the A/D Integration Time. All SMUs in the test system are 
synchronized. The measure time for the SMU requiring the longest measure time is the same for 
all SMUs in the test system. 
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ITM test configuration 
1. Create a device by clicking Device function from the toolbar. 
2. Click the desired device in the Image Browser (see next figure). 

Figure 225: Device type Image Browser 

 

• Define number of sub-device using SubDev down list box, then the created sub-devices with 
checkbox will be listed in Subdevices Included In box. 

• Click any row in the Pad SMUs Mapping box, it will highlight. Set the SMU as instructed in ITM 
section (refer to Device Setting tab in the next figure). 

• In the Subdevices Included in section of the screen, click the check box of the desired 
subdevices. 

• Match SMU, Pads, and Sub-device to the actual physical connection, to complete the test device 
structure definition. 

Figure 226: Multi-subdevice setting 
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If a Pad is set as NONE or GND, it will not appear in test set up page (users should make GND 
connection themselves). If a pad is set as Common, it will be shared by all sub-devices. The pad 
name cannot be the same. If named, the Invalid Pad Name dialog box will appear (see next figure). 

Figure 227: Invalid pad name 

 

Add a new ITM: 

1. From the side toolbar, click the ITM function. A new ITM multi-subdevice will be added to the 
configuration navigator (see next figure). 

Figure 228: ITM GUI of multi-subdevice 
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After creating the new ITM, it must be configured to meet user’s test requirements. There are three 
tabs in ITM dialog box that you can use for configuration: Definition tab, Data tab, and Status tab.  

Definition tab 

Device Num: The sub-device number is defined in the device work area based on hardware 
connection. 

SMU: The number is defined in the device work area, based on hardware connection. 

Pad: The name is defined in the device work area, based on the hardware connection. 

Function: Force function type. 

In the Function category, you can select the function you need performed. For example, you can 
choose Bias V, Bias I, Sweep V, Sweep I, Step V, Step I, V_meter, GND, or OPEN depending on 
your testing needs. 

Force Range: Specifies the SMU source range used for the voltage source, per the following options: 

• The Numerical Voltage Range options (200 mV, 2 V, 20 V, 200 V) allow user to manually click a 
SMU range to suit user’s needs.  

• The Auto option commands the SMU to automatically optimize the voltage range as the step 
voltage progresses. This option provides the best current resolution and control when stepping 
several decades. 

The current source specifies the type (Bias I, Sweep I and Step I) used to force the 
current, per the following options: 

• The Auto option commands the SMU to automatically optimize the current range as the step current 
progresses. This option provides the best current resolution and control when stepping several 
decades. 

• The Numerical Current range options (100 nA, 1 µA, 100 µA, 1 mA, 10 mA, 100 mA, 1 A, 1.5 A, 10 A) 
allow user to manually click a SMU range to suit user’s needs. This range must accommodate the Stop 
or Start value, whichever is greater. 

For example, when forcing Stop “1 mA” user would typically choose the 1mA SMU range 
or the Auto SMU range, which allows the SMU to pick the most appropriate range based 
on the current level. 

Source: Specifies any valid value that can be applied by the SMU. The unit of measure is volts or 
amps.  

Since there are two types of tests that are supported (Spot and Sweep), there are two types of format 
data that can be entered in the Source box. For a Spot test, enter a single value. For a Sweep test, 
double click the source cell. The Sweep V/I setting dialog will appear. Enter the Start, Stop, Stop and 
Points values, then click OK (see next figure). 
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Figure 229: Sweep V settings 

 

Measure: The unit is amps or volts with the following options (see next figure): 

Figure 230: Measure Variable sub-list box 

 

• I :Actual measured current.  
• V:Actual measured voltage values.  
• V(prog): The programmed voltage, as requested forced voltage values. For example, 2.5V is to 

be forced at a transistor drain terminal. The programmed value( V(prog) ) is exactly 2.5V, even if 
the measured value ( V ) would be 2.4997V. Under the programmed option, the reported value is 
exactly 2.5V, even if the measured value would be 2.4997V. 

• I(prog): The programmed current, as requested forced current values. 
• I+V:Measures I and V both.  
• I+V(prog): Measures I and returns V(prog). 
• V+I(prog): Measures V and returns I(prog). 
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Compliance: The Compliance box specifies any valid SMU current or voltage compliance limit. The 
current compliance is present for voltage forcing functions and the voltage compliance is used for 
current forcing functions. Here, forcing Bias V, the compliance is current compliance. The unit is Amp. 

Meas Range - The measurement range sub-list box specifies the SMU range used .The current 
measure range is present for voltage forcing functions and the voltage measure range is present for 
current forcing functions only.  

If the measure variable involves current measurement, that is, in the Measure sub-list box, the I, I+V, 
or I+V(prog) is selected for a voltage source, then the measure ranges that can be used by the SMU 
for current, are as follows: 

• The Auto option commands the SMU to automatically optimize the current measurement range. 
This option provides the best resolution. 

• The Limited Auto option is a compromise between the full Auto option and a fixed range option. 
Here one can specify the minimum range that the SMU uses when automatically optimizing the 
current measurements. This option saves time when maximum resolution at minimum currents is 
not needed. 

• The numerical range options (100 nA, 1 µA, 10 µA, 100 µA, 1 mA, 10 mA, 100 mA, 1 A, 1.5 A, 10 
A) allow one to manually click a fixed current measurement range to suit the needs. 

If the measure variable involves voltage measurement, that is, in the Measure sub-list box, the V, I+V, 
or V+I(prog) is selected for a current source, then the measure range that can be used by the SMU 
for voltage, are as follows: 

• The Auto option commands the SMU to automatically optimize the voltage measurement range 
as stepping/sweeping progresses. This option provides the best resolution when the 
measurements span several decades. 

• The Numerical Range options (200 mV, 2 V, 20 V, 200 V) allow user to manually click a fixed 
voltage measurement range to suit the needs. 

Set Force and Measure Function 
1. Configure the forcing and measure functions for each device terminal of a sub-device. If you want 

to know how to set these functions, refer to the ITM single device for detailed instructions. After 
setting up a device, you can right-click the mouse on any cell belonging to this device (see next 
figure). 

Figure 231: Apply Settings to Other Sub-Devices 
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2. After clicking this function, the same setting will cover all the devices. You can also edit the 
devices to suit the tests demands. 

Set the Timing (Optional) 

Enter desired time setting for the entire test as instructed in the ITM single device section or use the 
default setting. 

Data tab 
Set the Formulator (Optional) 

There are some special features designed for ITM under multi-subdevices. The main added features 
are the ‘Copy to All’ function and four new formulators including RES, RES_4WIRE, 
RES_4WIRE_AVG, and RES_AVG. These new features are only used in case of ITM under multi-
subdevices. 
Start the Formulator as follows: 
1. Open the Data tab for the test data that you want to analyze.  
2. In the Data tab, click on the Formulator function. The Formulator dialog box opens (see next 

figure). 

Figure 232: Formulator of ITM with Multi-subdevice (1) 

 

3. Edit the formulator you want to analyze, then click the Copy to All function. This formulator will be 
used by all who are using the same format variables generated by different sub-devices.  

4. Once the RG=RES(V_GATE_1,I_GATE_1) is added, click Copy to All. This formulator will apply 
to V_GATE_2, and I_GATE_2. And RG change to RG_1 and RG_2 at same time. RG_1 and 
RG_2 will list in output data sheet of DATA tab. 

These formulator functions are used in the ITM with multi-subdevices: RES, RES_4WIRE, 
RES_4WIRE_AVG, RES_AVG. For more information about how to use the formulator, refer to 
Understanding the Formulator. 
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Model 4200 ITM configuration 

When the ACS software is controlling the Model 4200 in net mode, make sure the Ethernet cable is 
connected to the PC and the Model 4200. 

There are two main parts in configuring a Model 4200 ITM: hardware configuration and ITM 
configuration. 

Configure Model 4200 hardware with ACS software 
1. Launch KCON; communication is through Ethernet in the KXCI settings page (see next figure). 
2. Launch KXCI. 

Figure 233: Set Model 4200-SCS communication mode 
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3. Connect the Model 4200-SCS to the Ethernet through netlink. Write down the IP address. 
4. Install ACS software on a system computer/laptop and connect the system computer/laptop to 

Ethernet through netlink. 
5. Set Model 4200 setting in ACS’s preference menu. 

• Access the Preference item in Tools menu (see next figure). 

Figure 234: Preferences in Tools drop-down 
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• Set the Model 4200 working mode, input the Model 4200 IP address in IP Address edit box (see 
next figure). 

Figure 235: Set Model 4200-SCS working mode in ACS 

 

1. Restart ACS. 
2. To scan the Model 4200-SCS, click the Scan Hardware function on the toolbar. The system 

queries the instruments and then displays the updated configuration information in the 
configuration navigator and the work area (see next figure). 

Figure 236: Hardware configuration after scan 
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3. From the configuration navigator, check that the hardware information matches the configuration 
of the physical system. (If not, use the configuration navigator to choose the appropriate device.) 
The next figure shows a typical setup. 

4. Click the Save function to save the new configuration.  

Figure 237: ACS on system computer for Model 4200-SCS in Ethernet mode 

 

5. Check the hardware configuration. 

• Click the configuration Hardware command from the Tools menu (see next figure). 

Figure 238: Configure Hardware in Tools menu 
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• The interface of the hardware configuration utility has two parts: The left panel is the configuration 
navigator; the right panel is the work area (see next figure). 

Figure 239: Hardware configuration interface 

 

• To scan the Model 4200-SCS, click the Scan Hardware function on the toolbar. The system 
queries the instruments and then displays the updated configuration information in the 
configuration navigator and the work area (see next figure). 

Figure 240: Hardware configuration after scan 
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• Using the configuration navigator, check that the hardware information matches the configuration 
of the physical system. If not, use the configuration navigator to choose the appropriate device. 

• Click the Save function to save the new configuration. ACS can now communicate with the Model 
4200-SCS ITM test module. There is no need to restart ACS. 

Configure a Model 4200-SCS ITM test module 
1. Click the New function on the toolbar from the ACS Main dialog box. You can also click the New 

command from the File menu. Click Tree Style in the Project Structure and input a Project Name 
(see next figure). 

Figure 241: Define New Test Project 
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2. Click the New Device icon in the vertical edit toolbar. You can also right-click Home in the Test 
Setup panel. For example, right-click Home and click the Insert Device option. Then a SMU Type 
dialog pops up, click the Model 4200 SMU to new the Model 4200 SMU (see next figure). Click 
OK and the new device is named device_42. 

Figure 242: SMU Type 

 

3. The Select Device Type dialog box will appear (see next figure). 

Figure 243: Select Device Type 
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4. Click a device and an image browser window opens. Choose the graphic of your choice and then 
click OK. A new device is created. Click this new device, vertical edit toolbar includes these items: 
New Device, New ITM, Rename, Delete, Copy and Cut (see next figure). 

Figure 244: Device type Image Browser 

 

Figure 245: Select a new device 
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5. Click the ITM icon in the vertical edit toolbar or right-click the device/insert ITM in the Test Setup 
panel to insert a new test module for the this device. An ITM test module is created for the device 
(see next figure). 

Follow the steps in the next section to configure the Model 4200 ITM parameters similar to the 2600B 
ITM. 

Figure 246: New Model 4200-SCS ITM 
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Summary of Configuring the ITM test 
This section summarizes the parameter configuration of an ITM. 

Match the physical and virtual connections manually: 
1. In the Test Setup panel, click on the ITM that needs configuration/reconfiguration. The Definition 

tab of the ITM work area opens by default 
2. In the Definition tab, review the virtual connections for each terminal. Ensure that the physical 

device connections match the virtual (Definition tab) device connections. If necessary, shut down 
the instrumentation and correct the physical connections. 

The physical device-terminal connections must accurately match virtual connections to avoid test 
errors results and potential device damage. 

Configure the forcing Function for each device terminal 

In the force Function area, select the desired cell then click on the SMU Terminal. The SMU is 
assigned to the corresponding table and is highlighted. 

Configure the Bias function: 
1. Enter the current or voltage value(s) and range to be forced for a static forcing function. 
2. Click the desired Measure Variable and corresponding Measure Range and default or desired 

Limited Auto.  
3. Enter the default or the desired Compliance. 

Configure the Step/Sweep function: 
1. Enter the Start, Stop, Step, and Sweep points for a Sweep forcing function. 
2. Enter Start, Stop, and Step points for a step forcing function. 
3. Enter the default or desired Force Range.  
4. Click the desired Measure Variable, and the corresponding Measure Range, and Limited Auto if 

enabled.  
5. Enter the default or desired Compliance. 
6. Repeat ALL of the steps above for the remaining device terminals. 

Enter the Default or Desired Time Setting: 
1. Click the test mode prior to configuring a completely new ITM. 
2. Add special delays for Sweeping and hold time in test-mode sweeping tests or configure the 

timing for Sampling test-mode tests. 
3. Enable a timestamp to be recorded for each measurement. 

Do not forget to make sure a device is configured correctly in each of these steps. If you create a 
multigroup test, configure every device as indicated previously, carefully following it step-by-step, 
making sure that all of the devices are configured correctly before executing them. 
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Script Test Module (STM) configuration 
An STM is a script that refers to a file or program that can be created using the Test Script Builder.  

Creating a script using Test Script Builder is discussed in the Writing or Modifying a Script section.  

After STMs are inserted into a Project Plan, they must be configured to meet the test requirements. 
This section describes the connection of Project Plan STMs to your modules and libraries, and 
entering/editing module parameters. 

Project Plan STM configuration: 
1. Open an STM. The STM displays in the STM work area on the Script tab. 
2. Connect/reconnect the name of the desired STM to an existing ACS-created user module using 

the STM Script tab of the STM work area. 
3. In the STM Script tab, check the SMU to match the physical connection, change inputs if 

necessary. 
4. Configure, or change the script, if any. 
5. Save the configuration using the Save function located on the toolbar. 
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Open a STM 
An STM work area allows you to enter information that defines a given STM. An STM work area also 
allows you to view and analyze test data created by the STM, both numerically and graphically. The 
three tabs associated with the STM work area are: 

• The Data tab displays the STM results in its Data worksheet in a spreadsheet format. This 
spreadsheet data sheet allows you to perform data analysis. The spreadsheet, displays the same 
output information as the Script tab. Cells in the spreadsheet may be hot-linked to cells in the 
Script tab. The Data tab also allows you to create and export graphs of the test and test-analysis 
results. The Data tab provides flexible plot-data selection, formatting, annotation, and numerical 
coordinate display (using precision cursors). 

• The Status tab monitors the current configuration status of the STM, reporting its readiness for 
use and recommending additional preparations if necessary. A test-ready report for a STM is the 
same as for an ITM. To view example Status tab reports for ITMs, refer to the ITM Status tab 
discussed earlier.  

• The Script tab allows you to specify a TSP-created user library and user module, and allows you 
to specify a limited number of test parameters. To configure or reconfigure an STM, you need to 
configure the features of the Script tab, which is the default tab of the STM work area.  

Open an STM work area: 
1. In the Test Setup panel, locate the STM to configure.  
2. Click on the STM to configure. For this example, the Resistor_ single STM was selected from the 

Test Setup panel (see next figure). 

Figure 247: Resistor single STM 
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If you inserted a completely new STM into the Project Plan that is not yet named or connected to a 
module, a blank STM Definition tab displays. 

The next figure shows a blank STM work area created by clicking the TSP function. 

Figure 248: A new blank STM 

 

Make configuration changes in the Script tab for the blank STM as follows: 
1. Right-click the STM and click the Rename command (see next figure). 

Figure 249: Name an STM 
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2. Type the name for this STM. In this example, the name is Res_iv.  
3. Click OK. 
4. Click the Import function located at the bottom of the STM work area to open a test script. The 

Choose the test Script dialog box displays (see next figure).  

Figure 250: Import script 

 

5. Choose the Resistor_sweep.tsp in the Resistor folder. 
6. Click the Open function. The script is imported into the STM Script tab (see next figure). 

Figure 251: Resistor sweep STM 
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The imported file can be edited in Script Editor, a tool embedded in ACS, or if you want to write one 
yourself, it will have to follow the ACS STM library rules. 

STM Script tab 
The STM Script tab is divided: 

• Module Type and device information area.  
• Group’s information area. 
• TSP Script area that displays the blank modules and allows you to import one into the user library 

or into your own library. 
 

Understanding a STM script 
A script is a collection of instrument control commands and programming statements. A script is 
made up of a chunk of programming code that is framed by shell commands. Program statements 
control script execution and provide services such as variables, functions, branching, and loop 
control. Because scripts are programs, they are written using a programming language. This 
language is called the Test Script Language or TSL. TSL is derived from the Lua scripting language. 

Script Examples 

You scripts can be written using the Test Script Builder (TSB). You scripts are loaded into the Series 
2600B instrument and can be saved in nonvolatile memory. Scripts not saved in nonvolatile memory 
will be lost when the instrument is turned off. 
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The example script below is used to do the resistance measurement. 
local  v_value = {} 
local  i_value = {} 
local  sensemode = 0 
local  testmode = 0 
local  RSMU1 = SMU1 
local  RSMU2 = SMU2 
local  forcevalue = 1 
local  myLIMIT = 0.1 
local  myNPLC = 1 
local  testdelay = 0.1 
local  resetflag = 1 
local  Rvalue = {} 
 
setmode(RSMU1, KI_INTGPLC, myNPLC) 
   setmode(RSMU1, KI_SENSE, sensemode) 
 
   if RSMU2 ~= KI_GND then 
      setmode(RSMU2, KI_SENSE, sensemode) 
      limiti(RSMU2, 1) 
   end --if 
 
   if testmode == 0 then 
      limiti(RSMU1, myLIMIT) 
      forcev(RSMU1, forcevalue) 
   elseif testmode == 1 then 
      limitv(RSMU1, myLIMIT) 
      forcei(RSMU1, forcevalue) 
   end –-if 
 
   if RSMU2 ~= KI_GND then 
      forcev(RSMU2, 0) 
   end –-if 
 
   delay(testdelay) 
   intgv(RSMU1, v_value) 
   intgi(RSMU1, i_value) 
   Rvalue[1] = v_value[1]/i_value[1] 
 
postdata("R_single", Rvalue[1]) 
 
if resetflag == 1 then 
   devint() 
end --if 

 

Script Using a Function 

TSL facilitates grouping commands and statements using the function keyword. Therefore, a script 
can also consist of one or more functions. Once a script has been run, the host computer can call a 
function in the script directly. TSL allows you to define functions. A function can take a predefined 
number of parameters and return multiple parameters if desired. 

To define a function and call that function, use the example below: 
function add_two(parameter1, parameter2) 
return(parameter1 + parameter2) 
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end 
print(add_two(3, 4)) 

Below is a function that returns multiple parameters. It is used for resistance measurement. 
function R_single(sensemode, testmode, RSMU1, RSMU2, forcevalue, myLIMIT, myNPLC, 

testdelay, resetflag, Rvalue) 
   local v_value = {} 
   local i_value = {} 
 
setmode(RSMU1, KI_INTGPLC, myNPLC) 
setmode(RSMU1, KI_SENSE, sensemode) 
   if RSMU2 ~= KI_GND then 
      setmode(RSMU2, KI_SENSE, sensemode) 
      limiti(RSMU2, 1) 
   end --if 
   if testmode == 0 then 
      limiti(RSMU1, myLIMIT) 
      forcev(RSMU1, forcevalue) 
   elseif testmode == 1 then 
      limitv(RSMU1, myLIMIT) 
      forcei(RSMU1, forcevalue) 
   end --if 
   if RSMU2 ~= KI_GND then 
      forcev(RSMU2, 0) 
   end --if 
   delay(testdelay) 
   intgv(RSMU1, v_value) 
   intgi(RSMU1, i_value) 
   Rvalue[1] = v_value[1]/i_value[1] 
   postdata("R_single", Rvalue[1]) 
   if resetflag == 1 then 
      devint() 
   end --if 
end --function 

 

You can call a function using the following example: 
Local Sensemode = 0 
local testmode = 0 
local RSMU1 = SMU1 
local RSMU2 = SMU2 
local forcevalue = 1 
local myLIMIT = 0.1 
local myNPLC = 1 
local testdelay = 0.1 
local resetflag = 1 
local Rvalue = {} 
R_single(sensemode, testmode, RSMU1, RSMU2, forcevalue, myLIMIT, myNPLC, testdelay, 

resetflag, Rvalue) 

Script header 

It is recommended that you add an output list header at the top of each STM, which is already 
functional in ACS. Make sure that this header is at the beginning of the script. 

--[[ 

--OUTPUT-- 
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I_drain 

V_gate 

--End of OUTPUT-- 

]]-- 

With this header, you will see next figure the following changes. 

In Data tab of a test module in Test Setup, you will see next figure the variable sequence is the same 
as in the output list. This output list is of highest priority compared to “postdata." If you add the output 
list, “postdata” will not be scanned and used. 

If a parameter is not in the output list, but you still post it, it will be added in the data sheet as well. 

Writing or Modifying a Script 

A script is a list of Instrument Control Library (ICL) commands and TSL statements. A script file is 
created using the Test Script Builder (TSB). TSB is a Keithley Instruments product that can be 
downloaded from the Keithley Instruments website under the Source and Measure products heading.  

To modify a script file in the STM work area: 
1. Click the script file name in the Test Setup panel of ACS. The script file opens in the STM work 

area and contains tabs depending on the contents of the script file (see next figure). 

Figure 252: Importing a Script 

 

2. Modify the script file as necessary.  
3. Click the Save function located at the bottom of Script tab in the STM work area. 

You can also access the Test Script Builder by clicking the Edit function. In the Test Script Builder, 
the function is at the bottom of the STM work area. 
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STM with the .xrc GUI File 

If the TSP file imported has a corresponding “.xrc” graphical user interface (GUI) file, ACS 
automatically loads and displays the GUI. You can set parameters on the GUI so that you do not 
need to edit the parameters (see the next several figures). You can generate the “.xrc” file yourself. 

It is recommended that only people who are familiar with XRCed software try to generate their own 
.xrc files. This process will require extensive knowledge and understanding to accomplish.  

Figure 253: TSP GUI example HCI 

 

If you input empty or invalid parameters in the GUI tab, you will receive a message indicating that the 
input is not correct (see next figure). 

Figure 254: Empty or Invalid input 
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After the correct input is entered, open the Script tab of this script to see next figure the TSP script 
(see next figure). 

Figure 255: ACS 4.2 Script tab of STM.eps 

 

Figure 256: TSP GUI example NBTI 
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The GUI (“.xrc” file) editor can be accessed by clicking the ACS Tools menu, then the TSP GUI 
Builder command (see next figure). 

Figure 257: Custom Test GUI Designer (XRC) in Tools menu 
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Create a TSP GUI file 

There is a feature in the ACS software package called Script Editor Tool. Keithley Instruments, Inc. 
recommends that you use this tool rather than the XRCed software GUI creation tool described 
below (see Script editor tool and Script editor tutorials in this section for more information). 
If you are familiar with XRCed software, including wxWindows class names, and with the XRC 
format, you can use the following information to assist in creating a TSP GUI file. This process will 
require extensive knowledge and understanding to accomplish. Also, note that the following 
information is not a step-by-step process on how to create a TSP GUI. If do not have experience or 
knowledge with XRCed software, it is strongly recommended that you use Script Editor. 

Before creating a TSP GUI, you should create a draft first so that you know how you want the GUI to 
look, depending on the functionality that is needed for your testing. First, we will show you an image 
of a simple GUI and show you how to create a TSP GUI based on a few simple parameters. For 
example, the next figure shows a simple GUI with three labels and three text boxes (see next figure). 

Figure 258: Simple GUI image 
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The purpose of this simple GUI is to take three values (a, b, and c) and add them together that 
returns a value, for example, the output will equal a + b + c. 

Once you have a draft of a GUI you want, go to Tools, then select Custom Test GUI Designer (XRC) 
(see next figure). 

Figure 259: Custom Test GUI Designer (XRC) in Tools menu 

 

Create a new object from the file menu (see next figure). 

Figure 260: Create a new object 
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Change the XML configuration navigator encoding (see next figure). 

Figure 261: Change the XML tree encoding 

 

Add a panel to the XML configuration navigator (only wxPanel is supported in ACS)(see next figure). 
Next, change the panel ID to TSP_PANEL (only this ID script is identified in ACS). 

Figure 262: Add panel for new object 

 

In the next figure (example) for the design GUI structure, notice the use of the GridSizer and BoxSizer 
(see next figure). 

Figure 263: Design GUI structure 
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Select the desired BoxSizer size for your project GUI and choose either vertical or horizontal (see 
next figure). 

Figure 264: Add sizers under the TSP panel 

 

Select the desired GridSizer size, add your StaticText (the label) and the TextCtrl (the text box) to 
your project GUI (see next figure). 

Figure 265: Add labels and text box under wxGridSizer 

 

Modify the information in the StaticText (label) and the TextCtrl (text box): 

1. Click on the StaticText node on the XML configuration navigator. 
2. Set the XML ID and label on the right. 
3. Click on TextCtrl (see next figure). 

Figure 266: Modify information 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 5: Test Setup 
 

ACS-901-01 Rev. H / December 2014 5-113 

 

4. Set the label for the StaticText (return information label, see next figure). 
5. Click on wxStaticText under wxBoxSizer, and set the label.  
6. Save your .xrc file, after you have completed the steps. 

Figure 267: Set label for wxStatic Text 

 

Once you have completed these steps, you can save this as a .xrc GUI that can be used in the Script 
Editor Tool. For more information about how to use the Script Editor and create a STM with the .xrc 
GUI, see the Script editor tool and Script editor tutorials in this section for more information. 

Helpful tips 

• Once completed, you should save your TSP script file to this folder: 
\\ACS\library\26Library\TSPLib; also, you should save your .xrc GUI file to this location: 
\\ACS\library\26Library\TSPLib\xrc. 

• Also, you should add a specification line with a recognizable format/name to the top of the TSP 
script to help identify it with the corresponding .xrc file. The ACS parsing engine will parse this 
format and determine the .xrc file that is related to the TSP script and will load the .xrc file. In 
other words, the TSP text and TSP GUI are linked by the .xrc file name that appears at the top of 
the text file. The suggested format/name is: ----<<xrc=HCI.xrc>>---- (see next figure). 

Figure 268: XRC specification line name 
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• The Name of the wxPanel must be called TSP_PANEL (see next figure). 

Figure 269: wxPanel named TSP_PANEL 

 
 

• The input XML ID parameter in the test module must have a corresponding control in the XRC 
GUI file so that ACS will utilize all of the correct input values that correspond to the input 
parameters. Therefore, the controls in the .xrc file must have the same name as the input (see 
next two figures) 

Figure 270: XML ID of the wxTextCtrl 

 

Figure 271: wxTextCtrl and XML ID 
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• You must make sure that your script contains a session code at the end of the script that tells the 
engine to execute a function with the given input parameters that is named --CALL-- (see next 
figure). 

Figure 272: Session named CALL 

 
 

• Make sure that you place your input parameters between two key words: --INPUT-- and --End of 
INPUT--. This is used by ACS to parse the input parameters (see next figure). 

Figure 273: INPUT and End of INPUT parameters 
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• Make sure that you place your output parameters between two key words: --OUTPUT-- and --End 
of OUTPUT--. This is used by ACS to parse the output parameters (see next figure). 

Figure 274: OUTPUT and End of OUTPUT parameters 

 
 

• You must make sure that your TSP script contains a session code so that it will execute the 
desired function. For example, every TSP script should have a main function. The next figure 
indicates the main function (TCR_EM is the main function) of this script (see next figure). 

Figure 275: Session code for executing scripts 
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Modify script for GUI import 

After the script with the .xrc GUI is imported to ACS, the corresponding information of the GUI and 
Script can be changed. If you want to modify information, use the GUI script that you imported. 

In the script, there must be a .xrc file name, input variable, function, and function call in order to 
modify different parts according to your requirements (see next two figures). 

Figure 276: Modify script for import GUI 

 

Figure 277: Modify script for import GUI (2) 
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In the test script program, the comments denote as “[[ ……]]”, whereas in C program comments 
denotes as “/* ……*/”. Input variables can be integer, double, string, table or instID. Additionally, in 
the -CALL-part, Call function name must be the same with Main function’s. The following of ‘--CALL -
-’ is automatically generated by ACS. 

You can set the limit range for input variables. For example: double a=0.0 in [-40,40]; double b=0.0 in 
[-40,]; integer a=0 in [,40] (see next figure). 

Figure 278: TSP GUI for STM 

 

 On the TSP GUI, you can input values according to what you want. If input is empty, you will receive 
an Invalid input message (see next figure). 

Figure 279: Invalid input 
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C language Test Module (CTM) configuration 
A CTM is a test module defined primarily by programming a C-language user module using KULT of 
Model 4200-SCS. It is one in which you typically configure key test parameters using a graphical user 
interface (GUI).   

After inserting a CTM into a project, it must be configured to meet the test requirements. This section 
describes the connection of CTMs to user modules and user libraries, and entering/editing module 
parameters.  

Connect/reconnect the selected CTM to an existing KULT-created user module using the CTM Setup 
tab of the CTM work area. 

There are two kinds of CTM: ACS Classic Style and Advanced Style (Support CTM List). Classic 
Style CTM only contains one test module, but the advanced style CTM contains many test modules.  

 
 

Classic CTM configuration 
1. Click the New CTM icon in the vertical edit toolbar. The Specify the CTM Type dialog box opens 

(see next figure).  

Figure 280: Specify the CTM Type 

 

2. Click the ACS Classic Style and Click OK, then CTM Setup Tab displays (see next figure). 

Figure 281: CTM Setup tab 
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3. In the User Lib drop-down menu of the Setup tab, click the user library that contains the desired 
user module to test. For this example, the ACS_DEMO library is selected. 

4. In the User Module drop-down menu of the Setup tab, click the desired user module to test. The 
CTM displays the configuration parameters for the selected user module. In the next figure, 
idvd_demo is selected as the user module.  

Figure 282: CTM Setup example 

 

5. Accept the default parameter values, or change them if desired. For an array input, click Set 
Value on the active sheet; the Array Value Setting dialog box displays (see next figure). 

Figure 283: CTM Array Value Setting 
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6. Choose the desired Array, then click the Apply function. This returns you to the Setup tab.  
7. Save the CTM and the project by clicking the Save or Save All function on the toolbar. 
8. Run the CTM.  
9. View the result in the Data tab. 

CTM work area 
A CTM work area allows you to enter information that defines a given CTM. A CTM work area also 
allows you to view and analyze test data created by the CTM, both numerically and graphically. Tabs 
available from the CTM work area are discussed below: 

The Setup tab of the CTM work area allows you to specify a KULT-created user library and user 
module. In addition, it allows you to specify a limited number of test parameters.  

The Data tab displays the CTM results and graph in its Data worksheet. The Data worksheet allows 
you to create and plot graphs of the test results. Refer to the Data Plot topic discussed later in this 
section.  

The Status tab monitors the current configuration status of the CTM (see next figure). 

Figure 284: CTM work area 

 

• User Lib drop-down menu box: Displays the available user libraries for selection.  
• User Module drop-down menu box: Displays the user modules in the user library for selection. 
• Parameter input area: Contains the following:  
• Parameter cells: Spreadsheet-like cells that receive inputs directly, or display parameter 

titles/descriptions. As in a standard spreadsheet, each cell is designated by a column and row (for 
example, the fourth column, second row is designated as D2). Any of the white cells next to 
parameter titles/descriptions are valid user-input cells. 

• Present-cell list box: 1) Displays the contents of the presently selected cell and 2) provides an 
alternative, more spacious place to input or change the parameters of the currently selected user-
input cell. 

• Documentation area: Typically displays descriptions, examples, requirements, etc., for the 
connected user module. 
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You should be aware that the CTM LPT commands will only work when the ACS software is installed 
on the Model 4200-SCS to control the Model 4200-SCS hardware, such as the SMU, CVU, SCP, 
VPU, etc. Also, if you are controlling the Model 4200-SCS hardware using the KXCI software and an 
Ethernet cable, you will not be able to use the KITE LPT commands at the same time. For more 
information about CTMs that are used on the Model 4200-SCS, refer to the supplied documentation 
that is located on the Keithley Instruments CD-ROM that was shipped with your purchase. 

Post data function in CTM 

In KITE UTM, the data post functions are PostDataInt (char *, int *), PostDataDouble (char *, double 
*) and PostDataString (char *, char*). But in ACS CTM, those functions can no longer be used if the 
KITE version is v7.1 or older. However, if the KITE version is equal to or greater than v7.2, all of the 
KITE UTM data post functions can be used in ACS. That means that the KITE user library can be 
used in ACS directly without any modifications. Note that the following functions have been added to 
take the place. 

• int  ACSPostDataInt (char *data_name, int data_val); 
• int  ACSPostDataFloat (char *data_name, float data_val); 
• int  ACSPostDataDouble (char *data_name, double data_val); 
• int  ACSPostArrayInt (char *data_name, int *data_array, int data_num); 
• int  ACSPostArrayFloat (char *data_name, float *data_array, int data_num); 
• int  ACSPostArrayDouble (char *data_name, double *data_array, int data_num); 

To use these functions in ACS, you should add “#include acsenv.h” in the C source code. 
 

Advanced CTM configuration 
1. Click the New CTM icon in the vertical edit toolbar. The Specify the CTM Type dialog box opens 

(see next figure). 

Figure 285: Specify the CTM Type 
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2. Click the Advanced (Support CTM List) and click OK, the CTM Setup Tab of this Advanced CTM 
is displayed by default (see next figure). 

Figure 286: CTM of Advanced Setup tab 

 

There are three main parts in the Setup tab:  

• Test libraries 
• Test module list 
• Test module setting 
1. In the Test Libraries box, click the user library that contains the desired user modules. For this 

example, the parlib library is selected.  
2. After the library unfold, all test modules containing in this library will list. Click the desired module 

to test by double-click it. For example, the Vtext module is double-selected. All configuration 
parameters for this CTM (see next figure). 

Figure 287: CTM Setup tab example 
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3. Set these parameters as classical CTM . For an array input, click active sheet; the Array Value 
Setting dialog box opens (see next figure). 

Figure 288: CTM Array Setting 

 

4. You can click the Description in the left bottom (see next figure). It typically displays descriptions, 
examples, requirements, etc., for this user module (see next two figures). 

Figure 289: Description function 

 

Figure 290: Description of CTM 
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5. Then click the Add function to add this module to the Test Modules List (see next figure). 

Figure 291: Add a test module to the Test Modules List 

 

6. In the Test Module List, you can see next figure _vtest[0] in the Test Module List. Then you can 
change the parameters as shown in the step 5, and select the Add function again, which means 
you can add this module with the different parameters many times (see next figure). 

Figure 292: Add a test module twice to the Test Modules List 

 

• Click the Reset function, to set all of the parameters of the module in the Test Module setting to 
their original values. 

• If you want to change the parameters of a module in the Test Module List, you can click and 
double-selected this module in the Test Module List, and then this module appears in the Test 
Module Setting. You can change the parameters as you want, and then click the Update function. 
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7. You can also add modules in other library to the Test Modules List. For example, click the 
kiscopeulib library and double-click the SCP2_CH1 module, and then click the   function; this new 
module is added to the Test Module List (see next figure). 

Figure 293: Add another test module to the list 

 

8. You can change the module’s test sequence in the Test Modules List by upper function and 
forward function. For example, if we want to test the _SCP2_CH1[0] module first, we can click 
this module, and click the up arrow function some times, then this module turns to the first place 
(see next figure). 

Figure 294: Change the module test sequence 

 

9. In the Test Modules List, right-click and there are four items: Click All, deselect All, Delete 
Selected Macro and Clear all. Click Delete Selected Macro to delete the selected the module, and 
Clear all to delete all the modules in the Test Module List (see next figure). 

Figure 295: Right-click in the Test Modules List 
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10. Save the CTM and the project by clicking the Save or Save All function on the toolbar. 
11. Run the CTM.  
12. View the result in the Data tab. 

The Data tab displays the CTM results and graph in its Data worksheet. The Data worksheet allows 
you to create and plot graphs of the test results. Refer to the Data Plot topic discussed later in this 
section.  

The Status tab shows the current configuration status of the CTM. 
 

Python language Test Module (PTM) configuration 
A PTM is a test module defined primarily by programming a Python language user module. It can be 
created by using the Script Editor in ACS software. 

The PTM can be used as a test module. PTMs can also be used to control instruments and process 
data. 

After inserting a PTM into a project configuration navigator, it must be configured to meet the test 
requirements.  

Configure a PTM: 

1. Click the New PTM icon in the vertical edit toolbar. The Setup tab is displayed (see next figure). 

Figure 296: Add a PTM 
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2. You can write a PTM script or import an existing test module. 

The imported file can be edited in Script Editor, a tool embedded in ACS, or you can write the code 
yourself. The code will have to follow the ACS STM library rules. For more information about the 
Script Editor, you can refer to the Script Editor Tutorials. 

3. Click the Import function to import this PTM module and click the Save function to save it (see 
next figure). 

  

The Data tab displays the PTM results and the graph in the Data worksheet. The Data worksheet 
allows you to create and plot graphs of the test results. Refer to the Data Plot of the Status tab where 
it monitors the current configuration status of the PTM.  
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Understanding a python script 
A python script is a script written in python programming language, and a script is a collection of 
instrument control commands and programming statements. Program statements control script 
execution and provide services such as variables, functions, branching, and loop control. 

Script Examples 

The example python script below is used to perform a diode measurement.  
from ACSLPT import * 
from ptmlpt.constantlpt import * 
from ACS_PostData import * 
import kimisc as misc 
from ACS_Global import * 
 
def Diode_DynamicZ_I1I2(PSMU='SMU1', NSMU='GNDU', I1=0.01, I2=0.02, RangeV=1, 

ComplianceV=20, nPLC=1.0, Holdtime=0.01, output_error='error', 
output_DynamicZ='DynamicZ', output_I1='I1', output_I2='I2', output_V1='V1', 
output_V2='V2'): 

   """ 
   VISIBILITY: NOT_HIDDEN 
   TYPE : standard 
   INPUTLIST 
      #Name, Type, Default Value, Min Value, Max Value, Unit 
PSMU,enum,'SMU1',('SMU1','SMU2','SMU3','SMU4','SMU5','SMU6','SMU7','SMU8'),,A  
NSMU,enum,'GNDU',('SMU1','SMU2','SMU3','SMU4','SMU5','SMU6','SMU7','SMU8','GNDU'),,

A 
      I1,float,0.01,-0.1,0.1,A  
      I2,float,0.02,-0.1,0.1,A  
      RangeV,int,1,1,5,A  
      ComplianceV,float,20,-1100,1100,A  
      nPLC,float,1.0,0.01,10,A  
      Holdtime,float,0.01,0,100,A 
END INPUTLIST 
OUTPUTLIST 
      #Name, Type, DefaultValue, Unit 
      output_error,str,'error',A 
      output_DynamicZ,str,'DynamicZ',A 
      output_I1,str,'I1',A 
      output_I2,str,'I2',A 
      output_V1,str,'V1',A 
      output_V2,str,'V2',A 
END OUTPUTLIST 
DESCRIPTION 
      Module Name: Diode_DynamicZ_I1I2 
      Instrument:Keithley S4200 SMU. 
      DUT: Diode 
      Function: Calculates the Dynamic Impedance based on two forward voltage or 

two reverse voltage measurements. 
      DynamicZ = (v2 - v1) / (I2 - I1) 
      Pin Connection: It uses one SMU to force forward current, while the other 

terminal is grounded. 
      ---PSMU:SMU name of P terminal. Valid from SMU1 to SMU8. 
      ---NSMU:SMU name of N terminal. Valid from SMU1 to SMU8, GNDU. 
      ---I1:P terminal forced current. Valid from -0.1 to 0.1. [A] 
      ---I2:P terminal forced current. Valid from -0.1 to 0.1. [A] 
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      ---RangeV:Limit auto range of voltage measurement. Valid from 1 to 5. For 
some instrument without lorange, it will be set to autorange. 

            Input           Range 
            ====================== 
            1                Full Auto 
            2                Limited Auto 0.2V  
            3                Limited Auto 2V  
            4                Limited Auto 20V  
            5                Limited Auto 200V 
      ---ComplianceV:Compliance of current force. 
      ---Valid from -1100 to 1100. [V] 
      ---nPLC:Number of power line cycles for integration. 
      ---Valid input from 0.01 to 10. 
      ---Holdtime:Holdtime before measurement. 
      ---Valid input from 0 to 100.  [s] 
      ---output_error : error value list 
   0 (OK) normal working condition;  
   -10000 (INVAL_INST_ID)An invalid instrument ID was specified. This generally 

means that there is no instrument with the specified ID in your configuration. 
   -10100 (INVAL_PARAM) An invalid parameter was specified.         
   -12021 (KI_COMPLIANCE) Measurement compliance occurred. 
   -12022 (KI_RANGE_COMPLIANCE) Range limit was reached during measurement. 
      ---output_DynamicZ : Dynamic impendence of diode. 
      ---output_I1 :  
      ---output_I2 :  
      ---output_V1 :  
      ---output_V2 :  
   END DESCRIPTION 
   """ 
 
   Get4200HWCtrl() 
 
   error = [ ] 
   DynamicZ = 0.0 
   #Some input checking is needed 
   if  abs(I1) > 0.1: 
      error.append(INVAL_PARAM) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_PARAM 
   if  abs(I2) > 0.1: 
      error.append(INVAL_PARAM) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_PARAM 
   if  RangeV < 1 or RangeV > 5: 
      error.append(INVAL_PARAM) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_PARAM 
   if  abs(ComplianceV) > 1100: 
      error.append(INVAL_PARAM) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_PARAM 
   if  nPLC < 0.01 or nPLC > 10: 
      error.append(INVAL_PARAM) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_PARAM 
   if  Holdtime < 0 or Holdtime > 100: 
      error.append(INVAL_PARAM) 
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      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_PARAM 
   #Map the SMUs with DUT terminals 
   PSMUId = getinstid(PSMU) 
   if not PSMUId: 
      error.append(INVAL_INST_ID) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_INST_ID 
   NSMUId = getinstid(NSMU) 
   if not NSMUId: 
      error.append(INVAL_INST_ID) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return INVAL_INST_ID 
   #Set range and compliance 
   limitv(PSMU, ComplianceV) 
   if NSMU != "GNDU": 
      limitv(NSMU, ComplianceV) 
   if RangeV == 1: 
      setauto(PSMU) 
   elif RangeV == 2: 
      lorangev(PSMU, 0.2) 
   elif RangeV == 3: 
      lorangev(PSMU, 2) 
   elif RangeV == 4: 
      lorangev(PSMU, 20) 
   elif RangeV == 5: 
      lorangev(PSMU, 200) 
   else: 
      lorangev(PSMU, 2) 
   #Set instrument config 
   setmode(PSMU, KI_INTGPLC, nPLC) 
   htime = int(Holdtime * 1000) 
   #Set stress 
   if NSMU != "GNDU": 
      forcev(NSMU, 0) 
   forcei(PSMU, I1) 
   delay(htime) 
   V1 = intgv(PSMU) 
   forcei(PSMU, I2) 
   delay(htime) 
   V2 = intgv(PSMU) 
   #check compliance 
   cstatus = getstatus(PSMU, KI_COMPLNC) 
   if cstatus == 2: 
      error.append(KI_RANGE_COMPLIANCE) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return error[len(error)-1] 
   if cstatus == 4: 
      error.append(KI_COMPLIANCE) 
      ACSPostArrayInt(output_error, error, len(error)) 
      return error[len(error)-1] 
   #test complete 
   devint() 
   Idelta = I1 - I2 
   if Idelta == 0:  
      Idelta = 1e-37 
   DynamicZ = (V1 -V2) / Idelta 
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   error.append(0) 
   ACSPostDataDouble(output_DynamicZ, DynamicZ) 
   ACSPostDataDouble(output_I1, I1) 
   ACSPostDataDouble(output_I2, I2) 
   ACSPostDataDouble(output_V1, V1) 
   ACSPostDataDouble(output_V2, V2) 
   ACSPostArrayInt(output_error, error, len(error)) 
   return  DynamicZ 
 
#--CALL-- 
 
PSMU = "SMU1" 
NSMU = "GNDU" 
I1 = 0.01 
I2 = 0.02 
RangeV = 1 
ComplianceV = 20 
nPLC = 1.0 
Holdtime = 0.01 
output_error = "error" 
output_DynamicZ = "DynamicZ" 
output_I1 = "I1" 
output_I2 = "I2" 
output_V1 = "V1" 
output_V2 = "V2" 
 
Diode_DynamicZ_I1I2(PSMU,NSMU,I1,I2,RangeV,ComplianceV,nPLC,Holdtime,output_error,o

utput_DynamicZ,output_I1,output_I2,output_V1,output_V2) 
 

Code Explanation 

It may be necessary for you to learn some basic knowledge of the Python language before you 
continue. You can download the Python IDE (Python Integrated Development Environment) in order 
to learn more about basic syntax and the environment (copy and paste this link in your internet 
browser and download the Python IDE:  http://www.python.org/download/).  

Here is an explanation of the code presented previously: 

Lines 1 - 4: Import declarations 

Lines 6 - 9: Declaring functions 

The declare function must follow the rule of indentation plus a colon. 

Declaration function rule (Python syntax rule): The keyword def starts the function declaration, 
followed by the function name, and the arguments in parentheses. Multiple arguments are separated 
with commas. 

Declaration variable rule (Python syntax rule): Parameters do not specify a data type. In Python, 
variables are never explicitly typed. Python figures out what type a variable is and keeps track of it 
internally. 

Lines 10 - 74: Function description/details 
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Between the triple quotes is the function's document string. Of course, you can add some other 
comments about the functions. 

Paragraph rule (Python syntax rule): Python functions have no explicit begin or end, and no curly 
braces to mark where the function code starts and stops. The only delimiter is a colon (:) and the 
indentation of the code itself. Indenting starts a block and un-indenting ends it.  

This means that whitespace is significant, and must be consistent. In this example, the function code 
(including the doc string) is indented four spaces. It does not need to be four spaces, it just needs to 
be consistent. The first line that is not indented is outside the function.  

The following example shows various indentation errors:  
def perm(l):                       # error: first line indented 
for i in range(len(l)):             # error: not indented 
   s = l[:i] + l[i+1:] 
      p = perm(l[:i] + l[i+1:])   # error: unexpected indent 
      for x in p: 
            r.append(l[i:i+1] + x) 
         return r                # error: inconsistent dedent 

For more information about the Python resource, copy and paste the following links in your internet 
browser: 

 http://www.python.org/download/ 

 http://www.activestate.com/Products/ActivePython/ 

 http://www.python.org/doc/ 

Post data function in PTM 
In CTM, the data post functions are ACSPostDataInt(char *, int *), ACSPostDataDouble(char *, 
double *) and ACSPostDataString(char *, char*). But in an ACS PTM, those functions can no longer 
be used and the following functions are added to take the place. 

• ACSPostDataInt(data_name, data_val); 
• ACSPostDataDouble(data_name, data_val); 
• ACSPostArrayInt(data_name, data_array, data_num); 
• ACSPostArrayDouble(data_name, data_array, data_num); 

To use these functions in ACS, you should import the ACS_PostData at the beginning of the Python 
source code (see next figure). 

Figure 297: Import the ACS PostData line in PTM header 
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Using Log Manager in PTM 
If you want to debug the program of a PTM, in this case, LogManager will be used. In the Preferences 
setting, you can change the log level for debug or production run. 

For the PTM Test module, you can use logInfo, logError, and logCritical to print log information in the 
ACS log window if this line is added in the header “from ACS_PostData import *”. The logCritical is 
the highest level and cannot be confined by all level settings. 

For example, in the ACS Preferences dialog box, set the info level as Info (see next figure).  

Figure 298: Select INFO Level in Advanced tab 
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Then add a new PTM test module and add the following lines: 
from ACS_PostData import * 
logInfo("@@@@@@@@HELLO, WORLD!!!@@@@@@@@@@") 

Click the Check button to compile or click run button to run this PTM, this string will be printed in log 
window (see next figure). In info level, the logError, and logCritical can also be used. 

It will not print a log message after setting the log level to Warning or Error. If the log level is set to 
Error, logError, and logCritical will be used. The logCritical is the highest level and will not be confined 
by all level settings (see next figure). 

Figure 299: Print line in log window 
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PTM with the .xrc GUI file 
The .xrc is a tool used for creating a GUI. As with a STM in ACS, a PTM can include a “.xrc” file for a 
test module. 

If the file imported has a corresponding .xrc graphical user interface (GUI) file, ACS automatically 
loads and displays the GUI. You can set parameters on the GUI so that you do not need to edit 
parameters on the script tab.  

You can generate the .xrc file yourself. For instructions on how to create a .xrc GUI, refer to How to 
create a TSP GUI file in this section.  

Configure a PTM with .xrc: 

1. After the .xrc PTM is imported, click the test name in the configuration navigator. The module will 
open and the GUI is shown by default. The module is in the Script tab of PTM work area. The 
next figure shows a GUI related.  

Figure 300: Importing a XRC PTM 
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2. Set the input parameters.  
3. Save the configuration using the Save function located on the toolbar. 

The inputs in GUI are related to the function call parameters in the script tab. 

To open the corresponding script tab, click the Script tab option (see next figure). 

Figure 301: Script tab of XRC PTM 

 

If one input parameter in GUI is empty, the value of this input parameter will be nothing in function call 
of the script. After the correct input is entered, the function call of script tab of this test module will 
change at the same time. 

 

Global data support in PTM and UAP 
In a PTM , ACS supports two-sided data flow:  

• Global data can be used in an UAP.  
• A PTM can change or set new global data, which can be used in any UAP or any other PTM after 

the PTM settings run over. The usage is no different than using the variable in global data (see 
next figure). 

Figure 302: Data flow 
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General module test in a PTM 
Configure the device under test 
1. Import the PTM module GeneralTestLib.py from PTMlib, and choose the General_HighV Module 

from the User Module combo (see next figure). 

Figure 303: General module test 

 

2. Click the Browse function, and the Select Device Type dialog box opens showing various Device 
Types for users to indicate their needed Device Map (see next figure). 

Figure 304: Select Device Type 
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3. Configure the device pads with different SMUs (see next figure). 

Figure 305: Device map example 

 

In the general module test, different kinds of SMUs are available for devices to perform the test. If 
ACS software is installed on a PC, the Model-4200 SMU cannot be used in this General test PTM, 
so the Model-4200 SMU will not be displayed on SMU Info box. Only when the ACS software is 
installed on the Model-4200 will the Model-4200 SMU be used (see next figure). 

This dialog box shows the SMUs’ detailed information.  

Figure 306: Selected SMU information 
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Configuring the SMU’s Force/Measure Table 
A Forcing Functions/Measure Options table is associated with an instrument object that is assigned to 
a device terminal. The Forcing Functions/Measure Options table items are used to configure the 
forcing function and measurements implemented by the instrument. This section explains the 
following: 

• Understanding and configuring each available forcing function. 
• Understanding and configuring the measurement options that are associated with a forcing 

function. These are discussed generically, for all forcing functions, at the end of this section.  
• Understanding and configuring the other controls on the Forcing Functions/Measure Options 

dialog box. 

SMUs Bias/Sweep/Step Setting Table 

There are three parts in Forcing Functions/Measure Options tables in the General Module Setup Tab: 

1. The Pad name and the SMU ID 
2. The force functions settings 
3. The measure options settings (see next figure). 

Figure 307: Forcing functions_measure options table 

 

Configure the Common Settings 
The Common Settings are used to configure the general module timing settings. There are three 
areas in the Common Setting: Test Speed; Test Mode; Advanced (see next figure). 

Figure 308: Common Settings 
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Understanding Test Speed 

The entries in the PLC and #Average list boxes control the A/D (analog-to-digital) converter 
integration time used to measure a signal. Each measured reading by a SMU is the result of one or 
more A/D conversions. A short integration time for each A/D conversion results in a relatively fast 
measurement speed, at the expense of noise. A long integration time results in a relatively low noise 
reading, at the expense of speed. The integration time setting is based on the number of power line 
cycles (NPLCs). For example: 

• For 60 Hz line power, 1.0 PLC = 16.67msec (1/60).  
• For 50 Hz line power, 1.0 PLC = 20msec (1/50). 

Understanding Test Mode 

There are two test modes you can choose in the mode area of the Common Settings dialog box: the 
Sweeping test mode and the Sampling test mode.  

The Sweeping test mode applies to any General Module in which one or more forced 
voltages/currents vary with time.  

The Sampling test mode applies to any General Module in which all forced voltages or currents are 
static (bias I or bias V), with measurements typically being made at timed intervals. Refer to the 
Forcing Function Summary Table discussed earlier. For example, sampling mode would be used to 
record a few static measurements, or to time-profile the charging voltage of a capacitor while forcing 
a constant current. 

The mode is used to observe and/or change the test mode as follows: 

• For a completely new General Module, the mode allows you to choose the Sweeping or Sampling 
test mode. Selecting the appropriate test mode simplifies configuration options and helps to avoid 
errors: 

A. Only the static forcing functions are configurable in the Sampling mode. 
B. Only mode-appropriate timing options are configurable. 

• For an existing library PTM that is in the Sampling mode, the mode area allows you to change to 
the Sweeping mode if you want to change some of the static forcing functions to sweeping forcing 
functions. 

Sweeping mode 

If any terminal of the device under test is configured for a sweeping forcing function—a Step or 
Sweep forcing function—the Sweeping mode is automatically enabled. Then, you can configure two 
Sweeping mode settings in the Common Settings dialog box. These are Delay Time and Hold Time 
(see next figure). 

Figure 309: Sweeping mode setting 
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• Hold Time setting - The starting voltage(s)/current(s) of a sweep may be substantially larger than 
the voltage/current increments of the sweep. Accordingly, the source settling time required to 
reach the starting voltage(s)/current(s) of a sweep may be substantially larger than the settling 
times required to increment the sweep. To compensate, you can specify a Hold Time delay to be 
applied only at the beginning of each sweep. You can specify a Hold Time delay of 0 to 1000s 
(seconds). The default Hold Time is 0s. 

The next figure shows an example Sweeping mode timing diagram. 

Figure 310: Sweeping mode timing diagram 

 

• When the test is started, the Hold Time (HT) provides extra settling time for the initial step change 
of the source. The Hold Time is a global setting. Note that the Hold Time is applied at the start 
(only) of each sweep; therefore, it is the same for all SMUs that are part of the test (as in the 
previous figure that includes Sweep, Step, and Bias). 

• SMU will delay Delay Time (D) before taking a measurement after forcing.  

Sampling mode 

The Sampling mode measures voltages/currents as a function of time while forcing constant 
voltages/currents (Bias I or Bias V). Refer to the Forcing Function Summary Table in “Understanding 
and configuring the force function parameters” discussed earlier in this section. For example, the 
sampling mode would be used to measure voltage while forcing a constant current. Time is measured 
relative to when the SMU(s) apply the forced voltage or current (that is, t = 0 at the step change from 
0.0 V/0.0 A to the applied voltage/current). 

ACS enables the sampling mode option only when all terminals of the device under test are 
configured for static forcing functions: Voltage Bias, or Current Bias. If any terminal of the device 
under test is configured for a step or sweep forcing function, the Sampling mode option is unavailable 
(see next figure). 

Figure 311: Sampling mode setting 
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You can configure three Sampling mode settings: Delay Time, Sample Number, and Hold Time. 

The Delay Time, Sample Number, and Hold Time settings control the Sampling mode, as follows: 

• Delay Time—Specifies the time between measurements (data points). Delay Time can be set 
from 0 to1000sec. 

• Sample Number—Specifies the number of data points to be acquired. Sample Number can be set 
from 1 to 4096.  

• Hold Time—After initial application of voltage/current by the SMU(s), the source settling time(s) 
can be substantial. To allow for settling, you can specify an extra Hold Time delay to be applied 
before making the first measurement. You can specify a Hold Time from 0 to 1000s (seconds). 

Figure 312: Sampling mode timing diagram 

 

• If needed, a Hold Time (HT) can be used to allow for extra source settling after the initial 
application of voltage(s)/current(s) by the SMU(s). Hold Time is a global setting, and is therefore 
the same for all SMUs in the test system. 

• A range-dependent Delay (D) is automatically applied by a SMU before each measurement, to 
allow for source settling. All SMUs in the test system are synchronized. Therefore, the Delay time 
applied by the most delayed SMU is the delay time applied to all SMUs. 

• SMU will delay Measure Time (MT) before taking a measurement after forcing. 

Understanding Advanced 

In the Advanced area, there are two lists for you to configure for your requirement. They are Test End 
Reset and Enable Trigger (see next figure). 

Figure 313: Advanced box of common settings 

 

For the Test End Reset configuration, there are two choices for you to configure. If you choose False, 
that means your test result will not be cleared. If you choose True, after the test is finished, it will clear 
the test results. 

For the Enable Trigger configuration, there are two choices.If you want to use trigger in your test 
configuration, you should choose True, otherwise choose False. 

For the most SMUs, Choose the Enable Trigger with False is generally accepted. 
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Configure a general purpose PTM 
The general purpose PTM is used to perform measurements with SMUs from different Keithley 
product lines. Its GUI provides an interface similar to the standard interactive test modules (ITM) for 
the Series 2600 and 2600B, therefore, no programming is required. 

You can see in the next figure that the general purpose test module can be used with any 
combination of the following SMUs: Series 2400, Series 2600, Series 2600B, Model 4200-SCS, and 
Model 237. 

For more information on how to configure different GPIB instruments, please refer to ACS Example 
hardware configurations (see "ACS Hardware examples" on page 17-1). 

Figure 314: General purpose module with multiple SMUs 
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The general purpose module in ACS can provide a total solution for component characterization tests 
with high power requirements. Because the general purpose module will work with a mix of several 
different types of SMUs, it can also be used in other applications, such as solar cell and LED testing. 

Due to hardware platform differences in the module-compatible SMUs, the general purpose module 
interface only supports the following forcing functions: BiasV/I, SweepV/I, and StepV/I. Unlike the 
Series 2600 and 2600B ITM, the general purpose module does not support log sweeps, dual sweeps, 
or list sweeps, and has limited auto ranging. 

The external trigger feature in the Common Settings is only used when using multiple Model 237 
SMUs with a Model 2361 Trigger Controller. To use this feature, you must configure the Model 2361 
as GPI1 (general purpose instrument 1) in the ACS hardware configuration. 

The other Common Settings are similar to those in the timing dialog of the standard Series 2600 and 
2600B ITM timing settings. The timing and speed of these tests is limited if you combine different 
generations of hardware. For the fastest test times, you should always use the Series 2600B 
SourceMeters in the standard tests associated with those instruments. 

When using only Series 2600/2600B SourceMeter instruments for a particular test, it is 
recommended that you use either an ITM or STM for optimum SMU performance. 

 

Open the general purpose PTM 
Configure the hardware system 

Before you configure a general purpose test module in the system, you need to configure and check 
the hardware first. For more information on how to configure different GPIB, Ethernet, and TSP 
instruments through ACS, refer to the ACS Hardware Configurations (on page 10-1) section. 

Add a new general purpose module 

Click the Add new test icon , then click PTM in the Specify the Test dialog box. Open the PTM, and 
click the Import function. In the dialog box that opens, select the Combined_Test_Mixed_SMUs.py 
script (see next figure). 

Figure 315: Import the General PTM 
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The general purpose PTM GUI opens on the ACS GUI (see next figure). 

Figure 316: General purpose PTM GUI 
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Configure the general purpose PTM 
After inserting a general purpose PTM into your project, you must configure it to meet your test 
requirements. 

Click the Browse function, and the Select Device Type dialog box will show various Device Types for 
you to choose (see next figure). 

The device you select in the general purpose PTM GUI is independent of the device in the 
configuration navigator. You must select a device in the module GUI to configure the general 
purpose PTM. For consistency with device definitions, you should select the same device for the 
general purpose module that the PTM exists under in the configuration navigator. By default, the 
imported PTM opens with the same device as the one in the configuration navigator where the PTM 
is created. 

Figure 317: Select Device type dialog box 
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Next, specify which SMU is connected to each device terminal. Click on a device terminal and the 
Select SMU For Test Module dialog box opens. Select the appropriate SMU and the device terminal 
will reflect your selection once it is made (see next figure). 

Figure 318: Map SMU and device terminal 
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The Model 4200-SMU cannot use general purpose PTMs if ACS is installed on a PC. This means 
that the Model 4200-SMU will not be displayed in the Select SMU For Test Module dialog box. Only 
when ACS is installed on the Model 4200-SCS will the Model 4200-SMU be available for general 
purpose PTMs. 

 

If a connection to the device is deemed unsafe by the software, you will not be able to run the test 
and you will see an error message in the Help area of the GUI. Here are some items to consider 
when configuring your hardware: 

 Non-A or B 26xx SMUs cannot be mixed with Model 265xA instruments. 

 A Model 2657A SMU cannot be mixed with Models 2651A, 2601A/2601B, or 2602A/2602B. 

 For two-terminal devices, a Model 2651A cannot be mixed with low-current SMUs. 

 For three-terminal devices, if a Model 2651A SMU is connected to the collector, then the emitter 
must be connected to ground or another Model 2651A SMU. If a Model 2651A SMU is 
connected to the base, then the emitter and collector must be connected to ground or another 
Model 2651A SMU emitter and collector. 

 For four-terminal devices, if a Model 2651A SMU is connected to the drain, a low-current SMU 
cannot be connected to the source. 

 

You must set the SMU’s Force Function, Force Range, Force Value, Measure, and Meas Range. For 
more information on how to set force and measure functions and variables, continue to the next topic 
in this section.  

You must also set the Common Settings information in the PTM GUI. The setting include the Test 
Speed, Test Mode, and Advanced information.  

Configure the Force and Measure parameters 

The Force and Measure settings are associated with an instrument object that is assigned to a device 
terminal. These settings are used to configure the forcing function and measurements implemented 
by the instrument. 

The following figure indicates all of the parameters that need to be configured for forcing and 
measuring. 

Figure 319: Force and Measure parameters 
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Common settings 

The Common Settings are used primarily to configure the timing settings for the General Purpose 
PTM. There are three areas in the Common Settings: Test Speed, Test Mode, and Advanced (see 
next figure). 

Figure 320: General purpose test module Common Settings 
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Test Speed: Controls the A/D (analog-to-digital) converter integration time used to measure a signal. 
Each measured reading by a SMU is the result of one or more A/D conversions. A short integration 
time for each A/D conversion results in a relatively fast measurement speed, however, there will be 
more noise. A long integration time results in a relatively low noise reading; however it will take 
longer, which decreases the speed. 

• PLC (power line cycle): For optimum immunity to line cycle noise, use an integer number for the 
PLC (for example, 1, 2, 3, etc.). The integration time setting is based on the number of power line 
cycles (NPLCs): 
For 60 Hz line power, 1.0 PLO = 16.67 msec (1/60) 
For 50 Hz line power, 1.0 PLO = 20 msec (1/50) 

• Average: The Average edit box is only used for series 23x and 2400 SMUs. For 2400 SMUs, the 
average number will range from 0 to 1000. For 23x SMUs, select these numbers = 
[0,1,2,4,8,16,32] (note that zero [0] is used to disable the average number setup 

The next table shows the range of allowed values for a NPLC and the Average field setting. 

Model PLC Average 
KI24XX [0.01 ~ 10] [0 ~ 100] 
KI23X [0.01 ~ 1] [0, 1, 2, 4, 8, 16, 32] 
KI26XX [0.001, 25] ignored 
KI4200 (on the 
4200) 

[0.01 ~ 10] ignored 
 

Test Mode: The Mode edit box lets you choose one of two possible test modes: Sweep or Sampling 
(see next figure). 

• Sweep Mode: Applies to any general test module in which one or more forced voltages/currents 
vary with time. 

Figure 321: Sweep Test Mode settings 
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If any terminal of the device under test (DUT) is configured for a sweep forcing function (Step or 
Sweep), sweep mode is automatically enabled. In this case, you can configure two other Test Mode 
settings in the Common Settings: Delay Time and Hold Time. 

Figure 322: Sweep mode timing diagram 
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• Hold Time(s): Specifies the time delay before the first measurement is taken. After the initial application 
of voltage or current by the SMU(s), the source settling time can be substantial. To allow for settling, 
you can specify an extra Hold Time delay to be applied before making the first measurement. You can 
specify a Hold Time from 0 to 1000 seconds. Hold Time is a global setting, and is therefore the same for 
all of the SMUs in the test system. 

• Delay Time: The Delay Time (DT) allows the source to settle at every step of a sweep. All SMUs in the 
test system are synchronized, therefore, the delay time applied by the most delayed SMU is the time 
applied to all of the SMUs. You can specify a delay time from 0 to 1000 seconds. The default delay time 
is 0 seconds. 

• Sampling Mode: Applies to any general test module where all of the forced voltages or currents 
are constant (bias I or bias V), and measurements are made at timed intervals. For example, 
sampling mode is used to record one or more static measurements, or to time-profile the charging 
voltage of a capacitor while forcing a constant current. 

ACS enables the Sampling mode option only when all of the terminals of the device under test are 
configured for static forcing functions: voltage bias, or current bias. If any terminal of the device under 
test is configured for a step or sweep forcing function, the Sampling mode option is unavailable (see 
next figure). 

Figure 323: Sampling Test Mode settings 

 

The Sampling mode measures voltage or current as a function of time while forcing constant voltage 
or current. Time is measured relative to when the SMU applies the forced voltage or current. 

If a General Purpose Test Module is configured for Sampling mode, you can configure three 
Sampling mode settings: Delay Time, Sample Number, and Hold Time (see next figure). 

Figure 324: Sampling mode timing diagram 
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• Hold Time: Specifies the time delay before the first measurement is taken. After the initial 
application of voltage or current by the SMU(s), the source settling time can be substantial. To 
allow for settling, you can specify an extra Hold Time delay to be applied before making the first 
measurement. You can specify a Hold Time from 0 to 1000 seconds. Hold Time is a global 
setting, and is therefore the same for all of the SMUs in the test system. 

• Delay Time: Specifies the time interval (INT) between measurements (data points). Delay Time 
can be set from 0 to 1000 seconds. 

• Sample Number: Specifies the number of data points to be acquired. The Sample Number can 
be set from 1 to 4096. 

A range-dependent delay is automatically applied by a SMU before each measurement to allow for 
source settling. All of the SMUs in the test system are synchronized, therefore the range-dependant 
delay time applied by the most delayed SMU is the time applied to all of the SMUs. If the Auto Delay 
box in the Misc tab of the Preferences dialog box is selected (go to the Tools drop-down to find 
Preferences),  the range-dependant Delay time will be applied to the Models 2635, 2636, 2635A, and 
2636A, but not for other 2600 or 2600B models (see next figure). 

The SMU will delay the Measure Time (MT) before taking a measurement after forcing. 
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Figure 325: Auto Delay on Preferences Misc tab 

 

Advanced: In the Advanced area there are five items for you to configure for your testing 
requirements (see next figure). 

Figure 326: Advanced area settings 
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Test End Reset: There are two choices: 

1. False: your test results will not be reset in the instruments when testing has completed.  
2. True: after testing is complete, all of the test results will be reset in the instruments. 

Stop on Compliance: There are two choices: 

1. False: the test will run to completion, even if a SMU enters compliance. 
2. True: the test will terminate immediately, if a SMU enters compliance. 

Enable Trigger: Used for the Model 237 with the Model 2361 Trigger controller. There are two 
choices: 

1. False: do not capture the measurement trigger value. 
2. True: capture the measurement trigger value. 

Except for the Model 237, it is acceptable to always choose false for the Enable Trigger function for 
SMUs. 

Start Ramp Delay: If a soft ramp is enabled at the start of the test, this setting determines the delay 
time between the steps. 

End Ramp Delay: If a soft ramp is enabled at the end of the test, this setting determines the delay 
time between the steps. 

For most SMUs, you can choose False for the Enable Trigger setting. 

Configure the Force and Measure functions/variables 

The Force and Measure settings are associated with an instrument object that is assigned to a device 
terminal. These settings are used to configure the forcing function and measurements implemented 
by the instrument (see next figure). 

Figure 327: Force and Measure functions variables 
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Force Func: There are seven functions that can be used in the Force Func parameter: 

1. Voltage bias (Bias V) 
2. Current bias (Bias I) 
3. Open 
4. Voltage sweep (Sweep V) 
5. Current sweep (Sweep I) 
6. Voltage step (Step V) 
7. Current step (Step I) 

For more information on how to set the voltage sweep and current sweep, refer to Configure force 
functions. 

Sense Mode: There are two choices. 

• Local: two-wire sensing 
• Remote: four-wire sensing 

If the SMU is a Model 42xx-SMU, the Sense Mode parameter will be grayed out and not available to 
change. 

Advanced: Double click the item, then open the Advanced Setting dialog (see next figure). 

Figure 328: SMU Advanced Setting parameters 
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Meas. Limits Auto: When the Meas Variable parameter is set to current measurement (I) and Meas 
Range is set to auto, then Meas. Limits Auto is enabled. This setting is used to specify the minimum 
range that the SMU uses when automatically optimizing the measurements. This option saves testing 
time when the maximum resolution at minimum currents is not needed. 

When the Meas Range parameter is set to auto, the Meas. Limits Auto function is enabled (the 
default value is disabled/off). If the Meas Range parameter is not set to auto, the Meas. Limits Auto 
function is disabled/off. 

The Meas. Limits Auto setting is available when a SMU is in any of the following modes: 

Number Force Func Meas Variable Meas Range 
1 Sweep V I+V auto 
2 Sweep V I auto 
3 Sweep V I+V(prog) auto 
4 Bias V I+V auto 
5 Bias V I auto 
6 Bias V I+V(prog) auto 
7 Step V I+V auto 
8 Step V I auto 
9 Step V I+V(prog) auto 
 

Soft Ramp: Allows the forced voltage or current to achieve the desired value after a certain number 
of steps. 

Start Ramp Step: The size of ramp steps at the beginning of the test. 
Stop Ramp Step: The size of the ramp steps at the end of the test. 
Num of Steps: The number of steps in the soft ramp. 

The Soft Ramp is from 0 to the desired value (bias value or first and last sweep/list value). If the bias 
or first or last sweep/list point is 0, no soft ramp is necessary. In the "No Soft Ramp" example, the 
gate breakdown occurs because of the 200V stress applied. However, with the "Soft Ramp function," 
you can keep the voltage differences at smaller levels until the desired voltage is applied (see next 
figure). 

Figure 329: Comparison of Soft Ramp and without Soft Ramp 
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CVU connection compensation 
It is recommended that you perform open and short compensations measurements before measuring 
the device capacitance. Once the compensation data is stored, it can be used repetitively across 
different devices if there is no change in instrument and cable connections. 

You can correct offset and gain errors caused by the connections between the Model 4210-CVU and 
the device under test (DUT) by using CVU connection compensation. Correction is a two-part 
process: 

1. Generate CVU connection compensation data for an open or short connection. 
2. Enable open or short correction values before executing a test. 

Perform CVU connection compensation any time the connection setup is changed. CVU connection 
compensation is not affected by changes in either temperature or humidity. 

 

Generate connection compensation data 
Open the CVU Compensation GUI from the Tools drop-down menu on the ACS toolbar. 

Figure 330: Open CVU Compensation GUI 
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The device interface settings determine the CVU Compensation GUI that opens (for more 
information, refer to Device interface setting): 

Figure 331: Device Interface Setting GUI 

 
 

If the Bias Tee option is not selected, the following CVU compensation GUI appears: 

Figure 332: CVU Compensation GUI without bias tee 
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However, if the Bias Tee option is selected, the CVU compensation GUI appears: 

Figure 333: CVU Connection Compensation.png 

 



Section 5: Test Setup ACS Automated Characterization Suite (ACS) Reference Manual 
 

5-162 ACS-901-01 Rev. H / December 2014 

 

 

2-terminal measurement 
2-terminal measurement (without bias tee) 

This measurement is applied to a CV test without a bias tee (for example, the CVITM; see the 
following: Enable compensation). 

• Measure Open: Click the button to generate open correction values. 
• Measure Short: Click the button to generate short correction values. 

See Measure open and measure short buttons for details on performing open and short corrections. 
 

2-terminal measurement (with bias tee) 

This measurement is applied to a Generic HV CV PTM (see the following: Enable open or short 
correction for Generic HV CV PTM). 

• Measure Open: Click the button to generate open correction values. 
• Measure Short: Click the button to generate short correction values. 

See Measure open and measure short buttons for details on performing open and short corrections. 
 

3-terminal measurement 
This measurement is applied to both Generic HV CV PTM and device specific PTM libraries. 

Level Setting: 
• Circuit-level parameters: This compensation data is applied to the following devices and libraries. 

 

 MOSFET BJT IGBT 
 Ciss Cib Cies 
 Coss Cob Coes 
 Crss  Cres 

 

• Component-level parameters: This compensation data is applied to the following devices and 
libraries. 

 

 MOSFET BJT IGBT 
 Cgd Ccb Cgc 

 Cgs Ceb Cge 

 Cds Cce Cce 
 

There are certain connection configurations that you can use with different devices, and the 
compensation will only need to be performed once. The Measure Open and Measure Short buttons 
group the same capacitance terminologies for MOSFET, BJT and IGBT. 

For example, the Ciss, Cib, and Cies input capacitance for MOSFET, BJT, and IGBT share the same 
connection configuration. The same compensation data can be used for all of them. 
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Using the CVU connection compensation 
Set the CVU cable length 

Use the menu to set the default SMA cable length. 

• 0 M: Use to make measurements at the terminals of the Model 4210-CVU (no cabling). This 
disables compensation. 

• 1.5 M: Use with the standard red SMA cables (1.5 m) supplied with the CVU (Keithley 
Instruments part number CA-447). 

• 3.0 M: Use the standard red SMA cables (3.0 m) (Keithley Instruments part number CA-446). 
This setting can also be used when using a switching matrix. 
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Measure open and measure short buttons 
Based on the test that you want to perform, select a Measure Open, or Measure Short button (see 
below for options). When you click a Measure Open or Measure Short button, a dialog box opens. 
Click the Help button and you will see connection information: 

Figure 334: Dialog box for Measure Open Ciss, Cib, Ces 

 
 

Make sure to set up the appropriate connection that appears once you click the Help button. For 
example, the previous figure shows the Measure Open Ciss, Cib, Ces CVU connection. 

Once you have the test connections completed, click the Start button to begin generating open or 
short compensation data.Note that the compensation data file that is created is saved in the following 
computer directory: C:\ACS_BASIC\compensation. 

If you are testing 2-terminal devices, the name of the generated file will be 2TComp.csv. Note that if 
you are testing 3-terminal devices, the name of the generated file will depend on the test that you 
select. The format of the generated compensation date file name will be similar to this format: 
Ciss_Cib_Cies_Comp.csv. 
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Enable compensation 
Compensation is done during test execution with open or short correction enabled. Open or short 
correction is enabled from the GUI Generic HV CV PTM or device-specific PTM, or the CVITM 
(ki42XXCVU). The compensation data can be seen in the Data tab for the Generic HV CV PTM or 
device-specific PTM: 

Figure 335: CVU Enable Open or Short Correction for CVITM 
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Enable open or short correction for Generic HV CV PTM 
The following GUI shows where to enable compensation in the specific test module. Additionally, 
compensation data can be viewed in the Data tab of the test module.  Compensation data appears as 
a second worksheet in that tab. 

Equation 1: Enable open or short correction for Generic HV CV PTM 
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Enable open or short correction for device-specific PTM 
Equation 2: Enable Open or Short Correction for device-specific PTM 

 
 

Within each test module, you have the option to select Using 8010 factory compensation. ACS stores 
default compensation data that was generated using cables and accessories supplied with remote 
bias tee kits (Model CVU-3K-KIT and PCT configurations).  

You can load the Generic HV CV PTM usding the default compensation data file from the 
Generic_HVCV_Test GUI. For a device specific PTM you can use the default compensation data file 
by selecting the Using 8010 factory compensation option. Note the name of the default compensation 
data file will depend on the test selected (notice that the name begins with "factory_8010_"; it will be 
similar to this file name: "factory_8010_Ciss_Cib_Cies.csv"). 
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Script editor tool 
The Script Editor is a tool used to create and manage user libraries.  

A user library is a collection of one or more user modules. User modules are Python programming 
language subroutines (or functions) or TSP script. User libraries are created to control 
instrumentation, analyze data, or perform any other system automation task programmatically. Once 
a user library has been successfully built using Script Editor, its user modules can be executed using 
the ACS software. 

The Script Editor provides a simple graphical user interface (GUI) that helps even a novice 
programmer to effectively enter code, compile a user module, and link (build) a user library. Script 
Editor also provides user-library management features, including the Open file, Delete, Copy Module 
and Library, Check, edit and browse, Save, and export functions. Script Editor manages user libraries 
in a structured manner. You can create your own user libraries to extend the capabilities without 
requiring a software upgrade from Keithley Instruments. 

To execute a Script Editor user module in ACS, you import or create a test module as TSP or PTM 
and connect it to the user module. Once this user module is connected to the test module, the 
following occurs each time ACS executes the PTM or STM: 

• ACS dynamically loads the user module and the appropriate user library. 
• ACS passes the user-module parameters—stored in the STM or PTM—to the user module. 
• Data generated by the user module is returned to the STM or PTM for interactive analysis. 

The next figure illustrates the relationships between user libraries, user modules, STM or PTM, ACS, 
and Script Editor. 

Figure 336: Relationship between ACS test module and Script Editor 
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Script editor dialog box 
The Script Editor graphical user interface (GUI) is shown in the next figure. It provides all the 
functions, controls, and user-entry areas needed to create/edit/view and build a user library and to 
create/edit/view and compile a user module. 

Figure 337: Script Editor 

 
 

Understanding the module identification area 
The module identification area is located at the right of the toolbar and defines the presently open 
user library and user module. The components of this area are used as follows: 

Module Type — Displays the type of the presently open (active) user module. There are two type 
module supported: TSP and PTM. For more information about understanding TSP and PTM, refer to 
Configuring a Script Test Module (STM) and Configuring a Python Language Test Module (PTM) in 
section 6 of this manual. 

Library Name — Displays the name of the presently open (active) user library. To specify a user 
library, use the Open file function. To delete a library, use the Delete function. To copy a library, use 
the Add function. To add a new library, use the add a new library function. 

Module Name — Displays the name of the presently open user module. This also allows you to 
create a copy of the presently open user module in the same user library. 

When naming a user module, remember to conform to case-sensitive Python or TSP programming 
language naming conventions. Do not duplicate names of existing user modules or user libraries. 

Library Visible/Library Hidden — Displays whether or not the presently open user library is available 
to ACS. To change the hidden/visible status, check or deselect the Hide option in the Module and 
Library definition area. 

GUI type — Click the GUI type for user module. In ACS, the PTM and STM can include a GUI. There 
are three types of GUI available: standard; .xrc; customize. For more information about using a STM 
with a GUI, refer to STM with the .xrc GUI File in this section 

Version info— shows the software author and the version information. 
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Understanding the module code entry area 
The module code-entry area is located below the module and library definition area. The module-
code-entry area is the ACS dialog box location where you enter, edit, or view the user-module code. 
Scroll bars located to the right and below the module-code entry area let you move through the code. 

The parameters that the module depends on to operate are defined in the Parameters tab area. After 
you add the parameters (by clicking the Add button) and entering their usage specifications, the Apply 
button is clicked and automatically updates the module definition area within the indicated changes 
(see next figure). 

Figure 338: Function definition area 

 

Do not enter the following Python code items in the module code-entry area. (Script Editor enters 
these at special locations based on information in other places in the Script Editor dialog box):  

 Import and global data 

 The function prototype  

To control internal or external instrumentation, use functions from the Linear Parametric Test Library 
(LPTLib). Refer to LPT Library Reference for more information about the Series 2600B.  

Do not enter the following TSP code items in the module code-entry area. (Script Editor enters these 
at special locations based on information in other places in the Script Editor dialog box):  

 The function call 

 The function prototype To control internal or external instrumentation, use functions from the 
Linear Parametric Test Library (LPTLib). Refer to LPT Library Reference for Series 2600B  for 
more information. 
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Understanding the tab areas 
Four tab areas are accessed by clicking one of the following tabs: Parameters, Imports (only for 
PTM), Module Description, and Log Console. Selections within these tab areas are facilitated using 
pop-up menus. The next sections describe the tab areas. (For TSP, there are three tabs: Parameters, 
Module Description, and Log Console. These three tab are same as corresponding tab of PTM). 

Parameters tab  
The Parameters tab area is used to define and display the following for each parameter that is 
included in the user module call: 

• Parameter Name. 
• Input or output (I/O) data direction. 
• Parameter Data Type. 
• Default, Min, and Max values, Unit, Comments for the parameter. 

The Parameters tab area is located near the bottom of the Script Editor main screen (see next figure). 

Figure 339: Parameters tab example entries 

 

To add, delete, or apply a parameter, do one of the following: 

• To add a parameter, click Add function and then enter the information as indicated in the field 
descriptions that follow. 

• To delete a parameter, first click the parameter name or any of the adjacent fields; then click 
Delete function. 

• To move a row of parameter up/down, click the row of the parameters by clicking the row number, 
then this row will be highlighted. After that, click Up/ Down function. 

• To apply changes made in the Parameters tab area, click Apply function. 
• To insert a new external path to Python system path list, click Add sys path function 

Figure 340: Select a row of parameters to move 
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Parameter Name field 

The Parameter Name field identifies the parameters that are passed to the user module. That is, 
these are the same parameters that would be specified in the user-module function prototype (which 
Script Editor constructs from the Parameters tab entries when you click Apply, and then displays in 
the module-parameter display area). 

Data Type field 

The Data Type field specifies the parameter data type. Clicking on the arrow at the right of the data 
type field activates a pop-up menu, which lists the following data types: 

For PTM: 

• enum — enumerable type data 
• str — string data 
• float — Single precision, floating point data 
• double — Double precision data 
• int — integer data 
• list — list type 
• dict — dictionary type 

For TSP: 

• enum — enumerable type data 
• str — string data 
• float — Single precision, floating point data 
• double — Double precision data 
• int — integer data 
• list — list type 
• dict — dictionary type 
• table — table type 

I/O field 

The I/O field defines whether the parameter is an input or output type. Clicking on the arrow to the 
right of the I/O field activates a sub-list box that shows the Input and Output selections. 

Output can be selected only for string data type (str).  

Default, Min, and Max fields 

The Default, Min, and Max fields are used to specify the following: 

• Default field — Specifies the default value for input parameter. 
• Min field — Specifies the minimum recommended value for input parameter (except list, dict, 

table, and str type). When the user module is used in ACS, configuration of the PTM/STM with a 
parameter value smaller than the Min value causes ACS to display an out-of-range message. 
(For a brief explanation of STM/PTM, refer to Configuring a script test module (STM) and 
Configuring a Python language test module (PTM)). 
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• Max field — Specifies the maximum recommended value for input parameter (except list, dict, 
table, and str type). When the user module is used in ACS, configuration of the PTM/STM with a 
parameter value larger than the Max value causes ACS to display an out-of-range message. 

When the data type is enumerable (enum) data, the value of Min/valid tuple field column in 
parameter tab is a valid tuple. You must set the min/valid tuple box first so that the default value can 
be selected from the drop-down menu (see next figure). 

Figure 341: Select a default value for enumerable data 

 

Import tab area 
The Import tab area only displays for PTM. It lists the import files used within the Python user module. 
This area can be used to add import statements to the presently open user module (see next figure). 
This tab can also be used to import the global statement.  

Figure 342: Imports tab 

 

In most case, Script Editor always need to enter form ACS_PostData import* into the Import tab area. 

Module Description tab area 

The Module Description tab area, shown in the next figure, allows you to enter descriptive information 
for the presently open user module. Information entered in this area documents the module to the 
ACS user and is used to create ACS user library help (see next figure). 

Figure 343: Module Description tab 

 



Section 5: Test Setup ACS Automated Characterization Suite (ACS) Reference Manual 
 

5-174 ACS-901-01 Rev. H / December 2014 

 

Do not use doc comment designators (---) in the Description tab area. When the user-module code is 
compiled, Script Editor also evaluates the text in this area. Code comment designators in the 
Description tab area can be misinterpreted; causing errors (see next figure). 

Figure 344: Description tab in ACS 

 

Log Console tab area 
The Log Console tab area displays any error syntax messages that are generated during a code 
check operation.  

When you click the check function   on the toolbar, a message will display in the log console tab.  
When error displayed in the Log Console tab area, Script Editor shows which line of code where the 
error occurred or the next line, depending on how the compiler caught the error (see next figure). This 
facilitates error corrections. If no errors are found, the Build tab area displays one of the following:  

• After a check — Checking completed, No error found! 

Figure 345: Log Console tab 
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Understanding the status bar 
The Status bar, located at the bottom of the Script Editor dialog box, displays the module saving path 
and a description of the Code Entry area at the cursor location. For example, if the cursor is in the 
row 42 and column 4 in the Code Entry area, the status bar describes that area (see next figure). 

Figure 346: Status bar 

 
 

Understanding the toolbar 

Most of the functions apply to the Script Editor GUI that is above the tab areas. Refer to 
Understanding the tab areas for more information. 

The Toolbar is shown in the next figure. 

Figure 347: Script Editor toolbar 

 

The Toolbar functions: 

Import Library — Opens an existing user library and displays the first module that is listed for that 
library. Clicking Open Module displays the Choose a File dialog box (see next figure) where you can 
select an existing user module. Click OPEN to see the selected module in place of the currently open 
module. 

Figure 348: Select a .py file 
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Delete — Deletes an existing user library or a user module from the indicated user library. Clicking 
Delete function displays the Please Select the Lib/Module to delete dialog box (see next figure). To 
delete a selected library and all of its contents, click the Delete function. To delete a particular test 
module from the selected library, click the Delete Module check box then click Delete function. Click 
Cancel to cancel the delete operation. 

Be careful when using the delete option. Deleting a library will delete all of the files in it. 

Figure 349: Select a module to delete 
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Copy Library and Module — Creates a copy of any existing library and module. Clicking the Copy 
Module and Library function displays the Copy Library dialog box (see next figure). Click the user 
library and module to copy. Enter the new library and module name in the New section. You must 
enter a unique user-module name. Click OK. The Existing Library or Module will be copied to the 
NEW category (see next figure). 

If you enter an existing library name to the New section, the module will be copied from one exiting 
library into another existing library. If you enter a new library name, the module will be copied into the 
new library. The module name in the existing area can be empty (all the modules in the source 
library will be copied to the destination library). 

Figure 350: Copy library and module 
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Check — When selected, checks the source files for syntax errors (including the description tab) in 
the module and, if successful, compiles them into object files.  

Browse or Edit the entire file — When selected, the Code Entry area will turn to whole file states. You 
can Browse or Edit the whole file in this case (see next figure). When you import a TSP or Python 
source code which is not generated by the Script Editor, it may launch this Browse entire file dialog 
box directly if the file format does not match the Script Editor’s expectations. 

Figure 351: Browse the entire file 
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Save Module — Saves the presently open user module source code. The saving path is 
\\ACS\library\26Library\TSPLib for TSP and \\ACS\library\pyLibrary\PTMLib. The path is assigned in 
Preferences settings dialog box (see next figure). For more information about changing and applying 
these settings, refer to the Advanced preference setting. 

Figure 352: Set the TSP and PTM path 
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Show the .xrc GUI of test module. Click this function to display the .xrc GUI builder tool. For more 
information about how to use this GUI builder, refer to How to create a TSP GUI file. 

Add a library or Module — Create a new library or user module. Clicking   near library name, shows a 
new library dialog box (see next figure). Enter the New Library name and New Module Name in the 
corresponding text boxes. The new name must not duplicate the name of any existing user module or 
user library in the entire collection of user libraries. After entering the name, click OK. A new library or 
a new module will be added to the path. You can also click the browse button to choose an 
alternative path to save the new library (see next figure figure5–207). 

Figure 353: Add library and module 

 

Preview GUI — After a .bmp file has been chosen and the library modules defined well, click the GUI 
Preview button. The dialog box opens (see next figure) in order for you to check a STM or PTM GUI. 
The errors in the GUI files can only be checked by clicking the Preview button. 

Figure 354: GUI preview 

 
 

Script editor tutorials 
This section includes two tutorials. Each tutorial provides step-by-step instructions for accomplishing 
common tasks with the script editor. 
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Tutorial 1: Create and run a new TSP 
The Script Editor is a tool that facilitates the development of user libraries. Each user library is 
comprised of one or more user modules, and each user module is created using the TSP or Python 
programming language. 

Create a new TSP 
1. Start the Script Editor by clicking the Script Editor item on the Tools Menu (see next figure). 

Figure 355: Script Editor in Tools menu 
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2. A blank Script Editor dialog box opens named Script Editor: Module NoName Library NoName 
(see next figure). 

Figure 356: Blank Script Editor 

 

3. Click the TSP type in Module Type area. 
4. Create a new user library 

• Click the Add a Library function near the Library box. The Copy Library dialog box opens (see 
next figure). 

Figure 357: Create a new library 
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• In the New Library text box, enter the new user library name. The library name must has a postfix 
as .py or .tsp. For this tutorial, enter Mylib1_Resistor.tsp as the new user library name. 

• For this tutorial, enter R_test1 as the new module name (see next figure).  

Figure 358: Enter new library and module name 

 

• Click OK. The new library and module names will appear in the script editor dialog box (see next 
figure). 

Figure 359: New Library name in Script Editor 
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Click GUI for TSP:  

1. Choose the standard option from the GUI Type items. When using the .xrc GUI, you can indicate 
the GUI file and the Event file for the library. For more information about the STM with .xrc GUI, 
refer to STM with the .xrc GUI File. 

2. Choose a test info graphic for the TSP. 
3. Set the group number for the test. 
4. Enter the Author and Version in edit box. 

Enter the required parameters for the code as follows: 

1. Click the Parameters tab (if the Parameters tab area is not already displayed). 
2. Click the Add function   at the right side of the Parameters tab area. 
3. Under Name, enter the first parameter name (or accept the default). For the R_test1 user module, 

replace the default name with RSMU1. 
4. Under I/O, specify whether the first parameter is an input or output parameter.  

For an output parameter, only the string data type is acceptable. 

• Under Data Type, enter the data type for the first parameter.  Here, we select the enum type for 
the first parameter 

• Under Default, Minimum, Maximum, and Units, enter default, minimum, maximum and units 
values for the parameter—to simplify and limit the choices to you.  

• If the data type is enum, you should set the Min/valid tuple value first: Right click the Min area, the 
Sequence Editor dialog box will open. Click the Append function. Input the items in the Add a new 
item dialog box. Click OK. The enum data is set. These values can be selected in default. 

• If the data type is a list, set the default value as follows: Right click the default value (the 
Sequence Editor dialog box opens). Add the item as indicated. Click OK. The value will appear in 
default box with this format [a,b,c] (see next two figures). 

Figure 360: Sequence Editor for setting enumerable parameter 

 

Figure 361: Add a new item for setting enumerable parameter 
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• For dict type (dictionary type, mostly used in PTM): Right click the default value (the Sequence 
Editor will appear). Click the Append function (the Dictionary Editor dialog box opens). Input the 
name and value in the Dictionary Editor (see next figure). The value will be formatted as 
{a:1,b:2,c:3}. 

• For table type (mostly used in TSP): add the item in table {} like a list. 

Figure 362: Add name and value for Dictionary Editor 

 

• For the mytsp1 user module, enter SMU1, SMU2, and KI_GND for RSMU1 enum data. 
• After the Min/Valid tuple value is set, the default value can be selected. In the next figure, SMU1 

for RSMU1 was chosen. 
• Enter the comments for the parameter, if desired. Click the comment area and an edit box will 

display. Enter the parameter description.  

Do not use doc comment designators (---) in the Description tab area. When the user-module code is 
compiled, Script Editor also evaluates the text in this area. Code comment designators in the 
Description tab area can be misinterpreted, causing errors. 

Figure 363: Enter comments 

 

• Repeat the steps to add a new item for all additional input and output parameters for the user 
module that you are creating. For the R_test1 module, add eight parameters (see next figure). 

Figure 364: Parameter tab 
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1. Click Apply function. In the module-parameter display area, the function prototype now includes 
the declared parameters.  

2. Module R_test1 (RSMU1, RSMU2, forcevalue, myLIMIT, myNPLC, testdelay, error, Rvalue)(see 
next figure). 

Figure 365: Script Editor after entering and applying parameters 

 

3. Enter the module description: 

• Click the Description tab at the bottom of the dialog box. The Description tab area opens (see 
next figure). 

• Enter any text needed to adequately document the user module to the Script Editor user—who 
does not see next figure the comments that you include with the code. 

Figure 366: Description tab 
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Do not use doc comment designators (---) in the Description tab area. When the user-module code is 
compiled, Script Editor also evaluates the text in this area. Code comment designators in the 
Description tab area can be misinterpreted, causing errors. 

1. Enter the TSP user module code for the R_test1 shown below. Refer to the LPT Library Function 
Reference, for a complete list of supported I/O and SMU commands. 

Enter the new TSP code into the module-code entry area. 

For the R_test1 user module, enter the simple code listed below: 
local v_value = {} 
local i_value = {} 
local error ={} 
setmode(RSMU1, KI_INTGPLC, myNPLC) 
limiti(RSMU1, myLIMIT) 
forcev(RSMU1, forcevalue) 
 
if RSMU2 ~= KI_GND then 
   forcev(RSMU2, 0) 
end --if 
 
delay(testdelay) 
intgv(RSMU1, v_value) 
intgi(RSMU1, i_value) 
 
Rvalue[1] = v_value[1]/i_value[1] 
posttable("Rvalue", Rvalue) 
table.insert(error, 0) 
posttable("error",error) 
 
devint() 
end  

Compile the user module 

For TSP, the Script Editor will simply check the user module description part as follows: 

1. Click the Check table at the toolbar. After you compile a user module, the Log Console tab area 
displays either a confirmation that the module compiled successfully or displays one or more 
compile-error messages. For TSP, the Script Editor simply checks the user module description 
part for the usage of the ”---”. 

2. In the Toolbar, click Check. The following occurs: 
3. The user-module source-code file is compiled. 
4. The Log console message tab indicates the compilation progress and, if problems are 

encountered, displays error messages. For example, when you check the R_test1 user module, 
you see next figure the Log console message tab (see next figure). 

Figure 367: Log Console message tab 
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5. Check until no errors exist.  

Save the user module: 
1. Click the Save function, all information of source code will save into the path 

C:\ACS\library\26Library\TSPLib  
2. For the example in the next figure, after clicking the save function, the following files will be 

saved. 

Figure 368: Log Console path saved 

 

3. Source code file (.tsp). The default saving path: C:\ACS\library\26Library\TSPLib. 
4. .Bmp file and .xrc file. The default saving path: C:\ACS\library\26Library\TSPLib\xrc. 
5. Events file. The default saving path: C:\ACS\library\26Library\TSPLib\event. 

The new standard TSP script will be created and saved in the path. If you continue to export this 
module from the Script Editor, you can open and run this module in ACS. 

Run the TSP: 
1. Add a new STM to configuration navigator. 
2. Click the Run function at bottom, then choose a Python test module. 
3. Choose a module from the TSPLib and it will open (see next figure). Accept the default 

parameters. You can experiment later after you have established that the user module executes 
correctly. 

Figure 369: UserLib module opening 

 

4. Save the STM and the project by clicking the Save All icon at the top of the ACS screen or by 
clicking Save All in the File menu. 

5. Execute the STM by clicking the green triangular Run Test/Plan icon at the top of the screen or 
by clicking Run in the Run menu. 

6. If the user module that you created generates data, check the execution results in the STM Data 
worksheet. To view the Data worksheet, click the Data tab at the top of the Definition document. 
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Tutorial 2: Create and run a new PTM 
This section provides a tutorial that is designed to help you to create a new PTM. For more 
information about PTMs, refer to Configuring a Python language test module (PTM) topic. 

Create a new PTM: 
1. Start the Script Editor by clicking the Script Editor item on the Tools Menu (see next figure). 

Figure 370: Script Editor in Tools menu 

 

2. A blank Script Editor dialog box opens named Script Editor: Module NoName Library NoName 
(see next figure). 

Figure 371: Blank Script Editor 
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• In the Create a new Library dialog box, enter the new user library name. For this tutorial, enter 
mylib2_Diode.py as the new user library name. 

• For this tutorial, enter Diode_test1 as the new module name (see next figure). 
• Click OK. The new library and module names will appear in the script editor dialog box. 

Figure 372: Name a new PTM 

 

1. Click the PTM type in Module Type area. 
2. Choose the GUI Type for the PTM.  

• Select a standard option in the GUI Type area. 
• Choose a bitmap from the browse path. 
• Set the group number for the test. 
• Enter the Author and Version in edit box. 
1. Click on the Parameter tab and enter the parameter information shown below (see next figure). 

Figure 373: Enter parameter for PTM 

 

2. Click on the Imports tab. 
3. A PTM can import other libraries to use in the current library. 
4. Click on the Imports tab at the bottom of the dialog box. The Imports tab area appears (see next 

figure). 

Figure 374: Imports tab 
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• Enter any additional imports files that are needed by the user module.  
• Enter the Module Description: 
• Click the Description tab at the bottom of the dialog box. The Description tab area opens. 
• Enter any text needed to adequately document the user module to the Script Editor user—who 

does not see next figure the comments that you include with the code. 

Figure 375: Module Description tab 
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Do not use doc comment designators (---) in the Description tab area. When the user-module code is 
compiled, Script Editor also evaluates the text in this area. Code comment designators in the 
Description tab area can be misinterpreted, causing errors. 

1. Click the Apply function. 
2. Enter the Python code for Diode_test1 as listed below. Refer to the Python LPT Library in section 

11, for a complete list of supported I/O and SMU commands. 

For the DynimicZ user module, enter the simple code listed below.  
#Map the SMUs with DUT terminals 
PSMUId = lpt.getinstid(PSMU) 
if not PSMUId: 
   error = -10000 
   post.ACSPostDataInt("error",error) 
   return error, DynamicZ 
NSMUId = lpt.getinstid(NSMU) 
if not NSMUId: 
   error = -10000 
   post.ACSPostDataInt("error",error) 
   return error, DynamicZ 
 
#Set range and compliance 
lpt.limitv(PSMUId, ComplianceV) 
if NSMUId != 4096: 
   lpt.limitv(NSMUId, ComplianceV) 
if RangeV == 1: 
   lpt.setauto(PSMUId) 
elif RangeV == 2: 
   lpt.lorangev(PSMUId, 0.2) 
elif RangeV == 3: 
   lpt.lorangev(PSMUId, 2) 
elif RangeV == 4: 
   lpt.lorangev(PSMUId, 20) 
elif RangeV == 5: 
   lpt.lorangev(PSMUId, 200) 
else: 
   lorangev(PSMUId, 2) 
 
#Set instrument config 
lpt.setmode(PSMUId, lpt.KI_INTGPLC,nPLC) 
htime = int(Holdtime * 1000) 
 
#Set stress 
if NSMUId != 4096: 
   lpt.forcev(NSMUId, 0) 
lpt.forcei(PSMUId, I1) 
lpt.delay(htime) 
V1 = lpt.intgv(PSMUId) 
 
lpt.forcei(PSMUId, I2) 
lpt.delay(htime) 
V2 = lpt.intgv(PSMUId) 
 
#check compliance 
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cstatus = lpt.getstatus(PSMUId, KI_COMPLNC) 
if cstatus == 2: 
   error = KI_RANGE_COMPLIANCE 
   post.ACSPostDataInt("error",error) 
   return error, DynamicZ 
if cstatus == 4: 
   error = KI_COMPLIANCE 
   post.ACSPostDataInt("error",error) 
   return error, DynamicZ 
 
#test complete 
lpt.devclr() 
Idelta = I1 - I2 
 
if  Idelta == 0: 
   Idelta = 1e-37 
 
DynamicZ = (V1 -V2) / Idelta 
 
post.ACSPostDataDouble("DynamicZ", DynamicZ) 
post.ACSPostDataDouble("I1", I1) 
post.ACSPostDataDouble("I2", I2) 
post.ACSPostDataDouble("V1", V1) 
post.ACSPostDataDouble("V2", V2) 
post.ACSPostDataInt("error",error) 
return error, DynamicZ 

Compile the user module: 
1. Click the Check table at the toolbar. After you compile a user module, the Log Console tab area 

displays either a confirmation that the module compiled successfully or displays one or more 
compile-error messages. For TSP, the Script Editor simply checks the user module description 
part for the usage of the ”---”. 

2. In the Toolbar, click Check. The following occurs: 
3. The user-module source-code file is compiled. 
4. The Log console message tab indicates the compilation progress and, if problems are 

encountered, displays error messages. For example, when you check the R_test1 user module, 
you see next figure the Log console message tab. 

5. Check until no errors exist. 

Save the user module: 
1. Click the save function, all information will save into the corresponding path (see next figure). 

Figure 376: Save information in Log Console 
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After clicking the save function the following files will be saved: 

• The source code file (.py file). The default saving path: C:\ACS\library\pyLibrary\PTMLib  
• The bmp file. The default saving path: C:\ACS\library\pyLibrary\PTMLib\xrc  
• The event file. The default saving path: C:\ACS\library\pyLibrary\PTMLib\event 

The new standard PTM will be created and saved. After you export it, you can open and run this 
module in ACS. 

The new standard PTM script will be created and saved in the path. You can open and run this 
module in ACS (see next figure). 

Figure 377: Import and open a PTM from PTMLib 

 

Open and run the PTM: 
1. Add a new PTM to the configuration navigator in the Test Setup area of ACS.  
2. Click the import function at bottom. Then choose a PTM from the PTMLib dialog box that opens. 
3. Click a PTM in PTMLib, then the PTM dialog box opens. 
4. Save the PTM. 
5. Execute the PTM by clicking the green triangular Run Test/Plan icon at the top of the screen or 

by clicking Run in the Run menu. 
6. If the user module that you created generates data, check the execution results in the PTM Data 

worksheet. To view the Data worksheet, click the Data tab at the top of the Definition document. 
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Executing a project plan 
You can modify the test Patterns, Subsites, Devices, and Test modules by using the Copy, Paste, 
Cut, and Rename general editing commands. After the test plan has been built, you can execute an 
entire project plan or individual parts of a project plan. This section describes the following topics: 

• Enabling tests (configuration navigator) 
• Run execution of Project Pattern 
• Run execution of individual Subsite Plans  
• Run execution of individual Device Plans 
• Run execution of individual tests 

 

Executing a project pattern 
Executing an entire Project Pattern executes all of its components (initialization pattern, Subsite 
Plans, Device Plans, ITMs, STMs, and CTMs) in the order they appear in the Test Setup panel. 
Before executing a plan, manually check whether the physical connections match the test plan 
connections correctly. If they do not match multiple times, manually check them until the specified 
SMU is matched correctly. 

Each component of the Project Plan has a corresponding checkbox. Selecting the component’s 
checkbox enables the test plan, while deselecting the component’s checkbox disables it. 

To execute an open Project Plan: 

1. Click on Pattern at the top of the Test Setup panel (see next figure).  

Figure 378: Select the Pattern node 
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2. Place the probe at one site.  
3. Enable the test by checking its corresponding checkbox; or disable the test by deselecting (see 

next figure). 

When running a project pattern, the prober controlling command is activated. Make sure the prober 
is correctly connected, or set to fake, to avoid errors. 

Figure 379: Select a Pattern (indicated with checkmark in box) 

 

4. If the Project Plan has not been saved, save the Project Plan by clicking the Save function in the 
ACS toolbar, or by clicking Save/Save All commands from the ACS File menu (see next figure). 

Figure 380: Save the Project Plan 

 

5. Start execution by clicking the triangular Run Test/Plan function in the toolbar (part A)(see next 
figure).  

Figure 381: Run Project Plan Test 
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6. The Run Test/Plan toolbar function becomes gray (part B), the Project Pattern executes, and the 
square Abort Test/Plan toolbar function is enabled for the duration of the execution, as shown 
above. You can click the Abort Test/Plan function at any time during execution to stop the 
execution. 

During execution, the Definition tab of the ITM work area, and the Script tab of the CTM and STM 
work areas change color, and during execution, the wafer map tab of pattern change color and the 
configuration navigator unfold (see next figure). These work areas cannot be edited at running time. 

Figure 382: A running pattern 

 

Each time you execute a test or test sequence using the Run function, the data from each test is 
inserted into its own Data worksheet. Each new run updates the worksheet. 
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Executing individual subsite plans 
Running a Subsite Plan executes only the components assigned to it (all of its Device Plans, ITMs, 
STMs, and CTMs) in the order that they appear in the Test Setup panel. 

Follow these steps to execute a Subsite Plan in an open Project Plan: 

1. If the test system is connected to a probe, place the probe at the site that contains the Subsite to 
be evaluated. 

2. In the Test Setup panel, click the name of the Subsite Plan to be executed (see next figure). 

Figure 383: Select subsite plan to execute 

 

3. Enable a test by clicking its corresponding checkmark; or remove the corresponding checkmark 
to disable a test. 

4. If the Project Plan has not been saved, save the Project Plan by clicking the Save/Save All 
function in the ACS toolbar, or by clicking Save/Save All commands from the ACS File menu (see 
next figure). 

Figure 384: Save the Project Plan 
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5. Start execution by clicking the triangular Run Test/Plan function in the toolbar (part A)(see next 
figure). The Run Test/Plan toolbar function becomes gray (part B), the Subsite executes, and the 
square Abort Test/Plan icon illuminates for the duration of the test.  

Figure 385: Run Project Plan Test 

 
 

Executing individual device plans 
Run Executing an individual Device Plan only the components assigned to the specified device plan 
(all of its ITMs and STMs) in the order in which they appear in the Test Setup panel will be executed. 

Follow these steps to execute an individual Device Plan from an open Project Plan: 

1. If the test system is connected to a probe, place the probe at the site that contains the device to 
be evaluated. 

2. In the Test Setup panel, click the name of the Device Plan to be executed (see next figure). 

Figure 386: Select the device to execute 
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3. Enable a test by clicking its corresponding checkmark; or disable a test by removing the 
corresponding checkmark. 

4. If the Project Plan has not been saved, save the Project Plan by clicking the Save/Save All 
function in the ACS toolbar, or by clicking the Save/Save All commands from the ACS File menu 
(see next figure). 

Figure 387: Save the Project Plan 

 

5. Start execution by clicking the triangular Run Test/Plan function in the toolbar (part A)(see next 
figure). The Run Test/Plan toolbar function becomes gray (part B), the Device executes, and the 
square Abort Test/Plan icon illuminates for the duration of the test. 

Figure 388: Run Project Plan Test 
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Executing individual tests 
Executing an individual ITM or STM plan runs only that specific test. 

Perform the following steps to execute an ITM or STM from an open Project Plan: 

1. If the test system is connected to a probe, place the probe at the site that contains the ITM, STM, 
or CTM to be evaluated. 

2. In the Test Setup panel, double-click the name of the ITM, CTM, or STM to be executed (see next 
figure). 

Figure 389: Select the STM to be executed 

 

3. If the Project Plan has not been saved, save the Project Plan by clicking the Save/Save All 
function in the ACS toolbar, or by clicking Save/Save All commands from the ACS File menu (see 
next figure). 

Figure 390: Save the Project Plan 

 

4. Start execution by clicking the triangular Run Test/Plan function (part A) in the toolbar, as shown 
below. The Run Test/Plan toolbar function becomes gray (part B), the ITM or STM executes, and 
the square Abort Test/Plan icon illuminates for the duration of the test (see next figure). 

Figure 391: Run Project Plan Test 
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Append and clear append 
Append run is functionally the same as Run, but all previous data is kept (including previous append 
data)(see next figure). 

Figure 392: START, REPEAT, APPEND, PAUSE, STOP, and CLEAR APPEND 

 

• Only enabled in manual operation mode.  
• Disabled in automation mode. 
• Append is operational at the: test; device; subsite; and pattern level. 
• Same effect as the RUN function, but all previous data is kept (including previous append data). 
• When a project is opened, ACS will look at if there are any append data files available for each 

test and load the data into data sheet accordingly. 
• The plot function will plot all the append data automatically. 
• The append data is appended in the data sheet (in a new section) below the previous data. 
• When you choose to output a .csv file, each append data iteration will be output to a different .csv 

file. 
• The naming convention is testname-append1.csv, testname-append2.csv. 

The CLEAR APPEND function will display a dialog box to click which append data to be cleared. 
When selected, the data file will be deleted and data sheet updated.  
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Append  

Each Append execution generates an additional Append worksheet (Append 1, Append 2, etc.) for 
each additional test that you run. For each Append execution thereafter, the new Append data 
displays a line in a different color. Each Append worksheet is displayed as one of the following tabs at 
the bottom of the sheet tab: Append 1, Append 2, and Append 3 (see next figure). 

The maximum number of times that you can append a test is 30. If you try to append more than 30 
times, a warning dialog box opens. 

Figure 393: Appended data worksheet 

 
 

Data plot 
This section describes the variations available with plotting data. 
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Open a graph sheet 
The Graph sheet is integrated in the same page with the Data sheet. There are two ways to open a 
Graph sheet:  

1. When setting up an ITM, STM, PTM, or CTM, you can switch to the Graph sheet of the current 
test by clicking the Data tab. Results of the current test are displayed, and graphs can be drawn 
according to the results. The next figure shows a graph sheet of a test with a data sheet at the 
bottom.  

Figure 394: An unconfigured graph sheet 

 

2. Click the Tool function on the toolbar. Choose the Offline Data Plotting item and then click a blank 
Data Plotting sheet similar to the one shown above. (NOTE: The data plotting sheet will have the 
same style except for the additional two functions that are over the top left corner.) Data and 
graphs on this sheet are not limited to the current test or the current project. Click the Import 
function to import data. Click the Exit function to exit the page.  

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 5: Test Setup 
 

ACS-901-01 Rev. H / December 2014 5-205 

 

Controlling graph properties 
Items in the Graph Settings menu and the Graph toolbar control the properties of the graph. 

Toolbar Buttons 

The toolbar is placed between the graph section and the data section.  

The properties graph toolbar contains seven functions; their functions are described below: 

1. Zoom (in): Enlarges a small, selected part of the graph. 
2. Home: Used to go back to the original size before zooming. 
3. Pan: Permits dragging along the graph. 
4. Save: Saves the graph sheet as a separate file; .png, .ps, .eps, and .svg are supported formats. 

Detailed instructions on these formats are discussed later in this section. 
5. Plot: Draws a graph out of the data selected. 
6. Plot Auto Scale: Auto scales all the graphs on the graph sheet. 
7. Formulator: Performs simple or complex data calculations on test data as well as on the results of 

other Formulator calculations. Detailed instruction about using the Formulator will be discussed 
later in this section. 

Save a data plot graph 

When the Save function is selected, a save dialog displays. You can save the plot in a .png, .ps, .eps, 
or .svg format, or save the test data in a .csv format (see next figure). 

Figure 395: Save data and graphs 
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Formulator data plot 
Understanding the Formulator 
The Formulator, accessible from the Data tab, allows you to perform simple and complex data 
calculations on test data as well as on the results of other Formulator calculations. The Formulator 
provides a variety of computational functions, common mathematical operators, and common 
constants. 

A formula created by the Formulator is an equation composed from a series of functions, operators, 
constants, and arguments. The next two sections summarize how the Formulator applies these 
elements. 

Formulator arguments and constants 

A formula created using the Formulator performs calculations on any combination of the following: 

• ITM, STM, CTM, or PTM test data. 
• Secondary data created by other Formulator formulas. 
• Standard constants in the list of constants. 

Some of the functions operate on Data tab columns of values (vectors) only. Others operate on single 
values (scalar) only. Still others operate on both single values (scalar) and columns of values 
(vectors). 

Likewise, the results of some calculations may be a column of values (vector) in the Data tab or a 
column containing only a single value. 

Realtime functions, operators, and formulas 

The Formulator provides a variety of functions and operators. Some of these may be used for 
realtime, in-test calculations for ITM data. Others may be used only for post-test data computations.  

A formula containing exclusively realtime operators and functions is a realtime formula. If a realtime 
formula is specified as part of an ITM definition, it executes for each data point generated by the ITM, 
just after it is generated. The results of a realtime formula may be viewed in the Data sheet or plotted 
during the test in the same way as test data. 

Realtime calculations do not apply to CTM data. A CTM Data worksheet does not update until the 
test is finished. 

The following operators and functions are realtime operators and functions: 

• Operators: +, -, *, /, ^ (exponent). 
• Functions: ABS, DELTA, DIFF, EXP, LN, LOG10, SQRT 

The formula below is a realtime formula: 

• RESULT1 = ABS(DELTA(I_ drain)) 

Realtime formulas execute as follows: 

• If a realtime formula is created before the ITM has been run, the formula executes automatically 
during each run. 

• If a realtime formula is created after an ITM has been run, the formula executes initially upon 
adding it to the ITM and automatically during each subsequent run. 
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Post-test-only functions and formulas 

A formula containing any one (or more) of the remaining Formulator functions is a post- test only 
formula. It executes only at the end of each run of the ITM, STM, or CTM in which the formula is 
defined. 

The results of a post-test only formula may be viewed in the Data worksheet or plotted only at the end 
of a test. 

The following functions are post-test only functions: 

AT, AVG, EXPFIT, EXPFITA, EXPFITB,LINFIT, LINFITSLP, LINFITXINT, LINFITYINT, MAX, 
MAXPOS, MIN, MINPOS, REGFIT, REGFITSLP, REGFITXIN, REGFITYINT, TANFIT, TANFITSLP, 
TANFITXINT, TANFITYINT, VTLINGM, VTSATGM 

The formula below is a post-test only formula, because MAVG is a post-test only function: 

RESULT2 = MAX(ABS(DELTA(I_ drain))) 

Post-test only formulas execute as follows: 

• If a post-test only formula is created before the ITM, STM or CTM has been run, the formula 
executes automatically at the conclusion of each run. 

• If a post-test only formula is created after an ITM, STM, or CTM has been run, the formula 
executes initially upon adding it to the STM, CTM, or ITM and automatically at the conclusion of 
each subsequent run. 

Start the Formulator as follows: 
1. Open the Data tab for the test data that you want to analyze.  
2. In the Data tab, click on the Formulator function. The Formulator dialog box opens (see next 

figure). 

Figure 396: Formulator Settings dialog box 
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Becoming familiar with the Formulator dialog box 

This section summarizes the significance/use of each Formulator dialog box feature: 

• Formula area 
• The Formula boxes 

The two boxes in the Formula area of the dialog box are used as follows:  

• The upper Formula box is used to create new formulas or edit existing formulas. 
• The lower Formula box displays the formulas that have been created for the ITM, STM, CTM, or 

PTM. 

The Add formulas function  

Clicking the Add function produces the following results: 

• Starts calculation execution for the formula in the upper Formula box. 
• Moves a formula from the upper Formula box into the collection of formulas displayed in the lower 

Formula box. 

The Delete formulas function 

Clicking the Delete function deletes the formula selected in the lower box. 

The Copy to All formulas function 

Clicking the Copy to All function copies the formula settings of subdevice to other subdevices 

Functions area 

The functions area displays a matrix of functions, as well as a generic F= function that can be used in 
place of a variable name to complete the equation. When you click a function, the function is added to 
the equation and displayed in the Formula box’s upper dialog box at the cursor position. 

Variables area 

The Variables area lists the names of all columns in the Data sheet.  

Columns created by some functions may contain only a single value. 

Device Attributes area 

The Device Attributes area describes the Attribute, Value, and Unit of the device. Beside L, T, W 
below the Attribute line means the Length,Temperature and Width of the device. This area comes 
from the Attribute contains of the Device Setting tab. 

Constants/Values area 

The Constants/Values area provides constants that may be conveniently inserted by name. 

When you click the constant in the constants list, the constant is added to the equation in the upper 
dialog box, at the cursor position. 

Add new constants function 

To add a new constant, click the New function. A dialog input box opens that allows you to input the 
name and value of your new constant. After you input the name and value, Click OK; the new 
constant will be added to the constants list (see next figure). 
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Figure 397: New constant 

 

Delete constants function 

To delete a constant, click the Del function.  

When you copy an existing project to a new system, if it is in the Formulator, you should also copy 
the KATS_const.ini file. 

1. If the ACS installed in a computer whose environment variables contain “KIDAT”, then the 
KATS_Const.ini file is located in the path specified in the value of “KIDAT”; it means, suppose 
KIDAT=C:\S4200\sys\dat, then the variable defined file is: C:\S4200\sys\dat\ KATS_Const.ini; 

2. If “KIDAT” is not defined in environment variables, the KATS_Const.ini file is located in the path 
where ACS is installed, it means, suppose ACS is installed in “\\ACS\KATS”, then the variable 
defined files: \\ACS\KATS \ KATS_Const.ini; 

If not, the formulator in module will disappear in the tsp file, and not effective if run directly after load. 

Understanding the Formulator functions 
The Formulator functions, as well as operators and constants, can be used singly or in various 
combinations to create simple or complex analysis equations. 

Multiple functions can be nested. For example, in one equation you can calculate the following: 

• Calculate a series of moving averages for a column of data (vector) in the Data worksheet, using 
the MAVG function. 

• Find the maximum value of the MAVG averages, using the MAX function. 
• Multiply the MAX found value by a constant. 

The equation below illustrates this use of nested Formulator functions. 

MAXDIFF = 10*MAX(MAVG(ColumnA)) 

The degree (number of levels) of nesting is unlimited. There are 69 formulator functions, including:  

ABS, AT, AVG, CURRENT_NOISE, DELTA, DIFF, DIMENSION, EXP, EXPFIT, EXPFITA, EXPFITB, 
FINDD, FINDLIN, FINDU, FIRSTPOS, GET_FREQ, GET_TBD, GET_TBD2, GET_VBD, GMMAX, 
JOIN, LASTPOS, LINFIT, LINFITSLP, LINFITXINT, LINFITYINT, LN, LOG, LOG10, LOGFIT, MAX, 
MAXPOS, MEDIAN, MIN, MINPOS,MOBILITY,NOISE_UTM, POW,POWERFFT, REGFIT, 
REGFITSLP, REGFITXINT, REGFITYINT, REGFIT_LGX_LGY, REGFIT_LGX_Y, REGFIT_X_LGY, 
RES, RES_4WIRE, RES_4WIRE_AVG(VPOS,VNEG,I), RES_AVG, SMOOTH, SQRT, SS, SSVTCI, 
SUBARRAY1, SUBARRAY2, TANFIT, TANFITSLP, TANFITXINT, TANFITYINT, TAR_YatX, 
TTF_DID_LGT, TTF_LGDID_T, TTF_DID_T, TTF_LGDID_LGT, VTCI, VTLINGM, VTSATGM, 
VT_SAT_TRI 

The purpose, format, and arguments for the above functions and all other functions available in the 
formulator are described below. An example is given in each case. 
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Formulator function reference 
ABS - Formulator function 
Purpose: Calculates the absolute value of each value in the designated column (vector) or the 
absolute value of any operand. 

Format: ABS(X)  

X = The name of any column (vector) listed under Columns or any operand. 

Example: F2 = ABS(I_GATE) 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
 

AT - Formulator function 
Purpose: Extracts and returns a single value from a column (vector).1 

Format: AT(V, POS)  

V = The name of any column (vector) listed under Columns. 

POS = The row number of column V where the single value is located. 

Example: IDSAT = AT(I_DRAIN, 36) 
 

AVG - Formulator function 
Purpose: Returns the average of all values in the column (vector). 

Format: AVG(V) 

V = The name of any column (vector) listed under Columns. 

Example: LEAKAGE = AVG(I_GATE) 
 

CURRENT_NOISE - Formulator function 
Purpose: This formula is used to calculate noise current from Ig. 

Format: CURRENT_NOISE(IMEAS,POINT_NUM) 

IMEAS = measured current 

POINT_NUM = The noise points number for calculate. 

Example: Ig_noise=CURRENT_NOISE(Ig,50) 
 

DELTA - Formulator function 
Purpose: Returns the differences between the adjacent values in a column (vector). That is, for 
column V, DELTA returns (V2 - V1), (V3 -V2), and so on. 

Format: DELTA(V) 

V = The name of any column (vector) listed under Columns. 

Example: GM = DELTA(I_DRAIN)/DELTA(V_GATE) 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
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DIFF - Formulator function 
Purpose: For all of the values in two selected columns (vectors), DIFF returns a third column (vector) 
containing the difference coefficients. That is, for columns V1 and V2, DIFF returns the following: 
(V12 - V11)/(V22 - V21), (V13 - V12)/(V23 - V22), etc. 

Format: DIFF(V1, V2) 

V1 = The name of any column (vector) listed under Columns. 

V2 = The name of any column (vector) listed under Columns. 

Example: GM = DIFF(I_DRAIN, V_GATE) 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
 

DIMENSION - Formulator function 
Purpose: Extract a subarray based on full array. 

Format: DIMENSION(V)  

V = The name of any column (vector) listed under Columns. 

Example: V2 = DIMENSION(V1) 

Remarks: Return a subarray 
 

EXP - Formulator function 
Purpose: Returns the exponential, e_value, for each value in a column (vector) or for any operand. 

Format: EXP(X) 

X = The name of any column (vector) listed under Columns or any operand. 

Example: NEWCURRENT = CURRENT*EXP(ANODEV) 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
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EXPFIT - Formulator function 
Purpose: Performs an exponential fit. 

Fits the following exponential relationship to a specified range of values in two columns (vectors)—
one column, VX, containing X values and the other column, VY, containing Y values: Y = EXPFITA * 
e(EXPFITB * X) where: EXPFITA and EXPFITB are fit constants.  

Using the above exponential relationship, returns a new column (vector) containing Y values 
calculated from all X values in column VX. 

Format: EXPFIT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be exponentially fitted, the row number (index) of 
the starting values. 

ENDPOS = For the range of X and Y values to be exponentially fitted, the row number (index) of the 
ending values. 

Example: DIODEI = EXPFIT(ANODEV, ANODEI, 2, LASTPOS(ANODEV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 

EXPFITA - Formulator function 
Purpose: Performs an exponential fit. 

Fits the following exponential relationship to a specified range of values in two columns (vectors)—
one column, VX, containing X values and the other column, VY, containing Y values: 

Y = EXPFITA * e(EXPFITB * X) 

where EXPFITA and EXPFITB are fit constants. Returns the value of the constant EXPFITA in the 
relationship above. 

Format: EXPFITA(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be exponentially fitted, the row number (index) of 
the starting values. 

ENDPOS = For the range of X and Y values to be exponentially fitted, the row number (index) of the 
ending values. 

Example: DIODEOFFSET = EXPFITA(ANODEV, ANODEI, 2, LASTPOS(ANODEV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 
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EXPFITB - Formulator function 
Purpose: Performs an exponential fit. 

Fits the following exponential relationship to a specified range of values in two columns (vectors)—
one column, VX, containing X values and the other column, VY, containing Y values: Y = EXPFITA * 
e(EXPFITB * X) where EXPFITA and EXPFITB are fit constants. 

Returns the value of the constant EXPFITB in the relationship above. 

Format: EXPFITB(VX, VY, STARTPOS, ENDPOS) 

X = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be exponentially fitted, the row number (index) of 
the starting values. 

ENDPOS = For the range of X and Y values to be exponentially fitted, the row number (index) of the 
ending values. 

Example: DIODEIDEALITY = 1/(EXPFITB(ANODEV, ANODEI, 2, LASTPOS(ANODEV))*0.0257) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 

FINDD - Formulator function 
Purpose: Given a column (vector) V, beginning at START, FINDD searches down the column until it 
finds a value that matches the specified value X. Then it returns the row number (index) of that value. 
If FINDD does not find an exact match for X, it returns the row number (index) of the V value that is 
closest to X. 

Format: FINDD(V, X, START) 

V = The name of any column (vector) listed under Columns. 

X = Any value (which may be the result of another calculation[s]). 

START = The row number (index) of the starting value for the search. 

Example: IF = AT(ANODEI, FINDD(ANODEV, 0.7, FIRSTPOS(ANODEV))) 

Remarks: Refer also to the similar functions FINDLIN (Find using linear interpolation) and FINDU 
(Find up). 
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FINDLIN - Formulator function 
Purpose: Find using linear interpolation - given a column (vector) V, beginning at START, FINDLIN 
searches down the column until it finds a value that is closest (but does not exceed) the specified 
value X. Linear interpolation is then used to determine its decimal location between the found value 
and the next value in the column (vector). The returned index number (in decimal format) indicates 
the position of the specified value. 

For example, assume you want to use FINDLIN to locate value 6 in the following array: 

(Index 1)V 

(Index 2)1 

(Index 3)4 

(Index 4)8 

The search finds the index marker that is closest to (but does not exceed) 6. In this case, Index 3 is 
the closest. Linear interpolation is then used to determine the decimal position of the specified value 
(6) which is between Index 3 (value 4) and Index 4 (value 8). Value 6 is halfway between Index 3 and 
Index 4. Therefore, FINDLIN will return Index 3.5. 

Format: FINDD(V, X, START)  

V = The name of any column (vector) listed under Columns.  

X = Any value (which may be the result of another calculation[s]). 

START = The row number (index) of the starting value for the search. 

Example: IF = AT(ANODEI, FINDLIN(ANODEV, 0.7, FIRSTPOS(ANODEV))) 

Remarks: Refer also to the similar functions FINDD (Find down) and FINDU (Find up). 
 

FINDU - Formulator function 
Purpose: Given a column (vector) V, beginning at START, FINDU searches up the column until it 
finds a value that matches the specified value X. It then returns the row number (index) of that value. 
If FINDU does not find an exact match for X, it returns the row number (index) of the V value that is 
closest to X. 

Format: FINDU(V, X, STARTPOS) 

V = The name of any column (vector) listed under Columns. 

X = Any value (which may be the result of another calculation[s]). 

STARTPOS = The row number (index) of the starting value for the search. 

Example: IF = AT(ANODEI, FINDU(ANODEV, 0.7, LASTPOS(ANODEV))) 

Remarks: Refer also to the similar functions FINDLIN (Find using linear interpolation) and FINDD 
(Find down). 
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FIRSTPOS - Formulator function 
Purpose: Returns the row number (index) of the first value in a column (vector), typically the number 
2. 

Format: FIRSTPOS(V) 

V = The name of any column (vector) listed under Columns. 

Example: STARTOFARRAY = FIRSTPOS(I_DRAIN) 

Remarks: Refer also to the function LASTPOS. 
 

GET_FREQ - Formulator function  
Purpose: Get the FFT frequency for a input time list. 

Format: GET_FREQ(time_source) 

Time_source = The name of time column (vector) listed under Columns. 

Example: Fre1=GET_FREQ(time1) 

Remarks: this formulator function just used in 1/f noise test project. 
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GET_TBD - Formulator function 
Purpose: This formula is used to get breakdown (BD) time of TDDB test. 

Format: GET_TBD(IS, TIME, CUR_J, SLOPE_J, NOISE_J, FIX_CUR_J, SLOPE_P_NUM, 
NOISE_P_NUM, AND_OR,METHODS)  

It includes following parameters.  

2 variables: IS and TIME.  

4 methods for BD criteria: CUR_J, SLOPE_J,NOISE_J, IX_CUR_J.  

2 parameters for calculation: SLOPE_P_NUM, NOISE_P_NUM.  

1 logic relationship: AND_OR. 

And choose what kinds of methods: METHODS.  

IS = gate current. 

TIME = test time. 

CUR_J= criteria current times for breakdown, as |Ig[n]/Ig[0]| >= CUR_J.  

SLOPE_J= criteria slope times for breakdown, as |slope[n]/slope[n-1]| >= SLOPE_J. 

NOISE_J= criteria noise times for breakdown, as |Inoi[n]/Inoi[n-1]| >= NOISE_J.  

FIX_CUR_J=fixed cursor for criteria, as |Ig[n]| >= FIX_CUR_J.  

SLOPE_P_NUM= the slope points number for each step calculate. If equals to 5, then slope of Ig is 
calculated every 5 points.  

NOISE_P_NUM= the noise points number for each step calculate. If equals to 5, then noise current of 
Ig is calculated every 5 points.  

AND_OR= ‘0’ or ’1’. ‘1’ stands ‘and’, means all methods selected are achieved then BD happens; ‘0’ 
stands ‘or’, means any of the methods selected are achieved then BD happens.  

METHODS= the used methods serial number. ‘1234’ means all 4 methods are chosen. ‘14’ means 
only first and fourth are chosen. 

Example: TBD=GET_TBD(Ig, time, 100, 50, 10000, 1E-4, 5, 5, 0,14) 

Remarks: The above example means calculating TBD using Ig and time array. The criteria current 
times is 100, criteria slope times is 50, the criteria noise times is 10000, the fixed cursor data for 
criteria is 1E-4. Slope of Ig is calculated every 5 points and noise current of Ig is calculated every 5 
points. Using the 1st and 4th methods, and these two methods are achieved then BD happens. 
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GET_TBD2 - Formulator function 
Purpose: This formula is used to get breakdown (BD) time of TDDB test. 

Format: GET_TBD2(IS, IS_TIME, ISILC, SILC_TIME, IS_CUR_J, ISILC_CUR_J, SLOPE_J, 
NOISE_J, FIX_CUR_J, SLOPE_P_NUM, NOISE_P_NUM,METHODS) 

It includes following parameters.  

4 variables: IS and IS_TIME, ISILC, SILC_TIME. 

4 methods for BD criteria: CUR_J, SLOPE_J,NOISE_J, FIX_CUR_J. 

2 parameters for calculation: SLOPE_P_NUM, NOISE_P_NUM. 

And choose what kinds of methods: METHODS.  

IS = gate stressed current. 

IS_TIME = stressed time. 

ISILC = gate leakage current. 

ISILC_TIME = measure ISILC time.  

CUR_J= criteria current times for breakdown, as |Ig[n]/Ig[0]| >= CUR_J.  

SLOPE_J= criteria slope times for breakdown, as |slope[n]/slope[n-1]| >= SLOPE_J. 

NOISE_J= criteria noise times for breakdown, as |Inoi[n]/Inoi[n-1]| >= NOISE_J.  

FIX_CUR_J=fixed cursor for criteria, as |Ig[n]| >= FIX_CUR_J.  

SLOPE_P_NUM= the slope points number for each step calculate. If equals to 5, then slope of Ig is 
calculated every 5 points.  

NOISE_P_NUM= the noise points number for each step calculate. If equals to 5, then noise current of 
Ig is calculated every 5 points.  

METHODS= the used methods serial number. ‘1234’ means all 4 methods are chosen. ‘14’ means 
only first and fourth are chosen. 

Example: TBD=GET_TBD2(Ig, time_str, I_silc, time_silc, 100, 50, 10000, 1E-4, 5, 5, 0,14) 

Remarks: The above example means calculating TBD using two group of arrays: Ig and time_str, 
I_silc and time_silc. The criteria current times is 100, criteria slope times is 50, the criteria noise times 
is 10000, and the fixed cursor data for criteria is 1E-4. Slope of Ig is calculated every 5 points and 
noise current of Ig is calculated every 5 points. Using the 1st and 4th methods, and these two 
methods are achieved then BD happens. 
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GET_VBD - Formulator function 
Purpose: Get breakdown (BD) voltage in VRamp test. 

Format: GET_VBD(IS, TIME, CUR_J, SLOPE_J, SLOPE_P_NUM, AND_OR, METHODS) 

IS = gate current. 

TIME = test time. 

CUR_J = criteria current times for breakdown, as |Ig[n]/Ig[0]| >= CUR_J. 

SLOPE_J = criteria slope times for breakdown, as |slope[n]/slope[n-1]| >= SLOPE_J. 

SLOPE_P_NUM= the slope points number for each step calculate.  

If equals to 5, then slope of Ig is calculated every 5 points.  

AND_OR= ‘0’ or ’1’. ‘1’ stands ‘ᾉand’, means all methods selected are achieved then BD happens; ‘0’ 
stands ‘or’, means any of the methods selected are achieved then BD happens.  

METHODS= the used methods serial number. ‘12’ means  two methods are chosen.  

Example: VBD=GET_VBD(Ig, time, 100, 50,5, 5, 0,1) 

Remarks: The above example means calculating VBD using Ig and time array. The criteria current 
times is 100, criteria slope times is 50. Slope of Ig is calculated every 5 points. Using the 1st 
methods, and it achieved then BD happens. 

 

GMMAX - Formulator function 
Purpose: Returns the maximum value from the two columns (vectors). 

Format: GMMAX(Id, Vg) 

Id= the I_drain vector. 

Vg= the V_gate vector. 

GM= DIFF(Id, Vg). 

Example: Neg= GMMAX(DIFF(I_drain, V_gate)) 
 

JOIN - Formulator function 
Purpose: to join multiply arrays together, and return a new array. 

Format: JOIN(array1,array2) 

Example: newarray=JOIN(array1,array2) 
 

LASTPOS - Formulator function 
Purpose: Returns the row number (index) of the last value in a column (vector). 

Format: LASTPOS(V) 

V = The name of any column (vector) listed under Columns. 

Example: NUMSWEEPPTS = LASTPOS(COLLECTORI) 

Remarks: Refer to the function FIRSTPOS. 
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LINFIT - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two sets of X and Y values selected 
from two columns (vectors), VX and VY. This equation corresponds to a line drawn through two 
points on a curve that is created by plotting the values in VY against the values in VX. The two points 
are specified by the arguments STARTPOS and ENDPOS. 

Using the linear equation, returns a new column (vector) containing Y values calculated from all X 
values in column VX. 

Format: LINFIT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = The row number (index) of the first set of X and Y values. 

ENDPOS = The row number (index) of the second set of X and Y values. 

Example: RESISTORFIT = LINFIT (RESV, RESI, FIRSTPOS(RESV), LASTPOS(RESV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. To return a linear regression fit for two columns 
(vectors), use the REGFIT function. 

 

LINFITSLP - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two sets of X and Y values selected 
from two columns (vectors), VX and VY. This equation corresponds to a line drawn through two 
points on a curve that is created by plotting the values in VY against the values in VX. The two points 
are specified by the arguments STARTPOS and ENDPOS. 

Returns the slope of the linear equation (value of “b” in Y = a + bX). 

Format: LINFITSLP(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = The row number (index) of the first set of X and Y values. 

ENDPOS = The row number (index) of the second set of X and Y values. 

Example: RESISTANCE = 1/LINFITSLP(RESV, RESI, FIRSTPOS(RESV), LASTPOS(RESV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. To return the slope of a linear regression fit for two 
columns (vectors), use the REGFITSLP function. 
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LINFITXINT - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two sets of X and Y values selected 
from two columns (vectors), VX and VY. This equation corresponds to a line drawn through two 
points on a curve that is created by plotting the values in VY against the values in VX. The two points 
are specified by the arguments STARTPOS and ENDPOS. 

Returns the X intercept of the linear equation: 

(value of “-a/b” in Y = a + bX). 

Format: LINFITXINT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = The row number (index) of the first set of X and Y values. 

ENDPOS = The row number (index) of the second set of X and Y values. 

Example: EARLYV = LINFITXINT(COLLECTORV, COLLECTORI, 56, 75) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. To return the X intercept of a linear regression fit for 
two columns (vectors), use the REGFITXINT function. 

 

LINFITYINT - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two sets of X and Y values selected 
from two columns (vectors), VX and VY. This equation corresponds to a line drawn through two 
points on a curve that is created by plotting the values in VY against the values in VX. The two points 
are specified by the arguments STARTPOS and ENDPOS. 

Returns the Y intercept of the linear equation: 

(value of “a” in Y = a +bX). 

Format: LINFITYINT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = The row number (index) of the first set of X and Y values. 

ENDPOS = The row number (index) of the second set of X and Y values. 

Example: OFFSET = LINFITYINT(GATEV, GATEI, FIRSTPOS(GATEV), LASTPOS(GATEV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. To return the Y intercept of a linear regression fit for 
two columns (vectors), use the REGFITYINT function. 
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LN - Formulator function 
Purpose: Returns the base-e (natural, Napierian) log of each value in a designated column (vector) or 
the Napierian log of any operand. 

Format: LN(X) 

X = The name of any column (vector) listed under Columns or any operand. 

Example: DIODEV = LN(ANODEI)*0.026 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
 

LOG - Formulator function 
Purpose: Returns the log value of each value in a designated column (vector) or the log of any 
operand. Note that it cannot accept two arrays in its parameters. 

Format: LOG(V,VBASE) 

V = The name of any column (vector) listed under Columns or a number. 

VBASE= The base value of logarithms. 

Example: F1 = LOG(I_DRAIN, 2) 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
 

LOG10 - Formulator function 
Purpose: Returns the base-10 log of each value in a designated column (vector) or the base-10 log of 
any operand. 

Format: LOG10(V) 

V = The name of any column (vector) listed under Columns or any operand. 

Example: F2 = LOG10(I_DRAIN) 

Remarks: This function can be used to perform calculations in realtime, while a test is executing. 
 

LOGFIT - Formulator function 
Purpose: Finds a log equation of the form Y = a + b*log10(X) from two sets of X and Y values 
selected from two columns (vectors), VX and VY. The two points are specified by the arguments 
STARTPOS and ENDPOS. 

Format: LOGFIT(VX, VY, STARTPOS, ENDPOS, POINTS=0) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = The row number (index) of the first set of X and Y values. 

ENDPOS = The row number (index) of the second set of X and Y values. 

Example: F3=LOGFIT(I_FM_pre1,I_Neg_pre1,23,56)   

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 
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MAVG(V,N) - Formulator function 
Purpose: Moving averages for the vector. 

Format: MAV(V,N); V = vector; N = window size. 

Example: FILTER = MAVG(GATEI, 3). 

Remarks: If N = 3 and V contains the 12 values X1, X2, X3 through X12, then MAVG(V,N) returns a 
column (vector) containing the following values:  
#REF, (X1 + X2 + X3)/3, (X2 + X3 + X4)/3, (X3 + X4 + X5)/3 through (X10 + X11 + X12)/3, #REF 

 

MAX - Formulator function 
Purpose: Searches all values in a column (vector) and returns the maximum value. 

Format: MAX(V) 

V = The name of any column (vector) listed under Columns. 

Example: MAXGM = MAX(DIFF(DRAINI, GATEV)) 
 

MAXPOS - Formulator function 
Purpose: Searches all values in a column (vector), finds the maximum value, and returns the row 
number (index) of the maximum value. 

Format: MAXPOS(V) 

V = The name of any column (vector) listed under Columns. 

Example: PEAKSTRESS = AT(GATEV, MAXPOS(SUBSTRATEI)) 
 

MEDIAN - Formulator function 
Purpose: Calculate the average value of V between start and stop index. 

Format: MEDIAN(V, start_pos, end_pos) 

V = The name of any column (vector) listed under Columns. 

Example: avg1= MEDIAN(V, 1, 20) 
 

MIN - Formulator function 
Purpose: Searches all values in a column (vector) and returns the minimum value. 

Format: MIN(V) 

V = The name of any column (vector) listed under Columns. 

Example: SMALLESTI = MIN(DRAINI) 
 

MINPOS - Formulator function 
Purpose: Searches all values in a column (vector), finds the minimum value, and returns the row 
number (index) of the minimum value. 

Format: MINPOS(V) 

V = The name of any column (vector) listed under Columns. 

Example: LOCATION = MINPOS(DRAINI) 
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MOBILITY - Formulator function 
Purpose: Mobility at Vg_tar by Id-Vg curve. 

Format: MOBILITY(w,l,ci,Vg_tar,Vth,Id,Vg) 

• w = Width of device gate 
• l = Length of device gate 
• ci = Capacitance of gate 
• vg_tar = Target VG 
• Vth = Threshold voltage 
• Id = Measured Drain current 
• Vg = Measured Gate voltage 

Example: U1= MOBILITY(10,0.03,1,0.05,0.078,Id,Vg) 
 

NOISE_UTIM - Formulator function 
Purpose: This formula is used to generate correct time array for noise current 

Format: NOISE_UTIM(MEASTIMES,POINT_NUM) 
 

POW - Formulator function 
Purpose: Returns the power value of each value in a designated column (vector) or any operand. 
Note that it cannot accept two arrays in its parameters. 

Format: POW(VBASE, VPOW) 

VBASE = The name of any column (vector) listed under Columns, or a number as base value. 

VPOW = The name of any column (vector) listed under Columns, or a number as power value. 

Example: I2 = POW(I_DRAIN, 2)  or  I2pow = POW(2, I_DRAIN) 
 

POWERFFT - Formulator function 
Purpose: Perform the forward FFT for input data source, get the power spectrum. 

Format: POWERFFT(data_source, dialog box) 

data_source: The value list of the sample data . a list 

dialog box: The name of the dialog box function. integer 

value mappings of the parameter dialog box: 
 

POWERFFT value mappings 
value  dialog box function execution 
1 rectangular 1 
2 hanning w(n) = 0.5*(1-cos(2*pi*n/(N-1))) 
3 hamming w(n) = 0.54-0.46*cos(2*pi*n/(N-1)) 
4 blackman w(n) = 0.42-0.5*cos(2*pi*n/(N-1))+0.08*cos(4*pi*n/(N-

1)) 
5 welch w(n) = 1-((n-0.5*(N-1))/0.5*(N+1))^2 
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Example: pow1=POWERFFT(IDrain, 2) 

Remarks: Return the power spectrum calculated for input source, this function only used in 1/f noise 
test project 

 

REGFIT - Formulator function 
Purpose: Performs a linear regression fit. 

Fits the relationship of the form Y = a + bX to a specified range of values in two columns (vectors): 
column VX containing X values and column VY containing Y values: Y = REGFITYINT + REGFITSLP 
* X where REGFITSLP and REGFITYINT are slope and Y-intercept constants. Using the above linear 
relationship, returns a new column (vector) containing Y values calculated from all X values in column 
VX. 

Format: REGFIT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: COLLECTORFIT = 

REGFIT(COLLECTORV, COLLECTORI, 25, LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 

REGFITSLP - Formulator function 
Purpose: Fits the relationship of the form Y = a + bX to a specified range of values in two columns 
(vectors): column VX containing X values and column VY containing Y values: Y = REGFITYINT + 
REGFITSLP * X where REGFITSLP and REGFITYINT are slope and Y-intercept constants. 

Returns the value of the slope constant REGFITSLP in the relationship above. 

Format: REGFITSLP(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: COLLECTORRES = 

1/REGFITSLP(COLLECTORV, COLLECTORI, 25, LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 
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REGFITXINT - Formulator function 
Purpose: Fits the relationship of the form Y = a + bX to a specified range of values in two columns 
(vectors): column VX containing X values and column VY containing Y values: Y = REGFITYINT + 
REGFITYINT * X where REGFITSLP and REGFITYINT are slope and Y-intercept constants. 

Returns the value of the X intercept for relationship above (–REGFITYINT/REGFITSLP). 

Format: REGFITXINT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: EARLYV = REGFITXINT(COLLECTORV, COLLECTORI, 25, LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 

REGFITYINT - Formulator function 
Purpose: Fits the relationship of the form Y = a + bX to a specified range of values in two columns 
(vectors)—column VX containing X values and column VY containing Y values: Y = REGFITYINT + 
REGFITSLP * X where REGFITSLP and REGFITYINT are slope and Y-intercept constants. 

Returns the value of the Y intercept (REGFITYINT) for relationship above. 

Format: REGFITYINT(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: OFFSET = REGFITYINT(COLLECTORV, COLLECTORI, 25, LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 



Section 5: Test Setup ACS Automated Characterization Suite (ACS) Reference Manual 
 

5-226 ACS-901-01 Rev. H / December 2014 

 

REGFIT_LGX_LGY - Formulator function 
Purpose: Performs a linear regression fit. 

Fits the relationship of the form LGY = a + bLGX to a specified range of values in two columns 
(vectors): 

column VX extracting LGX values and column VY extracting LGY values: LGY = REGFITYINT + 
REGFITSLP * LG X where REGFITSLP and REGFITYINT are slope and LGY-intercept constants. 

Using the above linear relationship, returns a new column (vector) containing LGY values calculated 
from all LGX values. That is, input value is normal VX, VY, but the fit relationship is built on LGY and 
LGX.  

Format: REGFIT_LGX_LGY(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: COLLECTORFIT1 = REGFIT_LGX_LGY(COLLECTORV, COLLECTORI, 25, 
LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 

REGFIT_LGX_Y - Formulator function 
Purpose: Performs a linear regression fit. 

Fits the relationship of the form Y = a + bLGX to a specified range of values in two columns (vectors): 
column VX extracting LGX values and column VY containing Y values: Y = REGFITYINT + 
REGFITSLP * LGX where REGFITSLP and REGFITYINT are slope and Y-intercept constants. 

Using the above linear relationship, returns a new column (vector) containing Y values calculated 
from all LGX values in column VX. That is, input value is normal value VX,VY, but the fit relationship 
is built on Y and LGX. 

Format: REGFIT_LGX_Y(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: COLLECTORFIT 2 = REGFIT_LGX_Y(COLLECTORV, COLLECTORI, 25, 
LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 
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REGFIT_X_LGY - Formulator function 
Purpose: Performs a linear regression fit. 

Fits the relationship of the form LGY = a + bX to a specified range of values in two columns 
(vectors)—column VX containing X values and column VY extracting LGY values: LGY = 
REGFITYINT + REGFITSLP * X where REGFITSLP and REGFITYINT are slope and LGY-intercept 
constants. 

Using the above linear relationship, returns a new column (vector) containing LGY values calculated 
from all X values in column VX. That is, input value is normal value VX, VY, but the fit relationship is 
built on LGY and X. 

Format: REGFIT_X_LGY(VX, VY, STARTPOS, ENDPOS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

STARTPOS = For the range of X and Y values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of X and Y values to be fitted, the row number (index) of the ending values. 

Example: COLLECTORFIT3= REGFIT_X_LGY (COLLECTORV, COLLECTORI, 25, 
LASTPOS(COLLECTORV)) 

Remarks: If a VX or VY value at either STARTPOS or ENDPOS is an invalid number (i.e., the value is 
#REF), the function will not return a valid result. 

 

RES - Formulator function 
Purpose: Calculate resistance vector value by giving V and I. 

Format: RES(V,I)) 

V=voltage vector listed in Variables box 

I=current vector listed in Variables box 

Example: RG_1=RES(V_Gate_1,I_Gate_1) 

Remarks: If a I or V value is an invalid number (i.e., the value is #REF), the function will not return a 
valid result. 

 

RES_4WIRE - Formulator function 
Purpose: calculate 4-wire resistance vector value by giving V and I. 

Format: RES_4WIRE(VPOS,VNEG,I) 

VPOS=positive voltage vector listed in Variables box 

VNEG=negative voltage vector listed in Variables box 

I=current vector listed in Variables box 

Example: RGD=RES_4WIRE(V_Gate_1,V_Drain_1,I_Gate_1) 

Remarks: If VPOS, VNEG, or I value is an invalid number (i.e., the value is #REF), the function will 
not return a valid result. 
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RES_4WIRE_AVG(VPOS,VNEG,I) - Formulator function 
Purpose: calculate 4-wire resistance average value by giving V and I. 

Format: RES_4WIRE_AVG(VPOS,VNEG,I) 

VPOS=positive voltage vector listed in Variables box 

VNEG=negative voltage vector listed in Variables box 

I=current vector listed in Variables box 

Example: RGD_AVG=RES_4WIRE_AVG(V_Gate_1,V_Drain_1,I_Gate_1) 

Remarks: If VPOS, VNEG , or I value is an invalid number (i.e., the value is #REF), the function will 
not return a valid result. 

 

RES_AVG - Formulator function 
Purpose: calculate resistance average value by giving V and I 

Format: RES_AVG(V,I) 

V=voltage vector listed in Variables box 

I=current vector listed in Variables box 

Example: RG_1=RES_ AVG (V_Gate_1, I_Gate_1) 

Remarks: If a I or V value is an invalid number (i.e., the value is #REF), the function will not return a 
valid result. 

 

RSQUAR(VX,VY,START_POS,END_POS) - Formulator function 
Purpose: Calculate correlation coefficients from an input matrix VX and VY 

Format: RSQUAR(VX,VY,START_POS,END_POS 

VX = column vectors 

VY = column vectors 

START_POS = end position to do correlation 

END_POS = end position to do correlation 

Example: R1=RSQUAR(V_Pos,I_Pos,5,20) 
 

SMOOTH - Formulator function 
Purpose: Smooth the vector using FFT. 

Format: SMOOTH (V, RANK) 

V = The name of any column (vector) listed under Columns. 

RANK = The rank number of smooth level. 

Example: I2 = SMOOTH (I1, 2) 

Remarks: If a V value is an invalid number (i.e., the value is #REF), the function will not return a valid 
result. 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 5: Test Setup 
 

ACS-901-01 Rev. H / December 2014 5-229 

 

SQRT - Formulator function 
Purpose: Returns the square root of each value in a designated column (vector) or the square root of 
any operand. 

Format: SQRT(X) 

X = The name of any column (vector) listed under Columns or any operand. 

Example: TWO = SQRT(4) 

Remarks: A negative value of X returns #REF in the Data worksheet. This function can be used to 
perform calculations in realtime, while a test is executing. 

 

SS - Formulator function 
Purpose: Extract the sub-threshold swing between a certain duration of current. The sub-threshold 
swing is defined as the deferential of Vg and log Id, for example, SS=dVg/dlogId. 

Format: SS (I_DRAIN, V_GATE, START_I, STOP_I) 

I_DRAIN = the drain current measured in the test.  

V_GATE = the gate voltage forced in the test. 

START_I = the start current to define the calculation region. 

STOP_I = the stop current to define the calculation region. 

Example: S0=SS (I_Drain_1, V_Gate_1, 1.3e-5, 1.5e-5) 

Remarks: If an I_DRAIN or V_GATE value is an invalid number (for example, the value is #REF), the 
function will not return a valid result. 

 

SSVTCI - Formulator function 
Purpose: Extract the sub-threshold swing from the certain duration between left offset and right offset 
of the constant current threshold voltage.  

Format: SSVTCI(I_DRAIN, V_GATE, VTCI,LEFT_OFFSET,RIGHT_OFFSET) 

I_DRAIN = the drain current measured in test. 

V_GATE= the gate voltage. 

VTCI= constant current threshold voltage. 

LEFT_OFFSET,RIGHT_OFFSET= left offset and right offset of the constant current threshold voltage 

Example: SLOPE=SSVTCI(I_Drain_1,V_Gate_1,VTH,-0.1,-0.1) 

Remarks: If a I_DRAIN or V_GATE value is an invalid number (i.e., the value is #REF), the function 
will not return a valid result. 
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SUBARRAY1 - Formulator function 
Purpose: Extract a subarray based on full array. 

Format: SUBARRAY1(V, start, period) 

V: vector array 

start: start index 

period: extraction period 

Example: VGate2=SUBARRAY1(VGate, 1, 5) 
 

SUBRRAY2 - Formulator function 
Purpose: Extract a subarray based on full array. 

Format: SUBARRAY2(V, start, stop) 

V: vector array 

start: start index 

stop: stop index 

Example: VGate2=SUBARRAY1(VGate, 1, 50) 
 

TANFIT - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two columns (vectors), VX and VY. This 
equation corresponds to a tangent of the curve that is created by plotting the values in VY against the 
values in VX. The value at which the tangent is found is specified by the argument POS. 

Using the linear equation, returns a new column (vector) containing Y value calculated from all X 
values in column VX. 

Format: TANFIT(VX, VY, POS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

POS = The row number (index) of the value where the tangent is to be found. 

Example: VTFIT = TANFIT(GATEV, DRAINI, MAXPOS(GM)) 

Remarks: If a VX or VY value at POS is an invalid number (i.e., the value is #REF), the function will 
not return a valid result. 
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TANFITSLP - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two columns (vectors), VX and VY. This 
equation corresponds to a tangent of the curve that is created by plotting the values in VY against the 
values in VX. The value at which the tangent is found is specified by the argument POS. 

Returns the slope of the linear equation (value of “b” in Y = a + bX). 

Format: TANFITSLP(VX, VY, POS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

POS = The row number (index) of the value where the tangent is to be found. 

Example: VTSLOPE = TANFITSLP(GATEV, DRAINI, MAXPOS(GM)) 

Remarks: If a VX or VY value at POS is an invalid number (i.e., the value is #REF), the function will 
not return a valid result. 

 

TANFITXINT - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two columns (vectors), VX and VY. This 
equation corresponds to a tangent of the curve that is created by plotting the values in VY against the 
values in VX. The value at which the tangent is found is specified by the argument POS. 

Returns the X intercept of the linear equation  

(value of “-a/b” in Y = a + bX). 

Format: TANFITXINT(VX, VY, POS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

POS = The row number (index) of the value where the tangent is to be found. 

Example: VT = TANFITXINT(GATEV, DRAINI, MAXPOS(GM)) 

Remarks: If a VX or VY value at POS is an invalid number (i.e., the value is #REF), the function will 
not return a valid result. 

 



Section 5: Test Setup ACS Automated Characterization Suite (ACS) Reference Manual 
 

5-232 ACS-901-01 Rev. H / December 2014 

 

TANFITYINT - Formulator function 
Purpose: Finds a linear equation of the form Y = a + bX from two columns (vectors), VX and VY. This 
equation corresponds to a tangent of the curve that is created by plotting the values in VY against the 
values in VX. The value at which the tangent is found is specified by the argument POS. 

Returns the Y intercept of the linear equation: 

(value of “a” in Y = a + bX). 

Format: TANFITYINT(VX, VY, POS) 

VX = The name of any column (vector) listed under Columns. 

VY = The name of any column (vector) listed under Columns. 

POS = The row number (index) of the value where the tangent is to be found. 

Example: OFFSET = TANFITYINT(GATEV, DRAINI, GMMAX) 

Remarks: If a VX or VY value at POS is an invalid number (i.e., the value is #REF), the function will 
not return a valid result.  

 

TAR_YatX - Formulator function 
Purpose: Find y_tar in y corresponding to x_tar in x’s index 

Format: TAR_YatX(x, y, x_tar) 

x x array 

y y arry 

x_tar target x 

Example: y0=TAR_YatX(V, I, 0.1) 
 

TTF_DID_LGT - Formulator function 
Purpose: TTF means time to failure. In HCI test, you may want to analyze two arrays – time array and 
degradation (in percentage), and find the specific time corresponding to the aimed degradation. This 
is accomplished by choosing different fitting Models.  

In this formulator, the fitting relationship is built on time log scale and degradation of drain current. 

Format: TTF_DID_LGT(DID, T, START_POS, END_POS, GOAL) 

DID = degradation (in percentage) of drain current listed under Columns 

T= time array listed under Columns 

STARTPOS = For the range of T and DID values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of T and DID values to be fitted, the row number (index) of the ending 
values. 

GOAL = the aim degradation (in percentage) value. 

Example: F1= TTF_DID_LGT (I_DRAIN_DEG, TIME, 5, 11, 10) 

Remarks: If a T or DID value at pos is an invalid number (i.e., the value is #REF), the function will not 
return a valid result.  
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TTF_LGDID_T - Formulator function 
Purpose: TTF means time to failure. In HCI test, you may want to analyze two arrays – time array and 
degradation (in percentage), and find the specific time corresponding to the aimed degradation. This 
is accomplished by choosing different fitting Models.  

In this formulator, the fitting relationship is built on time array and log value of degradation of drain 
current. 

Format: TTF_LGDID_T(DID, T, START_POS, END_POS, GOAL) 

DID = degradation (in percentage) of drain current listed under Columns 

T= time array listed under Columns. 

STARTPOS = For the range of T and DID values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of T and DID values to be fitted, the row number (index) of the ending 
values. 

GOAL = the aim degradation(in percentage) value 

Example: F2 = TTF_LGDID_T (I_DRAIN_DEG, TIME, 5, 11, 10) 

Remarks: If a T or DID value at pos is an invalid number (i.e., the value is #REF), the function will not 
return a valid result. 

 

TTF_DID_T - Formulator function 
Purpose: TTF means time to failure. In HCI test, you may want to analyze two arrays – time array and 
degradation (in percentage), and find  the specific time corresponding to the aimed degradation. This 
is accomplished by choosing different fitting Models. 

In this formulator, the fitting relationship is built on time array and degradation of drain current. 

Format: TTF_DID_T(DID, T, START_POS, END_POS, GOAL) 

DID = degradation (in percentage) of drain current listed under Columns. 

T = time array listed under Columns. 

STARTPOS = For the range of T and DID values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of T and DID values to be fitted, the row number (index) of the ending 
values. 

GOAL = the aim degradation (in percentage). 

Example: F3= TTF_DID_T (I_DRAIN_DEG, TIME, 5, 11, 10) 

Remarks: If a T or DID value at pos is an invalid number (i.e., the value is #REF), the function will not 
return a valid result. 
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TTF_LGDID_LGT - Formulator function 
Purpose: TTF means time to failure. In HCI test, you may want to analyze two arrays – time array and 
degradation (in percentage), and find the specific time corresponding to the aimed degradation. This 
is accomplished by choosing different fitting Models. 

In this formulator, the fitting relationship is built on time log scale and degradation of drain current. 

Format: TTF_LGDID_LGT(DID, T, START_POS, END_POS, GOAL) 

DID = degradation (in percentage) of drain current listed under Columns. 

T = time array listed under Columns. 

STARTPOS = For the range of T and DID values to be fitted, the row number (index) of the starting 
values. 

ENDPOS = For the range of T and DID values to be fitted, the row number (index) of the ending 
values. 

GOAL = the aim degradation(in percentage) value. 

Example: F4= TTF_LGDID_LGT (I_DRAIN_DEG, TIME, 5, 11, 10) 

Remarks: If a T or DID value at pos is an invalid number (i.e., the value is #REF), the function will not 
return a valid result. 

VTCI(u, w, l, Id, Vg) 
 

VTCI - Formulator function 
Purpose: algorithm by using u, w, l to calculate Id_target. 

Format: VTCI(u, w, l, I_DRAIN,V_GATE) 

u: the current density 

w: the device width 

l: the device length 

I_DRAIN : the I_drain vector 

V_GATE: the V_gate vector 

Example: VTH1 = VTCI(0.001,1,0.03,I_DRAIN,V_GATE) 

Remarks: If an I_DRAIN or V_GATE value at POS is an invalid number (i.e., the value is #REF), the 
function will not return a valid result.  
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VTLINGM - Formulator function 
Purpose: Extrapolates threshold voltage from measurement of maximum slope of the ID-VGS curve, 
as below: 

Vth = VGS(@Gmmax)-ID(@Gmmax)/Gmmax 

Where, VGS(@Gmmax) is the gate voltage at the point of the maximum slope of the ID-VGS curve; 

ID(@Gmmax) is the drain current at the point of the maximum slope of the ID-VGS curve; 

Gmmax is the maximum slope of the ID-VGS curve. 

Format: VTLINGM(I_DRAIN, V_GATE) 

I_DRAIN is the drain current measured in test. V_GATE is the gate voltage.  

Example: VTH0 = VTLINGM(I_DRAIN, V_GATE) 

Remarks: DC bias voltages for Vth measurements are VDS = VDS_lin,  

VBS = VBB typically, for PMOS, VDS_lin=-0.1 V(@VDD=5V); for NMOS, 
 VDS_lin=0.1V(@VDD=5V). 

If a I_DRAIN or V_GATE value is an invalid number (i.e., the value is #REF), the function will not 
return a valid result.  

 

VTSATGM - Formulator function 
Purpose: Extrapolates threshold voltage from measurement of the IDS-VGS curve. In saturation 
region of MOSFET, Vth=Vgs(@Ids=0). 

DC bias voltages for Vth saturation measurements are  

VDS = VGS = VDD, VBS = VBB 

Format: VTSATGM(I_DRAIN, V_GATE) 

Example: VTH1 = VTSATGM(I_DRAIN, V_GATE) 

Remarks: If an I_DRAIN or V_GATE value at POS is an invalid number (i.e., the value is #REF), the 
function will not return a valid result.  

 

VT_SAT_TRI - Formulator function 
Purpose: Vt algorithm by triple divide Id square root curve. 

Format: VT_SAT_TRI(Vg_tar, Id, Vg) 

Vg_tar Target VG 

Id Measured Drain current 

Vg Measured Gate voltage 

Example: VT0 = VT_SAT_TRI(0.08, Id, Vg 
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Accessing the graph settings menu 
To view the Graph Settings menu, right-click on any portion of the graph (see next figure) 

Figure 398: Graph Settings Menu 

 

The Graph Settings Menu functions are summarized below: 

• Reset original view: Returns to the original size after zooming or panning. 
• Forward navigation view: Moves forward one step at-a-time when zooming or panning. 
• Back navigation view: Goes backwards one step at-a-time after zooming or panning. 
• Zoom to rectangle: Zooms in on the section of the graph that is within the drawn rectangle. 
• Plot pan: Moves the graph by dragging. 
• Plot and Axis Setting: Sets general properties of the selected graph and parameters of its axis. 

Many sub-functions are provided. For more information, refer to “Defining Properties of a Graph 
and Axis” later in this section. 

• Cursor Setting: Adds a cursor to a graph and sets the cursor properties. For more information, 
refer to “Defining Cursor” later in this section. 

• Line Properties and Fitting: Sets the properties of a selected line and makes the fitting if the 
cursors are set. For more information, refer to “Editing Line Properties and Making Fitting” later in 
this section. 

• Cursor to MIN: Makes the selected cursor find the minimum point of attached curves. 
• Cursor to MAX: Makes the selected cursor find the maximum point of attached curves. 
• Delete Selected Plot: The plot on which the menu is shown will be deleted from the graph sheet 

and the other plots will be resized. 
• Delete Selected Line: Removes a selected line from the plot. To delete a specific line, first click 

the line to be deleted, right-click, then choose Delete Selected Line from the menu.  

Do not move the mouse from the line during manipulation. 

• Delete Selected Cursor: Deletes the specified cursor. To delete a cursor, first click on the cursor 
to be deleted, right-click, then choose the Delete Selected Cursor menu item. 

Do not move the mouse from the cursor during manipulation. 

• Delete Selected Fitline: Deletes the specified Fitline cursor. To delete a Fitline, first click the 
Fitline (if any) to be deleted, right-click, then choose the Delete Selected Fitline menu item. 
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Do not move the mouse from the Fitline during manipulation. 
 

Define a graph and plotting 
There are two steps when defining a graph and plotting:  

1. Define the data to be graphed. 
2. Plot according to the data.  

Defining the Data to be Graphed 
There are two steps in defining data to be graphed: 

1. Setting the axis to data. 
2. Clicking the data to plot. 

Right-click on the title of any column in the Data sheet to display the Graph Definition Menu (see next 
figure). 

Figure 399: Graph definition menu 
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• Valid for Series: The Valid for Series command is used when your test is a multi-step test and 
there are a series of results, as shown above. If the command is selected, the following settings 
to any column in the series are valid for all other columns in the same series. For example, if 
column B (I_Drain(1)) is set as X, column D (I_Drain(2)) will be set automatically as X.   

• Set X: The selected column is set as the X Axis on the graph. 
• Set Y1: The selected column is set as the Y Axis on left side of the graph. 
• Set Y2: The selected column is set as the Y Axis on right side of the graph. 

To draw a graph, at least one X and one Y1/Y2 should be set. 

ACS supports multi-plot using one data sheet. This allows different columns to be plotted to different 
graphs. 

After an axis is set, you should choose data to be plotted on one graph. To choose data, click the title 
of a column and the column is highlighted.  

To choose more than one column, drag the mouse over the desired column, or click Ctrl+left-click on 
the desired column. At least one X and one Y1/Y2 must be selected. The next figure shows the 
results of choosing data. 

Figure 400: Result of data selection 

 

If the data has not been selected, click the plot function, an XY setting dialog will display (see next 
figure). Check the desired X-Y setting in this dialog. 

Figure 401: XY setting 

 

Plot according to data 
Click the Plot function from the toolbar to display the Plotting menu (see next figure). 

Figure 402: Plotting Menu 
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After clicking the data to be plotted, choose one of the following commands:  

Plot1: Draws a graph on plot1, which already exists. If plot1 is not blank, the original lines will remain 
instead of being deleted. 

New Plot: Draws a graph on a new plot separate from the existing one. 

If the test is run on a multigroup, the results of all groups under test are shown on one plot (see next 
figure). 

Figure 403: Plot shows two ids_vd plots 

 

Defining Properties of a Graph and Axis: 

Right-click on any portion of the graph to be edited, then choose the Plot and Axis Setting command 
from the Graph Settings menu. The Plotting Setting dialog box is displayed. It contains two tabs: On 
the left is the Plot Setting tab; and on the right is the Axis Setting tab. The next figure illustrates the 
dialog box displayed for each of the tabs described above. 

Figure 404: Plot Setting and Axis Setting 
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The Plot Setting dialog box contains the following settings: 

• Plot Title: Sets the title of the selected plot. 
• Legend Visible: If selected, the legend appears on the plot. 
• Legend Position: Clicks the position for the legend on the plot. There are many positions 

available. However, the recommended position choice is "Best." 
• Comments: Used to write comments for the selected plot. In a plot, you can click Ctrl and drag 

the comment with the mouse to move its position (see next figure). 

After choosing all of the settings, Click Save to apply the settings, or click the Cancel function to 
cancel the settings. The next figure is an example of a plot having a Title on top, Legend at the right 
side, and Comments at the upper left corner of the plot. 

Figure 405: Results after setting the Plot Settings 

 

Figure 406: Results of dragging comment 
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The axis setting tab contains three parts that corresponds to the settings of the X, Y1, and Y2 axis. 
The items in these three parts are the same for each axis. Only one axis is used in this example. The 
next figure shows all the items and sub-items for one axis on the Axis Setting tab. 

Figure 407: Items on the Axis Settings tab 
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Title Section - properties for the axis title: 

• Text: Edits the name of the axis.  
• Rotation: Rotates the title if necessary. The X axis default is 0; the Y1/Y2 axis default is 90 º 

rotations. 
• Scale section: Sets the scale of the chosen axis. 
• Auto: The scale of the axis is auto-scaled according to the data. Auto is the default setting. 
• Min: Sets the minimum value of the axis. Valid when Auto is deselected. 
• Max: Sets the maximum value of the axis. Valid when Auto is deselected. 
• Abs: Plots the abstract value of the data along the axis. 
• Log: If selected, the axis is arranged in logarithmic format; if not selected, the axis is arranged in 

linear format. The default setting for Log is linear. 

Log format can only be set to positive data. If there is negative data, checking Abs first will solve the 
problem. 

• Invert: sets former minimum value of the axis as maximum value and former maximum value as 
minimum value. 

Advanced Setting properties for setting the axis ticks: 

• Auto: Selected by default. Sets the Ticks automatically; the other settings are ignored. 
• Rotation: Rotates the ticks if necessary. 0 is used by default. 
• Formatter: Sets the format for the Annotation of the Ticks. Three formats are provided: Integer, 

Float, and Scientific. 
• Precision: Sets the precision of the Annotation and is valid when Float or Scientific format is 

chosen.  
• Major: Sets the major unit to mark ticks along the axis.  
• Tick per Major: Number of sub-ticks inside a major tick. 

After all of the axis ticks’ properties are set, click Save to apply the settings, or Cancel to cancel the 
settings. The next figure shows a series of Ic_Vce curves with marked features. 

Figure 408: Ic_Vce curves bearing features of Axis and Ticks 
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Defining a Cursor: 

Right-click on any portion of the plot and choose Cursor Setting from the Graph Settings menu. The 
Cursor Setting dialog box displays. The next figure shows the Cursor Setting dialog box and the 
cursors on the I_V curve of a diode. 

Figure 409: Cursor Setting and the Cursors on Curve 
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• Label: Chooses the cursor to be edited. You can choose from the existing cursors, but cannot 
change their names. 

• Type: Chooses the shape of the selected cursor. 
• Color: Chooses the color of the selected cursor. 
• Size: Edits the size of the selected cursor. 
• Attach: Chooses between Floating and certain curves. If Floating is set, the cursor can go 

anywhere on the plot, otherwise it can only run along the selected curve. 
• Add: Adds a new cursor. Once Add is selected, a new cursor appears in the Label. 
• Apply: Applies the settings. 
• Exit: Exits the active dialog box. If Apply is not selected before Exit, the settings are ignored. 

To apply the settings for the cursor, click the Apply function. After clicking Apply, the cursor displays 
on the plot. If you click the cursor, the coordinates (x, y) of the current position display at the bottom 
of the plot. 

Editing Line Properties and Making Fitting 

Click the line to be edited, then right-click to choose the Line Properties and Fitting command from 
the Graph Settings menu. The Line Settings dialog box displays (see next figure). 

Figure 410: I_V curve of a diode with linear fitting line and formula used 
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The figure above illustrates the original line (black) together with the fitting line (blue) without features. 
The formula used displays at the bottom left corner of the sheet.  

Properties of the line: 

• Color: Clicks the color of the line selected. 
• Style: Clicks the style of the line: Solid, Dashed, Dotted, and Dash-Dot. 
• Marker: Marks the data points. Clicks the type for the marker. 

Line Fitting: 

• Cursor1: The first cursor defining the segment of the line to be fitted. Click from the list. 
• Cursor2: The second cursor defining the segment of the line to be fitted. Click from the list. 
• Method: Clicks the function used to fit the segment of the line. Linear, Regression, Exponential, 

and Log. 
• Label: Shows the label of the fitting line. You cannot edit this label. 
• Color: Clicks the color of the fitting line. 
• Style: Clicks the style of the fitting line: Solid, Dashed, Dotted, and Dash-Dot. 

Only one original line can have one fitting line. If the number of plots on the graph sheet exceeds 
two, the formula will not display. After you complete the settings, click the Save function in the Line 
Settings dialog box to apply the settings, or Cancel to cancel the settings. 
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User Access Points (UAP) 

Understanding UAP 
The User Access Point (UAP) is a user-friendly management interface used to configure all test 
features. UAPs are supported to let users extend the features and functions of the Keithley-provided 
test execution engine at the device, subsite, site, wafer, and cassette levels. This is accomplished by 
executing either PTM (Python Test Module) or CTM (C language Test Module) at the entry or exit of 
each level of automation. PTM and CTM code has access to the results (data collected) and 
instrumentation (see next two figures). 

Figure 411: UAP execution example 

 

Figure 412: Test execution engine 
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With UAPs you are capable of performing several robust tasks: 

• Display user instructions 
• Log lot information 
• Notified by text message or e-mail to pager or cell phone of a failure or exit condition 
• Display custom status information 
• Log results 
• Format and write custom results files 

To customize the test execution environment: 

1. Create a C-code or Python module. 
2. Pair the modules with user access points (UAP). User access points begin at the end 

of…Programs, Lots, Wafers, Sites, and Subsites. 
 

Handling the UAP tree 
To access the UAP tree, right-click on the configuration navigator in the Test Setup panel. A display 
menu appears. Click the Show UAP Tree menu item (see next figure). 

Figure 413: Show UAP Tree 
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Several UAPs are provided, such as: lot_begin; lot_end; wafer_begin; wafer_end; site_begin; 
site_end; subsite_begin; subsite_end; device_begin; device_end; test_begin; test_end. To add a 
UAP, check the corresponding check box (see next figure). 

Figure 414: UAP Test tree setup 

 
 

Editing a UAP 
1. Click on a UAP in the UAP tree; an editing panel appears. 
2. Click Enable this Function to enable the Shell Command during the automation test. You can also 

choose the execution timing of the Shell Command (before or after the nested modules). The 
following directory is called before all nested modules (see next figure). 

Figure 415: UAP Shell Command editing panel 
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3. There are two kinds of modules that can be added: Clicking the New CTM icon will add a C 
module (the same as CTM), and clicking the New PTM icon will add a Python module. Click the 
modules in the UAP tree and the editing panel of that module appears. Once all the modules and 
Shell Commands are correctly set, you can go to the Automation function and click RUN (see 
next two figures). 

Figure 416: UAP CTM editing panel 

 

Figure 417: UAP PTM editing panel; edit in Python language 

 

The following table will give you the UAP global variable name, type, and the associated comment. 
These can be accessed in a UAP PTM.  
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UAP global variables 

Variable Name Type Comment 
ACS_frame string the frame of ACS 
ACS_uap_level string current UAP level 
ACS_proj_path string current path 
ACS_proj_name string current project name 
ACS_lot_id string current lot ID 
ACS_slot_no int current slot number 
ACS_wafer_id string current wafer ID 
ACS_pattern_id string current pattern ID 
ACS_site_id string current die ID 
ACS_site_coord tuple current die coordinates 
ACS_ssite_id string current subsite ID 
ACS_ssite_loop int current subsite index of subsite loop 
ACS_ssite_loopNum int total loop num of the current ssite 
ACS_ssite_coord tuple current die coordinates 
ACS_dut_id string current DUT ID 
ACS_test_id string current test ID 
ACS_test_data dictionary current test data 
ACS_kdf_head dictionary kdf file header information 
ACS_kdf_data list current wafer data 
ACS_wdf_head dictionary wdf header information 
ACS_wdf_nonexist dictionary wdf non-exist dices dictionary 
ACS_t_start string test start time 
ACS_t_end string test end time 
ACS_first_wafer bool whether it is the first wafer in one cassette 
ACS_last_wafer bool whether it is the last wafer in one cassette 
ACS_first_site bool whether it is the first site in one wafer 
ACS_last_site bool whether it is the last site in one wafer 
ACS_output_list list all test's output list 
ACS_temp_klf string temporary klf file location 
ACS_prb_errcode int prober error code 
ACS_operator string user name 
ACS_die_type string die type 
ACS_remark string remark in automation panel 
ACS_session_name string session name in automation panel 
ACS_equipment_id string equipment in automation panel 
ACS_fixture_id string fixture id in automation panel 
ACS_testplan_ver string test plan version in automation panel 
ACS_process_level string process level in automation panel 
ACS_userdata_path string full path of user data 
ACS_ptm_path string PTM directory setting in preference 
ACS_site_loop int current sub site index of subsiteloop 
ACS_site_loopNum int total loop num of the current site 
ACS_ktxe_exit int exit the execution of ktxe 
ACS_ktxe_loop_wafer int current wafer loop flag 
ACS_run_mode string indicate automation or manual run 
ACS_Stress_Time float The accumulated time for the stress 

measure loop. Changed to different value 
according to subsite loop number. 

ACS_Stress_Duration float Stress duration time for each subsite loop. 
ACS_Disable_Subsite_List list If sub-site name is in this list, the sub-site will 

be skipped. 
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ACS_ Disable_DUT_List list If device name is in this list, the device will 
be skipped. 

ACS_Disable_Test_List list If test name is in this list, the test will be 
skipped. 

 
 

Add an attribute using UAP 
In ACS, you can set attributes for the test setup by using a UAP. An attribute adds further analysis to 
the ACS test results. An attribute could be any of the following items: 

• Any data point within a sweep has the attribute of sweep variables. For a family of curves, the 
step value is an attribute. 

• Device related parameters, such as W, L, Area… 
• Global information, such as temperature, pressure, and any non-zero stress conditions  
• Physical locations can be considered an attribute as well. Such as HCI, the W, L, and VDrain can 

be set as attributes.  

There are two ways to set an attribute and it depends on the test module type. For example, a RTM 
or other types of test modules. The following will give you a detailed introduction on how to set an 
attribute for these types. 

Add an attribute for RTM 
For RTM, you can use the ACS_user_attributes. The UAP can be added at the test_begin level (see 
next figure). 

Figure 418: Set attribute UAP for RTM 
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You can assign ACS_user_attributes a fixed value or some desired attribute value. The next figure 
shows a fixed attribute value: attr_dict={‘ACS_W’:0.2, ’ACS_L’:0.5,’ACS_T’:120}. The attribute 
dictionary value must be formatted as {‘attribute_name1’:attribute_value1, 
‘attribute_name2’:attribute_value2,…} and the attribute_value1 must be a single data. 

Add attribute for other test modules 
Except for RTMs, you can also add attributes for ITMs, STMs, CTMs, and PTMs. In this case, the 
UAP must be under the lot_begin UAP level. There is also an example to show the information for 
setting an attribute (see next figures). Open this UAP, you will see the code lines. As shown in the 
next figure, the first line is for setting a fixed attribute value: attr_dict={‘ACS_W’:0.2, 
’ACS_L’:0.5,’ACS_T’:120}. The attribute dictionary value must be formatted as 
{‘attribute_name1’:attribute_value1, ‘attribute_name2’:attribute_value2,…},and the attribute_value1 
must be a single data. 

Figure 419: UAP tree for other test modules 

 

The other lines indicated in the next figure are attribute generated code. They have the same function 
as other attribute values (see next figure). 

Figure 420: Attribute setting information 
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Prober control functions 
The Prober control functions allow you to control prober station movements and display the probed 
sites information in realtime. Click the Prober Control function from the edit panel and the Prober 
Control panel displays with the Wafer Map tab open in the work area (see next Figure).  

Figure 421: Prober Control GUI 

 
 

Section 6 

Prober Control 
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Wafer map indicator in Prober Control mode 
In Prober Control mode, the Wafer Map Indicator opens in the work area (see next figure). 

Figure 422: Wafer Map Indicator in Prober Control mode 

 

The Wafer Map Indicator is used to optimize the sites list, set the evaluation/standard mode of the 
prober station, change and show the color settings, show the state of chucking-up or chucking-down 
the prober, and to show the coordinates of the current site. 

Optimization –   This function allows you to optimize the order of sites that are going to be 
probed. Click the Optimize function and the Site Sequence Optimization dialog box 
opens. You can choose from sixteen different sequences. Also, the default Sequence 
Priority is set to site first (see next figure). 

If you want to print a pattern ID in the Log Window Display, you will need to select pattern first in the 
Sequence Priority (see the Automation section for more details). 

Figure 423: Sites Sequence Optimization 
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When a sequence is selected, the tester starts at the site closest to the chosen location, and then 
proceeds to all selected sites on the wafer, following the selected serpentine sequence. Click OK 
when finished.  

• Fake –   This function is used to set the evaluation/standard mode of the prober station 
configured using the Configure Hardware command from the Tools menu. You can click and 
toggle between the two different modes. When the configured prober Model is Offline, the 
function is displayed as FAKE  . When Online, the function is the Model name, for instance, TSK9   
as an example.  

• Chuck Up/Chuck Down –    This information is used to indicate the raised or lowered chuck state 
of the prober. 

• Current Site: (X; Y) – This information is used to indicate the coordinates of the current site 
captured by the mouse movement. 

• Colors – This area is used to show and set the color of sites. There are three status indicating 
colors: Default site, Current site and Touched site.  

• Default –   This button is used to indicate the color of the default setting. You can change the 
default color setting by clicking this button.  

• Current –   This button is used to indicate the color of the current site the prober is probing. You 
can change the color setting of the current site by clicking this button.  

• Touched –   This button is used to indicate the color of sites which have already been touched by 
the prober. You can change the color setting of touched sites by clicking this button. 

 

Prober control panel 
To access the Prober Control Panel, click the Prober Control function from the edit panel (see next 
figure). 

Figure 424: Prober Control panel 
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• Initialize – Click this function to initialize the specified prober station. If the prober is initialized 
successfully, all Prober Control panel functions enable. If the initialization fails, all Prober Control 
panel functions disable. 

• Home – This function is used to move the prober to the target site defined in the Wafer 
Description.  

• Load – This function is used to load a wafer from the cassette onto the prober station. 
• Unload – This function is used to unload the wafer from the prober station back to the cassette. 
• Probe Sites – This function is used to move the prober to the selected sites continuously in the 

optimized sequence.  
• Interval – Determines the time interval between two continuous movements of the prober. The 

time unit is in seconds. 
• Step Move – There are eight blue arrow functions in Step Move, which can be used to control the 

prober station to move in different directions. Surrounded by the arrow functions, the green Chuck 
Up/Down function   is used to control the prober station to raise or lower the chuck. 

 

Moving to a site 
1. Click the Initialize function. If the prober is configured correctly, there will be no errors and the 

other functions on the Prober Control panel enable. 
2. Double-click the site you want to move to on the Wafer Map, or you can click the arrow functions 

on Step Move until you drive the prober to the destination site. 
 

Moving to a subsite 
1. Move to the desired site on the wafer map. 
2. From the configuration navigator, locate the subsite item where you moved in the previous 

section and right-click on that item. 
3. Click the Move to Subsite command (see next figure). 

Figure 425: Right-click Menu of Subsite Node in Test Setup 

 

 



 

 

In this section: 

Automation functions ................................................................ 7-1 
Automation panel ..................................................................... 7-2 
Cassette information box ....................................................... 7-19 
Preference settings ................................................................ 7-20 
Read current test data ............................................................ 7-30 
Wafer map indicator ............................................................... 7-31 
Starting an automation test .................................................... 7-33 
Automation process example ................................................. 7-36 

 
 

Automation functions 
After your configuration navigator has been set up and your wafer has been drawn, you can enter 
Automation mode to test all wafers in a cassette. To enter Automation mode, click the Automation 
function from the edit panel; the Automation panel displays (see next Figure). The Automation 
functions are discussed below. 

Figure 426: Automation GUI 

 

Section 7 

Automation 
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There are three tabs in the automation dialog box: 

1. The Wafer Map tab is the primary interface, and allows you to configure an automation test and 
display the current configuration and automation run-time information.  

2. The Data tab displays the test results in spreadsheet format and in real time as the test executes.  
3. The Status tab monitors the configuration status of automation. The Automation functions include. 

• Auto-test information – Auto-Test information is used to input some information related to the 
automation test. The information items include: Lot ID, User Name, Die Type, Test Process Level, 
Fixture ID, Equipment ID, Laser ID, Test Plan Version, and Remark fields. 

• Options – Used to customize the automation process. There are three options: Skip 1st Wafer Load, 
Single Wafer, and Unload Wafer after Test. 

• Cassette information – Used to indicate the wafer mounted status in the cassette, and wafer test status 
during automation, which slot is under the testing process and which slot has been tested completely. 
The Bottom-up check-box specifies how wafers are arranged in the cassette. By default, the 
arrangement of wafers is from top to bottom. You can reverse the arrangement by clicking the Bottom-
up check-box. 

• Run-time information – Used to indicate the run-time information, current site, current subsite, and 
current test module, etc. 

 

Automation panel 
While in the Automation panel, click RUN to execute an automation test. The automation test runs 
through the entire cassette. Test progress is refreshed in realtime in the Run Time information table, 
which is located in the upper-right corner. The following section describes the various parts of the 
automation panel (see next Figure). 

Figure 427: Automation panel 
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Automatic test information 
The Auto-Test information table allows you to input some necessary details related to the automation 
test process, such as: Lot ID, User Name, Die Type, Test Process Level, Fixture ID, Equipment ID, 
Laser ID, Test Plan Version, and Remark field. This information can be accessed in a UAP to 
generate customized data files (see next Figure). 

Figure 428: Auto-Test Info box 

 

You can see in the previous Figure that the Lot ID, User Name, Die Type, Test Process Level, Fixture 
ID, Equipment ID, Laser ID, Test Plan Version, and Remark items have been defined.  

All items are for information logging only, except two required fields: Lot ID and User Name. 
Information logging is optional. The meaning of the information logging can be user-defined, and will 
have no impact on the data file or other ACS operations. 

 

Automatic test options 
ACS provides three option to customize the automation process: Skip 1st Wafer Load, Single Wafer, 
and Unload Wafer After Test (see next Figure). 

Figure 429: Options in the Automation Panel 

 

• Skip 1st Wafer Load – Applicable for some prober Models such as TEL, which requires the first 
wafer on chuck to finish the manual alignment operation before the launch the automation test. 
Check this function when the first wafer is already loaded. 

• Single Wafer – This tests the first wafer only. The load and unload commands will not be 
performed when the Single Wafer check box is selected. This is specially designed for semi-
automated probers. 

• Unload Wafer After Test – Only applicable when a single wafer is selected. Checking this box 
unloads the wafer automatically upon completion of the wafer test. 
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Advanced toolbar 
The Advanced toolbar is used for advanced automation control features and configurations (see next 
Figure). 

Figure 430: Advanced toolbar 

 

Advanced Settings: Used to define advanced wafer settings. 

Binning Settings: Defines and enables realtime binning. The binning result displays in the wafer map 
during automation. 

Wafer Level Plot: Offline binning map, raw data and plotting curve. 

Real Time Plot Settings: Define the critical test items in test plan that should be monitored in real-
time. 

Show Real Time Plot Window: Only activates when the Realtime Plot setting is configured. When 
selected, predefined plotting curve(s) will be updated in real-time. 

Post-inking Settings: Enables the post-inking function. 
 

Advanced Settings 
In the Advanced Settings dialog box, you can rename the wafer ID and define the wafer to be tested 
in automation. 

When you click the Advanced Setting function, the ACS software automatically retrieves the slot 
status from the prober and shows all in-slot wafers in the Advanced Setting table (see next Figure).  

Figure 431: Advanced Settings 
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• Default ID – This function sets all wafer IDs (column Wafer ID) to default value. The default value 
is 01 to 25 (depending on the previous information loaded). 

• Apply Setting –The wafer ID can be edited. This function enabled all wafer IDs to the customized 
value after edit them. 

• Test All – This function is used to click all the in-slot wafers(Test Column). Once selected, all 
wafers will be selected for testing. 

• Clear All –This function is used to unclick all the in-slot wafers(Test Column). Once selected, all 
wafers will be deselected for testing. 

 

Binning Settings 
After running the automation test, the binning method measures certain user-specified parameters 
(limits) against the results of each semiconductor device test, and then places the device test into an 
appropriate category (or “bin”). For example, if the device tests below the user-specified limit, the 
device would be placed into a bin labeled, “Failed” (see next Figure). These binned wafers are then 
performance-tested. The remaining wafers are certified according to the results of their performance 
level and placed in a wafer bank for later use. 

Figure 432: Binning Settings 

 

There are two parts to the binning system setup:  

1. Binning Settings 
2. Wafer Level Plot 

Click Binning Settings icon to enter data (see next Figure).  
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General Settings 
Enable Binning Check: If selected, the Enable Binning Check and all the following functions activate. 
When activated, the Enable Binning Check feature runs a test on the devices, compares the results to 
the limits set by You, and places them in specific bins. Sites can be color-coded to distinguish 
between the various categories (Bins). In addition, a different color can be set for every site on the 
binning wafer map.  

Criteria: The drop-down list is Pass and Fail. Pass means that if all test results are within the Bin 
range (Low < = X < = High), the tested die will be placed in the Pass bin. Fail means that if the tested 
die does not fall within the Bin range (X < Low or X > High), the tested die will be placed in the Fail 
bin. 

Number of Bins: The drop-down list is 1 (highest priority), 2, 3, ... 15 (lowest priority). When clicking a 
number, the same amount of Bin tables will be generated. There are a total of 15 Bins supported. 
Each Bin has a priority level. Bin 1 has the highest priority level, and Bin 15 has the lowest. When 
binning, the software will check if it is in Bin 1 first, if not then Bin 2, then Bin 3... and so on up to and 
including Bin 15. If a tested die does not fall into any Bin category, it will enter All Bin Pass or All Bin 
Fail (see next Figure). 

Figure 433: Binning flow chart 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 7: Automation 
 

ACS-901-01 Rev. H / December 2014 7-7 

 

Names and Colors:  

• All Bins Fail/Pass Sites (1 Character only): Sets the name and color for all bin Fail/Pass criteria 
sites. For pass criteria, it will show All Bins Fail Sites. The default value is blank.  

• Invalid Sites (1 Character only): Sets the name and color for invalid sites. The default value is 
blank. 

• Deselect Sites (1 Character only): Sets the name and color for unselected sites. The default value 
is blank. 

Bin Tables 

• ID: Parameter id, defined as “parameter_name” + “@” + “test_name”. An “@test_name” string is 
appended to the end of the parameter name to distinguish between parameters from different 
tests. 

• Name: Parameter name. 
• Low/High: Defines the binning range for the corresponding parameter. The Binning operation 

uses this range. 
• Spec High/Low in limits table: Used to enter the low and high values that will determine if a die 

passes or fails during automation. The rest is shown on the wafer map in automation. This range 
is also used to generate a summary report. 

• Valid High/Low in limits table: Used to set an Exit Condition to tested die that falls out of the valid 
high/low range. If a test is out of range, a corresponding Exit action activates. This range is also 
used in the summary report. 

• High/Low in Binning table: Used to set the high/low parameters when binning is enabled. All 
wafer sites are assigned different bins according to the binning settings. When Binning is 
enabled, wafer map in Automation shows the binning result, rather than the pass/fail information 
with Spec High/Low. 

• Bin Parameters: Click the Bin Parameters function to click the desired parameters for binning 
operation. The Click Binning Items dialog box opens (see next Figure). 

To avoid possible errors when setting parameters, remember to consider the differences between 
Valid High/Low, Spec High/Low in the limits table, and High/Low in the Binning table.  
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Figure 434: Select Binning Items 

 

The listed parameters in the Select Binning Items dialog box originate from the test modules in Test 
Setup. 

After checking the parameters that will be used for binning, click OK to activate them. The selected 
parameters will be shown in the corresponding Bin table. The Low and High values will be loaded 
with the default settings (the first time) or from previously saved binning settings. 

• Bin Name (1 character only): Sets the name and color for current Bin. 
• Bin Pass/Fail color: Sets bins to different colors. 
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Bin Setting Procedure 
If binning is enabled, the binning information will show on the wafer map during automation. In 
addition, an optional binning file generates that transfers the results to the wafer level binning plot to 
detect locations with problems.  

For realtime binning operation, follow these procedures: 

1. Build one automation test project that runs properly. 
2. From the Automation panel, click the Advanced Binning Settings function in the Advanced group; 

the Binning Settings panel displays. 
3. Check "Enable Binning Check" to click binning. 
4. Choose the binning criteria based on Pass/Fail requirements. 
5. Choose the number of bins, from 1 to 15; Bin 1 has the highest priority, Bin 15 has the lowest. 

When binning, the software will first check if the results fit into Bin 1. If the results fit into Bin 1, the 
binning process advances to the next site to be tested. If the results from the test do not fit into 
Bin 1, the software will sequentially check the remaining bins for a fit. If the results do not fit into 
any bin, an All Bin Pass or All Bin Fail statement appears.  

If the testing results of a site are placed into a bin, the binning process advances to the next site to 
be tested. 

6. Click the Bin Parameters function in the bottom right corner and choose the desired parameters 
for accessing the bin. Then set the binning Low/High range. You must set each bin individually. 

7. Set the binning colors. Set the All Bin Pass Sites color. The All Bin Pass Sites color displays if a 
device does not fall into a bin. Then, go to Invalid Sites and Unselected Sites to set their bin 
colors. Next, set every bin color and name. 

After bin setting is complete, Click OK to run automation. The binning results are displayed in real-
time on the wafer map, and any location on the binning wafer with a problem detected and displayed. 

Binning demo case: 

1. Build a project by first clicking the STM named “random.” The random STM generates random 
data smaller than one and calculates an average value using the formulator. 

2. Click the Binning Settings   function to access the binning settings panel. 
3. Check Enable Binning Check in the Binning Settings panel, then click as follows: Criteria: Pass; 

Number of Bins: 5 (see next Figure). 
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Figure 435: Binning Settings example 
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4. For this demonstration, click the Bin Parameters function and then click the output 
“data@random” for every bin. 

5. Set the limits for every bin as: bin1[0,0.2], bin2[0,0.4], bin3[0,0.6], bin4[0, 0.8], bin5[0,0.95]. 
6. Set color for every bin: 5 bins; choose a different color for each bin. 
7. Click OK. 
8. Click the RUN function to run automation. Binning results display in real-time on the wafer map 

(see next Figure). 

Figure 436: Binning real-time results (example) 
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Wafer Level Plot 
As a result of the tests performed during binning, the wafer plots are assigned to specific categories 
for later use. Binning wafer plots are important to trace root causes for higher future yields. For 
example, from binning characteristics, engineers can collect data and correlate them with specific 
processes. This saves time and aids in finding root causes of problems. 

In this part, you can retrieve binning test results, trace the unwanted data, and get a desired site plot. 
Click the Wafer Level Plot icon (see next Figure). 

Figure 437: Blank Wafer Level Plot 
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Wafer Level plot definition 
The items in the Wafer Level plot dialog box are as follows (see next Figure): 

Select Lot: Click the Select Lot function, then open the desired .kdf file. After the file is loaded, the bin 
map of the first tested wafer shows (see next Figure). 

The selected .kdf file should be generated from the current test plan and should match the current 
test plan. 

Figure 438: Wafer Level Plot 
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Test time: Disabled in .kdf version. 

Wafer: The drop-down list clicks the binning tested wafer. The Prev Wafer button will move You to the 
wafer prior to the one selected in the drop-down list; the Next Wafer button will move You to the wafer 
after the one selected in the drop-down list. After you click a wafer, the bin map of this wafer is shown 
in the figure. 

Analysis Plotting and Analysis data sheet: This plotting supports the data plotting and site analysis. In 
data plotting, data is retrieved from all sites belonging to the current wafer. In site analysis plotting, 
data is retrieved from one selected site. Here, using the above case, “random,” is an example of one 
of the two types of plotting. 

The items in data sheet of the wafer level plot dialog box: 

• Lot Name 
• Wafer ID 
• Site ID 
• Bin value 

There are a total of 15 Bins supported, and the Bins have been prioritized. Bin 1 has the highest 
priority, and Bin 15 has the lowest. When binning, the software will check if it is in Bin 1 first, if not 
then Bin 2, then Bin 3... then Bin 15. If not in any Bin, it will enter All Bin Pass or All Bin Fail (see next 
Table). 

Bin Value Comment 
1,2,3,…15 Bin 1, Bin2,…Bin 15 
0 All bin pass (in fail criteria) or all bin fail (in pass criteria) 
<0 Abnormal result 

The erased site has no value in .kdf file, so it does not show here. But in binning file (.nbf file), the 
erased site’s value is 255. It is just a virtual number. 

For data plotting, set average value of random data “VALUE_AV” as axis Y1, then click the plot 
function icon. Click Plot1, and the average value of the random data from the wafer 1 test site is 
plotted (see next Figure). 
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Figure 439: Data plotting example 

 

Site analysis plotting: 

Select the Click Test to execute Site Analysis for the test module you want the performed . A dialog 
box will open (see next Figure). 

Figure 440: Site Analysis plotting 
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Select the test module you want to perform the site analysis, then click OK. 

Click the site in the bin map to show the plotting. The data of this plotting is shown to the right, and 
the selected site in the Analysis data sheet highlights in the data sheet at the bottom (see next 
Figure). 

Figure 441: Site Analysis plotting example 

 

If you do not see next Figure plot, verify whether a plot has been defined in the Data Sheet of Test 
Setup. After all the above steps have been taken, you can trace data and do site analysis. 

 

Real-Time Plot Settings 
The real-time plot settings define plots in the data sheet. 

1. Select the Realtime Plot Settings function; a dialog box opens (see next Figure).  

Figure 442: Automation Realtime Plot Settings 
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2. The configuration navigator shows the tests included in the automation. Check the tests whose 
plots need to be displayed in realtime. 

Allowed Total Plots: Indicates that the maximum number of plots is 36. 

Selected Total Plots: Shows the number of plots that have been selected. 

If save plot automatically is selected at the end of each site, the Realtime Plot Settings dialog box will 
automatically save the plotting curve to the “kdf” folder of the current project. Click OK to finish this 
step. 

Click the Show Real Time Plot dialog box function and a dialog box opens (see next Figure). You are 
now able to choose View Style and do basic operations. 

Figure 443: Real-time Plot 
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Post-inking 
• This feature is used for automation wafer inking after automation test. Only EG probers are 

supported. 
• The post-inking feature performs automation and inking separately. Before accessing the post-

inking function, you must first run the automation test and generate a data file and binning file. 
• Click the post-inking Settings icon (see next Figure). 

Only EG probers are supported for Post Test Inking. 

Figure 444: Post Inking Settings 

 

Description of the post-inking dialog box items: 

• Binning File: Indicates the binning file path. 
• Browse: Used to load the binning file. 
• Ink Bad (Erased) Die: Sets the erased die inking number. 
• Wafers in binning file: Lists binning wafer ID. 
• Option: Loads wafer mode option. 

The post-inking process: 

• Click Browse to load the specified binning file. 
• Set the number of the Bad (Erased) Die Inking No. 
• Choose Manual or Auto wafer load mode. 
• Use Run, Pause, Stop, and Exit to control the inking process. 
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Cassette information box 
Cassette information shows the run-time information of the wafers/slots in a cassette. There are four 
types (see next Figure). Move mouse over the wafer to get the wafer status. 

Figure 445: Cassette Info box 

 

• Selected Wafer (dark blue) 
• Unselected wafer or nonexistent wafer (purple) 
• Current Test Wafer (light blue) 
• Tested Wafer (green) 
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Preference settings 
The Preferences settings may be accessed from the Tools menu option (see next Figure) and are 
used to apply customized settings before automation testing.  

Figure 446: Preferences function in Tools menu 
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The options include clicking data file paths, data file formats, Auto-Test information fields, etc., is the 
graphic depicting the Preference Setting dialog box (see next Figure). 

Figure 447: Preferences settings 

 

There are four tabs in Preference Setting dialog: 

• Path 
• Misc 
• Automation Settings 
• Advanced 
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Preference settings path tab 
Project Repository – The project repository path. You can also press the associated Browse button  
to click another project path. 

Auto-Load Project – Sub-list the auto load project path when launching ACS, including the last loaded 
project, default project, and none. 

Default Project – The default project path. This field and the associated Browse button are only 
accessible when the “Default Project” option is selected in the Auto-Load Project list. 

Summary Reports Path – The summary reports path. You can also press the associated Browse 
button  to click another path. 

TSP Library Path –The TSP library path. You can also press the associated Browse button  to click 
another path. 

User Data Path – Used to set the binning file and data file path. The User Data Path will be saved as 
software parameter. This path can be read in a UAP, letting a user put the data file in this path. It may 
also be read by Convert Data dialog as a default output data file path (see next Figure). You can also 
press the associated Browse button  to click another path. 
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Figure 448: Misc tab of Preferences settings 

 

PTM Path – Set the PTM library path. You can also press the associated Browse button  to click 
another path. 
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Miscellaneous (Misc) tab 
Reset wafer map after adjust die site – Apply the check to reset the wafer map if the die size is 
adjusted in the Wafer Description. Checked by default. 

Wafer Shape – Customize the wafer shape to either Circle (the default) or Square. 

SMU Remote Sense – Click the remote sense operation of the indicated SMU(s); typical for the four 
wire test of a resistor. 

Check all – Selects all the SMU Remote Sense boxes (these are deselected by default). 

Auto Delay – Select to enable the auto delay function of the Model 2635A or 2636A in an ITM or 
RTM. 

Initiate Unused SMU – Only used for RTM and ITM’s SMU. There are three states for the initiate 
unused SMU, Default, High Impedance, Force Current 0A.  

Default : OUTPUT_NORMAL OFF mode. Selected by default and it outputs 0 V when the output is 
turned off. 

High Impedance : HIGH_Z OFF mode. Zero the output (in either volts or current) when off. 

Force Current 0A: 0A at ON mode. Force the output current 0 amps and turn on the output. 

Clear? – Used to clear old scripts in Series 2600B SourceMeter instruments when a project is opened 
and the automation is run.  

Prober Movement intervals (ms) – The interval time between each prober movement in the 
automation test. The default value is 0 µs. 

S4200 IP address – Model 4200-SCS IP address (for when S4200 remote control is required). 

If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the 
Series 2600B and Series 2400 instruments in the system will be set to four-wire (4-W) mode when 
executing a test. Also, the SMU Remote Sense option box in the Preferences settings Misc tab will 
be disabled. When all the matrices are set to Local Sense, all of the Series 2600B and Series 2400 
instruments in the system will be set to two-wire (2-W) mode when executing a test. It is highly 
recommended that all the matrices in the system are in the same mode. For more information on 
how to configure a matrix, refer to the ACS Hardware Configurations section. 
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Automation setting tab 
Only the Lot ID and User Name fields are required, other fields are for information logging and are 
optional. The Auto-Test information table can be modified (see next Figure). 

Figure 449: Automation Settings tab 
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The Auto-Test Information items can only be modified in engineering mode. 

Items on Automation Setting tab (see previous Figure) are listed below: 

User mode – Allows the user to click either Engineering mode or Operator mode. 

Automation Information– Any deselected items will not be shown in the Auto-Test Information table. 
You can also assign the default value in the edit box (to the right) for each item. For example, 
deselect the ‘Test Process level’, ‘Fixture ID’, ‘Equipment ID’, and input Lot ID value, run ACS; these 
modifications can be reflected in Auto-Test Information table(see next Figure). 

Figure 450: Automation Settings 
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Save Test Data to Data Base – Check to save automation test results data to the database. Checked 
by default. 

Save Test Data to KDF file – Check to save automation test results data to a .kdf file. Checked by 
default. 

Do Not Remove Old KDF Folder When Overwrite – Check to prevent the old KDF folder from being 
removed when a new project is run. Unchecked by default. 

Save 2D array data to separate file – Selected to save the two dimensional array data of the 
automation test to separate KDF files. Selected by default. 

Save 2D array data to KDF file – Selected to save the two dimensional array data of the automation 
test results data to one KDF file... 

Prefix/Postfix – Allows the user to specify a prefix and postfix to be applied to the data file. After 
creating a prefix/postfix, in the Advanced Settings dialog of the Automation Panel, click Apply Settings 
to accept the new wafer IDs. 

Generate Test Data File (.kdf file) Each Wafer – Once checked, the software generates a .kdf file for 
each wafer (unchecked by default). Only one .kdf file generates during automation. 
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Advanced tab 
Parallel Execute Group In – you have three choices: Test, Device, and Subsite (see next Figure). 

Working Mode – you have two choices on the drop-down arrow: local mode or network mode. The 
network option is for server/client mode (for more information, refer to the Server Solution section). 
The local mode option is the default (see next Figure). 

Log Window Display Level – you have three choices: INFO, WARNING, and ERROR to show the log 
message. The log level configuration will be effective immediately (see next Figure). 

Show Prober Status on the LogWindow – when you select this option, the prober control information 
will display on the log window. 

Figure 451: Advanced tab settings 
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If you are using the UAPs in a module and you want to print wafer ID and pattern ID information in 
ACS, you will have to choose the radio button INFO in the Log Window Display Level of the 
Advanced tab. You will also have to click on the Optimization function of the Wafer Map tab (see 
next Figure). 

Figure 452: Optimization function on Wafer Map tab 

 

Once you select Optimization, the Site Sequence dialog box opens. This is where you select pattern 
first in the Sequence Priority to ensure that your pattern ID is displayed in the log window when you 
print from the UAPs of your module (see next Figure). 

Figure 453: Pattern first in Sites Sequence Optimization function 

 

The default Sequence Priority is set to site first. 
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Read current test data 
Select Read Current Test Data from Tools drop-down menu, the Read Current Temporary Data 
dialog will display (see next two Figures). 

Figure 454: Read Current Test Data in Tools Menu 

 

Figure 455: Read Current Temporary Data 
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Click the Browse button to specify the .tmp file. Once the target file is found, click the Read button to 
display the Show Current Temporary Data dialog (see next Figure). 

Figure 456: Show Current Temporary Data 

 
 

Wafer map indicator 
During the Automation Test, the information in the Basic Monitor Items table will be updated 
automatically to show the current running information (see next Figure). 

Figure 457: Basic Monitor Items table 
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The Wafer Map Indicator is used to optimize the sites list, set the Offline/Online mode of the prober 
Model, change and show the color settings, and to show the coordinates of the current site (see next 
Figure). These functions are discussed below: 

Figure 458: Wafer map indicator 

 

Optimization – Optimizes probing path of selected sites to minimize the prober moving time. You can 
choose from 16 different sequences. When a sequence is selected, the tester starts at the site closest 
to the chosen location and then proceeds to all selected sites on the wafer, following the selected 
serpentine sequence. 

This function is used to set the Offline/Online mode of the prober Model configured using the 
Configure Hardware command from the Tools menu. You can toggle the function to switch between 
the two different modes. When the configured prober Model is Offline, the function is displayed as 
FAKE. When Online, the function is the Model name, for instance TSK9. 

Current Site (x, y) – This information is used to indicate the coordinates of current site pointed to by 
the mouse/cursor. 

Current Site – This function is used to show and set the color of the current site on which the prober 
is probing. You can change the color setting of the current site by clicking this function. 

Pass Site – This function is used to show and set the color of those sites that have already passed 
testing. In the passed state, all test modules in the site have qualified output values validated by the 
pre-defined limits. You can change the color setting of a passed site by clicking this function. Fail Site 
– This function is used to show and set the color of those sites that fail to pass testing. In the failed 
state, all test modules in the site do not have qualified output values validated by the predefined 
limits. You can change the color setting of failed sites by clicking this function. 
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Starting an automation test 
1. Click the Run function on the toolbar to start an automation test. The automation test is launched. 
2. Click the Pause function   on the toolbar to pause the automation test. 
3. Click the Stop function   on the toolbar to stop the automation test. 
4. You can view a Summary Report of the test execution using the ACS Summary Report functions. 

These functions are discussed in “Summary Report Panel” later in this section. 

The data file or data file folder name is derived from the Lot ID that is assigned by you before the 
automation test. Therefore, if the data file already exists, the KDF File or db file Exist dialog box 
opens you can choose to backup the file (see next Figure). 

Figure 459: KDF File or db folder Exists 
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The results of an automation test are saved into a *.kdf file (Keithley Data File) or a data base file (db 
folder file) automatically. You can also click these two saving formats in the Tools->Preferences 
options dialog box (see next Figure). 

Figure 460: Preference Setting_Automation Setting tab 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 7: Automation 
 

ACS-901-01 Rev. H / December 2014 7-35 

 

A Keithley data file (.kdf) contains the following items: 

Head part contains: 
"typ"   : type and version, 
"lot"   : lot ID, 
"prc"   : process ID, 
"dev"   : device ID, 
"tst"   : test program name, 
"sys"   : tester name, 
"tsn"   : tester number, 
"opr"   : user name, 
"stt"   : start time, 
"sk1"   : search key 1, 
"sk2"   : search key 2, 
"sk3"   : search key 3, 
"lmt"   : limit file name, 
"wdf"   : wafer description file name, 
"com"   : comment 
<EOH> 

Data part contains: 
wafer_id, split, boat, slot 
site_id, coordinate_x, coordinate_y, bin_value 
data_id,test_value 
... 
<EOS> 
... 
<EOW> 
... 

The data_id part can contain from three to four parts, which are separated by the following symbols: 
¡°@¡± sign. For example, output_name@test_name@sub_site[@GROUP_ID], and the group id (the 
fourth part) is optional. 

If more than one group is in the test, the group_id will be added into the data_id. 
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Automation process example 

Example 1: Binning and post-inking 
This example shows a typical operation flow of automation with real-time binning and post-inking.  

1. Click File > New, then click the New Project function to start a new project. A dialog box appears 
(see next Figure).  

Figure 461: New Test Project 

 
 

2. Input the desired name of the project and appropriate information, then click OK. 
3. Click Wafer Description on the left side of the panel. Input the wafer parameter information as the 

wafer under test (see next Figure). 

Figure 462: Wafer Description panel 
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4. Click Test Setup. You can now set up your own test plan. There are several test modules 
available: ITM, STM, CTM, and PTM. Select the module that you want to run (see next Figure). 

5. Right-click the module on the configuration navigator and select Show UAP Tree (see next 
Figure). 

Figure 463: Access UAP tree 

 
 

6. The UAP window will open (see next Figure). 

Figure 464: Available UAPs 
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7. Select the Lot end UAP, then add two Python modules to the configuration navigator (see next 
Figure). 

Figure 465: UAP and test tree management 
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8. Import binning modules from the ACS UAP library: NBF.py and NDF.py. Also, if desired, you can 
write your own binning customized PTM module, then click Save (see next Figure). 

You should use the NBF to generate binning files for the wafers in a cassette. It must be put at LOT 
end UAP. Also, you should use the NDF to generate data files for wafers in the cassette. It must be 
put at LOT end UAP.  

An NBF file contains the following items: 

Wafer header part contains: 
<WAFER> 

WAFER ID: wafer01 
TEST SESSION NAME: operator 
LOT ID: lot01 
EQUIPMENT ID: Keithley S500 
FIXTURE ID:   
TESTPLAN NAME: demo 
TESTPLAN VERSION: 1.1 
TEST PROCESS LEVEL: T4 
FLAT REGION: 180 
DIE SIZE X (mm): 5.65 
DIE SIZE Y (mm): 0.75 
COORDINATE QUADRANT: 1 
REFERENCE DIE X: 4 
REFERENCE DIE Y: 15 
TEST OPERATOR: TL 
TEST START TIME: 07-May-2009 14:36 
TEST END TIME: 07-May-2009 14:36 
 

Bin value part contains: 
site_coordinate_x, site_coordinate_y, bin_value 
... 

</WAFER> 
... 

An NDF file contains the following items: 

Header part contains: 
<HEADER> 

TEST SESSION NAME:   
LOT ID: lot1 
WAFER ID: wafer01 
EQUIPMENT ID: Keithley S500 
FIXTURE ID:   
TESTPLAN NAME: 36mm FET Jun 
TESTPLAN VERSION: 1.1 
TEST PROCESS LEVEL: T4 
FLAT REGION: 180 
DIE SIZE X (mm): 5.65 
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DIE SIZE Y (mm): 0.75 
COORDINATE QUADRANT: 1 
REFERENCE DIE X: 4 
REFERENCE DIE Y: 15 
TEST OPERATOR: TL 
TEST START TIME: 07-May-2009 14:36 
TEST END TIME: 07-May-2009 14:36 

</HEADER> 
Data part contains: 
<DATA> 

<WAFER> 
wafer_id 
 <SITE> 
 site_coordinate_x, site_coordinate_y 
 output_name,test_value 
 ... 
 bin, bin_value 
 </SITE> 
 ... 
</WAFER> 
 ... 

</DATA> 

Figure 466: Importing a PTM file for UAP 
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1. After you have built the test setup, navigate to the Automation panel. Input the appropriate 
operation information, such as Lot ID, User Name, Die Type, and Remark (see next Figure). All of 
the operation information prints in the resulting data file (.kdf, .NDF). 

Figure 467: Automation setup panel 

 
 

2. After all the above steps have been completed, click save, then click the Run function to initiate 
the Automation process. ACS automatically loads all the wafers and runs the desired tests. All 
test data and the binning results are saved in the .kdf file. 

3. After the test ends - because lot_end UAP is enabled - the two PTM modules will execute. .NBF 
and .NDF files will be written according to the data in the .kdf file. This will take some time, 
depending on your computer speed. Wait until ACS finishes this procedure, which is signified by 
the Run function turning from a color to gray.  

4. The .NBF and .NDF files are ready for post-inking. Navigate to the post-inking dialog and browse 
for the .NBF file.  

5. In the Manual Load Wafer mode, a dialog displays to inform you to load the wafer with a specified 
wafer ID. Follow the dialog prompts, loading the correct wafer (see next Figure). 

Figure 468: Browsing for the .nbf file 
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Example 2: Stress migration 
In the stress migration (SM) test, another challenge is that you would like to see the data in real time 
during automation, and determine whether to stop the test automatically if a number of consecutive 
sites failed on one parameter (in case of a bad probe pin). So the automation logic needs to be 
changed as well. In ACS, you can change the process flow (or, operation flow) in order to see the 
data in real time. 

Operation flow 

1. Create a new project. 
2. Import the SM comma separated value (.csv) setting file. 
3. Confirm the .csv data. 
4. Set the wafer map and click the site to be tested in the wafer map. Save the project. 
5. Run automation. 
6. Temporarily halt the test when x number of consecutive die fails.  
7. Check the data in wafer map data tab. 
8. Check the Pass/Fail in wafer map. 
9. The first four steps are detailed in the previous section Importing a custom setting project file.  

Create a new project for SM 

For each .csv file, it is better to create a new project. From the ACS menu, choose File->New, and 
ACS will show the dialog below. Enter the Project Name to make a new project in ACS (see next 
Figure). 

Figure 469: Create a new project for SM 
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Import the SM .csv setting file 

From the ACS File menu, click Import-->Test Plan File(*.csv) (see next Figure). 

Figure 470: Select stress migration .csv file 

 

Confirm the .csv data 

After the .csv file is selected, ACS will show the ImportDataConfirm dialog box (see next Figure). 
Confirm the data file is the desired test file, then click OK to move to the next step. 

Figure 471: Import Data Confirmed 
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There are two import modes: 

1. Refresh - replace existing one if they are same in test configuration navigator. 
2. Append - append in test configuration navigator. 

After you import the .csv data file, the test configuration navigator, including the SM script test 
modules, is created automatically (see next Figure). 

Figure 472: Test setup tree including SM script test modules 

 

Setup wafer map 

Next, you will be ready to setup the wafer map and the site to be tested (see next Figure). 

Figure 473: Setup wafer map and site to be tested 
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Run Automation 

After you have setup the wafer map, you can run automation (see next Figure). 

Figure 474: Run Automation 

 

Temporarily halt the test when x number of consecutive die fails 

An x number of consecutive die is read from .csv file. If that x number is greater than 0, ACS will 
check the rule automatically. 

When consecutive dies fail and reach the setting number x, you will see next Figure a dialog box (see 
next Figure). Click Yes to exit the test, click No to continue. 

Figure 475: Run Automation complete 
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Check Testing Data In Wafer Map Data Tab 

The displayed testing data can be updated when switching from wafer map to data tab. You can click 
the Refresh function to update data. This tab can display one wafer test data (see next Figure).  

Figure 476: Check testing data in Wafer Map Data tab 

 

You can click to save the whole wafer data to .csv file when that wafer test is complete in the 
Preference Settings. You also can click Save To .csv to save the current data to a .csv file.  

Check Pass/Fail in Wafer And Bin Plot panel 

You can check pass/fail based on Subsite or Device selection when testing is in process. When you 
click Subsite or Device, the wafer map will be updated, however, it cannot be updated dynamically 
without selection (see next Figure). 

Figure 477: Check Pass_Fail in Wafer Bin Plot 
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Example 3: Save a .csv file 
Create a new project: 

1. From the ACS menu, click File->New. The ACS software will display a dialog box where you must 
enter a Project Name to make a new project (see next Figure).  

Figure 478: Create a new project 

 

2. Add a new device and test module.  
3. Add a new device that is a Series 2600B SourceMeter instrument.  
4. Add a new ITM test module and configure its settings.  

Selected test sites: 

Click the Patterns, and click some sites in the Wafer Map (see next Figure). 

Figure 479: Selected test sites 
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Click test wafers 

1. Click the Automation panel and open the Advanced Settings dialog. Click the Wafer 01 and Wafer 
02, and then click OK and Save this project (see next Figure).  

Figure 480: Selected Test Wafer 

 

2. Set the Lot ID and Operator, and choose the way to save the .csv file.  

There are three ways to save the .csv file (see next Figure).  

a. Automatically save to .csv file after each wafer  
b. Automatically save .csv file after each site  
c. Parameter in Column  

Figure 481: Three ways to save a .csv file 
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Run the project: 

Run this project and you can see that the displayed testing data can be updated when switching from 
the wafer map to the data tab (see next Figure). 

Figure 482: Testing data in the Wafer Map Data tab 

 

Test results are saved in a .csv file: 

1. After the run is finished, in the …\ACS\Projects\test\kdf, there is a folder named like this 
xxx_WaferInfo (xxx is Wafer ID‘s name). Open this folder, there are two folder and two .csv files 
(see next Figure).  

Figure 483: The save data folder 

 

The .csv files are created by checking the Automatically save to .csv file after each wafer. 

2. Click two wafers in step 4, so two .csv files are created, the data are saved after each wafer. 
Open Wafer_1_20080529092635.csv (see next Figure). This wafer contains four test site, as 
shown in H,I, J,K row. 

Figure 484: The .csv file saved after each wafer 

 

The folder Wafer_1 and Wafer_2 are created by checking the Automatically save .csv file after each 
site.  

3. Open folder Wafer_1, you can see four .csv files (see next Figure). Because you selected four 
test sites in step 3, there are four .csv files, which are created after each site. 

Figure 485: Open the Wafer_1 folder 
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4. Open a .csv file in …\ACS\Projects\test\kdf\test_WaferInfo\Wafer_1 (see next Figure). This .csv is 
saved after each site, so there is only one site. 

Figure 486: The .csv file saved after each site 

 

Check the Parameter in the column: 

1. Check the Parameter in column in the data tab, save and run this project again. Then open the 
Wafer_1_20080529104534.csv in the …\ACS\Projects\test\kdf\test_WaferInfo (see next Figure). 

Figure 487: The .csv file saved after each wafer and parameter 

 

You can see the Parameter in column F (see next Figure), is the same as rows 1 – 5 of column A in 
previous Figure. 

2. Open Site_n1p1_20080529104534.csv\\ACS\Projects\test\kdf\test_WaferInfo\Wafer_1 (see next 
Figure). 

Figure 488: The .csv file saved after each site and parameter 

 

You can see the Parameter in the column (see next  two Figures) is the same as the rows in the 
Deselect a parameter in a column Figure. 

Figure 489: Select a parameter in a column 

 

Figure 490: Deselect a parameter in a column 

 

All saved test results reported are based the times checked in the limits page. 
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Statistics introduction 
Statistics is the science of making effective use of numerical data relating to groups of individuals or 
experiments. It deals with all aspects of this, including not only the collection, analysis and 
interpretation of such data, but also the planning of the collection of data, in terms of the design of 
surveys and experiments.  

Statistical methods can be used to summarize or describe a collection of data. This is useful in 
research, when communicating the results of experiments. In addition, patterns in the data may be 
modeled in a way that accounts for randomness and uncertainty in the observations, and are then 
used to draw inferences about the process being studied.  

Using the Automated Characterization Suite (ACS) statistics feature, you can create an output file in a 
Keithley data file (.kdf). This feature also supports multiple .kdf files. By using this feature, you can do 
simple analysis on test results and make necessary adjustments and modify test conditions. 

Additionally, you can view the online data plot results while ACS testing is in progress. 
Run-time monitoring 

When ACS is running, you can do the statistical analysis at the same time. This will save you time 
and allow you to find any problems in the run-time monitoring. While in online mode it allows you to 
automate all reports (including the statistical analysis), as well as notify you of abnormal yield levels 
or parameters that are not within specifications. Parameter specifications that are monitored in run-
time include: semiconductor test results; mean; sigma; range levels, etc. 
Broad statistical analysis range 

ACS can perform statistical analysis on your semiconductor data, from analyzing a mean, median, or 
sigma. Using the built in editor, that has many filtering options, you can change the data and 
immediately see the effect on mean, median, sigma, or range. The built in report lets you easily find 
the optimal parameter test limits. 
Easy data import and control 

You can start the semiconductor data analysis by either manually selecting the test data files from 
ACS for semiconductor characterization statistical data analysis, or using the running data 
automatically. ACS offers a very easy and flexible interface to select test data files and filter the 
information to process for your semiconductor characterization or production analysis. When 
leveraging the ACS built in .kdf file, you can review the data file headers at insertion time.  

 

Section 8 

Statistics 
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Required files 
Keithley data files (.kdf) for all plots when ACS is not running. 

 

Statistics limitations 
1. Only supports the .kdf files for statistical analysis and does not support database. 
2. Only supports the common statistical modeling analysis.  
3. Does not support the ability to compare the history data with the online data. 
4. Supports all the test modules except PTM when ACS enters demo mode. 
5. Not compatible with previous versions; only supports ACS version 4.2 and higher.  

 

Statistics settings 

Statistics configuration 

You will need to select the plot type first, then configure the plot settings. Depending on the type of 
plot, the settings may differ between the selected plots. There are five different plot types: Wafer 
Mapping; Trend; BOX; Histogram; CDF (see next Figure). 

Figure 491: Plot types 
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Here are the basic steps you need to follow when running a statistical analysis. 

You should setup Run-Time Settings when you want run-time analysis. To do this, click the box 
Enable Run-Time (see next figure), and you can specify the variables you want to analyze. If you 
want to create statistics offline, you do not need to do Run-Time Settings. 

Figure 492: Run-Time Settings and Enable Run-Time 

 
 

1. Select the plot type and configure the plot settings (see next figure): 
2. Click the Update Plot function. 
3. Repeat as necessary. 

Figure 493: Statistics panel 
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Two modes are supported for statistical analysis. The data used in the two modes is from different 
sources:  

1. Run-Time 
• The plot will be refreshed from memory data when ACS is running and you use the Run-Time Settings 

function. 
2. Offline 

• The plots show the results of the selected .kdf files. You will need to select the .kdf files that you want to 
analyze. 

No matter what mode, the plot will be refreshed after clicking Update Plot. 
 

Statistics operations 
The following steps show you how to do simple statistical analysis and must be done in the order as 
described. 

If you want to analyze a test in Run-Time mode, you must click the Run-Time Settings function and 
choose Enable Run-Time. Then you must choose the devices you want to analyze in the 
configuration navigator (see next figure): 

Figure 494: Run-Time Settings of Statistics 
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If you are in evaluation mode, you must import the data file (.kdf) that you want to analyze. 

1. Select the plot type you want to analyze. 
2. Choose the Settings that you need, based on the plot type. 
3. Click the Update Plot function. 
4. Repeat these steps as many times as necessary (see next figure). 

Figure 495: Statistical operation flow chart 
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Plot types 
There are five plot types available in the statistics feature. The parameter settings depend on the plot 
type selected (for example, Wafer Mapping, Trend, BOX, Histogram, and CDF). 

There are different tabs available for each plot type. For example, the Wafer Mapping plot contains 
WaferMapping and data. If you select the Histogram and/or NormalCDF on property settings, you will 
have these plots available, as well as clicking the Update Plot function. Note that it is also possible to 
export data from the data tab to a .csv file by right-clicking on the data (see next figure). You can 
also copy the selected data. 

Figure 496: data tab Export 
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Wafer Mapping plot 
The Wafer Mapping plot is able to rapidly and automatically create a map of the entire wafers with the 
testing results displayed. This enables rapid process feedback early to avoid adding expense to 
wafers, or portions of wafers, that may have poor yields. It also provides rapid feedback to the 
fabrication process, allowing you to make adjustments to the process to improve the overall yield. 

The Wafer Mapping plot works at the site level, as one site on the wafer map is displayed by one 
state. That means only a single data point comes from every site for the selected variables that are 
used in the wafer mapping statistic function. You will have to locate the variable value by location, 
such as lot, wafer, or device, for the RTM, including the subdevice, and then switch the wafer to view 
the site distribution.  

You can view the Histogram and CDF plot at the same time, if desired. Use the settings to determine 
your parameters.  

Wafer Mapping parameters 
After choosing the Wafer Mapping plot type, the parameters you need to configure are KDFs,Wafer, 
Location, Variable, Bin Info, and Property. 

Set the Wafer Mapping Settings 
1. Click the ellipsis next to the KDFs function to add a file (see next figure). 

Figure 497: Wafer Mapping GUI settings 

 

After you click the ellipsis, you will need to click the Add function (see next figure). 

Figure 498: Add KDF files 
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Once you click Add, you will have to choose the KDF file that you want to upload (see next figure). 

You can select more than one KDF file by pushing the Ctrl key plus clicking with your mouse and 
selecting one file at time, or pushing the Shift key plus clicking your mouse to select several files that 
are in sequence. 

Figure 499: Choose KDF file 

 

1. Choose the Wafer from the drop-down list (see next figure). 

 

Figure 500: Trend parameters Wafers selection 
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2. Choose the test module Location (see next figure). 

Only one Location can be selected. 

Figure 501: Wafer Mapping parameters Location selection 

 

3. Choose the Variable from the drop-down list (see next figure). 

Figure 502: Wafer Mapping parameters Variable selection 
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4. When you select the Bin information parameter, a dialog box opens where you must input the 
desired parameters. For example, you must enter the desired start point value and stop point 
value. The Print (True) option will print the data on the WaferMapping. Additionally, you can 
import settings or export settings that you have created (see next figure). 

Figure 503: Wafer Mapping Bin info parameter 

 

The Bin Settings can be saved to a .csv file and uploaded at a later time for testing purposes. Once 
you input all the desired parameters for your Bin (color, minimum and maximum value, and number 
of bins), you must choose OK to continue, or choose Cancel to end. 

5. Select the ellipsis next to the Property item to enable the advanced settings (see next figure). 

Figure 504: Wafer Mapping parameters Property 
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Histogram: (True) Generates a histogram of the data when you click Update Plot. 

Normal CDF: (True) Generates the cumulative distribution function plot when you click Update Plot. 

Scientific notation: (True) Enables the Wafer Mapping data to display in scientific notation. 

Precise place: Sets the number of effective digits of the data displayed in the Wafer Mapping.  

1. After you have set all of the parameters, you must click the Update Plot function to see the 
newest plots (see the next figures). 
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You can select both the Histogram and NormalCDF plot. After you update the plots, the Wafer 
Mapping viewing area will contain a tab for each plot (see the next figures). 

Figure 505: Histogram plot pane 

 

Figure 506: NormalCDF plot pane 

 

In the wafer mapping plot, you can save the plot by clicking on the save icon (see next figure). 

Figure 507: Wafer Map Plot icons 
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• Bin Value: saves the coordinates and values of all the sites to a .vbf file. If the site contains no 
data, the value is -1 by default. 

• Bin NO (Bin Number): saves the coordinates and bin numbers of the sites in the selected bins to 
a .nbf file. If the site is not in any bin, the bin number will be -1 by default. 

• Plot: saves the plot to a .png, .eps, or .svg file. 

The following is the Save dialog box for the Bin value, Bin NO. or Plot (see next figure). 

Figure 508: Wafer Mapping Save 

 
 

Trend plot 
The Trend plot is at the wafer level. That means a single point comes from every wafer for the 
selected variable. The mean, minimum, and maximum values, which are calculated from all site 
values, are shown in the plot for each wafer.  

The limit information of the variable and current test data will be loaded automatically when ACS is 
testing. Select multiple .kdf files by clicking on the .kdf files parameter settings if ACS is not running. 
You will see the updated plot when you select the Update Plot function.  

The following is the Trend plot GUI settings (see next figure). 

Figure 509: Trend Plot GUI settings 
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Choosing the parameter settings is similar to the Wafer Mapping settings, however, there are some 
differences. The parameters you need to configure are KDFs, Wafers, Location, Variable, Filter, and 
Limit.  

 Set the Trend Settings 
1. Click the ellipsis next to the KDFs function to add a file. 
2. After you click the ellipsis, you will need to click the Add function (see next figure). 

You can select more than one KDF file by pushing the Ctrl key plus clicking with your mouse and 
selecting one file at time, or pushing the Shift key plus clicking your mouse to select several files that 
are in sequence. 

Figure 510: Add KDF files 

 

3. Once you click Add, you will have to choose the KDF file that you want to upload (see next 
figure). 

Figure 511: Choose KDF file 

 

4. Next, choose the Wafer (or more than one) from the drop-down list (see next figure). 

Figure 512: Trend parameters Wafers selection 
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5. Next, you must choose the test module Location (see next figure). 

Only one Location can be selected. 

Figure 513: Trend parameters Location selection 

 

6. Next, choose the Variable from the drop-down list (see next figure). 

Figure 514: Trend parameters Variable selection 

 

7. When you click the ellipsis for the Filter setting, the dialog box named Settings opens where you 
can set the minimum and maximum of the variable that you choose based on the .kdf file 
selected. For example, you must enter the desired minimum setting and maximum setting that 
you want to measure in your plot. 

Figure 515: Trend parameters Filter Settings 
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8. Select the ellipsis next to Limit so that you can determine the Target specification limit, the lower 
specification limit (LSL), and the upper specification limit (USL). The default value for the Target, 
LSL, and USL is determined by the limit files or limit settings in ACS (see next figure). 

Figure 516: Trend parameters Limit Settings 

 

9. After you have set all of the parameters, you must select the Update Plot function to see the 
newest plots. There are two tabs where you can view the plot information: Trend and data (see 
next figure). 

Figure 517: Trend plot tabs 
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BOX plot 
The BOX plot is at the lot level and will help you to display differences between populations without 
making any assumptions of the underlying statistical distribution. In other words, you can see 
differences between lots for selected variables. You are able to select the lots by selecting multiple 
.kdf file parameter settings and you can select different devices and different variables to see the 
differences between the selected wafers.  

The following is the BOX GUI settings (see next figure). 

Figure 518: BOX GUI settings 
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Choosing the parameter settings is similar to the Wafer Mapping settings, however, there are some 
differences. The parameters you need to configure are KDFs, Wafer, Location, Variable, Filter, and 
Property.  

 Set the BOX Settings 
1. Click the ellipsis next to the KDFs function to add multiple .kdf files. 
2. After you click the ellipsis, you will need to click the Add function (see next figure). 

Figure 519: Add KDF files 

 

3. Once you click Add, you will have to choose the KDF file that you want to upload (see next 
figure). 

You can select more than one KDF file by pushing the Ctrl key plus clicking with your mouse and 
selecting one file at time, or pushing the Shift key plus clicking your mouse to select several files that 
are in sequence. 

Figure 520: Choose KDF file 
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4. Next, choose the Wafer from the drop-down list (see next figure). 

Figure 521: BOX parameters Wafer selection 

 

5. Next, you must choose the test module Location (see next figure). 

Only one Location can be selected. 

Figure 522: Trend parameters Location selection 
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6. Next, choose the Variable from the drop-down list (see next figure). 

Figure 523: BOX parameters Variable Settings 

 

When you choose True, you will see a percentage change from the previous lot to the last lot. Also, 
when you choose False, you will see all of the lots used in the plot. 

7. When you click the ellipsis for the Filter setting, you will see a dialog box named Settings where 
you can set the minimum and maximum of the variable that you choose based on the .kdf file 
selected. For example, you must enter the desired minimum setting and maximum setting that 
you want to measure in your plot  (see next figure). 

Figure 524: Filter Settings 
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8. Select the ellipsis next to the Property item in order to set a Normal CDF, a Log Normal CDF, and 
a Shift (see next figure). 

Figure 525: BOX parameters Property 

 

Normal CDF: (True) Generates the NormalCDF plot. 

Log Normal CDF: (True) Generates the LogNormalCDF plot. 

Shift: (True) Computes and plots the percentage shift of each selected lot (.kdf) as compared to the 
lot with the earliest time stamp. For example, if three .kdf files are selected, then the file with the 
earliest timestamp is used as the baseline. The other two lots are compared to the baseline lot and 
the equation below is used in the calculation: 
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1. After you have set all of the parameters, you must select the Update Plot function to see the 
newest plots. There are two tabs where you can view the plot information: BOX and data (see 
next figure). 

The bottom of the BOX is the 25th percentile of the lot and the top is the 75th percentile. Also, the red 
band represents the 50th percentile (the median). The whiskers of the lot defines the length of the 
whiskers as a function of the inner quartile range. They extend to the most extreme data point. The 
default is 1.5 IQR (interquartile range). 

Figure 526: BOX plot tabs 

 
 

Histogram 
The Histogram feature is a graphical display of tabulated frequencies indicated with a bar graph (see 
next figure).  
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The following is the Histogram GUI parameter settings (see next figure). 

Figure 527: Histogram GUI settings 
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Choosing the parameter settings is similar to the Wafer Mapping settings, however, there are some 
differences. The parameters you need to configure are KDFs, Wafer, Location, Variable, Filter, Limit, 
Property, and Compared.  

 Set the Histogram Settings 
1. Click the ellipsis next to the KDFs function to add a file. 
2. After you click the ellipsis, you will need to click the Add function (see next figure). 

You can select more than one KDF file by pushing the Ctrl key plus clicking with your mouse and 
selecting one file at time, or pushing the Shift key plus clicking your mouse to select several files that 
are in sequence. 

Figure 528: Add KDF files 

 

3. Once you click Add, you will have to choose the KDF file that you want to upload (see next 
figure). 

Figure 529: Choose KDF file 
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4. Next, choose the Wafer from the drop-down list (see next figure). 

Figure 530: Histogram parameters Wafer selection 

 

5. Next, you must choose the test module Location (see next figure). 

Only one Location can be selected. 
 

Figure 531: Trend parameters Location selection 

 



Section 8: Statistics ACS Automated Characterization Suite (ACS) Reference Manual 
 

8-26 ACS-901-01 Rev. H / December 2014 

 

6. Next, choose the Variable from the drop-down list (see next figure). 

Figure 532: Histogram parameters Variable Settings 

 

7. When you click the ellipsis for the Filter setting, you will see a dialog box named Settings where 
you can set the minimum and maximum of the variable that you choose based on the .kdf file 
selected. For example, you must enter the desired minimum setting and maximum setting that 
you want to measure in your plot  (see next figure). 

Figure 533: Filter Settings 

 

8. Select the ellipsis next to Limit so that you can determine the lower specification limit (LSL), and 
the upper specification limit (USL)(see next figure). 
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9. Select the ellipsis next to Property and you will see a dialog box where you can make the 
following settings (see next figure). 

Figure 534: Histogram Property Settings 
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• display_filter_span: if this is False and x_auto_scale is True, the histogram is generated 
according to the bins number. In other conditions, the histogram will be generated according to 
the bins span. 

• bins: sets the bins number. 
• normed: (True) sets counts to normalized. 
• x_auto_scale: (True) x-axis is auto-scaled. 
• x_min_scale: minimum value of x-axis when x_auto_scale is False. 
• x_max_scale: maximum value of x-axis when x_auto_scale is False. 
• y_auto_scale: (True) y-axis is auto-scaled. 
• y_min_scale: minimum value of y-axis when y_auto_scale is False. 
• y_max_scale: maximum value of y-axis when y_auto_scale is False. 
• mean: (True) displays mean value on the histogram. 
• sigma: (True) displays 1σ sigma limit on the histogram. 
• 3sigma: (True) displays 3σ sigma limit on the histogram. 
• limit: (True) displays limit values in the histogram. 
• PDF: (True) displays probability density function overlayed on the histogram. 
• Cpk: (True) displays the process capability overlayed on the histogram. 
1. Click the ellipsis next to Compared and a dialog box opens where you can add a lot to compare. 

The histogram displays the differences. Leave the Compared option blank when you do not want 
to compare the differences. 

2. After you have set all of the parameters, you must click the Update Plot function to see the 
newest plots. There are two tabs where you can view the plot information: Histogram and data 
(see next figure). 

Figure 535: Histogram plot tabs 
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Cumulative distribution function (CDF) 
In ACS software, the CDF feature is a graphical display of probability distribution that is indicated with 
a line plot (see next figure).  

Figure 536: Normal CDF plot pane 

 

The following is the CDF GUI parameter settings (see next figure). 

Figure 537: CDF GUI parameter settings 
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Choosing the parameter settings is similar to the Histogram settings. The parameters you need to 
configure are KDFs, Wafer, Location, Variable, Filter, Property, and Compared.  

Set the CDF Settings 
1. Click the ellipsis next to the KDFs function to add a file. 
2. After you click the ellipsis, you will need to click the Add function (see next figure). 

You can select more than one KDF file by pushing the Ctrl key plus clicking with your mouse and 
selecting one file at time, or pushing the Shift key plus clicking your mouse to select several files that 
are in sequence. 

Figure 538: Add KDF files 

 

3. Once you click Add, you will have to choose the KDF file that you want to upload (see next 
figure). 

Figure 539: Choose KDF file 
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4. Next, choose the Wafer from the drop-down list (see next figure). 

Figure 540: CDF parameters Wafer selection 

 

5. Next, you must choose the test module Location (see next figure). 

Only one Location can be selected. 

Figure 541: Trend parameters Location selection 
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6. Next, choose the Variable from the drop-down list (see next figure). 

Figure 542: CDF parameters Variable Settings 

 

7. When you click the ellipsis for the Filter setting, you will see a dialog box named Settings where 
you can set the minimum and maximum of the variable that you choose based on the .kdf file 
selected. For example, you must enter the desired minimum setting and maximum setting that 
you want to measure in your plot  (see next figure). 

Figure 543: Filter Settings 

 

8. Select the ellipsis next to Property.  

There are three types of CDFs for you to use: normal, log normal, and Weibull. To choose the type of 
CDF you want, you must click the ellipsis next to the Property Settings, then click the down-arrow on 
the Settings dialog box (see next figure). 

Figure 544: Types of CDFs 
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9. Click the ellipsis next to Compared and a dialog box opens where you can add a lot to compare. 
The histogram displays the differences. Leave the Compared option blank when you do not want 
to compare the differences. 

10. After you have set all of the parameters, you must click the Update Plot function to see the 
newest plots. There are two tabs where you can view the plot information: CDF and data (see 
next figure). 

Figure 545: CDF plot tabs 
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Summary report panel 
Select the Summary Report function from the View panel, and the Summary Report panel displays in 
the Edit panel (see next Figure). A blank Lot Summary Report displays in the work area. 

Figure 546: Lot Summary Report 

 

Section 9 

Summary Report 
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Check Data with Limits – Used to choose whether to check the testing results with the limits setting in 
the test plan. 

Data File – Used to choose a Keithley data file (.kdf). Click the Browse function and choose the target 
data file (.kdf). 

Ext. Limits File (Optional) – Used to choose an external Keithley limits file (.kdf). This option is 
available only after the Check Data with Limits is selected. You can click the Browse function and 
choose a limits file to replace the test plan limits setting. 

Include Raw Data – Used to click whether or not the report will contain Raw Data. By default, this 
checkbox is deselected.  

HTML Style checkbox – Used to click the style of report; HTML or plain text. 

• Generate Report function – Click this function to start generating a summary report. 
• Print function – Click this function to print the generated report shown in the work area. 
• Save function – Click this function to save the current report. 

 

Generating a summary report 
After testing is completed, you can generate a summary report and view the results of a test in the 
summary report. The summary report contains such information as testing time, user name, and 
measured data from a Keithley data file .kdf, and pass/fail information based on test data and limits 
setting. The Summary Report function provides the following capabilities:  

• You can generate a Summary Report and a Raw Data report (see next figure). The Summary 
Report is a summarized report that includes means, standard deviations, and other statistics. The 
Raw Data report is a detailed report that includes all the raw data. 

Figure 547: Lot Summary Report demo 
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• You can generate an HTML script report and a plain text report (see next figure). In an HTML-
style raw report, a hyperlink is set on each row label of the summary table and on the array 
results. If you click the row label, the cursor will jump to the corresponding column in the Raw 
Data table. If you click an array that is shown as a hyperlink, it will expand.  

Figure 548: Plain Text format report 

 

• You can sort tested data in the reports according to Limits, Critical, or Results.  

Settings for each of these reports are discussed in more detail “Summary Report Panel” earlier in this 
section. 

As seen in the previous figures, each report has two different parts – Lot Summary Report and Raw 
Data. Each is in an HTML-style and in plain text formats. 

Each report is preceded by a report header that is called the Lot Summary Report. The report header 
displays information about the lot, process, device, testing time, and user name. The header lines are 
displayed on each report page. Raw Data consists of all raw tested data. You can choose whether 
you want to display Raw Data.   
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Understanding the lot summary report 
Header: A header is placed at the top of the Lot Summary Report. An empty field in the header 
indicates that the corresponding field in the data file is empty at the time of searching. The data is 
listed with test names as row labels on the left and test information is in columns across the top. The 
test information consists of the mean, minimum, and maximum for the sites based on the executed 
testing plan (see next figure). 

Figure 549: Wafer Summary Report 
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Title: if only one wafer saved in the current loaded kdf file, the title will be “Wafer Summary Report: 
%wafer id%”. If multi-wafer saved in the kdf file, then the title will be  “Lot Summary Report: %wafer 
id%” (see next figure). 

Following the header is a series of column field labels. These fields contain various data derived from 
the .kdf file. Some fields, such as %Spec and %Vld, may include an asterisk next to the data points to 
indicate the data is out of range, alerting you to notice potentially bad data points. The following 
paragraphs describe the fields that serve as the column indicators for the standard report shown in 
the above two figures.  

• Lot/Wafer: if single wafer option has been selected before generating the kdf file, the label will be 
“Wafer”, and the wafer id value will be the same as the title. Otherwise, the label would be “Lot”. 
Lot id value is the one input in the Auto-Test Information box in Automation (this value has been 
saved in the kdf file) 

There are two conditions that will generate a one-wafer kdf file, one is in single wafer mode, the title 
is “Wafer Summary Report: %wafer id%”, the lot/wafer label is "Wafer." The other is that we only 
click on wafer to be tested in the automation or stop the test in the first wafer, the title is “Wafer 
Summary Report: %wafer id%”, the lot/wafer label is “Lot.” 

• User Name: defined in the Auto-Test Information box in Automation, input parameter, saved in 
kdf. 

• Process: defined as Test process level in the Auto-Test Information box in Automation, input 
parameter, saved in kdf. 

• Start time: the test start time, saved in kdf. 
• Device: defined as Die Type in the Auto-Test Information box in Automation, input parameter, 

saved in kdf. 
• Sys: the Computer name, saved in kdf. 
• Test name: Tester name, defined as Equipment ID in the Auto-Test Information box in 

Automation, input parameter, saved in kdf. 
• Test station: Test station number, default value is 1, saved in kdf. 
• Limits: The limits file name. The limits file used for generating the summary file. If external limits 

file has been specified, the value will be the specified file, if not a temp file named “temp.klf” will 
be used during the generation, after generation, the temp file will be deleted automatically. 

Special symbols: 

• “?” - If the raw data is outside valid limits, a “?” symbol will be added beside the data, and the 
data will be marked with red color. 

• “*” - If the raw data is outside spec limits, a “*” symbol will be added beside the data, and the data 
will be marked with red color. 

• “#” - If the raw data of a critical parameter is outside spec limits, a “#” symbol will be added beside 
the data, and the data will be marked with red color. The critical part is defined in the limits editor. 

• “-” - If there is no corresponding value to the output parameter in the site, the cell value would be 
“-” 

Total num of wafers/sites: Total number of wafers and total number of sites can be got from the kdf 
file (see next figure). 
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Statistic table: Following the header is a series of column field labels. These fields contain various 
data derived from the “.kdf” file. Some fields, such as %Spec and %Vld, may include an asterisk next 
to the data points that indicates the data is out of range and gives alerts on the potentially bad data 
points. The following paragraphs describe these fields that serve as the column indicators for the 
standard report shown in the above two figures. 

• Name: The unique test output id. This is the parameter name to which the data is corresponding.  
• Units: The parameter units, defined in the limits editor. This field is blank if no limits file is 

specified in the Summary Report panel. 
• Mean: Mean value of all the data for this parameter. The average for each parameter is 

calculated from the data of all testing sites. It is the arithmetic mean of all the results 
• Sdev: SDEV value of all the data for this parameter, depend on the data and the target value 

defined in the limits editor. This is the standard deviation from the mean of the parameter’s data 
points. 

• Min: minimum value of all the data for this parameter. 
• Max: maximum value of all the data for this parameter 
• %sedv: %SDEV value of all the data for this parameter, depend on the data and the target value 

defined in the limits editor. This is the standard deviation deselected as a percentage offset from 
the mean. 

• Specl and Spech: spec low value and high value defined in the limits editor. These are the 
specification constraints from the limits file. These values show quick identification for data points 
that are out of range. If no limits file is specified, the default value is -1.00e+16 and 1.00e+16, 
respectively. 

• %spec: yield value of the data inside the spec limits, if the value is less than 50, a “*” will be 
appended, and marked with red color. This is the percentage of data points that are within SpecL 
and SpecH. 

• Cnt: the total records number of this parameter(times this parameter has been tested in the 
automation) 

• %vld: yield value of the data inside the valid limits. if the value is less than 50, a “*” will be 
appended, and marked with red color. 

 

Understanding raw data 
Raw Data is an expanded part of the Lot Summary Report. The additional data found in Raw Data 
consists of the actual testing data derived from the .kdf file.  

Raw Data uses the same header file as the Lot Summary Report. The parameters are listed in 
columns instead of rows. The information shown in a standard report is listed in the bottom rows on 
each raw report page. This information is calculated in the same way as in the Lot Summary Report.   

In Raw data, separated to different section with each wafer, array data will be located in a list. 
Different color and symbols will be used regarding the data value and limits setting (refer to the 
special symbol section). 

Wafer statistic table: 

• Count: the number of data inside the valid limits in the current wafer 
• mean/stdev/%stdev/min/max: mean/stdev/%stdev/min/max  value of data in the current wafer  
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Customize user data path and convert data 
User data path 

In the Tools Menu, click Preference to set the binning file and data file path. After you click 
Preference, a dialog box appears (see next figures). 

Figure 550: Access Preferences in the Tools menu 
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Figure 551: User Data Path in Preferences setting 
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A User Data Path dialog allows you to click the directory path for the software parameter data. This 
path can be read in UAP, letting you put the data file in this path. Also it can be read by Convert Data 
dialog as a default output data file path. 

Convert data 

This is a GUI for converting .kdf file into NDF, NBF, and NRF files. It can be accessed from the Tools 
menu bar (see next figures). 

Figure 552: Access Convert Data in the Tools menu 

 

Figure 553: Convert Data 
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• Keithley Data File: Used for browsing the .kdf file.  
• Generate Wafer Report/NDF/NBF: This check box tells the software whether to generate the 

corresponding file. 
• Wafer Report – Select Wafer: Used to select which wafer to generate a report on. 

Output Folder: Used to store all NDF/NBF/NRF files. 

ACS software has a large device test library, including the parametric libraries, WLR library, and 
Common library. In ACS software, you can also build a library to import and use. The tables below 
summarize all the test modules in the Device test, WLR libraries, and Common library. Detailed 
descriptions on each module are in this section. 

 



 

 

In this section: 

ACS hardware configurations introduction ............................. 10-1 
ACS hardware configuration utility ......................................... 10-2 
Instrument system configuration .......................................... 10-16 
Configuration file locations ................................................... 10-42 

 
 

ACS hardware configurations introduction 
The Automated Characterization Suite (ACS) hardware configuration utility is used to manage the 
hardware configuration of the Keithley instruments: 

• Model 707A, 707B, 708A and 708B Switching Matrices 
• Model 2010 Multimeter 
• Series 2400 SourceMeter® 
• Series 2600B SourceMeter 
• Series 3400 PGU 
• Series 3700 System Switch/Multimeter 
• Model 4200-SCS Semiconductor Characterization System 
• External GPIB instruments and all external system components supported by the ACS software tools 

Using the hardware configuration utility, these instruments can be easily added, configured, and 
removed from the system configuration.  

If you make changes to the hardware (for example, remove one instrument, change the 707B work 
mode, change node information, etc.) while you are running ACS, you should follow this procedure 
as follows: 

1, Click the Scan Hardware function in the toolbar to re-scan hardware. 

2, Click the Save function to update the changes. 

3, Restart ACS for the changes to take effect. 

4. Check the Test Setup to ensure the new hardware configuration is correct. 
 

Section 10 

ACS Hardware Configurations 
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ACS hardware configuration utility 
The hardware configuration utility is used to scan information on the hardware instruments of ACS 
and modify configurable properties. 

When you first start the ACS software, during the startup process, an automatic hardware scan is 
accomplished and the configuration is complete. 

To start the hardware configuration utility, click the Configure Hardware option from the drop-down list 
in the Tools menu (see next Figure). 

Figure 554: Start hardware configuration utility 
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The hardware configuration utility main dialog box opens. The interface of the hardware configuration 
utility has two parts (see next figure):  

1. The left panel is the Configuration Navigator: all instruments and equipment that are included in 
the ACS system configuration are displayed here. 

2. The right panel is the Work Area: Instruments and equipment properties are viewed and modified 
here. 

Figure 555: Hardware configuration utility interface 

 
 

The configuration navigator provides a tree view of all instruments and equipment present in the ACS 
system configuration. The configuration navigator can be expanded and minimized by clicking on the 
arrows. 

The work area shows each instrument in the system configuration and its associated properties. 
Clicking an instrument in the configuration navigator causes the associated properties dialog box to 
open in the work area. 
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Configuration navigator 
The configuration navigator displays a tree that shows each component present in the system 
configuration. Clicking a component, or node, in the configuration navigator causes the properties 
associated with the selected component to be displayed in the work area. The next figure shows a 
typical system configuration with the configuration navigator partially expanded. 

Figure 556: Configuration navigator view of typical system 
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Device interface setting 
Different test fixtures or interface panels may have an impact on instrument settings. ACS Basic uses 
the Device Interface Setting to manage the hardware configuration in order to optimize the default 
instrument settings. The figure below shows the Device Interface Setting GUI. 

In the Device Interface Setting GUI, you have to choose  the Model 8010 High Power Test Fixture, 
Model 8020 High Power Interface Panel, or Other device with or without a bias tee. See the figure 
below for the GUI interface, also, the table below for configurations to include default settings. 

Figure 557: Hardware configuration device interface setting 
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1. Select the model of your test fixture or device interface. If you have Models 8010 or 8020, select 
accordingly; otherwise select Other.  

2. Select the Bias Tee option if you are using any of the following bias tees: Model CVU-3K-Kit, 
Model CVU-200-KIT, Model 8020-CVU, or Model 4205-RBT.  

 

In order to use the  the bias tees with the CV instrument in the Model 4200-SCS and access the high 
voltage capacitance measurement modules, ACS must be installed on the Model 4200 (there is no 
remote support). 
If you do not need a bias tee and want to use the Model 4210-CVU alone, you should use the CVITM 
test module. The CVITM test module requires the Model 4200-SCS software KXCI, which can be 
used remotely, as long as ACS software is installed on the remote computer. 

3. Click Apply.  
 

If you have a bias tee in your configuration, you must make sure to select the bias tee option in the 
Device Interface Setting in order to access the appropriate CVU connection compensation. For more 
information refer to CVU connection compensation.  
 

The table below details how the Device Interface Setting changes the default instrument settings: 

 Model With bias tee option? Delay 
factor 

Contact 
check 

Measurement 
speed 

 8010 No 1 On Normal 
 8010 Yes (applies to CVU-3K-KIT,  CVU-

200-KIT, or 4205-RBT 
2 On Quiet 

 8020 No 1 Off Normal 

 8020 Yes (applies to 8020-CVU bias tee) 2 Off Quiet 

 Other No 1 On Normal 

 Other Yes (applies to CVU-3K-KIT, CVU-
200-KIT, or 4205-RBT 

2 On Quiet 

The delay factor is a multiplier to the Auto Delay and is applied when Auto Delay is enabled. Auto 
Delay is an instrument-specific delay associated with the SMU measurement range. Auto Delay and 
Contact Check can be enabled in the Miscellaneous (Misc) tab under Tools Preference menu. Refer 
to the Miscellaneous (Misc) tab topic. If you make changes in this tab after configuring Device 
Interface Settings, you will override values presented in the above table. Measurement speed is 
controlled in the Timing window of ITMs.  Refer to ITM timing settings and Model 42XX SMU ITM for 
more details. If you make changes to timing after configuring Device Interface Settings, you will 
override the measurement speed settings in the above table. 
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Scan hardware 
The ACS system will automatically detect instruments that have a GPIB address, such as Series 
2600B system groups, Model 4200-SCS, and other Keithley instruments. The prober station 
configuration information is read from the Model 4200-SCS KITE’s configuration file at the same time 
(refer to the Model 4200-SCS documentation for more information). 

The hardware configuration can be used to scan following hardware systems: 
 

• Model 707B/708B Switching Matrix (configured for ICL mode, not DDC) 
• Model 2010 Multimeter 
• Series 2400 SourceMeters  
• Series 2600B SourceMeters  
• Series 3400 PGU 
• Series 3700 Switching Matrix 
• Model 4200-SCS as child to a system computer 

To scan the hardware system, click the Scan Hardware icon on the toolbar.  

The system queries the instruments and then displays the updated configuration information in the 
configuration navigator and the work area. 

 

Scan the instruments (Series 2400, 2600B, 3400, 3700, and Model 707B, 708B, 
2010) 
ACS will scan the Series 2400, 2600B, 3400, 3700, and Model 707B, 708B, 2010 instruments and all 
the hardware from the GPIB address from 0 to 30.  

 

Scan Model 4200-SCS 
You can use the ACS software to scan the Model 4200-SCS by assigning an IP address in the ACS 
preferences dialog. For more information about how to set the preference dialog in the ACS, refer to 
Configuring a 4200 ITM. 

 

Simulating scan in Demo mode 
If ACS runs in Demo mode, it can simulate a virtual system, such as the Series 2600B, Series 3700, 
and Model 4200. The Series 2400 and 3400 cannot be simulated in the scan in Demo mode. 
To simulate a scan of the Series 2600B instruments: 
1. Click the Scan Hardware icon. The hardware configuration dialog appears (see next figure). 
2. Enter the specific Model of the Series 2600B system, the total groups and the number of SMUs 

per group desired. 
3. Click OK. The configuration navigator is displayed in the left panel, with corresponding 

information displayed in the work area in the right panel. 
To simulate a scan of the Series 3700 and Model 707B, 708B instruments: 
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1. Click the Scan Hardware icon. The hardware configuration dialog box opens (see next figure).  
2. Select the KI3700, KI707B, or KI708B from the With matrix as subordinate item in the hardware 

configure dialog box. For more information about the Model 3700, 708B, and 708B used as a 
subordinate or child, refer to TSP Link connections and Assigning node numbers topic. 

3. Click OK. 
To simulate a scan of the Model 4200-SCS: 
1. Click the Scan Hardware icon. The hardware configuration dialog box opens (see next figure).  
2. Select the With S4200 Demo item in hardware configure dialog box.  
3. Click OK. 

 

Figure 558: Hardware configuration (Demo Version) 
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Add and delete an external instrument 
ACS is capable of adding external instruments. An external instrument is defined as an instrument 
that is not configured when you accomplish a hardware scan of the system. An external instrument 
must be manually added to your hardware configuration. The following information provides more 
information about adding and deleting external instruments to your system. 

The supported external instrument categories are: 

• Switch Matrix 
• Capacitance Meter 
• General Purpose Test Instrument 

All supported external instrumentation and equipment is controlled by ACS Python Test Modules 
(PTM).  

ACS provides Python LPT libraries for each supported external instrument (see next Table). You can 
use these libraries to create your own test modules. 

ACS also provides a number of standard Python user libraries to control external equipment that is 
typically used in semiconductor characterization applications. Standard user-module libraries are 
provided for the equipment (see next Table). 

Supported external equipment table 

Category Instrument LPT Library1 User Library2  

Switch matrix3  Model 707A/707B Switching Matrix ki70xlpt 
 

switchctrl4  
 Model 708A/708B Switching Matrix 

Capacitance meter5  Model 590 CV Analyzer ki4200cvulpt 
 

CVITM6  
 Model 595 CV Analyzer 

General purpose test 
instrument7  
 

Any IEEE-488 controlled instrument or equipment 
 

created by user 
 

TEKSCOPE8  

HiPowerITM9  

1 LPT library is saved in this path: \\ACS\library\pyLibrary\ptmlpt. For more about the ACSLPT library functions, you can refer to the Python 
LPT Library. 

2 The User library saved in this path: \\ACS\library\pyLibrary\PTMLib. For more about the PTMLib library, you can refer to the Python User 
Library. To learn more about how to import a PTM, refer to PTM with the .XRC GUI File. 

3 ACS supports the Keithley Instruments Model 707A/707B and 708A/708B Switch Matrices. The Model 708A/708B accepts a single matrix 
card. The Model 70A7/707B accepts up to six matrix cards. Only one switch matrix can be present in the system configuration at a time. 

4 The switchctrl saved in \\ACS\library\pyLibrary\PTMLib\ switchctrl. To learn more about how to use the switchctrl library, refer to 
Switch_Control. 

5 Up to four supported capacitance meters may be added to system configuration. 

6 The CVITM saved in \\ACS\library\pyLibrary\PTMLib\CVITM. To learn more about how to use this library, refer to Configuring Capacitor 
Meter library. 

7 ACS supports up to sixteen general purpose test instruments (GPIs). Two-terminal and four-terminal types may be present in the system 
configuration simultaneously, but the total number of GPIs cannot exceed sixteen. 

8 The TEKSCOPE is saved in the \\ACS\library\pyLibrary\PTMLib\TEKSCOPE. To learn more about how to use this library, refer to 
Configuring Scope library. 

9 The HiPower_24 is saved in the \\ACS\library\pyLibrary\PTMLib\HiPower_24. To learn more about how to use this library, refer to 
Configuring Series 2400 SourceMeter instruments library. 
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To add or delete an external instrument: 

1. Click the add instrument function or right click the instrument node in the configuration navigator 
and click the pop-up item (see next figure). 

You can add an external instrument to an internal or an external instrument. However, you can only 
delete the external instrument from the hardware configuration dialog box (see next figure). 

Figure 559: Add or delete external instruments 

 

2. After clicking the Add External Instrument option, the External Instrument dialog box opens. In 
this dialog box you must Select the Type of Instrument and the model number, then click OK (see 
next figure).  

 

Figure 560: Switch Matrix 

 

Delete an external instrument 

1. Click on the external instrument that you want removed in the configuration navigator, then click 
the delete external instrument function. A single-item pop-up menu opens; clicking the pop-up 
menu item deletes the instrument.  

2. Alternatively, you can delete an external instrument by clicking it and then click the DELETE 
function. You will see a message asking to confirm this action (see next two figures). 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 10: ACS Hardware Configurations 
 

ACS-901-01 Rev. H / December 2014 10-11 

 

Figure 561: Warning message for removing device 

 
 

Figure 562: Delete an external instrument 

 
 

Add switching matrix 

Each supported external instrument is added to the system configuration by clicking it from the 
category. When you click the Add External Instrument function, the supported instrument categories 
will display: 

• Model 707A/707B switching matrix 
• Model 708A/708B switching system 

 

Figure 563: Switch Matrix 
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Capacitance meter 

ACS is capable of adding a capacitance meter to the system configuration (see next figure). The 
following types of capacitance meters can be added to system configuration: 

• Model 590 CV Analyzer 
• Model 595 Quasistatic CV Meter 

 

Figure 564: Type of Capacitance Meter 

 
 

General Test Terminal 

ACS is also capable of adding a General Test Terminal. You can click the type of terminal (see next 
figure). 

Figure 565: Type of General Test Terminal 

 
 

ACS is capable of adding general purpose test instrument to the system configuration by selecting it 
from the category: 

• Custom GPI 
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Customize terminal 

If you selected the custom general purpose instrument (GPI) to customize the terminal, a dialog box 
will display (see next figure) that requires you to fill out some basic information: 

1. Click the type of terminal.  
• General purpose test terminal 
• Capacitance meter 
• Other source meter 

2. Click the communication.  
• GPIB 
• RS232 

3. Click the GPIB address.  
4. Enter the terminal name. 
5. Enter the Model number.  
6. Enter the LPT Model. 
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The LPT Model name must be the same as the python file name saved in the ptmlpt folder 
(\\ACS\library\pyLibrary\ptmlpt). ACS supplies these LPT library packages: ki23xlpt, ki24xxlpt, 
ki26xxlpt, ki37xxlpt, ki42cvulpt, ki42xxlpt, ki70xlpt, kiag4284lpt, ki20xxlpt. 

7. Click OK to complete the customized terminal configuration. 

If you choose the Capacitance Meter type of terminal, there are two GPIs that are supported (see 
next figure): 

• AG4284 
• AG4980  

Figure 566: Customize Capacitance Meter 
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The Other Source Meter option supports the KI236, KI237, and KI238 instruments as indicated in the 
next figure (see next figure). 

Figure 567: Customize Other Source Meter 
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Add a Series 2290 high voltage power supply 
The Series 2290 is not detected during the ACS software's hardware scan. You must add it as an 
external instrument (refer to the Add and delete an external instrument (on page 10-9) topic). 

You must configure the Model 2290 as a GPIx (general purpose instrument; x = 1,2,3, etc.) in the 
ACS hardware configuration (see next figure): 

Figure 568: Add Model 2290 to hardware configuration 

 
 

Once you have the instrument add to the hardware configuration, you must close and restart ACS. 
For more information about the Series 2290, refer to the Power supply library (on page 15-30) topic. 

 

Instrument system configuration 
Each instrument that is included in the system configuration appears in the configuration navigator. 
Clicking a configuration navigator node causes the corresponding attributes or properties to be 
displayed in the work area. The following sections describe the properties for each supported 
instrument. 
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KI system configuration 
When you click the KI System Configuration in the configuration navigator, the work area displays the 
system configuration. 

Figure 569: KI System Configuration 

 
 

Series 2600B system properties 
Single configuration: When the node of a Series 2600B instrument on the configuration navigator is 
selected, the work area displays an overview of the instrument(s). 

Group configuration: When the node of GROUPx on the configuration navigator is selected, the 
work area displays the groups’ GPIB address and configuration. 

SMU configuration: When the node of a Series 2600B SMUx on the configuration navigator is 
selected, the work area shows the SMU properties, specifications, and power capacity (see next 
figure). 
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Example: Model 2651A 
Figure 570: Model 2651A information 

 
 

The Model of the SMU is displayed in the first line. The SMU offset information displays in the second 
line: SMU A corresponds to offset=0; SMU B corresponds to offset=1. The next three lines display the 
SMU node number, its hardware version, and serial number. The last two lines display the calibration 
date. The first is the last time the SMU was calibrated, while the second is the scheduled date when 
the SMU should be calibrated. 
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Composite SMU 
ACS supports combining two 2651A, 2636A/B, 2612A/B, or 2602A/B SMUs as a single SMU. Two 
2651A SMUs can be combined in parallel as a single SMU. This will give you the capability to output 
100 A, or use in series for an 80 V output. Combining two 2636A/B or 2612A/B or 2602A/B SMUs in 
parallel can extend the operating range to 20 A pulse, or use in series to extend the operating range 
to 400 V pulse. In the configuration navigator, the combined 2651A SMUs are considered a 
composite SMU. The work area will show the properties for the composite SMU. 

Figure 571: Combine two SMUs 

 



Section 10: ACS Hardware Configurations ACS Automated Characterization Suite (ACS) Reference Manual 
 

10-20 ACS-901-01 Rev. H / December 2014 

 

Click the Combine SMUs icon  and a dialog box opens where you choose the SMUs to combine 
(only two 2651A, 2636A/B, 2612A/B, 2602A/B SMUs can be combined). 

Parallel (100 A or 20 A). Two SMUs are in parallel for higher current output. The composite 2651A 
SMU is named SMUx_100A (x represents the SMU number). The composite 2636A/B, 2612A/B, or 
2602A/B SMU is named SMUx_20A (x represents the SMU number).  

Figure 572: Parallel composite SMU connections 
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The parallel SMU can only be used in an ITM. 

In the configuration navigator, the composite SMU is labeled "Virtual SMUs" (see next figure). The 
properties of the composite SMU are displayed in the work area. 

Figure 573: Virtual SMUs 

 
 

Series 2400 system properties 
Series 2400 SMU configuration  
When the node of a Series 2400 SMUx on the configuration navigator is selected, the work area 
shows the SMU properties, specifications, and power capacity (see next two figures). 
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Figure 574: Series 2400 SourceMeter instruments configuration 

 
 

Figure 575: SMU configuration information 

 
 

The Model of the SMU is displayed in the first line. The next three lines display the SMU Serial 
Number GPIB_ADDRESS and Instrument name. 
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Series 3400 system properties 
Series 3400 PGU configuration  
When the node of a Series 3400 PGU instrument on the configuration navigator is selected, the work 
area displays the Instrument Properties and Matrix Connection (see next figure). 

Figure 576: Model 2651A information 

 
 

The model of the PGU is displayed in the Instrument Properties text box and it also contains the GPIB 
address and the serial number of the instrument. The Matrix Connection shows the connection 
between the channel terminal and the matrix terminal. 

When the instrument is connected through a matrix, the Connection column will display a column 
number. Otherwise, the Connection column will display NC when not connected through a matrix. 
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Series 3700 system properties 
Model 3706 configuration 
When the node of a Model 3706 on the configuration navigator is selected, the work area shows the 
Properties, Instrument Connection Scheme, and specifications (see next figure). 

Figure 577: Model 3706 information 

 
 

A Model 3706 Properties tab contains the following: 

• Instrument Properties area: displays the node and the two type of cards.  
• Instrument Connection Scheme area: allows you to specify the instrument connection scheme: 

a. Row-column or instrument-card 
b. Instrument SENSE terminals (for example, local or remote sense for measurements). 

The following Instrument Connection Scheme selections define the scheme for interconnections 
between the instruments, the switch-matrix rows and columns, and the test system (prober or test 
fixture). 

• Row-Column (instruments to rows and prober/test fixture to columns) or Instrument Card (both 
instrument and prober/test fixture to columns). 

• Local Sense (connections only to instrument FORCE terminals) or Remote Sense (connections 
both to instrument FORCE and SENSE terminals). 

• Series 3700 General Specifications area: displays the information about the specifications. 
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Series 3700: multiplexer card 
The next figure shows two cards are inserted. They are multiplexer card (Card1) and Switch card 
(Card2). When the node of CARD1 is selected, the work area shows properties and specifications 
(see next figure). 

Figure 578: Multiplexer card information 
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As for Card1, the Card Properties area contains information about Model, Group, Hardware Version, 
Serial Number, and Description. Specifications for cards are also listed. 

 
If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the 
Series 2600B and Series 2400 instruments in the system will be set to four-wire (4-W) mode when 
executing a test. Also, the SMU Remote Sense option box in the Preferences settings Misc tab will 
be disabled. When all the matrices are set to Local Sense, all of the Series 2600B and Series 2400 
instruments in the system will be set to two-wire (2-W) mode when executing a test. It is highly 
recommended that all the matrices in the system are in the same mode. For more information on the 
Preference settings, refer to the Automation section. 

Series 3700: matrix card 
When the node of CARD2 is selected, the work area shows the Properties and connection options 
that may be defined for the device (see next figure).  

Figure 579: Matrix card information 

 
 

The Card Properties area for the matrix card is different from that of the multiplexer card in that there 
are two additional areas that provide for the definition of the connection method: 

• Rows area 
• Columns area 

In the Rows area, the combo boxes labeled 1 through 6 correspond to the 6 rows of all Model 3706 
compatible matrix cards. Use the drop-down menus of the combo boxes to connect the rows to 
various instrument terminals. 

 
Prober or test-fixture pins are always connected to matrix-card columns. 

In the Columns area, the combo boxes labeled 1 through 16 (or 17 through 32 for this example) 
correspond to the 16 columns of all Model 3706 compatible matrix cards. Use the drop-down menus 
of the combo boxes to connect the columns to various instrument terminals and/or prober/test-fixture 
pins. 
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You may connect instrument terminals to the matrix card columns only when the Instrument 
Connection Scheme setting is active.  

• As for the work area of Card2, you can chose the items in the drop-down menu in Rows and 
Columns area. There are different connections for Card2. 

• Row-Column: With the Row-Column scheme, instruments are connected to switch matrix rows, 
and prober/test fixture pins are connected to switch-matrix columns. This connection scheme is 
the simplest. Instrument signals can route to prober/test-fixture pins through only one matrix card. 
However, the Row-Column scheme limits the number of external instruments. If you need to 
connect numerous external instruments to the prober/test-fixture, use the Instrument Card 
scheme. 

Figure 580: Row-column, Local Sense connection scheme example 

 
 

• Instrument Card: With the Instrument Card scheme, both instruments and prober/test fixture pins 
are connected to the columns of the switch matrix. Instrument signals route to the prober/test-
fixture pins through two or more matrix cards, as illustrated in the next figure. This connection 
scheme can support large systems with numerous instruments, by removing the 8-row 
instrument-connection limitation. 

Figure 581: Instrument card, Local Sense connection scheme example 
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• Local Sense: Use Local Sense when the measurement-pathway resistance is small and the 
associated voltage errors are negligible. The measurement pathway is comprised of the following 
conductors, connected in series: 
a. The cables used to connect the instruments to the matrix 
b. The internal matrix-card signal path 
c. The cables used to connect the matrix to the prober or test fixture 

Current flowing through the measurement pathway creates a voltage drop (an error voltage) that is 
directly proportional to the pathway resistance. This error voltage is present in all Local Sense voltage 
measurements. 

• Remote Sense: Use Remote Sense to eliminate the effects of measurement pathway resistance. 
The next figure illustrates the use of Remote Sense in an instrument card configuration. Note that 
Remote Sense requires twice as many measurement pathways. The FORCE pathways (in red) 
are the current-carrying pathways and the SENSE pathways (in blue) are the measurement 
pathways. 

Figure 582: Instrument card, Remote Sense connection scheme example 
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Models 707A/707B and 708A/708B switch matrices 
Models 707A, 707B, 708A, and 708B switch matrices can be added to the ACS hardware 
configurations through the Add an external Instrument with GPIB connection. Models 707B and 708B 
can also be automatically scanned and added to the configuration through the GPIB and TSP link as 
a master or subordinate.  

Note that ACS supports multiple matrices, such as Models 707A, 707B, 708A, 708B, and Series 3700 
instruments to the hardware configuration. Additionally, ACS supports multiple matrices as a group or 
as individual instruments. 

ACS also supports both device dependent commands (DDC) mode and instrument control language 
(ICL) mode for Models 707B and 708B: 

• DDC mode instruments must be manually added to the hardware configuration 
• ICL mode instruments are automatically scanned and added to the hardware configuration 

Model 707B and 708 configuration 
When the node (or instrument) of a Model 707B or 708B in the configuration navigator is selected, the 
instrument Properties, Instrument Connection Scheme, and specifications are viewable in the ACS 
GUI (see next figure) 

Figure 583: Model 707B or 708B properties 

 



Section 10: ACS Hardware Configurations ACS Automated Characterization Suite (ACS) Reference Manual 
 

10-30 ACS-901-01 Rev. H / December 2014 

 

The Model 707B or 708B Properties tab contains: 

• Instrument Properties: model of instrument; associated group (ICL mode); node (ICL mode); work 
mode (ICL or DDC); card list (ICL mode), and GPIB address (DDC mode). 

• S530 System: Kelvin mode enabled or disabled (Model 707A/707B only). 
• Instrument Connection Scheme (you specify the instrument connection scheme): 
A. Row-Column or Instrument-Card 
B. Instrument SENSE terminals: Local or Remote Sense used for measurements 
C. Common LO or Independent LO 

• Switch Card: select matrix cards for the system (Model 707B has six slots; Model 708B has one 
slot)(see next figure): 

Keithley 7071 Matrix Card 
Keithley 7072 Matrix Card 
Keithley 7072 HV Matrix Card 
Keithley 7072 HVD Matrix Card with Discharges 
Keithley 7136 Low Current MUX Card 
Keithley 7174 Low Current Matrix Card 
Keithley 9174 Semiconductor Matrix Card 

If any of the matrices in the system are set to Remote Sense or the S530 Kelvin mode, all of the 
Series 2600B and Series 2400 instruments in the system will be set to four-wire (4-W) mode when 
executing a test. Also, the SMU Remote Sense option box in the Preferences settings Misc tab will 
be disabled. When all the matrices are set to Local Sense, all of the Series 2600B and Series 2400 
instruments in the system will be set to two-wire (2-W) mode when executing a test. It is highly 
recommended that all the matrices in the system are in the same mode. For more information on the 
Preference settings, refer to the Automation section. 
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Figure 584: Models 707B and 708B switch cards 
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Matrix Card information 
When you click one of the matrix cards on the hardware configuration navigator, a GUI dialog box 
opens. The GUI is where you configure the hardware (see next figure). 

Figure 585: Model 7071 matrix card properties 
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The Matrix Card Properties tab contains: 

• Card Properties: instrument model, slot number, hardware version, serial number, and the 
description of the card.  

• SMU info: instrument model, GPIB addresses, maximum voltage and current, voltage and current 
range. 

• Rows: A through H correspond to the eight (8) rows of all Model 707B/708B compatible matrix 
cards. Use the drop-down menus to connect the rows to various instrument terminals. 

• Columns: one through 12 correspond to columns of all Model 707B/708B compatible matrix 
cards. Use the drop-down menus to connect the columns to various instrument terminals or 
prober test-fixture pins, or any combination of both terminals and prober pins depending on your 
needs. 

S530 Configuration 
When the S530 Kelvin option is selected,  the Instrument Connection Scheme properties will 
automatically be selected to the Instrument Card, Remote Sense, and Common LO functions (see 
next figure). 

Figure 586: S530 Kelvin configuration 
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S530 Configuration 
When the S530 Kelvin option is selected, the Instrument Connection Scheme properties will 
automatically be selected to the Instrument Card, Remote Sense, and Common LO functions (see 
next figure). 

Figure 587: ACS S530 Kelvin configuration 

 
 

Model 4200 system properties 
Selecting KI 4200-SCS in the configuration navigator causes the Model 4200-SCS system properties 
to be displayed in the work area. 
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Figure 588: Model 4200 group properties 
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Selecting KI 4200-SCS SMU in the configuration navigator causes the Model 4200-SCS SMU system 
properties to be displayed in the work area. 

Figure 589: Model 4200 SMU information 
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Model 2010 system properties 
When you select the Model 2010 in the configuration navigator, the work area shows the instrument 
properties, specifications, and power capacity (see next two Figures). 

Figure 590: Model KI2010 system configuration 

 

In the next figure, you will see the instrument name displayed, the Serial Number, and GPIB Address. 

Figure 591: Model KI2010 configuration information 
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Model 590 CV analyzer 
When you select the Model 590 CV Analyzer in the configuration navigator, its Properties & 
Connections tab opens (see next figure). 

 

Figure 592: Model 590 CV analyzer 

 
 

This Properties & Connections tab provides access to the Model 590 instrument properties and also 
provides useful switch-matrix connection information. The Instrument Properties area of this 
Properties & Connections tab provides access to the following Keithley Instruments Model 590 
instrument properties: 

• Model: Full vendor name, model number, and instrument description. 
• GPIB Address: Primary GPIB address drop-down selection menu. Addresses that are in use are 

displayed with asterisks (*) next to them. The minimum address value is 0; the maximum is 30 
(GPIB address 31 is reserved as the Model 4200-SCS controller address). If the selected GPIB 
address conflicts with the GPIB address of another instrument in the configuration, a warning 
exclamation-point symbol (!) is displayed next to the address (see next two figures). 
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You can programmatically read the GPIB address, and other instrument properties, on the system 
configuration using the LPTLib getinstattr function. Proper usage of getinstattr allows you to develop 
user libraries in a configuration independent manner. 

Figure 593: GPIB address selection 

 
 

Figure 594: GPIB address properties 

 
 

When a matrix is included in the system configuration, the Matrix Connections area of this Properties 
& Connections tab displays the matrix connections that are associated with the Model 590 
measurement terminals. 
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Capacitance meter configuration 
When you configure a capacitance meter, the only item that you can change is the GPIB address. 
You will also see the matrix connection displayed (see next figure). 

Figure 595: Configuration of capacitance meter 

 
 

Save function 
The Save icon on the toolbar is enabled when you modify any configurable properties.  

Restart ACS after the new configuration is saved. 
 

Checking the configuration 
 

1. Start the hardware configuration utility from the Tools menu of ACS. 
2. Click the Scan Hardware function on the toolbar. The hardware information is displayed in the 

work area.  
3. Using the configuration navigator, navigate through the listed hardware. 
4. Verify that the hardware information matches the configuration of the physical system (if not, use 

the configuration navigator to choose the appropriate device).  
5. Click Save to keep the new configuration and restart ACS so that you can use the prober. 
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Prober station configuration 
If the system has a configured prober station, it is displayed on the configuration navigator as a node. 
When this node is selected, the work area displays the properties of the prober station. There are two 
configurable properties: Model and Number of Pins/Position (see next figure). 

Figure 596: Prober configuration interface 

 
 

When setting up the prober, refer to the Probers Reference Manual, located in the Help menu drop-
down list (see next figure). 

Figure 597: Probers Reference information 
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Configuration file locations 
A configuration file is created and saved by you when you set up your test parameters. When you 
start ACS after creating a configuration file, the software will automatically find and read the file. 

The following are examples of configuration file names and the path where the files are saved: 

• ACS_hdcon_Online.kcf 
• ACS_hdcon_Demo.kcf 
• \\ACS\KATS\CONFIG 
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Server solution introduction 
The ACS server solution is for remote testing from a file transfer protocol (FTP) server. In this mode, 
the test project will be built on the server. When the test is done, the test data (kdf+db) will be 
uploaded to the server automatically. The test flow of the server solution is as follows: 

• On the remote side, configure the server. 
• On the test computer, configure the ACS working mode as network. 
• Restart ACS (with the USB license key in place ); configure the FTP server in ACS: server ip, 

server port, user name, password, server root. Then test the FTP connection to the server. 
• Every time ACS starts, it will decide if there is a newer version and You can make the decision 

whether to download the new build or continue with their current build. 
• The tester computer will import the test project from the server or You can create a new project 

on the server. 
• The tester will save the data locally when running test modules. The data will be saved to 

CurAppPath\Projects\ProjectName\temp and CurAppPath\Projects\ProjectName\data when the 
test module is run.  If the preferences have been set to automatically upload the data to the 
server it will be saved to CurAppPath\Projects\ProjectName\kdf and 
CurAppPath\Projects\ProjectName\db.  

• ACS can be configured to save the Test data (kdf+db) to the server automatically.. 
• The tester computer will save the project to the server-side immediately; If several users are 

visiting the same project, only 1 tester has the right to save the project, others can import, run 
automation, and upload test data concurrently, but will not be able to save the project. 

 

Install and configure an FTP server 

Install the FTP server 
1. Install an FTP server. For example, install FileZilla_Server.exe. 
2. Follow the installation process, until the installation is complete. 

 

Section 11 

Server Solution 
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Configure the FTP server 
Key points in configuring the FTP server. 
1. Share the FTP folder in the LAN 
2. Make sure the folder’s shared name is the same as the alias of the FTP folder.  
3. Allow users to change the files in this folder. 
4. Make the shared folder’s user name and password the same as the FTP server’s user name and 

password. This will make it easier to use.  
5. Structure of FTP folder (see next Figure). 

Figure 598: Structure of FTP folder 

 

6. You can put your old projects in the Projects/2600B directory or in the Projects/4200 directory, 
then they can be opened by different users.  

7. Put the newest release in the Build folder, together with a version_information.ini file, which 
records the newest build information. 

The following steps are the main steps to install and configure the FTP server: 

1. Add user 
2. Set the FTP folder and set alias name 
3. Set user’s permissions – read, write, delete, append 

The FileZilla Server will start automatically after installation. Or click Start->menu->all programs-
>FileZilla Server->FileZilla Server Interface. The Connect to Server dialog box will show the server 
address by default (see next figure). 

Figure 599: Connect to Server 
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8. Enter the server address and ports if needed. Then click the OK button. Then the FileZilla server 
page will display (see next figure). 

Figure 600: FileZilla server page 

 

9. Then click the Edit-> Users, and the Users page will display (see next figure). 

Figure 601: Setup user account 
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10. Click the Add button, and the Add user account dialog will display (see next figure). 

Figure 602: Add user account 

 

11. Type your name and click the OK button. Check Password, then type any group member in the 
Group membership edit box (see next figure). 

Figure 603: Type a password in Account settings 

 

12. Click the Shared folders option in the Page box, and then click the Add button to add 
D:\ftphomedir as the FTP home dir; click the Add button again and add another dir, 
d:\ftphomedir\acsroot (see next figure). 

Figure 604: Setting FTP home directory 
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13. Right-click d:\ftphomedir\acsroot and click Edit aliases to input acsroot as its alias name (see next 
figure). 

Figure 605: Select Edit aliases 

 

14. Type acsroot in the box in the Enter directory aliases window. Make sure to match the folder’s 
shared name in the LAN (see next figure). 

Figure 606: Input an alias for the folder's shared name 
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After you enter the directory name, click OK. 

15. Click the Shared folders option and click the FTP dir (d:\ftphomedir\acsroot), and check all the 
items in the Files and Directories boxes (see next figure). 

Figure 607: Setting the FTP directory 

 

16. Next, click OK to close the dialog box. 
17. Then click the Edit-> Settings from the FileZilla server dialog box to enter the FileZilla Server 

Options (see next figure). 

Figure 608: Edit Settings in the server 
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Once you choose Settings in the FileZilla Server Options dialog box, you will see next figure the 
General settings options (see next figure). 

Figure 609: FileZilla Server Options 

 

In the Timeout settings section, the recommended settings are:  

• Connections timeout = 0 
• No Transfer timeout = 0 
• Login timeout = 0 

Click OK to finish configuring the FileZilla Server. 

After finishing the configuration of the FileZilla Server, the next step is to set up ACS as a network. 
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Configure ACS as a network 
1. For ACS with a certain license, in the ACS user interface top menu click Tools and click 

Preference. 
2. Open the Advanced tab in the Preference Settings window that will display.  
3. Click network as the Working Mode (see next figure).  

Figure 610: Preference Setting_Advanced FTP setting tab 
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4. Click OK. 
5. Then close and restart the ACS user interface. 
6. Then click Tools menu of the ACS user interface and click Preference. There should now be an 

FTP Server tab. Click this tab to open the FTP server page (see next figure). 

Figure 611: FTP Server tab 

 

7. Input the Server IP, Sever Port (21 for default), User name, Password, and FTP Root (acsroot). 
8. Keep the Confirm Password the same as the Password, or there will be a warning dialog to 

instruct you to input again (see next figure). 

Figure 612: Connection failure Warning 

 

9. Click the Test button to test the FTP Connection to the specified server. If a fail dialog appears, 
check your network, make sure your FTP server is started, and confirm your Configuration 
information is correct. 

When you connect to the server successfully, the Test Success dialog will display (see next figure). 

Figure 613: Connection Test Success 
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Update online 
Sometimes when working in network mode, the server will detect new build information, with a 
version higher than the local version. In this case, when you run ACS a dialog box will open asking 
you to update your version of the ACS software (see next figure). 

Figure 614: Update ACS software online 

 

Press the Cancel button to continue with the current version; or press the Download button to 
download the new build *.exe. 

Below is an example of version_information.ini: 

#Keithley build information File for network version 

[version_information] 

version = V3.3 #version number (formatted like this): 

build_exe = acsrelease3.5.exe   # the new build exe file’s name 

build_date = Jan 31, 2008       #build date 

build_time = 11:40:00 PM       #build time 
 

Build an ACS project on the server 
When ACS is in network mode, a project can be built and opened on the server . Compared with the 
local mode, there are two differences: 

- The opened project’s default location is ftproot(acsroot)/Projects  

- The new project’s default location is ftproot(acsroot)/Projects/2600B 

In fact, in operation there is no critical difference compared to local mode: if you open a new project 
in local mode (such as d:\ACS_Home\Projects\testPrj), while the working mode is network, ACS will 
do the same as in local mode. 
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Access test data in network mode 
In ACS network mode, for Automation test: 

The db data can be saved on the server after the test is complete, with this location : ftproot (acsroot 
for example) / Projects/2600B (or 4200) /project_Name /db /testerIP_testerHostid (such as 
10.40.65.129_aa3ac10d/lotid/lotid.db(or lotid.wdf); 

The db data can be saved locally before the test is complete, with this location : curAppPath(it means 
the ACS run path )/ Projects/project_Name(such as aa)/db/lotid/lotid.db (or lotid.wdf); 

The .kdf data can be saved on the server after the test is complete, with this location : ftproot(acsroot 
in the example)/ Projects/2600B(or 4200)/prjName(such as aa)/kdf/testerIP_testerHostid(such as 
10.40.65.129_aa3ac10d/kdf/lotid.kdf(lotid/wafer*.kdf); 

The db data can be saved locally before the test is complete, with this location : curAppPath(it means 
the ACS run path )/ Projects/prjName(such as aa)/kdf/lotid.kdf(lotid/wafer*.kdf); 

After the test is complete and test data is uploaded to the server successfully, the path 
curAppPath(the ACS run path )/ Projects/prjName(such as aa)/db(and kdf) will be removed from local 
disk. 

For manual test: 

The test or data folder can be saved on the local side only, with this location : curAppPath(it means 
the ACS run path )/ Projects/prjName(such as aa)/temp(or data). 

 

Upload test data to the server 
When you are working in network mode there is no difference when configuring a wafer description, 
test setup, or other sections. But when the test is complete, click the OK button in the Completion 
dialog box (see next figure). 

Figure 615: Test Complete 

 

After clicking the OK button, the .db and .kdf data file will upload to the server automatically, if you 
have configured the preference page to save the .db and .kdf files. ACS will display a progress bar 
showing how much time remains to finish uploading (see next figure). 

Figure 616: Uploading test data progress 

 

 



 

 

In this section: 

KTE conversion tool introduction ............................................ 12-1 
Process overview ................................................................... 12-2 
Configuration .......................................................................... 12-3 
Additional adjustments ........................................................... 12-6 
Limitations of the conversion tool ........................................... 12-7 

 
 

KTE conversion tool introduction 
ACS software contains a Keithley test environment (KTE) conversion tool that allows you to convert 
KTE projects to ACS projects.  

The KTE conversion tool is a stand-alone software package which means it is not part of the ACS 
GUI. Also, you can execute the conversion tool without opening and running ACS software. 

The KTE conversion tool is packaged with the ACS software. When you install ACS (version 4.3 or 
newer), the conversion tool will also be installed. 
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Process overview 
There are 2 ways to start the KTE conversion tool: 

1. Open the Command Prompt from the Start menu and type c:\ACS\KATS\startktec. Note that the 
default installation directory location for ACS is c:\ACS. If you installed ACS to a different 
directory, you will need to type the correct path for the command to function correctly (see the 
next two Figures): 

Figure 617: Command Prompt 

 

Figure 618: Command Prompt GUI 

 

2. Using a file browser, navigate to the installation location and find the ACS folder. Next, find the 
subfolder named KATS. Within the KATS subfolder you need to run the executable file named 
kte_conv_app.exe (this is an application file and you must double-click the file in order for it to 
open and run). 

The conversion tool will open and you will see the following dialog box (see next figure). 

In this dialog box you will need to select a CPF file, create a new project name, and select the path 
where the converted project will reside. Once you click Convert, the tool will execute the conversion. 

Figure 619: KTE conversion tool GUI 

 

The conversion of the KTE project structure to ACS will automatically generate the ACS project 
structure. However, you will need to create or modify you user library routines in order to support the 
ACS hardware (see Hardware mapping in this document for more information). 
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Configuration 

KTE test plan location 
The KTE utility, Keithley Component Manager (kcm), can be used to package the files used by the 
recipe into a single tape archive (.tar) file. This package can then be placed into a shared area for use 
by the conversion tool. 

The following command can be used on a KTE system to create this package (make sure you replace 
cassettePlanName.cpf  with the name of the KTE recipe that you want to convert): 
kcm -e  cassettePlanName.cpf 

This will create a cassettePlanName.cpf.tar file. This file can then be placed into a directory that is 
available to the S530 system computer and expanded for use by the conversion tool. 

It is recommended that you keep all of your KTE test plan files in the same directory for quick 
access. 

 

Hardware mapping from KTE to ACS 
The instrument identifications (IDs) that are used in KTE are not the same IDs that are used in ACS 
software. Therefore, you will need to manually map the ID information to ensure that the ACS project 
is functional (for example, transfer the KTE instrument IDs to the equivalent ACS instrument IDs).  

A global data file (.gdf) named hw_mapping.gdf (hw = hardware)(see next figure), contains the 
information needed to translate the KTE hardware instruments IDs to the ACS hardware instruments 
IDs. The format of the .gdf file is the same as a KTE .gdf file. 

Figure 620: Hardware mapping GDF 
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If you place the hw_mapping.gdf file in the same directory as the converted test plan files before 
conversion, the conversion tool will merge all specified .gdf test plans together. If there is no 
specified .gdf file in the test plan, the hw_mapping.gdf file itself will be used in the converted project. 

For example, here are some use cases that indicate how the hardware mapping .gdf file is used: 

Case 1: There are several .gdf files used in a test plan, and you have already placed the pre-defined 
hw_mapping.gdf file in the test plan directory. When this is the case, the conversion tool will merge all 
of the .gdf files and the hw_mapping.gdf file to a new .gdf file named: 
ACS_GEN_hw_mapping_all.gdf  

The new merged .gdf file will be used in the converted project. 

Case 2: A .gdf file is not specified in the test plan and you place the pre-defined hw_mapping.gdf file 
in the test plan directory. When this is the case, the pre-defined hw_mapping.gdf file is used in the 
converted project. 

Case 3: You have not placed the pre-defined hw_mapping.gdf file in the test plan directory. If this is 
the case, and you run the conversion tool, you will receive an error that is similar to the following: 
File "C:\ACS\Projects\p11-02\honey\lib\test.py", line 1, in ? 
  forcev(VIMS1, 1) 
 NameError: name VIMS1 is not defined 

In order to alleviate any potential issues with your converted project, you have to define a hardware 
mapping .gdf file and specify the path of the file for the converted project. You must specify the .gdf 
file path in the ACS GUI for the Wafer Description Cassette Plan Setting tab. If there is a .gdf file 
path already specified, you can append the hardware mapping information to the .gdf file (see next 
figure). 

Figure 621: GDF path 

 

If the KTE test plan uses the linear parametric test library (LPTLib) functions sweepx, asweepx, or 
bsweepx, and the KTM is configured to convert to a python test module (PTM), the hardware 
mapping .gdf file (hw_mapping.gdf) must be configured before the conversion. If this file is not 
created before you attempt your conversion, the conversion will stop. 
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ACS PTM or STM? 
A KTE test macro (KTM) can be converted to either a python test module (PTM) or a script test 
module (STM) in ACS. The conversion.ini configuration file is used to determine if a KTM is converted 
to a PTM or to a STM. 

The conversion tool converts KTMs to STMs by default. 

For example, If you have a test macro named my_HV_macro.ktm, you must add the name to the 
configuration.ini file in order for this macro to be converted to a PTM (see next figure). 

The task of converting KTM files should only be done by someone who has clear knowledge of the 
test modules. Also, you can convert several or all your macros at one time using this method. 
 

Figure 622: The conversion.ini file 

 

The advantages of a PTM: easy to reuse; flexible; able to call the user library, and able to use 
external instruments.  

Any test procedure related to the high-voltage Model 2410 and (or) the CVU must use a PTM. 

The advantage of a STM is a faster speed of execution compared to a PTM. 
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Additional adjustments 
System engineers are the intended users of the KTE conversion tool. They can convert their KTE test 
plans (CPF and corresponding files for S900, S600, or S400 systems) to ACS test plans as they 
perform integration and acceptance of their first S530 system purchase. Once these projects are 
converted, there are some additional tasks for engineers to complete: 

• The userlib and parlib routine calls in the KTMs will be translated and called from the PTMs or 
STMs. However, the userlib and parlib routines themselves need to be either created or ported 
from the KTE test routines. The port is necessary due to the hardware differences between the 
S530 and S400 or S600 test systems. 

• If the LPT routines (for more information refer to the ACS Programming manual) are called from 
any KTM files, the translated LPT calls in the PTMs or STMs need to be checked for the correct 
parameters and calling methods. 

During the conversion process, the conversion tool will display a dialog box informing you of what has 
been converted and what needs to be manually adjusted (see next figure). 

Figure 623: The conversion report 

 

The conversion tool will generate a list of test libraries that needs to be created or modified before the 
ACS project can run successfully:  
--Please do manual conversion for PARLIB first!  
--Please do manual conversion for TUTORIAL first! 
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Limitations of the conversion tool 

Test macro conversion 
The conversion tool simply provides a mapping of the KTE test macros to python (or LUA) scripts. 
Any special logic, such as nested ‘if’ statements, and unsupported LPT commands, are not 
supported. These conditions will need to be validated and manual editing will need to occur in order 
to get the test sequences fully functional in the ACS environment. 

For the functions or commands that cannot be converted, the conversion tool will generate place-
holders to indicate items that you need to modify: 

KTM: 
A. Support assignment statement. 
B. Support routine call statement. 
C. Support "if" statement of 1 level, no nesting; Support 1 level {} in C language, no nesting; Support 

&& and || key words. 
D. Support the following math operations within KTE macros: abs, fabs, exp, log, log10, pow. 
E. No support for C pointer/structure reference, such as ->, *, etc; each of these items will exist as 

place-holders and require the user to do some modifications. 
F. No support for commands that are not defined in the ACS LPT (or commands in userlib) library. 

The conversion tool will keep the commands the same as they are in the original KTM file. These 
place-holders are markers that indicate where the user is required to do some modifications. 

LPT: 
The KTE LPT commands that are supported are listed in the next table: 

Supported KTE LPT commands table 
DEVCLR 
DEVINT 
SETxMTR 
ADDCON 
CONPIN 
CONPTH 
CLRCON 
DELCON 
TSTSEL 
LORANGEx 
RANGEx 
SETAUTO 
FORCEx 
LIMIT 
AVG 
INTG 
MEASx 
IMEAST 
ASWEEPx 
BSWEEPx 
RTFARY 
SAVG 
SINTGx 
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SMEASx 
SWEEPx 
TRIGxG 
TRIGxL 
ADELAY 
DELAY 
RDELAY 
ENABLE 
EXECUT 
INSHLD 
KIBCMD 
KIBDEFCLR 
KIBDEFINT 
KIBRCV 
KIBSND 
KIBSPL 
KIBSPLW 
SETVIMS 
BMEASx 
SEARCHx 

 
 

UAP modules 
In the user access point (UAP) modules, you will notice that the functionality within the ACS software 
does not match the UAP functionality within the KTE software. Due to this incompatibility, the UAP 
code used in a KTE recipe must be recreated in the ACS environment. 

 

Limits file 
In the KLF file, the conversion tool translates the following fields: RPT, CRT, TAR, UNT, VAL, and 
SPC. The conversion tool does not support the CAT, AF, AL, CNT, or ENG fields. 

• UNT, units string 
• CAT,category parameter 
• RPT, report parameter 
• CRT, critical parameter 
• TAR, target parameter 
• AF, abort_action parameter 
• AL, abort_limit parameter 
• VAL, valid minimum value, valid maximum value 
• SPC, spec minimum value, spec maximum value 
• CNT, control minimum value, control maximum value 
• ENG, engineering minimum value, engineering maximum value 

Support one WDF only for a single project. Wafer description must be the same among all the tested 
wafers. 
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Cassette plan mode 
The conversion tool will only support the conversion of KTE CPF recipes that use the same wafer 
plan file for all slots in the cassette. This is known as “ALL” mode in a KTE Cassette Plan. 

 



 

 

In this section: 

ACS Commands introduction ................................................. 13-1 
ACS Commands .................................................................... 13-3 

 
 

ACS Commands introduction 
The command line execution function in ACS is available to you as a way to start ACS software by 
using the command window. ACS can be started and operated through command lines in the 
Windows® command execution utility. First, you must open the Command Prompt from the Start 
menu. Second, you will need to input the command that you want to execute (see next two Figures). 

Figure 624: Command Prompt 

 

Figure 625: Windows command execution utility 
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Using the command lines provides a convenient way for the interaction between ACS and those who 
also keep a comparatively matched consistency with the S400 or S600 system in operating style and 
diversification of user interface. The commands are listed in the next Table. The commands are case 
insensitive and path free. 

Table: Command list 

Commands Description 
startacs start ACS software 
startauto perform automatic execution 
startktec start KTE conversion tool 
loadprj load an ACS project 
hide hide ACS GUI 
show show ACS GUI 
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ACS Commands 

Start ACS command 
Purpose: start ACS software by using the command window. 
Format: 
startacs [-options] [args] 

When you use the startacs command, you can specify login options to load after ACS has started. 
However, you cannot use this command if ACS is already open (see next Table). 

Table: Start ACS command options 

Options Arguments Example Description 
N/A N/A startacs start ACS in online or offline mode 
-d N/A startacs -d start ACS in demo mode 
-prj project name startacs -prj HCI start ACS with a project loaded as the 

default 
-help N/A startacs -help show the help information 

Here is an example of a command line that will open ACS in demo mode and will load project HCI as 
the default: 
startacs –d –prj HCI 

Automatic execution 
Purpose: start ACS software to automatically execute a .xml project by using the command window. 
Format: 
startauto [-options] [args] 

When you use the startauto command, you must make sure that ACS is already open. However, you 
cannot use this command if ACS is executing a test. Also, for this command to execute, you will 
need to make sure that the Keithley limit file (.klf) and the wafer description file (.wdf) file are 
identified in the file path (see next Table). 

Table: Start auto command options 

Options Arguments Example Description 
-l Keithley limit file startauto -l D :\H.klf start automation with the H.klf 
-prj project name startauto -w D :\a.wdf start automation with a .wdf imported 
-lid lot ID number startauto -lid LOT1 start automation with lot LOT1 
-help N/A startauto -help show the help information for this command 

Here is an example of a command line that will first open the project HCI, then with a H.klf applied 
and a .wdf imported, and then the LOT ID configured with LOT1: 
startauto -l D:\H.klf -w D :\a.wdf -prj HCI -lid LOT1 
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Start KTE conversion tool 
Purpose: start the KTE conversion tool that allows you to convert KTE projects to ACS projects by 
using the command window. 
Format: 
startktec 

For more information about the KTE conversion to ACS projects, see the KTE conversion to ACS tool 
section. 

Load an ACS project 
Purpose: load an ACS project by using the command window. 
Format: 
loadprj [-options] [args] 

When you use the loadprj command, you must make sure that ACS is already open. However, you 
cannot use this command if ACS is already executing a test (see next Table). 

Table: Load project command options 

Options Arguments Example Description 
N/A project name loadprj HCI load a project named HCI 
-help N/A loadprj -help show the help information for this command 

Hide the ACS GUI 
Purpose: hide the ACS GUI by using the command window. 
Format: 
hide 

Show the ACS GUI 
Purpose: show the ACS GUI by using the command window. 
Format: 
show 
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UF BTI Introduction 
The Keithley Instruments Automated Characterization Suite (ACS) software contains an optional 
ultra-fast BTI (bias temperature instability) package that can only be used with the Keithley 
Instruments Model 4200-SCS Semiconductor Characterization Suite. 

If you do not have a Model 4200-SCS, the ultra-fast BTI option will not be functional with your 
version of ACS. For more information about the Model 4200-SCS that is used with the ACS software, 
refer to the supplied documentation that was shipped with your purchase. You can also visit the 
Keithley Instruments website at www.keithley.com to search for updated information by model 
number. 

 

Ultra-fast BTI is a reliability test, therefore, it uses AC and DC reliability stress and measure 
techniques (stressing a device and measuring how the device withstands the stress). This technique 
of stress and measure is with ultra-fast coordination of the Keithley Instruments Series 2600B 
SourceMeter®, the Model 4200-SCS with the Model 4225-PMU, two Model 4200-SMUs, and the 
Model 4225-RPM that provides the source and measure.  

The Model 4200-BTI-A Ultra-Fast BTI Package combines advanced DC I-V and ultra-fast I-V 
measurement capabilities with automatic test executive software to provide an advanced NBTI/PBTI 
test platform to the semiconductor test industry. The 4200-BTI-A package, which builds on the Model 
4200-SCS semiconductor parameter analyzer’s test environment, includes all the instruments, 
interconnects, and software needed to make NBTI and PBTI measurements on silicon CMOS 
technology. 
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UF BTI general notes 
In order to conduct ultra-fast testing, the Model 4200-SCS must use a Model 4225-PMU ultra-fast I-V 
module. Each Model 4200-SCS chassis can accommodate up to six Model 4225-PMU modules to 
provide up to twelve ultra-fast source and measure channels. The Model 4225-PMU module is the 
hardware core of the ultra-fast I-V measurement capability for characterizing NBTI and PBTI 
degradation in microseconds, allowing for accurate lifetime measurements for Designed-In Reliability 
(DIR) that support modeling for device and circuit design. It integrates a sophisticated two-channel 
waveform generator with high-speed voltage and current measurement capabilities, a deep 
measurement buffer, and a real-time test execution engine. 

Unlike traditional pulse generation solutions, the Model 4225-PMU can be programmed to output the 
complex waveforms required in ultra-fast BTI testing. And, unlike traditional Arbitrary Waveform 
Generators (AWGs), the waveforms’ duration and complexity are not limited by bitmap or memory 
depth. Instead, the 4225-PMU employs a high-level waveform description language that uses the 
concept of segments, segment libraries, and looping. In addition, the waveform description specifies 
exactly when measurements must be made during the waveform and the type of measurement to be 
made. 

 

The following measurement types are supported and multiple measurement types can be linked to 
form a test sequence: 

• Spot 
• Step sweep 
• Smooth sweep 
• Sample 

The programmable sample period can be set as fast as 5 ns, so most measurements will include 
multiple samples. The system’s real-time test execution engine automatically calculates the 
mathematical mean of the samples, which reduces the volume of data that must be transferred and 
parsed during the course of the test. The resulting measurements are streamed back to the high-level 
test module for near-real-time analysis and test termination. 

Each channel of the Model 4225-PMU combines high speed voltage outputs (with pulse widths 
ranging from 20 nanoseconds to DC) with simultaneous current and voltage measurements. With this 
combination of ultra-fast high-speed voltage source and current measurement capabilities, the Model 
4200-SCS and ACS software tools can be used for a wide range of ultra-fast I-V test applications. 
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The Model 4225-RPM (Remote Pulse Measure) connects to the Model 4225-PMU and expands the 
PMU's capabilities by providing four additional low current ranges, offering current sensitivity down to 
tens of picoamps. The Model 4225-RPM also reduces cable capacitance effects and supports 
switching automatically between the Model 4225-PMU, the Model 4210-CVU, and other SMU 
modules installed in a Model 4200-SCS chassis (see next Figure). This allows you to choose the 
most appropriate instrument for a particular measurement task without re-cabling. 

Figure 626: Model 4225-RPM and Model 4200-SCS backplane 

 
 

ACS software solution 
The ultra-fast BTI test software module brings together the measurement capabilities of the Model 
4225-PMU and 4225-RPM through an intuitive interface without compromising test flexibility. It makes 
it easy to define stress timing, stress conditions, and a wide range measurement sequences from 
spot, sweep, and sample tests. The test module allows measuring recovery effects as well as 
degradation. It also offers prestress and poststress measurement options for both single device and 
multiple device tests that incorporate the Model 4200-SCS’s DC SMUs for high-precision low-level 
measurements, however, DC tests are only available for single devices. 

 

When used together, the Model 4225-PMU and Model 4225-RPM provide all the tools necessary to 
perform a range of applications that otherwise cannot be supported in a single instrument chassis: 

• Single-Pulse Charge Trapping/high-Κ dielectric characterization 
• Silicon-On-Insulator testing 
• LDMOS/GaAs isothermal characterization 
• Flash RTS ID 
• Phase-change random access memory (PCRAM) testing 
• Ultra-fast NBTI characterization 
• Charge pumping measurements 
• Thermal impedance characterization 
• MEMs capacitor testing 
• Random telegraph signal (RTS) CMOS 
• Charge-based capacitance measurement (CBCM) materials testing for scaled CMOS, such as 

high-Κ dielectrics 
• NBTI/PBTI reliability tests 
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UF BTI hardware configuration 
Interconnect 
The 4200-BTI-A package provides all the cabling and connectors required to connect to standard 
coaxial probe manipulators. For enhanced measurement accuracy, you will be able to add an optional 
multi-measurement performance cable (MMPC) kit that connects the Model 4200-SCS to a prober 
manipulator, simplifying switching between DC I-V, C-V, and ultra-fast I-V testing configurations. This 
kit eliminates the need for re-cabling, as well as maximizing signal fidelity by eliminating the 
measurement errors that often result from cabling errors. Versions engineered for Cascade Microtech 
and SUSS MicroTec probers are available. There is also a general-purpose kit for connecting the 
4225-PMU to other triaxial and coaxial probe stations. 

Before you start to configure your testing parameters, make sure that Hardware Configuration has 
been run to ensure that connections to the SMU and RPM have been established. 

The following table shows the minimum required hardware to utilize ultra-fast BTI with the Model 
4200-SCS: 

 

Ultra-fast BTI minimum hardware requirements 

Quantity Part number Name 
One 4225-PMU pulse source and measure unit card 

Two 4225-RPM remote pulse measure unit card 
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The 4200-BTI-A package provides all of the necessary interconnect cables supplied for hardware 
configurations. However, you may find that the connection cables and adapters needed will depend 
on your specific prober hardware. 

The 4225-RPM contains two input and two output TRX connections for the SMU sense and SMU 
force. It contains one CVU potentiometer SMA connection and one CVU current potentiometer SMA 
connection. It also contains one RPM control slot for the RPM control cable. There is a status LED on 
top of the unit that turns green when fill-in-the BLANK occurs, red when fill-in-the BLANK occurs, and 
yellow when fill-in-the BLANK occurs (see next figures). 

The Model 4225-RPM comes with an optional magnetic base for added stability. 

Figure 627: Model 4225-RPM input connections 

 

Figure 628: Model 4225-RPM output connections 
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There is a status LED on top of the unit that signifies the current measurement state of the RPM (see 
next figure): 
Green = pulse 
Blue = SMU/DC 
Red = CV 

Figure 629: Model 4225-RPM status LED 

 
 

The ultra-fast BTI coordination of instruments sourcing and measuring time starts at <100 ns and 
can increase to seconds or hours depending on your application and needs. 

 

When using the Model 4225-RPM, the following timing, measurement, speed and simplicity 
capabilities are recognized: 

• Measure low current (<10 nA resolution and noise) 
• Quickly Measure low current (at least one reading within 1 µs) 
• Visibly Measure low current (1 µs off-stress window includes source transitions of rise, fall ,and 

settling) 
• Flexibly source waveforms and measure methods 
• Provide SMU capability without re-cabling 
• SMUs not connected while pulsing, pulsers not connected (high impedance, low leakage) when 

performing SMU sweeps  
 

When you connect the Model 4200-SCS to the Model 4225-RPM it must be from the Model 4200-
SMU and the Model 4225-PMU. The Model 4225-RPM must be connected to the device under test 
(DUT) (see next figure). 

When you connect the Model 4200-SMU to the Model 4225-RPM, make sure you use the input 
connections for the SMU sense and force using the standard triax cables. Also, for the Model 4225-
PMU, make sure you use the RPM control cables to connect the Model 4225-RPM. Once you have 
made those connections, you can make the connections from the Model 4225-RPM to the DUT. The 
cables that are used for connecting to the DUT are the multi-measurement performance cables 
(MMPC). 
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The following graphic shows the minimum hardware requirements for the Model 4225-PMU, the 
4200-SMUs, the 4225-RPMs, and the DUT. 

Figure 630: Model 4225-RPM detailed diagram to DUT 

 

This top-down view of a Cascade Microtech analytical probe station illustrates best practices for 
interconnecting the Model 4225-RPM to the prober using the blue MMPCs (see next figure). 

 

Figure 631: Interconnection for Model 4225-RPM to prober 

 

This close-up of two Model 4225-RPMs highlights the DC SMU, C-V, and ultra-fast I-V cable 
connections (see next figure). 
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Figure 632: Interconnection of two Model 4225-RPMs to prober 

 
 

UF BTI descriptions 
The ultra-fast BTI project in ACS includes python test modules (PTM) and interactive test modules 
(ITM) (see next figure). 

An ITM is used for DC testing. 

Figure 633: ACS ultra-fast BTI project tree 
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The ACS graphical user interface (GUI) for PTMs and ITMs contains three main tabs (Setup, Data, 
Status) and is similar to the NBTI project (see next figure). 

Figure 634: Ultra-fast BTI Setup tab 

 

In this Reference manual, there is a topic named Python language Test Module (PTM) configuration 
(on page 5-127). Refer to this topic for additional information regarding PTMs. You can also find 
more information about the NBTI test setup, including the GUI interface. 
Additionally, a PTM is defined by the python software language. ACS software contains example 
projects that include ultra-fast BTI PTM modules that you can review for more information. 

 

After you create a new ultra-fast BTI PTM in the configuration navigator, you must make sure that it is 
configured correctly for your test requirements: 

1. Setup -- contains five sub-tabs for test parameter purposes and is the primary interface that 
allows you to configure an ultra-fast BTI test module and display the current configuration. 

2. Data -- contains plot and data information of test results that are displayed in spreadsheet format 
and plot format in real-time test execution. 

3. Status -- contains text of test results based on configured parameters. 

In the Setup tab there are five sub-tabs: 

1. Device Settings 
2. Stress Settings 
3. Pre-Stress Tests 
4. Measure 
5. Post-Stress Tests 

When you first open the PTM GUI, the following figure gives an example of what you will see. This is 
where you begin to configure your testing parameters (see next figure). 

Before you start to configure your testing parameters, make sure that Hardware Configuration has 
been run to ensure that connections to the SMU and RPM have been established. 

 

Import a python file 

You can click the Import or Save function on all five sub-tabs at any time (see next figure). 

Figure 635: Import and Save function 

 



Section 14: Ultra-Fast BTI ACS Automated Characterization Suite (ACS) Reference Manual 
 

14-10 ACS-901-01 Rev. H / December 2014 

 

Click the Import function and the dialog box opens where you can import a python script file (see next 
figure). 

The python script file will overwrite the current PTM file information that you are viewing in your 
project folder. 

Figure 636: Import a python file 

 

Load Device 
On the device level (for example, the DUT nMOSFET_42) of the Device Settings tab, you will need to 
add hardware to your test configuration. Click the Load Device function and the dialog box opens 
where you choose the device (see next figure). 

Figure 637: Select the BTI device 
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Once you select the device, the dialog box opens. Depending on the type of device chosen, you can 
pick a bitmap graphic that will display on the Device Settings tab (see next figure). 

Figure 638: Bitmap device Image Browser 

 

Device Settings tab 

In the next figure, you see that two Model 4225-RPMs are connected to the drain and the gate of the 
pMOSFET device. Also, note that the source and bulk of the device are connected with a MMPC 
Ground. 

Figure 639: BTI PTM Device Settings 
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Depending on your configuration and parameters, the following table shows how the Pad Name 
(type) and the RPM type are used interchangeably (in other words, how they can be configured): 

Pad Name (type) RPM type 

Drain RPM 
Gate RPM 
Source RPM, MMPC Ground, None 
Bulk RPM, SMU, MMPC Ground, 

None  

You can use the drop-down arrow to choose the type of RPM, based on your configuration and the 
Pad Name (see next figure). 

Figure 640: Pads-SMUs Mapping settings 

 

If there is only one subdevice when a terminal is connected to the RPM, the SMU connected to the 
RPM will appear in the SMU connected to RPM column and the SMU test will be available in the 
Pre-Stress Tests and Post-Stress Tests. If there is more than one subdevice in your configuration 
settings, the SMU connected to RPM column will not be available and the SMU test will not be 
available (see next figure). 

Figure 641: More than one subdevice 
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Save RPM Mapping 

Click the Save RPM Mapping function and the dialog box opens where you can choose to save your 
.csv file (see next figure). 

Figure 642: Save RPM Mapping file 
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Load RPM Mapping 

Click the Load RPM Mapping function and the dialog box opens where you can select a .csv file to 
import (see next figure). 

When you load a .csv file, you will have to navigate to the folder where the ACS projects have been 
saved to find the correct file. 

Figure 643: Import RPM Mapping file 

 

Stress Settings tab 
On the Stress Settings tab you will see five different areas that you need to configure for testing 
parameters (see next figure): 

• Stress Time - establishes the duration of the test and each BTI PTM can have a unique stress 
time 

• Recover Time - the Recover function must be selected for this area to be enabled; the Stress 
Time settings are duplicated when this area is enabled 

The default function is for the Recover Time area to duplicate the Stress Time settings, however, you 
can change the Recover Time settings if needed. 

• Stress Type - DC and AC are the available types 
• Recover Type - identical to Stress Type; DC and AC are the available types 
• Stress Conditions - establishes the conditions needed for your test 
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Figure 644: BTI PTM Stress Settings 

 

Stress Time settings  

You have three choices to configure your stress time scale:  

• Linear - ensures all stress times are the same 
• Log - ensures all stress times increase logarithmically with each cycle 
• List - allows you to specify the stress times  

If you select Linear, the Stress List options (Insert, Remove, and Clear) will be not be active and you 
must make changes to the edit boxes for your testing needs (see next figure): 

• First Stress - enter the amount of time (seconds) your devices are stressed during first cycle 
• Last Stress - enter the total stress time for your entire subsite plan 
• Points - enter the number of stress points you want for your test 

Figure 645: Stress Time Linear settings 
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If you select Log, the Stress List options (Insert, Remove, and Clear) will not be active and you must 
make changes to the edit boxes for your testing needs (see next figure):  

• First Stress - enter the amount of time (seconds) your devices are stressed during first cycle 
• Last Stress - enter the total stress time for your entire subsite plan 
• Stresses/Decade - enter the number of tests that you want performed 

Figure 646: Stress Time Log Settings 

 

If you select List, the Stress List options will be active and you can make changes directly in the list 
(see next figure):  

• Insert - use your keyboard to enter a series of stress times by clicking the function 
• Remove - select one of the list items and click Remove will remove that item from the list 
• Clear - click and the entire Stress List will be removed 

Figure 647: Stress Time List settings 

 

Stress Type settings 

The Stress Types available are DC and AC. In the DC type, Frequency, Duty Cycle, and Rise/Fall 
Time are not functional. These stress type settings are only available in the AC type (see next figure). 

Figure 648: Stress Type settings DC 
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In the AC type, you will see the following functions where you can change the settings based on you 
testing needs (see next figure): 

Frequency - you will need to choose and input based on your testing needs (highest frequency 
available is 10 M) 

Duty Cycle - you will need to choose and input based on your testing needs 

Rise/Fall Time - you will need to choose and input based on your testing needs 

Figure 649: Stress Type settings AC 

 

Stress setting limitation 

The UF BTI module uses a 4225-PMU to generate the waveform and take measurements. According 
to the 4225-PMU specifications, the test module sets a limitation to the stress time sequences. In the 
GUI, a note will show how many sequences are used and how many sequences are left. If the stress 
time exceeds the maximum limits, you will see an indication in the GUI (see next figure). 

Figure 650: Stress Time sequences 
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NOTE: Between the Stress Time settings and the Recover Time settings are the following five 
settings: 

1. Stress/Recover Cycle - enter the fixed number of times (cycles) that you want the subsite test to 
execute (256 maximum) 

NOTE: The Stress/Recover Cycle is only available when the Recover function is enabled. 

2. Hold Time(s) - measures the device (DUT) before testing occurs; you can specify 0 to 1000 
seconds; default is 0 

NOTE: The Hold Time should be less than the shortest stress/recover time so that monitor will be 
performed in each stress/recover section once monitor is enabled. 

3. Sample Rate - defines the sampling rate of the PMU cards (all cards involved in BTI testing will 
have the same sampling rate) 

4. Transition Time - the interval between corresponding points on the rising or the falling edge of the 
pulse 

5. Temperature - shows the current temperature of the chuck in Celsius 

You will also see the Test Diagram function in this area (see next figure). These settings are for 
global usage in the test configuration that will be used in the Pre-Stress Tests, Measure, and Post-
Stress Tests. 

Figure 651: Stress and Recover settings 
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If you select the Test Diagram function, the dialog box opens that defines the type of testing with an 
example diagram (see next figure). 

Figure 652: Test Sequence Diagram 

 

Recover Time settings  

Similar to the Stress Time Settings, you have three choices to view your stress time scale:  

• Linear - ensures all stress times are the same 
• Log - ensures all stress times increase logarithmically with each cycle 
• List - allows you to specify the stress times  

However, note that you have to select the Recover option for the Recover Time and Recover Type 
features to be functional, including the Stress/Recover Cycle function mentioned previously (see next 
figure). 

Figure 653: Stress Settings Recover function 
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If you select Linear, the Stress List options (Insert, Remove, and Clear) will be not be active and you 
must make changes to the edit boxes for your testing needs. 

• First Stress - enter the amount of time (seconds) your devices are stressed during first cycle 
• Last Stress - enter the total stress time for your entire subsite plan 
• Points - enter the number of stress points you want for your test (128 maximum) 

If you select Log, the Stress List options (Insert, Remove, and Clear) will not be active and you must 
make changes to the edit boxes for your testing needs (see next figure):  

• First Stress - enter the amount of time (seconds) your devices are stressed during first cycle 
• Last Stress - enter the total stress time for your entire subsite plan 
• Stresses/Decade - enter the number of tests that you want performed (128 maximum) 

If you select List, the Stress List options will be active and you can make changes directly in the list 
(see next figure):  

• Insert - use your keyboard to insert a series of stress times by clicking the function 
• Remove - select one of the list items and click Remove will remove that item from the list 
• Clear - click and the entire Stress List will be removed 
Recover Type settings 

The Recover Types available are DC and AC, which are the same as the Stress Types . In the DC 
type, Frequency, Duty Cycle, and Rise/Fall Time are not functional. In the AC type, you will see the 
Frequency, Duty Cycle, and the Rise/Fall Time available for you to change based on your testing 
needs. 

Depending on your testing needs, the Stress Type and Recover Type (AC or DC) do not have to be 
identical as far as values or type. In other words, the Stress Type can be AC and your Recover Type 
can be DC, if desired. 

Stress Conditions 

The Stress Conditions are in columns and they represent the terminals that are connected to the 
RPM. You can view and set up the conditions needed for your test: 

Checked - you can choose if the device in that row should be tested by selecting or deselecting (see 
next figure). 

Device No. - indicates the number of the device. 

W(um) - you can change the width of the device in microns for testing purposes. 

L(um) - you can change the length of the device in microns for testing purposes. 

RPM - you can view the status of module. 

Terminal - you can view the area of the RPM that is going to be tested. 

Pin No. - indicates the pin that is tested. 

Stress Voltage - you choose the constant high voltage state that you want applied. 

Stress Base - is only enabled for AC stress and you choose the low voltage that you want applied. 

Recover Voltage - your defined high voltage state applied 

Recover Base - is only enabled for AC recover and it displays the defined low voltage state applied 
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The Stress Voltage is available no matter what stress type is enabled. The Stress Base is enabled 
for AC stress only. When Recover is enabled, Recover Voltage is available for both AC and DC 
recover. And, Recover Base is only enabled for AC Recover type. 

Monitor - if enabled for a terminal, the current of that terminal will be measured once at the beginning 
of each stress/recover loop on a PMU and RPM. 

The Monitor function will be active if the Stress Type or Recover Type is DC. 

Meas Range - you can choose the range of parameters needed based on the device and stress 
conditions. 

Phase_shift (Stress) - on the terminal gate is disabled; the shape of the waveform on the gate is the 
same as graphic in the GUI; the phase shift of the waveform on other terminals will use the waveform 
on the gate as a reference and will shift to the left side; a valid shift value will fall between 0 - period; 
ACS will check the input value. 

Phase_shift (Recover) - defines the phase shift in Recover phase. 

The Phase_shift function will be active if the Stress Type or Recover Type is AC. 

Figure 654: Stress Conditions 

 

Pre-Stress Tests tab 
On the Pre-Stress Tests tab you will see a list of your pre-stress tests as well as an area for you to set 
up your Output Parameters Settings. Additionally, you will see four different functions that allow you 
to add four different types of tests (see next figure). 

• SMU - measurement of DC; available if one subdevice is connected to RPM 
• Spot - measurement that returns one value 
• Sweep - measurement that has a starting and stopping point, over a period of time, that returns a 

range of values 
• Sample  - measurement that allows you to choose when to start measuring and the amount of 

points you want to measure 
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Figure 655: BTI PTM Pre-Stress Tests 

 

You can choose all four tests at once and run your tests, or select one at a time. 

The SMU test is a DC test and is performed on the SMU. Also, note that this test is only available if 
one subdevice is connected. If there is more than one device, the SMU test will not be available (see 
next figure). 

Figure 656: Timing of DC test 
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The Spot, Sweep, and Sample tests are performed on the PMU that is connected to the RPM. 

The Spot, Sweep, and Sample tests are available on the Pre-Stress Tests tab, Measure tab, and the 
Post-Stress Tests tab. All three tests function the same on each tab. For more information and 
descriptions of each test, continue to the next topic for the Measure tab. 

 You can change the sequence of the testing by clicking the row of the test and clicking the up or 
down arrow to the right of the window, or delete any test by clicking the red X.  

The SMU test cannot be moved and it will run first before any other tests. 

The Pre-Stress Tests Output Parameters Settings allow you to create Global parameters, indicate a 
low and high variable, and if the testing should exit based on the established parameters. 

Measure tab 
On the Measure tab you will see a tab for each device that you have configured for testing, as well as 
an area for you to set up Parameter Properties/Degradation Targets. You will also see Tests Settings 
for the device and four different functions that allow you to add four different types of tests (see next 
figure). 

• Spot - measurement that returns one value 
• Sweep - measurement that has a starting and stopping point, over a period of time, that returns a 

range of values 
• Sample - measurement that allows you to choose when to start measuring and the amount of 

points you want to measure 
• Inter Stress -  unique test inserted between two measurements to allow the DUT time to recover 

from the prior measurement (contains voltage value that is usually associated with the stress 
value) 

The Measure tab does not allow you to run DC tests. 
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Figure 657: BTI PTM Measure 

 

The terminals shown on the GUI represent the terminals connected to the RPM.  

Spot test: spot mean measurement with the PMU. No calculation is provided for the spot test.  

Double click in the Timing column cell of a test and the Timing window of the spot test will display. A 
measurement is made during the Meas Window and is defined by Meas Start and Meas Stop values. 
One current value is returned (see next figure). 
Timing of Spot test 

Figure 658: Timing of Spot test 
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Sweep test: sequence of spot mean measurement with the PMU. The value of Points is at least two. 
The Start and Stop voltage value of the sweep terminal are split by a comma. Formulas are available 
by double clicking a Formula column cell of a sweep test. Double click the Timing section and the 
Timing of Sweep test is displayed (see next figure). 
Timing of Sweep test 

Figure 659: Timing of Sweep test 

 

Timing of Sample test 

Sample test: waveform capture measurement is performed. Data is collected at the sample rate. You 
can choose to measure during the transition time. Once the measurement time is complete, ACS will 
calculate the data and display the points once you set the pulse top value. An example of the Timing 
for Sample is displayed in the next figure. 

Figure 660: Timing of Sample test 
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Inter Stress: allows you to define some special voltage status between two tests. Usually, the device 
will go back to stress condition for a while because in the previous tests the device might recover. No 
measurement is provided with Inter Stress. As indicated in the test diagram, Inter Stress test will only 
be applied in the  measurement phase after a stress phase. It will not be applied to the recover-
measure phase, it cannot be the last test completed, and it cannot be the only test performed (see 
next figure). 

Figure 661: Timing of Inter Stress 
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ACS provides basic calculation of Vth, Gm, and sub-threshold slope among others. However, if you 
double click a Formula column cell, the Formulator Settings window appears. The Formulator is a 
mathematical test results analysis tool where you can manipulate test data with user-defined 
formulas. It allows in-test and post-test data computation (see next figure). 

Formula is available for sweep test only. 

Formulator Settings 

Figure 662: Formulator Settings dialog box 

 

Parameter Properties/Degradation Targets 

These are variables and the measured and calculated results that have only one value will appear in 
this table. The Parameter Properties/Degradation Targets functions determine when to stop a test on 
a device. The Shift function is from the initial value of a variable and is calculated and compared with 
the target value. When the target is met, the test on that device will be terminated. If Recover is 
enabled, this section of the GUI is disabled (see next figure). 

Figure 663: Parameter Properties_Degradation Targets functions 
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Post-Stress Tests tab 
Post-Stress Tests are the same as Pre-Stress Tests: 

• SMU - measurement of DC; available if one subdevice is connected to RPM 
• Spot - measurement that returns one value 
• Sweep - measurement that has a starting and stopping point, over a period of time, that returns a 

range of values 
• Sample  - measurement that allows you to choose when to start measuring and the amount of 

points you want to measure 

Refer to the previous topics on Pre-Stress Tests and Measure for more information and descriptions 
of each test.  

The only difference is the Output Parameters Settings. Note that the Pre-Stress Tests Output 
Parameters Settings allow you to create Global parameters, indicate a low and high variable, and if 
the testing should exit based on the established parameters. The Post-Stress Tests Output 
Parameters Settings does not allow you to configure these same types of parameters and are for 
measurement purposes only (see next figure). 

DC testing is permitted, however, DC testing will be performed after pulse testing has completed. 

Figure 664: Post-Stress Tests 
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UF BTI project information 
There are two demo projects that are included with your version of ACS software for the ultra-fast BTI 
test. The UF_BTI_1DUT  is one project that represents a standard 4-terminal device. The 
UF_BTI_nDUTs is another project that is a more complicated device structure since it consists of 
more than one device. 

Since PBTI (positive bias temperature instability) tests are usually performed on nMOSFET devices 
and NBTI (negative bias temperature instability) tests are usually performed on pMOSFET devices, 
the ACS software package contains tests for both devices (see next figure). 

Figure 665: UF_BTI_1DUT test tree 
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Tests (or modules) that are under the nMOSFET_42 device are: 

• RPM_config: PTM test used to turn RPMs to SMU mode so that a SMU test can be performed. 
• IdsVg_NMOS: ITM test used to get IdVg curve of a device with SMU. 
• RPM_config1: PTM test used to turn RPMs to PMU mode since BTI tests are all performed with 

PMU. 
• UF_PBTI_Vt: PBTI test which contains IdVg test and Vt (threshold voltage) extraction in 

measurement phase. 
• UF_PBTI_OTF: On_The_Fly PBTI test which extracts shift of threshold voltage in measurement 

phase. 
• UF_PBTI_Id: PBTI test contains sampling on drain current in measurement phase. You can 

capture the drain current immediately after stress. 

Tests under the pMOSFET_42 device are similar to the nMOSFET_42 device, with the exception of 
the polarity of the voltage. 

When a test structure contains more than one device, there are two possibly different cases:  

1. Devices that have shared device terminals. 
2. Devices that have separate device terminals.  

In the case of shared terminals, ACS permits a shared gate, source, and bulk. However, it is not 
possible for devices to have a shared drain. Included with your version of ACS software, you will find 
a project that provides tests for separate PMOS devices (named PMOS_notshared_Gate) and shared 
gate PMOS devices (named PMOS_shared_Gate) (see next figure). 

Figure 666: UF_BTI_nDUT test tree 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 14: Ultra-Fast BTI 
 

ACS-901-01 Rev. H / December 2014 14-31 

 

Tests (or modules) that are under the PMOS_shared_Gate device are: 

• RPM_config: PTM test used to turn RPMs to PMU mode since BTI tests are all performed with 
PMU. 

• UF_NBTI_S_Vt: NBTI test which contains IdVg test and Vt (threshold voltage) extraction in 
measurement phase. 

Tests under the PMOS_notshared_Gate device are similar to the PMOS_shared_Gate device, with 
the exception of separate device gates for each device. Also, in either test structure, all testing is 
accomplished in parallel. 

In the next figure, notice that the device graphic shows one gate for three different devices. Also, 
notice that there are three different sources and one bulk (see next figure). 

Figure 667: Multiple DUT for shared Device Settings tab 

 

In the next figure, notice that the device graphic shows a separate (not shared) gate for both devices. 
Also, notice that each device has a separate source and separate bulk (see next figure). 

Figure 668: Multiple DUT for not shared Device Settings tab 
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UF BTI data 
Data tab 
When you perform tests during the ultra-fast BTI testing, data is captured and can be viewed on the 
Data tab (see next figure). 

Figure 669: PTM Data tab GUI 

 

You can use the Plot Only function to view the test results, the Data Only function, or both functions 
(Plot and Data) simultaneously (see next figure). 

Figure 670: PTM Plot and Data GUI 
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Each module will have test results that you can view. Plus, you can save the results in order to view 
the data at a later date (see next figure). 

Figure 671: Save Plot and Data information 
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Introduction 
The ACS software package provides several sample projects and test modules for special use cases. 
Theses sample projects or test modules are usually for specific instruments. This section gives a 
detailed description about these projects: 

• Model 237-HV reliability test modules (RTM) 
• High-voltage and high-current CV PTM  
• Charge pumping test module 
• SWEAT test module 
• Power supply library 
• DC stress-measure test module 
• Pulse stress-measure loop project 
• Stress migration project-resistance batch measurement 

 

Section 15 

ACS sample projects and test modules 
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Model 237-HV RTM 
The Model 237-HV (high-voltage) reliability test module (RTM) is an extended version of the 2600-
based RTM module that uses the Model 237-HV source-measure unit (SMU). These test modules 
extend the voltage range applied to a device under test (DUT). The Model 237 SMU is able to reach 
±1100 volts. These test modules include HV TDDB, HV VRamp, HV JRamp, and HV HCI modules. 
The test flow and function is the same as the corresponding 2600-based RTM modules. These test 
modules are in the PTM category, and support two DUTs tested sequentially. For more information 
about TDDB, VRamp, JRamp, and HCI, refer to the ACS 2600 RTM manual (document number 
ACS2600RTM-900-01).  

Model 237-HV RTM features: 

• Enables ±1100V bias 
• Used with PTM modules 
• Sequential execution with two DUTs 

 

Hardware configuration 
The Model 237-HV RTM uses the Model 237-HV SMU. This instrument is a general purpose 
instrument in the ACS hardware configuration. For details on how to add a general purpose 
instrument, refer to ACS Reference Manual (document number ACS-901-01)(see next figure). 

Figure 672: Add a Model 237-HV SMU 
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Model 237-HV TDDB 
To access the Model 237-HV TDDB module, first create a PTM, then import the file from the following 
location: C:\ACS\library\pyLibrary\PTMLib\KI237_HV_TDDB.py. 

The differences between the Model 237-HV TDDB module and the TDDB are shown in the following 
examples: 

• The Model 237-HV TDDB is for two DUTs in a tested sequentially (refer to the next figure for the 
hardware connection). 

Figure 673: Model 237-HV hardware connection 

 

• Test flow: the stress will only be applied once, and there is no SILC (stress induced leakage current) 
test in the Model 237-HV TDDB. The test diagram of the Model 237-HV TDDB is shown in the next 
figure: 

Figure 674: Model 237-HV test diagram 
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• Settings: the Model 237-HV TDDB can be configured for a Max Time stress (for instance, a one-time 
stress, which does not have an inter-stress measurement, and contains the time span of the Max Time 
setting). The GUI for setting the time is shown in the next figure. 

Figure 675: Model 237-HV TDDB settings GUI 
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Model 237-HV VRamp 
The Model 237-HV VRamp is used with two DUTs in a sequential test. To access to the Model 237-
HV VRamp module, first create a PTM, and then import the file from the following location: 
C:\ACS\library\pyLibrary\PTMLib\KI237_HV_Vramp.py. 

The test flow for the Model 237-HV VRamp is the same as the 2600-based-RTM VRamp module (see 
the next figure): 

Figure 676: Model 237-HV VRamp settings 
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Model 237-HV JRamp 
Model 237-HV JRamp is used for two DUTs sequential test. To access to the 237-HV JRamp module, 
first create a PTM, and then import the file from the following location: 
C:\ACS\library\pyLibrary\PTMLib\KI237_HV_Jramp.py. 

The test flow for the Model 237-HV JRamp is the same as the 2600-based RTM JRamp module (see 
the next figure): 

Figure 677: Model 237-HV JRamp settings 
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Model 237-HV HCI 
The Model 237-HV HCI is with for two DUTs in a sequential test. To access to the Model 237-HV HCI 
module, first create a PTM, and then import the file from the following location: 
C:\ACS\library\pyLibrary\PTMLib\KI237_HV_HCI.py. 

A typical two DUT test connection is shown in the next figure: 

Figure 678: Model 237-HV HCI two DUT connection 
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The test flow and settings for the Model 237-HV HCI are similar to the 2600-based RTM HCI module. 
The only difference is that in the Model 237-HV HCI, the SMU assignment is at the Stress Settings 
tab rather than the device level on the configuration navigator. The Stress Settings tab is shown in the 
next figure: 

Figure 679: Model 237-HV HCI settings 
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High-voltage capacitance-voltage PTM 

Generic high-voltage capacitance-voltage PTM overview 
You can make capacitance-voltage (CV) measurements using this PTM module. 

The following are supported SMUs: 

• 4200 SMU 
• 2600 SMU 
• 2657 SMU 

The configuration of this PTM module requires the following setup: 

• Model 4200-CVU (to supply AC voltage). 
• Model 4205-RBTs (200 V remote bias tee) or 3 kV remote bias tee (up to four bias tees can be 

used in the configuration). 
• Model 8010 Test Fixture or Model 8020 Test Fixture 

For supplies of ±200 V or 400 V differential DC bias or sweep voltage, either the 4200 SMU or the 
2600 SMU can be used. The 4205-RBTs are connected to the device under test (DUT) through the 
Model 8010 test fixture. 

For supplies of 3 kV DC bias or sweep voltage, the 2657A SMU is needed. The 3 kV remote bias tees 
are connected to the DUT through the Model 8020 test fixture. 

Figure 680: HV_CV measurement hardware connections 

 
 

In the previous graphic, a four-terminal device is shown. You can also use this test for two-terminal 
and three-terminal devices. 
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Generic high-voltage capacitance-voltage functions 
The generic high-voltage high-current PTM library module is in the following directory: 
C:\ACS_BASIC\library\pyLibrary\PTMLib\GenericHVCVlib.py 

To open the module, import the .py file to your test. 

You can use this module to switch between three functions: C vs. V, C vs. t and C vs. f. The details of 
these three functions are indicated in the following figure. Descriptions follow the figure. 

Figure 681: High-voltage capacitance-voltage PTM module GUI 
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Generic high-voltage capacitance-voltage GUI descriptions 

Function: 

C vs. V: Using a voltage sweep, capacitance is measured at every step of the sweep to generate a 
Capacitance versus Voltage graph. An example is shown in the following figure. 

Figure 682: C vs. V waveform example 

 
 

C vs. t: Performs a specified number of capacitance measurements (Sample Count) at a specified 
time interval (Measurement Delay) with voltage and frequency held constant. The capacitance versus 
time measurements is then plotted on a graph. An example is shown in the following figure. 

Figure 683: C vs. t waveform example 
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C vs. f: Using a frequency sweep, capacitance is measured at every frequency point to generate a 
Capacitance versus Frequency graph. An example is shown in the following figure. 

Figure 684: C vs. f waveform example.png 

 
 

CVU connection compensation: 

• Compensation data file: Select compensation data file to be used. 
• Open: Enable or disable open compensation for CVU 
• Short: Enable or disable short compensation for CVU 

 

Double-click the cell to display the Timing dialog box for the selected function. 

Figure 685: C vs. V, C vs. t, and C vs. f Timing dialog boxes 

 

Measurement Speed: Selects the SMU and CVU measure speed. 

• Fast: Optimizes speed at the expense of noise performance. It is a good choice for fast 
measurements where noise and settling time are not concerns.   

• Normal: The most commonly used setting. It provides a good combination of speed and low 
noise, and is the best setting for most cases.   

• Slow: Optimizes the low-noise measurements at the expense of speed. If speed is not a critical 
consideration, it is a good choice when you need the lowest noise and most accurate 
measurements. 
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• Custom: Allows you to fine-tune the timing parameters to meet a particular need. With Custom, 
you can configure the integration time and the number of readings to produce a composite 
setting. The entries in the PLC edit fields control the A/D (analog-to-digital) converter integration 
time used to measure a signal. A short integration time for each A/D conversion results in a 
relatively fast measurement speed, at the expense of noise. A long integration time results in a 
relatively low noise reading, at the expense of speed. The integration time setting is based on the 
number of power line cycles (NPLCs):   
• For 60 Hz line power, 1.0 PLC = 16.67 msec (1/60 of a second).   
• For 50 Hz line power, 1.0 PLC = 20 msec (1/50 of a second). 

• CV optimized: This option allows you to select a setting that gives an accurate CV measurement. 
• PLC: If you selected the Custom measurement Speed mode, you can enter any value between 

0.001 and 25 NPLC. If you selected the Fast, Normal, Slow or CV optimized measurement 
Speed mode, ACS sets the A/D Integration Time correspondingly. The next table summarizes the 
allowed A/D Integration Time settings for various measurement Speed modes. 
Measurement speed PLC 
Fast 0.01 

Normal 1 

Slow 10 
Custom 0.001 to 25 
CV optimized 10 

 

• Delay Factor:  After applying a forced voltage or current, an SMU waits for a delay time before 
making a measurement. The delay time allows for source settling. The default delay time is pre-
programmed and range-dependent to allow for the very long settling times needed at very low 
current ranges. The applied delay time is a multiple of the default delay time and the value in the 
Delay Factor edit box specifies this multiple. 
Applied delay time = (Default delay time) x (Delay Factor) 
For example, if the default delay time is 1 ms and the Delay Factor is 0.7, the applied delay time 
is 0.7 ms (1 ms x 0.7). 
If you select the Custom measurement speed mode, you can enter a custom Delay Factor of 0 to 
100. If you select the Fast, Normal, Slow or CV optimized measurement speed mode, the SMU 
sets an appropriate fixed Delay Factor. 

Measurement speed Delay 
Factor 

Fast 0.7 

Normal 1.0 

Slow 1.3 
Custom 0 to 100 
CV optimized 1 
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• Filter Factor: To reduce measurement noise, an SMU applies filtering, which may include 
averaging of multiple readings to make one measurement. The value entered in the Filter Factor 
edit box specifies a multiple of this preprogrammed filtering. 
If you select the Custom measurement speed mode, you can enter a Filter Factor value of 0 to 
100. If you select the Fast, Normal, Slow or CV optimized measurement speed mode, the SMU 
sets an appropriate fixed Filter Factor. 

Measurement speed Filter Factor 
Fast 0.2 

Normal 1 

Slow 3 
Custom 0 to 100 
CV optimized 3 

 

Presoak Time (sec): Time in seconds to apply soak voltage. 

Measurement Delay (sec): Delay time in seconds before measurement. The delay time allows for 
source settling. 

#Sample (1-10000): Specifies the number of data points to be acquired during the test. 
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SMU settings: 

Pad: Cannot be changed here. Pads are fixed and referenced to the diagram in the device map field.   

SMU: Cannot be changed here. It can only be assigned in the device map field based on the 
hardware connection. 

Pad Name: The header for the data related to the hardware connection. 

Function: The function type for force. Double-click to select one of the following options from the 
drop-down list: 

• C vs. V: Bias V/Sweep V/List V/GND/Open can be selected, but only one SMU can be set to 
Sweep V or List V 

• C vs. t: Only Bias V/GND/Open can be selected 
• C vs. f: Only Bias V/GND/Open can be selected  

Source: The source value of SMU. Double-click the Source cell to display a Settings dialog box.  

Options for Bias V: 

• Presoak V: When the test is started and before measurement sequence, the device is stressed at 
a specified voltage (Presoak V) for a specified period of time (Presoak Time), as shown in the 
following figure. 

• Bias Level: Defines a constant and valid voltage at the terminal. 

Figure 686: Bias V settings 

 

Figure 687: Presoak V and Presoak time 
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Options for Sweep V: 

• Dual Sweep: You can set the SMUs in a test to perform a dual sweep. When enabled, the SMU 
will sweep from Start to Stop, and then continue to sweep from Stop back to Start. When it is 
disabled, the SMU will only sweep from Start to Stop. 

Figure 688: Sweep V settings 

 
 

Figure 689: Dual voltage sweep example 

 
 

• Presoak V: When the test is started and before measurement sequence, the device is stressed at 
a specified voltage (Presoak V) for a specified period of time (Presoak Time). 

• Start: The Start edit box specifies the voltage forced for the first data point of the sweep. 
• Stop: The Stop edit box specifies the voltage forced for the last data point of the sweep. 
• Step: The Step edit box specifies the size of the voltage increments and determines the 

calculated Points value {Points = integer value of [1 + (Stop - Start)/(Step)]} 
• Points: Shows the number of data points that are input when a sweep is executed. 
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Options for List V: 

• Presoak V: When the test is started and before measurement sequence, the device is stressed at 
a specified voltage (Presoak V) for a specified period of time (Presoak Time). 

• Points: The number of points for the forcing values.  
• Import Settings From CSV File: Allows you to import and then save a .csv file.   

• Edit item : Change the number. 

• New item : Adds a new item. 

• Delete item : Delete the selected item. 

• Move up : Move the selected item up. 

• Move down : Move the selected item down. 

Figure 690: List Sweep Settings 
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Measure: Measures the voltage unit in volts. 

Compliance: Enables the test to abort and turn off the SMU output when it reaches the compliance 
(limit) value. The value is limited by the specifications of the SMU.  

Meas.Range: This item is disabled. 

Advanced: Double-click the Advanced cell to open a dialog box that allows you to set advanced 
features for this SMU.  

Range Parameters: 

• Force Range: Specifies the SMU force range used to force voltage, including Best Fixed and 
numerical range options. 

• Meas. Limited Auto: This item is disabled. 

Misc: 

• High Capacitance Mode: Sets the SMU to high capacitance mode. 

Figure 691: SMU Advanced settings dialog box 
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CVU settings: 

Pad #: Changed with AC settings in the device map field accordingly.  

CVU: Cannot be changed here. It can only be assigned in the device map field. 

Pad Name: Changed with AC settings in the device map field accordingly. 

Function: Changed with the function selected. 

Frequency: Test frequency (Hz). A variable that selects the measurement frequency to use. 

• In C vs. V and C vs. t, the frequency is biased (10 KHz to 2 MHz) 
• In C vs. f, the frequency sweeps up or down 

Figure 692: Sweep Frequency Settings 

 

ACV: AC test voltage of CVU (10 mV to 100 mV RMS). 

Model: The parameters that can be measured by 4200-CVU: 

• Cp-Gp-D: Parallel Capacitance and Conductance and Dissipation Factor. 
• R+jX: Resistance and Reactance. 
• Z,Theta: Impedance and Phase Angle. 
• Cs-Rs-D: Series Capacitance and Conductance and Dissipation Factor. 
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Advanced 

Figure 693: CVU Terminal Properties dialog box 

 

• I Range: Fixed 1 mA 
• Capacitance Range Estimator: The capacitance is calculated from the capacitive impedance 

The test frequency range is calculated using the following formula: 

 

• C Max: The calculated capacitance 
• I Max(Range): Fixed 1 mA 
• Frequency: Test frequency, the value changed with the setting in CVU settings GUI accordingly 
• AC drive Voltage: Measured AC voltage, the value changed with the setting in CVU settings GUI 

accordingly 
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Device specific high-voltage capacitance-voltage PTM 
The device specific high-voltage capacitance-voltage PTM libraries are located in the following 
computer directory: ACS_BASIC\library\pyLibrary\PTMLib. They include the following test libraries 
specific to different devices:  

Specific_IGBT.py 
Specific_nMOSFET.py 
Specific_npnBJT.py 
Specific_pMOSFET.py 
Specific_pnpBJT.py 
Specific_nPowerMOSFET.py 
Specific_pPowerMOSFET.py 
Specific_npnPowerBJT.py 
Specific pnpPowerBJT.py 

Import the .py file you need for your test and the device module opens. 
 

Discharge test 
The discharge test PTM library module is located in the following computer directory: 
ACS_BASIC\library\pyLibrary\PTMLib\ Discharge_Test.py.  

This module is optional and is used to safely discharge the bias tee capacitance, especially once 
each CV test ends in which there is DC bias applied by the Model 2657A. You can import the .py file 
and insert in the test sequence. This module can discharge bias tees by programming all SMUs to 
zero volts with 1 mA compliance and turning their outputs on for 1 second then turning off. 

This module can be used for both Generic _HVCV_Test and device specific PTMs in MultiMode. 
 

Charge pumping test module 
Charge Pumping is a measure technique to evaluate the surface-states at the Si-SiO2 interface of the 
MOSFET devices. This method applies pulse on the gate of the MOSFET and measures the bulk 
current when the source and drain are biased. The bulk current is generated by the repetitive 
recombination at the interface traps of the minority carriers with majority carriers when the gate pulses 
the channel between inversion and accumulation. 

Charge pumping test module features: 

• PTM module 
• Using Agilent 8110 for waveform generating 
• Three pulse methods: square, triangle, trapezoid 
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Connection 
The gate of the MOSFET is connected to a pulse generator, and the source and drain are connected 
to SMU2. Also, the bulk is connected to SMU1 for the current measurement. 

Figure 694: Charge pumping module instrument connections 
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The Charge Pumping test module uses as Agilent 8110 (or 8110A) as the pulse generator, the SMU1 
is for the bulk current measurement, and SMU2 is for the bias on the Source and Drain. The Agilent 
8110 is added to the ACS Hardware configuration as a General Purpose Instrument (GPI), see the 
next two figures: 

Figure 695: Customized instrument settings 

 

Figure 696: General Custom Instrument Properties and Connection 
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Test modules settings 
The Charge Pumping Test Module has several functions to achieve different pulse methods. The 
function can be selected from the User Module drop-down menu. The module uses the standard ACS 
test module GUI(see next figure). To access to the Charge Pumping module, first create a PTM, and 
then import the file from the following location: C:\ACS\library\pyLibrary\PTMLib\ChargePumping.py. 

Figure 697: Charge pumping settings GUI 
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Square pulse method 
BaseSweep8110 and AmplSweep8110 

The BaseSweep8110 generates fixed amplitude voltage pulses on top of a linear voltage sweep. The 
AmplSweep8110 generates generates voltages pulses with linearly varying amplitude.  

Figure 698: Base sweep and amplitude sweep 

 

The test flow is shown in the next figure: 

Figure 699: Square pulse method test flow 
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Triangular pulse method 
FreqLinearSweep_Tria8110 and FreqFactorSweep_Tria8110 

These two modules generate a triangular pulse with an increasing frequency:  

FreqLinearSweep_Tria8110 generates pulses with linearly increasing frequency. 
FreqFactorSweep_Tria8110 generates a pulse with an exponentially increasing frequency. 

Figure 700: Triangular pulse method 

 

The test flow is shown in the next figure: 

Figure 701: Triangular pulse method test flow 
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Trapezoidal pulse method 
RiseTimeLinearSweep_Trap8110 and FallTimeLinearSweep_Trap8110 

These two modules generate a trapezoidal pulse. RiseTimeLinearSweep_Trap8110 has a linearly 
changing rise time. FallTimeLinearSweep_Trap8110 has a  fall time that varies linearly. 

Figure 702: Trapezoidal pulse method 

 

The test flow is shown in the next figure: 

Figure 703: Trapezoidal pulse method test flow 
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SWEAT test module 
The standard wafer level electromigration accelerated test (SWEAT) method is an accelerated 
electromigration test performed on microelectronic metallization. This highly accelerated test was 
developed as a method to quickly obtaining a measure of metallization reliability and for providing 
process control data to the semiconductor manufacturer. 

The SWEAT method uses a feedback control loop to adjust the stress current applied to the 
metallization such that temperature and current density of the structure maintain the target time to 
failure within a programmed error band.    

SWEAT test module process:   

SWEAT test module process: Description 
Initial R measurement Resistance measurement 
Phase 1: ramp current until temperature > TCT +50 
degrees Celcius 

TCT = Chuck temperature as input by you 

Phase 2: ramp current until ETF is achieved ETF = estimated time to failure as input by you 
Phase 3: adjust current to keep ETF Adjust the current as needed 
Final R measurement Resistance measurement 

 

For more details about the procedure for executing the SWEAT algorithm, refer to the website 
www.jedec.org (JEP119A: A Procedure for Performing SWEAT). 

 

Test module settings 
To access the SWEAT test module, first create an STM, then import the file from the following 
location: \\ACS\library\26Library\TSPLib\SWEAT.tsp. The details are indicated in the next figure. A 
description of the figure contents follows the figure. 

Figure 704: ACS SWEAT STM settings GUI 
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The SWEAT GUI inputs: 

• FH (Force High): allows you to choose the device terminal. 
• SH (Sense High): allows you to choose the device terminal. 
• FL (Force Low): allows you to choose the device terminal. 
• SL (Sense Low): allows you to choose the device terminal. 
• EX1 (Extrusion): allows you to choose the device terminal, if there is no extrusion terminal, select 

0. 
• EX2 (Extrusion): allows you to choose the device terminal, if there is no extrusion terminal, select 

0.       
• Compliance V:  Voltage compliance. Test will stop when compliance is achieved.  
• Current limit : Maximum current for the test. Test will stop when next current achieves this value.  
• Material: Material (choose 0 for Al and 1 for Cu). 
• TCR@Tref: temperature coefficient of resistance at Tref, can be manually input from GUI or 

automatically use the TCR module test result. Also, you can manually input the value. Click the 
Browse button and load the value form the user data folder (see the next figure). 

Figure 705: ACS User data folder location 
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• Chuck Temp ('C): This is the Chuck temperature of the structure before joule heating.  
• Ref Temp ('C): Reference temperature for TCR ('C). Reference temperature at which TCR is 

calculated. 
• Jinit (A/cm*cm): Force current density at the beginning of stress.  
• Area (cm*cm): Area of the test line. The cross-sectional area of the narrowest region of the test 

structure.  
• Ea (eV): Constant 'Ea' in Black's equation; the activation energy of the metallization. 
• n: Constant 'n' in Black's equation; the current density factor.  
• A: Constant 'A' in Black's equation; the empirically determined constant.     
• Expected Failure Time: Expected target failure time. The time it takes for the combined stress of 

temperature and current density to result in a prescribed increase in resistance of the test 
structure (definition of failure) as determined by Black’s equation.  

• Rchuck_fail (Ohm): Initial contact check. Before stress begins, R is measured at Chuck 
temperature. If the measured R is greater than this value, a failure occurs. 

• Max Time (s):  Time limit for the test. 
• F: In phase 3; R fails when R ≥ (1+F)*R phase3 (where Rphase3 is the R value when entering 

phase3). 
• time cycle (s): The time of a stress-measure judge-loop.  
• BE (s): In phase 3, stress current will be adjusted when calculated time to failure exceeds BE of 

expected failure time. 
• judge on EX: When selected, the results of EX1 and EX2 will be taken into judgment. 

 

Power supply library 
This module is intended to make simple leakage current measurements on two and three terminal 
devices using a Series 2290 high voltage power supply and a SMU. This module can support the 
following SMUs for measuring the current through the device: Models 2611A/B 2612A/B, 2635A/B 
2636A/B, 4200-SMU, 4210-SMU. Each SMU should be connected to a Model 2290-PM-200 
Protection Module to protect the SMU from high voltage in the event of a device breakdown.  

Figure 706: Test connection example 
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 The Series 2290 is not detected during the ACS software's hardware scan. You must add it as an 
external instrument (refer to the Add and delete an external instrument (on page 10-9) topic).  

The power supply library "PowerSupply.py" is located in the C:\ACS\library\pyLibrary\PTMLib folder. 
To add the power supply library to your project, insert a PTM and then import this library. For more 
details on importing specific PTM libraries, refer to the the Python language Test Module (PTM) 
configuration (on page 5-127) topic. 

Figure 707: Power supply GUI 
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Inputs 
HV Power Supply Settings 

• Global Name: GPI1, GPI2, …, GPIn.                 
• Device Connection: List of pins to connect.         

Test Mode Settings        

• Mode:  Allows you to select test mode (Bias or Sweeping) from a list.              
• Bias V: Force value for the bias. 
• Number of Points: The number of points to sweep. 
• Sweep start V: Initial force value for the sweep. 
• Sweep stop V: Final force value for the sweep.    

Other Power Supply Settings       

• Current Limit: The programmed high voltage power supply current limit. The default value is 1 
mA. The maximum value depends on the power supply selected in the hardware configuration. 

• Current Trip Value: The programmed high voltage power supply current trip value. The high 
voltage output shuts off when the output current exceeds the current trip value. The default value 
is 1 mA. The maximum value depends on the power supply selected in the hardware 
configuration. 

• Voltage Limit: The voltage limit is a protection feature to prevent the output voltage from being set 
too high or overshooting because of dramatic load changes. The output voltage cannot be set 
higher than the voltage limit. The default value is the maximum of the power supply. 

SMU Settings 

• Global Name: SMU1, SMU2, …, SMUn 
• Device Connection: List of pins to connect.   
• Current Limit: The programmed SMU current limit. The default value is 1 mA. The minimum and 

maximum values depends on the SMU used. 
• Current Meas.Range: Specifies the SMU current measure range to use. The Auto option 

configures the SMU current range for autorange. The default is Auto. 
• nPLC: Number of power line cycles for integration. The default value is 1. 
• Measurement Delay: Use to apply a delay before each measurement is taken. Use seconds to 

specify a delay, or set to Auto. If the measure delay is set to Auto, a range-dependent delay is 
applied each time the instrument performs a current measurement, or after changing current 
ranges during an autorange measurement. The range-dependent delay varies by SMU model. 
The Auto setting only can be applied to a 26XX SMU. When the 42XX SMU is used, you have to 
input a specific value. If you use Auto for the 42XX SMU, this delay will be disabled by default 
and measurements are taken immediately. 

• Abort on Compliance: There are two choices:   
1. False: The test will not abort once it reaches the SMU's programmed current limit. 
2. True: The test will abort once it reaches the SMU's programmed current limit. 
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DC stress-measure loop project 
The DC stress-measure loop project performs a stress test for device reliability analysis. This project 
uses stress-measure subsite loop to control the loop. It contains specific user access points (UAPs)  
that allow you to save specific data files and you can bypass subsite, device, or testing based on the 
pass or fail judgment. 

The DC stress-measure loop project features: 

• Complete ACS project with limited configuration navigator settings 
• Subsite loop to implement stress-measure for reliability tests 
• Simple fail criteria 
• PTM for pulse stress  

 

Project setting 
To access the DC stress-measure loop project, click on File on the toolbar and select Open. Navigate 
to the folder: C:\ACS\Projects\ DC_Stress_Measure_loop. Select the DC_Stress_Measure_loop.xml 
file.  

Figure 708: DC stress_measure loop project 
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The following are the UAPs in the project configuration navigator: 

• Lot Begin UAP 
FILE_IV_lot_begin module: This creates the used data file directory, Gfdir, where the I-V data is 
stored. The file is stored here: C:\ACS\user_data, in a folder named with the LotID_timestamps or 
WaferID_timestamps (single wafer). For example, the lot1_20140925153952, the user data file 
directory is C:\ACS\user_data\lot1_20140925153952. 
Set_Fail_Condition module: Prompts you to set the fail criteria Minimum, Maximum, and Type 
(Type is either percent or absolute). Clicking OK records the setting in the global variable 
Vt_DUT1_limit. Clicking Cancel exits the test and stops the automation. The data evaluation to 
this fail occurs in the Pass_or_Fail Test End UAP module. 

Figure 709: DC stress-measure Set Failure Condition GUI 

 



ACS Automated Characterization Suite (ACS) Reference Manual Section 15: ACS sample projects and test modules 
 

ACS-901-01 Rev. H / December 2014 15-35 

 

• Site Begin UAP 
FILE_IV_site_begin module: Creates a global data file, Gnewdata, that is used to record the test 
results at the end of the test. 
RESET_Skip_list module: Clears the list of subsites, devices, or tests to skip. In the stress-
measure loop, if a device, subsite, or test fails, then it is added to the skip list which means that 
the failed item is not tested for the remainder of the test. However, at the beginning of a new test, 
or if there are new results, the skip list is reset and all items are tested again. 

• Test End UAP 
FILE_IV_test_end module: Outputs the I-V test data to the user data file directory created in the 
UAP Lot Begin module File_IV_lot_begin. The file name format is 
WaterID_IVdutid_testmodulename_stresstime.csv, for example, test_IV1_MOS_0000010.csv, 
DUT ID is the index value in ACS_dut_id. 
FILE_STRESS_test_end module: Outputs the data collected during the stress monitoring to the 
user data file directory created in the UAP Lot Begin module File_IV_log_begin. The file name 
format is waferID_STR_testmodulename_stresstime.csv, for example, 
test_STR_STRESS_0000010.csv. 
FILE_PARAM_test_end module: Records the VT, VT_PRE, and VT_POS calculated values to 
the used data file directory created in the UAP Lot Begin module File_IV_log_begin. The file 
name format is waferID_PARAM_DEVdutid_patternID.csv, for example, 
test_PARAM_DEV1_main.csv, DUT ID is the index value in ACS_dut_id. 

• Pass_or_Fail module: Compares the VT_PRE data collected during the MOS-pre test with VT 
data collected during the stress loop. Minimum and maximum limits are set in the UAP lot_begin 
module Set-Fail_Condition. If comparison criteria selected in the UAP Set_Fail_Condition is abs, 
when abs (VT - Base_Val4_VT) is out of range [min, max], then the device fails. If comparison 
criteria selected in the UAP Set_Fail_Condition is PCT when 100.0*abs (VT - 
Base_Val4_VT)/Base_Val4_VT) is out of range [min, max], then the device fails. When the device 
fails, the ACS_Disable_DUT_List is updated. The tests under this DUT node will not run in the 
ACS platform. If all the DUT nodes under the subsite node fail, the ACS_Disable_Subsite_List will 
be updated. The tests under this subsite node will not run in the ACS platform. 
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Configure the DC stress-measure loop test 
Configure the pre-test subsite to generate the pre-test data for comparison. 

1. Click on the pre_test subsite in the project navigator (see next figure). 
2. Click on the subsite loop tab. 

Figure 710: Set Subsite Loop for subsite pre_test 

 

3. See the Subsite Loop Mode to Cycle Mode. 
4. Set the number of cycles to 1 so that the pre-test only executes once. 
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Configure the stress_loop subsite 
 

The stress_loop subsite specifies the values of the the stress parameter. The stress parameter is 
controlled by the "STRESS" PTM which is located under the "stress_loop" subsite. The sample 
project uses time as the stress parameter. However, you can write a custom PTM in place of the 
"STRESS" PTM that will control another parameter, such as temperature. 

Figure 711: Set Subsite Loop for subsite stress_loop 

 

1. Set the Subsite Loop Mode to Stress/Measure Mode. 
2. Configure the Stress/Measure Mode Setup by setting the First Stress Time/Value. 
3. Configure the Total Stress Time/Value and the #Stresses/Decade parameters.  

For example, if the #Stresses/Decade is 5, the project will add 5 different length/size stresses to the 
DUT.  
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Configure the stress voltages 
The PTM STRESS  subsite is used for the stress-measure loop stress phase.  

Figure 712: PTM stress GUI 

 

1. Configure the stress voltages for each SMU in the test. 
2. Configure the current limits for each SMU in the test.  

During the stress portion of the loop, the SMU will not make any measurement and will essentially 
behave as a DC power supply. 

You also need to configure the measurement portion of the stress-measure loop. 

The ITM MOS in the configuration navigator (under DEV1) is for the measure phase of the stress-
measure loop. 

For each SMU in the test, configure the forcing function, forcing mode, source value, compliance, and 
measure function for the stress loop. 
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Monitor the DC stress-measure loop test 
You should execute this project in Automation mode. For more information about executing projects, 
refer to the Automation (on page 7-1) topic. 

During automation, you can check the Basic Monitor Items to see the subsite loop that is executing in 
automation (see next figure). 

Figure 713: DC stress-measure Basic Monitor Items 

 
 

Test flow 
The following figure shows the basic test and stress flow in this project using an example where you 
can specify a list of five stress times.  

Figure 714: Basic test and flow of DC stress_measure project 

 

• For loop 1, a DC stress voltage is applied by the SMUs for 10 seconds. 
• For loop 2, a DC stress voltage is applied by the SMUs for 5 seconds. 
• For loop 3, a DC stress voltage is applied by the SMUs for 5 seconds. 
• For loop 4, a DC stress voltage is applied by the SMUs for 5 seconds. 
• For loop 5, a DC stress voltage is applied by the SMUs for 5 seconds. 

 

Test result data 
The DC stress-measure loop project saves and displays data the same as other ACS projects. You 
can define a data plot on the data tab of each test. Also, you can set the automation real-time plot for 
the test and see the data results of the plot in real time. The test results will be saved to 
C:\ACS\Projects\DC_Stress_Measure_loop and can be saved to the following types of files: .kdf, .db, 
or .csv. Additionally, there is a customized test result file specified in the UAP lot_begin. 
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Pulse stress-measure loop project 
The Pulse stress-measure loop project performs a stress test for device reliability analysis. This 
project uses a stress-measure subsite loop, and to stress and measure different devices using 
different tests.  

Since different tests are used for stress, or measure, the recovery time for the device is introduced in 
the loop. This project is for a use case where the device under test (DUT) does not have much 
sensitivity to the recovery time; however, you may need to evaluate changes in the characteristics 
after different stresses have been applied (for example, DC, or Pulse, and different waveforms). 

The pulse stress-measure loop project features: 

• Complete ACS project with limited configuration navigator settings 
• Subsite loop to implement stress-measure for reliability tests 
• Simple exit criteria 
• PMU for pulse stress (for example, waveform files can be used to define a customized stress for 

each loop) 

This project is only available when ACS is installed on a Keithley Model 4200-SCS. 
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Example connection of DUT 
The following DUT connections are examples of how to use the pulse stress-measure loop project for 
testing.  

Figure 715: Single DUT test with two RPMs 

 

Figure 716: Two DUTs with two RPMs 

 

Figure 717: Two DUTs with four RPMs 
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Project setting 
To access the Pulse stress-measure loop project, click on File on the toolbar and select Open. 
Navigate to the folder: C:\ACS\Projects\Stress_Measure_Loop. Select the Stress_Measure_Loop.xml 
file.  

Figure 718: Pulse stress-measure loop project 

 

The following are the UAPs in the project configuration navigator: 

• automation_begin UAP 
Set_Fail_Condition module: Prompts you to set the fail criteria Minimum, Maximum, and Type 
(Type is either percent or absolute). Clicking OK records the setting in the global variable 
Vt_DUT1_limit. Clicking Cancel exits the test and stops the automation. The data evaluation to 
this fail occurs in the Pass_or_Fail Test End UAP module. 

Figure 719: Set Failure Condition GUI 
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• Site Begin UAP 
RESET_Skip_list module: Clears the list of subsites, devices, or tests to skip. In the stress-
measure loop, if a device, subsite, or test fails, then it is added to the skip list which means that 
the failed item is not tested for the remainder of the test. However, at the beginning of a new test, 
or if there are new results, the skip list is reset and all items are tested again. 

• Test End UAP 
Pass_or_Fail module: Compares the VT_PRE data collected during the MOS-pre test with VT 
data collected during the stress loop. Minimum and maximum limits are set in the UAP lot_begin 
module Set-Fail_Condition. If comparison criteria selected in the UAP Set_Fail_Condition is abs, 
when abs (VT - Base_Val4_VT) is out of range [min, max], then the device fails. If comparison 
criteria selected in the UAP Set_Fail_Condition is pct when 100.0*abs (VT - 
Base_Val4_VT)/Base_Val4_VT) is out of range [min, max], then the device fails. When the device 
fails, the ACS_Disable_DUT_List is updated. The tests under this DUT node will not run in the 
ACS platform. If all the DUT nodes under the subsite node fail, the ACS_Disable_Subsite_List will 
be updated. The tests under this subsite node will not run in the ACS platform 
Pass_or_Fail UAP: When the test ends for the first subsite loop, it is recorded  for the first 
measurement value as the base value for comparison. At the end of each test, the test 
determines whether the result is out of the limit value that is set in the automation_begin UAP 
Set_Fail_Condition. If it is out of limits, the DUT is marked as failed and will exit the stress-
measure loop. The other DUT will continue the loop until it reaches the maximum loop number or 
it fails.  

• Set the Subsite Loop for subsite Measure_Stress_loop (see next figure): 

Figure 720: Set Subsite Loop for subsite Measure_Stress_Loop 
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In the previous figure, the Stress/Decade is three. This means that the project will add three 
different kinds of stress to the DUT.  

• Choose the test for each DUT (for example, for DUT1 and DUT2). 
IV1 and IV2 are the tests for DUT1 and DUT2, respectively. You can add any test to these two 
devices. These are the measure phases of the stress-measure loop.  
Choose the stress waveform. The PTM Stress under device "SegArbStress" is for the stress 
phase. The following is an example setting for the two DUTs with two RPMs. This means that the 
stress terminal for DUT1 is PMU1_1, and the stress terminal for DUT2 is PMU1_2.  

Figure 721: PTM stress on two DUTs 
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Click the Browse button to add a waveform.The waveform is read from the waveform .ksf file. The 
.ksf file is created by Kpulse. For example, the Segment ARB waveform in this sample project is 
located in file1.ksf.  
You should execute this project in Automation mode. During automation, you will know which 
subsite loop is executing in automation by using the Basic Monitor Items GUI (see next figure): 

Figure 722: Pulse stress-measure Basic Monitor Items 

 
 

Test flow 
The following figure shows the basic test and stress flow in this project. First, ACS executes all of 
DUT1 tests. Next, ACS executes all of the DUT2 tests. Once all testing is complete, ACS forces 
stress (pulse or DC voltage, depending on the settings) to one or both of the DUTs. 

During the stress, ACS makes measurements and the PMU functions as a pulse generator or a DC 
power supply. 

Figure 723: Basic test and flow of the project 

 

Stress is applied and calculated during every loop: 

1. Utilizes the Segment ARB waveforms, which are read from the waveform .ksf file. 
2. Determines ACS_Stress_Duration of every loop. 
3. Calculates pulse cycles, and uses the smallest integer greater than or equal to 

ACS_Stress_Duration or period as pulse cycles. 
4. Applies the stress during each loop, which is the same number of Segment ARB waveforms to 

pulse cycles. 
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Test result data 
The Pulse stress-measure loop project saves the same type of data as any another ACS project. You 
have the ability to define a data plot on the data tab of each test (for example, IV1 and IV2 in this 
project). Also, you can set the automation real-time plot for these two tests and see the data results of 
the plot in real time. The test results can be saved to the following types of files: .kdf, .db, or .csv. 

 

Stress migration project–resistance batch measurement 
Stress migration (which may also be called stress voiding or stress-induced voiding), describes the 
movement of metal atoms under the influence of mechanical stress gradients. This will cause the 
resistance of the metal line to rise and form a void, which may cause electrical failures. Usually the 
mechanical stress is caused by a thermal process. 

The stress migration project is able to make batch resistance measurements to multiple DUTs. The 
test project itself does not provide stress, so there needs to be another procedure used in order to 
achieve the stress process. The test project can display the test results as defined with a fail or pass 
in real time. This project is contained in a .csv file, which makes it convenient for editing. The project 
is generated by importing the .csv test plan file. By importing the file, it simplifies the procedure for 
you so that you do not have to create your own project. However, you can edit the .csv file for your 
specific needs, if desired. 

Stress migration project features: 

• A complete ACS project generated by importing test plan file (in an easy to modify .csv test plan 
format) 

• Batch resistance measurements 
• A real-time test result display (allows you to exit the project if the test fails) 

 

Instrument connection 
The instruments should all be Series 2600, 2600A, or 2600B in a single GPIB or Ethernet group, 
which are connected in a daisy chain by TSP Link. The automatically generated project will only 
select Group 1. You can manually adjust groups after the project is generated. The connection 
between a SMU terminal and DUT is defined in the test plan .csv file.  
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Test flow and settings 
Create a Stress Migration test project: 

1. Create a new ACS project, input a Project Name (see next figure).  

Figure 724: New ACS project 

 



Section 15: ACS sample projects and test modules ACS Automated Characterization Suite (ACS) Reference Manual 
 

15-48 ACS-901-01 Rev. H / December 2014 

 

2. Import the test plan file (*.csv): File->Import->Test Plan File (*.csv). The test plan file 
(SM_input_format.csv) is located in the following location: \ACS\Projects\. 

Figure 725: Import a test plan 
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3. Choose Refresh in the "please select the import mode" drop-down list. Once you refresh the data, 
the existing file is replaced in the configuration navigator. If you choose the Append function in 
the drop-down list, you will see new modules in the configuration navigator; if the names of the 
modules appended already exist, the appended modules will be given new names. 

Figure 726: Import data confirmation 
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4. Configuration navigator: 

Figure 727: Test tree 

 

Project explanations from the configuration navigator: 

• site_end UAP: if there are consecutive site failures, a dialog box opens to let the user choose to 
continue testing or exit. Failure conditions are defined in the test plan .csv file as "x_test." 

• Pattern_1: has one HOME subsite and five subsites (for example, Macro1_Device - 
Macro5_Device). 
• Each subsite MacroX has one device MacroX_Device. 
• Each MacroX_Device has one STM MacroX_STM_Test. 
• In each MacroX_STM_Test, each R_meas function call performs one resistance measurement. 
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Test plan 
The Test Plan csv File (SM_input_format.csv) Format and the Generated STM Module MacroX_STM_Test 

The Test Plan csv File contents are as following table: 

Column names Comments 
Macro Name Corresponding to subsite name in subsite definition tab. 
X(µm) Corresponding to subsite X position in subsite definition tab. 
Y(µm) Corresponding to subsite Y position in subsite definition tab. 
Test Structure Name Corresponding to the device name (DevName) in the 

generated STM script. 
terminal Corresponding to the resistor measurement mode (ResMode) 

in the generated STM script. 4: four terminals; 2: two 
terminals. 

Ground Rule(GR) Y: enable gnd (ground) connection. N: disable gnd 
connection. If enable and the F +, F - , S +, S - cells are 
blank, the terminals will be assigned as gnd (KI_GND). 

Force (A) The force current value applied to the ForceHi terminal. If the 
cell is blank, the force function will be voltage force. The 
Force (A) and Force (V) should not both be blank. 

Force (V) The force voltage value applied to the ForceHi terminal. 
Clamp The compliance value. Current Compliance for voltage force 

function, and voltage Compliance for current force function. 
Output Output information. 
x_test Failed site threshold. After this number of sites fails, ACS 

displays a dialog for you to choose whether to continue or 
exit. 

F + The SMU number of force Hi SMU (for example, 4 stands for 
SMU4). 

S + The SMU number of sense Hi SMU. 
F - The SMU number of force Lo SMU. 
S - The SMU number of sense Lo SMU. 
Expected R (Ohm) Expected resistance. 
Shift range (%) The "pass" shift range. If abs (RValue-ExpectedR) < 

ExpectedR*ShiftRange*100%. the test will pass, otherwise it 
will fail. 

Description (based on 
documentation) 

The description of the structure on this row. 

When you import the test plan .csv file, ACS will also generate a STM (MacroX_STM_Test). The STM 
script structure is shown in the following figure: 
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Figure 728: The generated STM script 
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Each STM test module includes four parts: 

• Output definition 
• Instrument pre-sets 
• Using R_meas call function to measure resistance. 
• Reset instruments 

The R_meas function is used to perform the resistance measurement. An explanation of R_meas is 
below: 

R_meas (DevName, ResMode, ForceVIMode, FHiSMU, FLoSMU, SHiSMU, SLoSMU, ForceValue, 
ComplValue, NPLC, RstFlag, OutputOffFlag, ExpRValue, ShiftRange, vHi_value, vLo_value, 
iHi_value, iLo_value, R_value) 

The parameters in the function that are corresponding to the SM_input_format.csv file: 

• DevName: test structure name 
• ResMode: terminal ( 0 for 4 terminals; 1 for 2 terminals) 
• ForceVIMode: If the cell in Force (A) column is blank and the cell in Force (V) column has a value, 

ForceVIMode is assigned to 0 which represents voltage force function and current measurement. If the 
cell in Force (A) column has value and the cell in Force (V) column is blank, ForceVIMode is assigned 
to 1 which represents current force function and voltage measure.  

• FHiSMU: F+ 
• FLoSMU: F- 
• SHiSMU: S+ 
• SLoSMU: S- 
• ForceValue: Force (A) when ForceVIMode is equal to 1; Force (V) when ForceVIMode is equal to 0 
• CompIValue: Current value in compliance 
• ExpRValue: Resistance value expected 
• ShiftRange: Percent of the shift range for the resistance value. For example, if the absolute value of 

(RValue-ExpRValue) is lower than (ExpRValue*ShiftRange*100%), the test will pass, if it is not lower, it 
will fail. Therefore, the RValue is the actual measured resistance value. 

The following parameters are additional settings. The default values are set to be commonly used 
values: 

• NPLC: Measurement speed setting. 0.001(fast) to 25(slow). Default value is 1. 
• RstFlag: To flag if reset SMUs after one R_meas function. ( 1: reset; 0: not to reset) Default value is 0. 
• OutputOffFlag: To flag if turn SMUs output off after one test. (1: turn off; 0: not to turn off) Default value 

is 0. 

The others are output parameters to save measurement results: 

• vHi_value: Voltage value measured at SHiSMU for 4 terminals device or FHiSMU for 2 terminals device. 
• vLo_value: Voltage value measured at SLoSMU for 4 terminals device or FLoSMU for 2 terminals 

device. 
• iHi_value: Current value measured at FHiSMU. 
• iLo_value: Current value measured at FLoSMU. 
• R_value: Calculate from the above values. R = abs(vHi-vLo/iHi). 
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Automation 
In this particular Stress Migration project, the generated site_end UAP is used to implement the 
function that has the same Test Structure fail for the "x_test." You will see a dialog box where you can 
choose to exit the project or continue testing (see next figure). The "x_test" parameters are defined in 
the SM_input_format.csv file. (For more information on how to set up the automation function, refer to 
the Automation section in this manual). 

Figure 729: Consecutive fail dialog box 

 

In the Automation Data tab, the failed test is highlighted in red (see next figure): 

Figure 730: Automation Data tab 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 15: ACS sample projects and test modules 
 

ACS-901-01 Rev. H / December 2014 15-55 

 

Error code 
In the output, there is an "error$StructureName" indicating the error code of the test: 

• -10100: ResMode is not 0 or 1. 
ForceVIMode is not 0 or 1. 
When ForceVIMode is 0, ForceValue > 200 or ComplValue > 0.1 
When ForceVIMode is 1, ForceValue >0.1 or ComplValue >200 
NPLC < 0.001 or NPLC > 25 
RstFlag is not 0 or 1 
OutputoffFlag is not 0 or 1 

• -10200: FHiSMU, FLoSMU, SHiSMU, SLoSMU are not all set to the correct SMU number. 
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Introduction 
ACS enables you to import or export a test plan for a project to the subsite level or device level. A test 
plan consists of all of the tests and settings under a certain subsite level or device level in the 
configuration navigator. If you import or export a subsite or device node, all of the tests and settings 
under the subsite or device will be added or saved. Additionally, ACS provides preset test plans as 
test module templates covering most semiconductor device tests and power device tests. 

 
 

Section 16 

Test Module Template 
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Import and export a test plan 
The Import and Export function is accessible by right-clicking any pattern, subsite, or device level 
node in the configuration navigator. 

ACS has preset test plans for many semiconductor device parametric tests. These preset test plans 
are located in the following computer directory:  \ACS\Test Module Template\. If you want a device 
level test plan, you need to import it from the "device" folder. If you want a subsite level test plan, you 
need to import it from the subsite folder. 

The "device" folder contains high voltage capacitance test modules for several semiconductor devices 
and has five test module templates for a Vds reliability test. The Test module templates for device test 
plans (on page 16-4) lists all of the high voltage capacitance measurements located in this folder. For 
more detail about Vds reliability tests, refer to Section 18 VDS Sample tests (on page 18-1) . Also, the 
"subsite" folder contains parametric tests for many semiconductor devices that you can choose from. 

When you click the Import function, a dialog box opens (see next figure). In the dialog box, select the 
appropriate .xml file test plan that you want to add to the configuration navigator. An imported test 
plan is added to the configuration navigator as a new device or a new subsite, depending on the type 
you choose. 

The imported subsite, device, and test is named with a suffix "_PxSSy", "_PxSSyDz" and 
"_PxSSyDzTm" respectively as an indication to the position in the configuration navigator (note that 
"_PxSSyDzTm" means pattern "x", subsite "y", device "z" and test "m" in the configuration navigator). 

Figure 731: Import a test plan 
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When you click the Export function a dialog box opens (see next figure). In the dialog box, you must 
name the Device, and choose a Location to save the device test plan. Additionally, you can export all 
of the current test test data by selecting "Include Test Data."  

You can export a subsite level or a device level test plan. When you export a subsite or device level 
test plan you are exporting all of the tests and settings in the subsite or device level in the 
configuration navigator. Once the test plan has been exported it can be imported to another project at 
any time. 

Figure 732: Export a test plan 
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Test module templates for device test plans 
ACS provides semiconductor device parametric tests, including those for high voltage capacitance 
(HVCV) measurements that are located in the following computer directory: \ACS\Test Module 
Template\ device. The following tables list all of these tests. 

IGBT library tests 

 Device Device test plan Tests 

 
IGBT IGBT_HVCV Cce, Cgc, Cge, Cies, Coes, Cres 

 
nMOSFET library tests 

 Device Device test plan Tests 

 
nMOSFET nMOSFET_HVCV Cds,Cgd,Cgs,Ciss,Coss,Crss 

 
pMOSFET library tests 

 Device Device test plan Tests 

 
pMOSFET pMOSFET_HVCV Cds,Cgd,Cgs,Ciss,Coss,Crss 

 
nPowerMOSFET library tests 

 Device Device test plan Tests 

 
nPowerMOSFET nPowerMOSFET_HVCV Cds,Cgd,Cgs,Ciss,Coss,Crss 

 
pPowerMOSFET library tests 

 Device Device test plan Tests 

 
pPowerMOSFET pPowerMOSFET_HVCV Cds,Cgd,Cgs,Ciss,Coss,Crss 

 
npnBJT library tests 

 Device Device test plan Tests 

 
npnBJT npnBJT_HVCV Ccb,Cce,Ceb,Cibo,Cobo 
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pnpBJT library tests 

 Device Device test plan Tests 

 
pnpBJT pnpBJT_HVCV Ccb,Cce,Ceb,Cibo,Cobo 

 
npnPowerBJT library tests 

 Device Device test plan Tests 

 
npnPowerBJT npnPowerBJT_HVCV Ccb,Cce,Ceb,Cibo,Cobo 

 
pnpPowerBJT library tests 

 Device Device test plan Tests 

 
pnpPowerBJT pnpPowerBJT_HVCV Ccb,Cce,Ceb,Cibo,Cobo 

 

Test module templates for subsite test plans 
ACS provides semiconductor device parametric tests that are located in the following computer 
directory: \ACS\Test Module Template\subsite.  

The following tables list all the subsite test plans for common semiconductor devices and all of the 
available tests. The subsite test plans with a "_26xxB" suffix include tests based on an ITM for the 
Models 26xxB and 265xA instruments. The subsite test plans with a "_MixedSMUs" suffix include 
tests based on a general PTM or mixed SMU pulse PTM. The two types of PTM are for mixed use of 
Model 26xxB, 265xA, 24xx. and 42xx SMUs. The sections following the tables provide detail about 
each of the included tests. 

Diode library tests 

Device Subsite test plan Tests 
Diode 

 
Diode_26xxB DynamicZ, Spot_IfdVfd, 

Spot_IrdVrd Spot_VbrIrd, 
Spot_VfdIfd, Spot_VrdIrd 
Sweep_IfdVfd, Sweep_IrdDVrd 

Diode_MixedSMUs DynamicZ, Spot_IfdVfd, 
Spot_IrdVrd Spot_VbrIrd, 
Spot_VfdIfd, Spot_VrdIrd 
Sweep_IfdVfd, Sweep_IrdVrd 
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Zener library tests 

Device Subsite test plan Tests 
Zener Zener_26xxB BVZ, IR, VF 

 

Two-terminal resistor library  tests 

Device Subsite test plan Tests 
Resistor (2W) 

 
Resistor_26xxB Spot_IV_2SMU, 

Spot_VI_2SMU, 
Sweep_IV_2SMU, 
Sweep_VI_2SMU 

Resistor_MixedSMUs BVCBO, BVCEI, BVCEO, 
BVCEV, HFE_SW, IBCO, 
IBEO, IbIcVbe, IbVbe, ICBO, 
ICEO, ICEV, IcVcb, 
IcVce_BiasIb, IcVce_BiasVb, 
IcVce_StepIb, IcVce_StepVb, 
VBCO, VCE 

 

npnBJT library tests 

Device Subsite test plan Tests 
npnBJT 

 
npnBJT_26xxB BVCBO, BVCEI, BVCEO, 

BVCEV, BVEBO, BVECO, 
HFE_SW, IBCO, IBEO, 
IbIcVbe, IbVbe, ICBO, ICEO, 
ICEV, IcVcb, IcVce_BiasIb, 
IcVce_BiasVb, IcVce_StepIb, 
IcVce_StepVb, IEBO, IECO, 
IeVeb, VBCO, VCE 

npnBJT_MixedSMUs BVCBO, BVCEI, BVCEO, 
BVCEV, HFE_SW, IBCO, 
IBEO, IbIcVbe, IbVbe, ICBO, 
ICEO, ICEV, IcVcb, 
IcVce_BiasIb, IcVce_BiasVb, 
IcVce_StepIb, IcVce_StepVb, 
VBCO, VCE 
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pnpBJT library tests 

Device Subsite test plan Tests 
pnpBJT 

 
pnpBJT_26xxB BVCBO, BVCEI, BVCEO, 

BVCEV, BVEBO, BVECO, 
HFE_SW, IBCO, IBEO, 
IbIcVbe, IbVbe, ICBO, ICEO, 
ICEV, IcVcb, IcVce_BiasIb, 
IcVce_BiasVb, IcVce_StepIb, 
IcVce_StepVb, IEBO, IECO, 
IeVeb, VBCO, VCE 

pnpBJT_MixedSMUs BVCBO, BVCEI, BVCEO, 
BVCEV, BVEBO, BVECO, 
HFE_SW, IBCO, IBEO, 
IbIcVbe, IbVbe, ICBO, ICEO, 
ICEV, IcVcb, IcVce_BiasIb, 
IcVce_BiasVb, IcVce_StepIb, 
IcVce_StepVb, IEBO, IECO, 
IeVeb, VBCO, VCE 

 

npnPowerBJT library tests 

Device Subsite test plan Tests 
npnPowerBJT 

 
npnPowerBJT_26xxB BVCBO, BVCEO, BVEBO, 

HFE, ICBO, ICEO, ICES, 
ICEV, IcVce_StepIb, 
IcVce_StepVbe, IEBO, VbeON, 
VbeSAT, VceSAT, VCESUS 

npnPowerBJT_MixedSMUs IcVce_StepIb_MIX, 
IcVce_StepVbe_MIX, 
VceSAT_MIX 

 

pnpPowerBJT library tests 

Device Subsite test plan Tests 
pnpPowerBJT 

 
 

pnpPowerBJT_26xxB BVCBO, BVCEO, BVEBO, 
HFE, ICBO, ICEO, ICES, 
ICEV, IcVce_StepIb, 
IcVce_StepVbe, IEBO, VbeON, 
VbeSAT, VceSAT, VCESUS 

pnpPowerBJT_MixedSMUs IcVce_StepIb_MIX, 
IcVce_StepVbe_MIX, 
VceSAT_MIX 
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TRIAC library tests 

Device Subsite test plan Tests 
TRIAC TRIAC_26xxB IDRM, IGT, IHneg, IHpos, 

ILneg, ILpos, IRRM, VGT, 
VTneg, VTpos 

 

IGBT library tests 

Device Subsite test plan Tests 
IGBT 

 
 

IGBT_26xxB BVCES, ICES, IcON, 
IcVce_StepVge, IcVge, IGESF, 
IGESR, VceSAT, VF, VgeON, 
VGETH 

IGBT_MixedSMUs IcVce_StepVge_MIX, 
IcVge_MIX, VceSAT_MIX 

 

nPowerMOSFET library tests 

Device Subsite test plan Tests 
nPowerMOSFET 

 
 

nPowerMOSFET_26xxB BVDSS, GFS, IdON, IDSS, 
IdVd_StepVg, IdVg_StepVd, 
IGSSF, IGSSR, RdsON, 
VdsON, VgsON, VGSTH, VSD 

nPowerMOSFET_MixedSMUs IdON_MIX, IdVd_StepVg_MIX, 
RdsOn_MIX, VgsON_MIX 

 

pPowerMOSFET library tests 

Device Subsite test plan Tests 
pPowerMOSFET 

 
 

pPowerMOSFET_26xxB BVDSS, GFS, IdON, IDSS, 
IdVd_StepVg, IdVg_StepVd, 
IGSSF, IGSSR, RdsON, 
VdsON, VgsON, VGSTH, VSD 

pPowerMOSFET_MixedSMUs IdON_MIX, IdVd_StepVg_MIX, 
RdsOn_MIX, VgsON_MIX 
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nMOSFET library tests 

Device Subsite test plan Tests 
nMOSFET 

 
 

nMOSFET_26xxB BVDSS, BVDSV, BVGDO, 
BVGDS, BVGSO, IDL, 
IDS_ISD, IdVd_BiasVg, 
IdVd_StepVg, IdVg_BiasVd, 
IdVg_StepVd, IdVg_StepVsub, 
IGL, IgVg, ISL, Vtci, Vtext, 
Vtext_llsq 

n_MixedSMUs BVDSS, BVDSV, BVGDO, 
BVGDS, BVGSO, IDL, 
IDS_ISD, IdVd_BiasVg, 
IdVd_StepVg, IdVg_BiasVd, 
IdVg_StepVd, IdVg_StepVsub, 
IGL, IgVg, ISL, Vtci, Vtext 

 

pMOSFET library tests 

Device Subsite test plan Tests 
pMOSFET 

 
 

pMOSFET_26xxB BVDSS, BVDSV, BVGDO, 
BVGDS, BVGSO, IDL, 
IDS_ISD, IdVd_BiasVg, 
IdVd_StepVg, IdVg_BiasVd, 
IdVg_StepVd, IdVg_StepVsub, 
IGL, IgVg, ISL, Vtci, Vtext, 
Vtext_llsq 

p_MixedSMUs BVDSS, BVDSV, BVGDO, 
BVGDS, BVGSO, IDL, 
IDS_ISD, IdVd_BiasVg, 
IdVd_StepVg, IdVg_BiasVd, 
IdVg_StepVd, IdVg_StepVsub, 
IGL, IgVg, ISL, Vtci, Vtext 

 

Diode test module template 
The diode test module template is used to test some parameters of a diode, such as the forward 
voltage and current, reverse voltage and current, I-V curve, and dynamic impedance. The TSP files 
are used with a Series 2600B instrument to create test script files based on the Series 2600B LPT 
library. 

 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-10 ACS-901-01 Rev. H / December 2014 

 

DynamicZ 
Description: 

Module Name: DynamicZ  

DUT: Diode 

Function: Measures the Dynamic Impedance based on two forward voltage measurements or two 
reverse voltage measurements: DynamicZ = (v2 - v1) / (I2 - I1) 

Pin connections: Uses one SMU to force the forward current. Connect the other terminal to GND or 
use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 733: Diode DynamicZ pin connection 

 
 

Spot_IfdVfd 
Description: 

Module Name: Spot_IfdVfd 

DUT: Diode 

Function: Measures the forward current of a diode at a specified forward voltage. 

Pin connections: The P terminal forces a forward voltage. Connect the N terminal to GND or use a 
SMU to supply a zero voltage bias. (See next figure.) 

Figure 734: Diode_ Spot_IfdVfd pin connection 
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Spot_IrdVrd 
Description: 

Module Name: Spot_IrdVrd 

DUT: Diode 

Function: Measures the leakage current of a diode at a specified reverse voltage. 

Pin connections: Force a reverse voltage or zero voltage to terminal P. Connect the N terminal to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 735: Diode_Spot_IrdVrd pin connection 

 
 

Spot_VbrIrd 
Description: 

Module Name: Spot_VbrIrd 

DUT: Diode 

Function: Measures the breakdown voltage of a diode at a specified reverse current. 

Pin connections: Force a reverse current to the P terminal. Connect the N terminal to GND or use a 
SMU to supply a zero voltage bias. (See next figure.) 

Figure 736: Diode_Spot_VbrIrd pin connection 
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Spot_VfdIfd 
Description: 

Module Name: Spot_VfdIfd 

DUT: Diode 

Function: Measures the forward voltage of a diode. 

Pin connections: Uses one SMU to force forward current to the P terminal. Connect the N terminal to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 737: Diode_Spot_VfdIfd pin connection 

 
 

Spot_VrdIrd 
Description: 

Module Name: Spot_VrdIrd 

DUT: Diode 

Function: Measures the reverse voltage of a diode at a specified reverse current. 

Pin connections: Force a reverse current to the P terminal. Connect the N terminal to GND or use a 
SMU to supply a zero voltage bias. (See next figure.) 

Figure 738: Diode_Spot_VrdIrd pin connection 
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Sweep_IfdVfd 
Description: 

Module Name: Sweep_IfdVfd 

DUT: Diode 

Function: Measures the forward current with a forward voltage sweep to indicate a forward I-V 
characteristic of a diode. 

Pin connections: Apply a forward voltage sweep to terminal P. Connect the N terminal to GND or use 
a SMU to supply a zero voltage bias. (See next figure.) 

Figure 739: Diode_Sweep_IfdVfd pin connection 

 
 

Sweep_IrdVrd 
Description: 

Module Name: Sweep_IrdVrd 

DUT: Diode 

Function: Measures the reverse current with a reverse voltage sweep to indicate the reverse I-V 
characteristics of a diode. 

Pin connections: Apply a reverse voltage sweep to the P terminal. Connect the N terminal to GND or 
use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 740: Diode_Sweep_IrdVrd pin connection 
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Zener test module template 
The ZENER parametric test module template is used to test parameters of a ZENER device, including 
leakage, on-state, and breakdown properties. 

 

BVZ 
Description: 

Module Name: BVZ 

Module Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Two-terminal ZENER 

Function: Measures the regulator voltage from the cathode to anode at the maximum rated current 
that is given in the data sheet. 

Pin Connection: Use a SMU to apply a negative current (IZM) and make voltage measurements from 
the anode to the cathode. Connect the cathode to GND or use a SMU to supply a zero voltage bias. 
(See next figure.) 

Figure 741: ZENER BVZ pin connection 
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IR 
Description: 

Module Name: IR 

Module Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Two-terminal ZENER 

Function: Measures the reverse leakage current at a specific reverse voltage from the cathode to 
anode that is given in the data sheet. 

Pin Connection: Use a SMU to apply a negative voltage and make a current measurement from 
anode to cathode. Connect the cathode to GND or use a SMU to supply a zero voltage bias. 

Figure 742: ZENER IR pin connection 
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VF 
Description: 

Module Name: VF 

Module Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Two-terminal ZENER 

Function: Measures the forward voltage at a specific forward current from the anode to cathode. 

Pin Connection: Use a SMU to apply positive current and make a voltage measurement from the 
anode to the cathode. Connect the cathode to GND or use a SMU to supply a zero voltage bias.  

Figure 743: ZENER VF pin connection 

 
 

Two-terminal resistor test module template 
The two-terminal resistor test module template is used to test parameters of a two-terminal resistor, 
such as resistance (Source V measure I or Source I measure V, 2-wire or 4-wire). This library is used 
with a Series 2600B instrument to create test script files based on Series 2600B LPT library. 
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Spot_IV_2SMU 
Description: 

Module Name: Spot_IV_2SMU 

DUT: Two-terminal generic device 

Function: Measures the current at a specified voltage to determine the resistance. 

Pin connections: Ensure that you set the sense mode of the SMU in the software toolbar (Tools > 
Preferences). If remote sense mode is used, which corresponds to four-wire measurement 
instruments, connect the Sense High lead of the SMU closer to the device than the Force High lead 
(see next figure). 

Figure 744: Two_term_resistor_spot_IV_2SMU pin connection 

 
 

Spot_VI_2SMU 
Description: 

Module Name: Spot_VI_2SMU 

DUT: Two-terminal generic device 

Function: Measures the voltage at a specified current to determine the resistance. 

Pin connections: Ensure that you set the sense mode of the SMU in the software toolbar (Tools > 
Preferences). If remote sense mode is used, which corresponds to four-wire measurement 
instruments, connect the Sense High lead of the SMU closer to the device than the Force High lead 
(see next figure). 

Figure 745: Two_term_resistor_spot_VI_2SMU pin connection 
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Sweep_IV_2SMU 
Description: 

Module Name: Sweep_IV_2SMU 

DUT: Two-terminal generic device 

Function: Measures the current reading during a voltage sweep and use the values to calculate the 
resistance. 

Pin connections: Ensure that you set the sense mode of the SMU in the software toolbar (Tools > 
Preferences). If remote sense mode is used, which corresponds to four-wire measurement 
instruments, connect the Sense High lead of the SMU closer to the device than the Force High lead 
(see next figure). 

Figure 746: Two_term_resistor_sweep_IV_2SMU pin connection 

 

Sweep_IV_2SMU ITM 

Module Type: ITM 

Instrument: Keithley Instruments Series 2600B, Model 4200-SMU 

Sweep_IV_2SMU General Test Module 

Module Type: General Test Module  

Instrument: Keithley Instruments Series 2400 SMU 
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Sweep_VI_2SMU 
Description: 

Module Name: Two-terminal Resistor_ Sweep_VI_2SMU 

DUT: Two-terminal generic device 

Function: Measures the voltage during a current sweep and use the values to calculate the 
resistance. 

Pin connections: Ensure that you set the sense mode of the SMU in the software toolbar (Tools > 
Preferences). If remote sense mode is used, which corresponds to four-wire measurement 
instruments, connect the Sense High lead of the SMU closer to the device than the Force High lead 
(see next figure). 

Figure 747: Two_term_resistor_sweep_VI_2SMU pin connection 

 
 

npnBJT test module template 
This npnBJT parametric test module template is used to test parameters of a npn-type power BJT, 
including leakage, breakdown, gain, on-state, and characteristic curves. 
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BVCBO 
Description: 

Module Name: BVCBO 

DUT: Three-terminal BJT 

Function: Measures the Collector-Base breakdown voltage of the BJT, with the Emitter open. 

Pin connections: Use one SMU to force a reverse current to the Collector. Open the circuit to the 
Emitter or use a SMU to supply zero current bias. Connect the Base to GND or use a SMU to supply 
a zero voltage bias. (See next figure.) 

Figure 748: Three_term_npnBJT_BVCBO 
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BVCEI 
Description: 

Module Name: BVCEI 

DUT: Three-terminal npnBJT 

Function: Measures the the Collector-Emitter breakdown voltage of the npnBJT with a bias Base-
forced current. 

Pin connections: Use a SMU to force current to the Collector. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias.(See next figure.) 

Figure 749: Three_term_npnBJT_BVCEI pin connection 
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BVCEO 
Description: 

Module Name: BVCEO 

DUT: Three-terminal npnBJT 

Function: Measures the Collector-Emitter breakdown voltage, with the Base opened. 

Pin connections: Use a SMU to force current to the Collector. Open the circuit to the Base or use a 
SMU to supply zero current bias to the Base. Connect the Emitter to GND or use a SMU to supply a 
zero voltage bias. (See next figure.) 

Figure 750: Three_term_npnBJT_BVCEO pin connection 
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BVCEV 
Description: 

Module Name: BVCEV 

DUT: Three-terminal npnBJT 

Function: Measures the Collector-Emitter breakdown voltage with a biased Base. 

Pin connections: Use a SMU to force voltage to the Base. Use a SMU to force current to the 
Collector. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 751: Three_term_npnBJT_BVCEV pin connection 
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BVEBO 
Description: 

Module Name: BVEBO 

DUT: Three-terminal npnBJT 

Function: Measures the Emitter-Base breakdown voltage of the npnBJT with the Collector opened. 

Pin connections: Use a SMU to force current to the Emitter. Connect the Base to GND or use a SMU 
to supply a zero voltage bias. Open the circuit to the Collector or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 752: Three_term_npnBJT_BVEBO pin connection 
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BVECO 
Description: 

Module Name: BVECO 

DUT: Three-terminal npnBJT 

Function: Measures the Emitter-Collector breakdown voltage of the npnBJT with the Base opened. 

Pin connections: Use a SMU to force current to the Emitter. Connect the Collector to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Base or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 753: Three_term_npnBJT_BVECO pin connection 
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HFE 
Description: 

Module Name: HFE_SW 

DUT: Three-terminal npnBJT 

Function: Measures the Collector current, Base current, and DC current gain based on the Collector 
sweep voltage. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias the Base. 
C or u.  

HFE= Ic/Ib: 

• Force CollectorV sweep 
• Measure Ib and Ic 
• Check for measurement problems 
• Calculate HFE(= Ic/Ib) 

Figure 754: Three_term_npnBJT_HFE_SW pin connection 
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IBCO 
Description: 

Module Name: IBCO 

DUT: Three-terminal npnBJT 

Function: Measures the base-Collector current with the Emitter opened. 

Pin connections: Use a SMU to force voltage to the Base. Connect the Collector to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias. (See next figure.) 

Figure 755: Three_term_npnBJT_IBCO pin connection 
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IBEO 
Description: 

Module Name: IBEO 

DUT: Four-terminal npnBJT 

Function: Measures the Base-Emitter current with the Collector opened. 

Pin connections: Use a SMU to force voltage to the Base. Connect the Collector to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias. (See next figure.) 

Figure 756: Three_term_npnBJT_IBEO pin connection 
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IbIcVbe 
Description: 

Module Name: IbIcVbe 

DUT: Three-terminal npnBJT 

Function: Measures the Base current and Collector current of the npnBJT by sweeping a specified 
Base voltage, and measures the Ib-Vbe and IcVbe curves and the gummel plot if the axis properties 
of result have changed (logarithm instead of right-angle coordinate). 

Pin connections: Use a SMU to apply a voltage sweep to the Base. Use a SMU to bias the Collector. 
Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 757: Three_term_npnBJT_ IbIcVbe pin connection 
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IbVbe 
Description: 

Module Name: IbVbe 

DUT: Three-terminal npnBJT 

Function: Measures the Base current of the npnBJT by sweeping a specified Base voltage, and 
measures the Ib-Vbe curve. 

Pin connections: Use a SMU to apply a voltage sweep to the Base. Use a SMU to bias the Collector. 
Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 758: Three_term_npnBJT_IbVbe pin connection 
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ICBO 
Description: 

Module Name: ICBO 

DUT: Three-terminal npnBJT 

Function: Measures the Collector-Base cut off current with the Emitter opened. 

Pin connections: Use a SMU to force voltage to the Collector. Connect the Base to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias. 

Figure 759: Three_term_npnBJT_ICBO pin connection 
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ICEO 
Description: 

Module Name: ICEO 

DUT: Three-terminal npnBJT 

Function: Measures the Collector-Emitter cut off current with the Base opened. 

Pin connections: Use a SMU to force voltage to the Collector. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Base or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 760: Three_term_npnBJT_ICEO pin connection 
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ICEV 
Description: 

Module Name: ICEV 

DUT: Three-terminal npnBJT 

Function: Measures the Collector-Emitter cut off current with a bias Base voltage. 

Pin connections: Use a SMU to force voltage to the Base and the Collector. Connect the Emitter to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 761: Three_term_npnBJT_ICEV pin connection 
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IcVcb 
Description: 

Module Name: IcVcb 

DUT: Three-terminal npnBJT 

Function: Measures the Collector current of the npnBJT by sweeping a specified Collector voltage. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias the 
Emitter. Connect the Base to GND or use a SMU to supply a zero voltage bias. 

Figure 762: Three_term_npnBJT_IcVcb pin connection 
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IcVce_BiasIb 
Description: 

Module Name:  IcVce_BiasIb 

DUT: Three-terminal npnBJT 

Function: Measures the Collector current based on a Base step current and a Collector sweep 
voltage, and a series of IcVce curves with a Base current step. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias the current 
to the Base.  Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next 
figure.) 

Figure 763: Three_term_npnBJT_IcVce_BiasIb pin connection 
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IcVce_BiasVb 
Description: 

Module Name:  IcVce_BiasVb 

DUT: Three-terminal npnBJT 

Function: Measures the Collector current based on the Collector sweep voltage and a fixed based 
voltage, and measures a series of IcVce curves with a fixed Base voltage. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to supply a zero 
voltage bias to the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. 
(See next figure.) 

Figure 764: Three_term_npnBJT_IcVce_BiasVb pin connection 
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IcVce_StepIb 
Description: 

Module Name: IcVce_StepIb 

DUT: Three-terminal npnBJT 

Function: Measures the Collector current based on the base step current and the Collector sweep 
voltage, and measures a series of IcVce curves with a Base current step. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to apply a step 
current to the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See 
next figure.) 

Figure 765: Three_term_npnBJT_IcVce_StepIb pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-38 ACS-901-01 Rev. H / December 2014 

 

IcVce_StepVb 
Description: 

Module Name: IcVce_StepVb 

DUT: Three-terminal npnBJT 

Function: Measures the Collector current based on the Base step and the Collector sweep voltage, 
and measures a series of IcVce curves with a Base voltage step. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to apply a step 
voltage to the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See 
next figure.) 

Figure 766: Three_term_npnBJT_IcVce_StepVb pin connection 
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IEBO 
Description: 

Module Name: IEBO 

DUT: Three-terminal npnBJT 

Function: Measures the Emitter-Base cut off current with the Collector opened.  

Pin connections: Use a SMU to force voltage to the Emitter. Connect the Base to GND or use a SMU 
to supply a zero voltage bias. Open the circuit to the Collector or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 767: Three_term_npnBJT_IEBO pin connection 
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IECO 
Description: 

Module Name: IECO 

DUT: Three-terminal npnBJT 

Function: Measures the Emitter-Collector current with the Base opened. 

Pin connections: Use a SMU to force voltage to the Emitter. Open the circuit to the Collector or use a 
SMU to supply a zero voltage bias. Open the circuit to the Base or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 768: Three_term_npnBJT_IECO pin connection 
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IeVeb 
Description: 

Module Name: IeVeb 

DUT: Three-terminal npnBJT 

Function: Measures the Emitter current of the npnBJT with a specified sweeping Emitter voltage, and 
measures the IeVeb curves. 

Pin connections:Use a SMU to apply a sweep voltage to the Emitter. Use a SMU to apply biased 
voltage to the Collector. Connect the Base to GND or use a SMU to supply a zero voltage bias. (See 
next figure.) 

Figure 769: Three_term_npnBJT_IeVeb pin connection 
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VBCO 
Description: 

Module Name: VBCO 

DUT: Three-terminal npnBJT 

Function: Measures the Base-Collector voltage of the npnBJT with the Emitter opened. 

Pin connections: Use a SMU to apply a biased current to the Base. Connect the Collector to GND or 
use a SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias. (See next figure.) 

Figure 770: Three_term_npnBJT_VBCO pin connection 
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VCE 
Description: 

Module Name: VCE 

DUT: Three-terminal npnBJT 

Function: Measures the Collector-Emitter voltage the npnBJT. 

Pin connections: Use a SMU to apply a biased current to the Collector. Use a SMU to applied a 
biased voltage to the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. 
(See next figure.) 

Figure 771: Three_term_npnBJT_VCE pin connection 
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Ccb 
Description: 

Module Name: Ccb 

DUT: Three-terminal npnBJT 

Function: Measures the capacitance between the Collector and Base terminals with the Emitter 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base. Use the Series 2600B to supply zero voltage bias. Connect a Series 
2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Emitter. Use 
the Series 2600B to supply zero voltage bias. 

Figure 772: Three-term npnBJT Ccb pin connection 
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Cce 
Description: 

Module Name: Cce 

DUT: Three-terminal npnBJT 

Function: Measures the capacitance between the Collector and Emitter terminals with the Base 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Emitter. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Base. 
Use the Series 2600B to supply zero voltage bias. 

Figure 773: Three-term npnBJT Cce pin connection 
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Ceb 
Description: 

Module Name: Ceb 

DUT: Three-terminal npnBJT 

Function: Measures the capacitance between the Emitter and Base terminals with the Collector 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 774: Three-term npnBJT Ceb pin connections 
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Cibo 
Description: 

Module Name: Cibo 

DUT: Three-terminal npnBJT 

Function: Measures the capacitance between the input terminals (Base and Emitter) with the 
Collector terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 775: Three-term npnBJT Cibo pin connection 
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Cobo 
Description: 

Module Name: Cobo 

DUT: Three-terminal npnBJT 

Function: Measures the capacitance between the output terminals (Base and Collector) with the 
Emitter terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Open the circuit 
to the Emitter. 

Figure 776: ACS Three_term_npnBJT_Cobo pin connection 

 
 

pnpBJT test module template 
The pnpBJT device parametric test module template is used to test parameters of a pnp-type BJT, 
including leakage, breakdown, gain, on-state, and characteristic curves. 
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BVCBO 
Description: 

Module Name: BVCBO 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Base breakdown voltage of the pnpBJT device with the Emitter 
opened. 

Pin connections: Use a SMU to apply a reverse current to the Collector. Connect the Base to GND or 
use a SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias. (See next figure.) 

Figure 777: Three_term_pnpBJT_BVCBO pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-50 ACS-901-01 Rev. H / December 2014 

 

BVCEI 
Description: 

Module Name: BVCEI 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Emitter breakdown voltage of the pnpBJT device with a bias Base-
forced current. 

Pin connections: Use two SMUs to force current to the Base and Collector. Connect the Emitter to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 778: Three_term_pnpBJT_BVCEI pin connection 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-51 

 

BVCEO 
Description: 

Module Name: BVCEO 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Emitter breakdown voltage with the Base opened. 

Pin connections: Use a SMU to force current to the Collector. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Base or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 779: Three_term_pnpBJT_BVCEO pin connection 
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BVCEV 
Description: 

Module Name: BVCEV 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Emitter breakdown voltage with the Base forced with a voltage bias. 

Pin connections: Use two SMUs to force voltage to the Base and Collector. Connect the Emitter to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 780: Three_term_pnpBJT_BVCEV pin connection 
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BVEBO 
Description: 

Module Name: BVEBO 

DUT: Three-terminal pnpBJT 

Function: Measures the Emitter-Base breakdown voltage of the pnpBJT device with the Collector 
opened. 

Pin connections: Use a SMU to force current to the Emitter. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Collector or use a SMU to supply zero 
current bias. (See next figure.) 

Figure 781: Three_term_pnpBJT_BVEBO pin connection 
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BVECO 
Description: 

Module Name: BVECO 

DUT: Three-terminal pnpBJT 

Function: Measures the Emitter-Collector breakdown voltage of the pnpBJT device with the Base 
opened. 

Pin connections: Use a SMU to force current to the Emitter. Open the circuit to the Base or use a 
SMU to supply zero current bias. Connect the Collector to GND or use a SMU to supply a zero 
voltage bias. (See next figure.) 

Figure 782: Three_term_pnpBJT_BVECO pin connection 
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HFE 
Description: 

Module Name: HFE 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector current, Base current, and DC current gain based on the Collector 
sweep voltage. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias the Base. 
Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) HFE = 
Ic/Ib: 

• Force CollectorV sweep 
• Measure Ib and Ic 
• Check for measurement problems 
• Calculate HFE= Ic/Ib 

Figure 783: Three_term_pnpBJT_HFE_sw pin connection 
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IBCO 
Description: 

Module Name: IBCO 

DUT: Three-terminal pnpBJT 

Function: Measures the Base-Collector current with the Emitter opened. 

Pin connections: Use a SMU to force voltage to the Base. Connect the Collector to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias.(See next figure.) 

Figure 784: Three_term_pnpBJT_IBCO pin connection 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-57 

 

IBEO 
Description: 

Module Name: IBEO 

DUT: Three-terminal pnpBJT 

Function: Measures the Base-Emitter current with the Collector opened. 

Pin connections: Use a SMU to force voltage to the Base. Connect the Emitter to GND or use a SMU 
to supply a zero voltage bias. Open the circuit to the Collector or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 785: Three_term_pnpBJT_IBEO pin connection 
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IbIcVbe 
Description: 

Module Name: IbIcVbe 

DUT: Three-terminal pnpBJT 

Function: Measures the Base current and Collector current of the pnpBJT device with a specified 
Base voltage sweep, measures the IbVbe and IcVbe curves, and measures the gummel plot if the 
axis properties of the data plot have changed (the logarithm instead of right-angle coordinate. 

Pin connections: Use a SMU to apply a sweep voltage to the Base. Use a SMU to bias the Collector. 
Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 786: Three_term_pnpBJT_IbIcvbe pin connection 
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IbVbe 
Description: 

Module Name: IbVbe 

DUT: Three-terminal pnpBJT 

Function: Measures the Base current of the pnpBJT device with a specified Base voltage sweep, and 
measures the IbVbe curve. 

Pin connections: Use a SMU to apply a sweep voltage to the Base. Use a SMU to bias the Collector. 
Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 787: Three_term_pnpBJT_IbVbe pin connection 
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ICBO 
Description: 

Module Name: ICBO 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Base cut-off current with the Emitter opened. 

Pin connections: Use a SMU to force voltage to the Collector. Connect the Base to GND or use a 
SMU to supply a zero voltage bias. Open the circuit to the Emitter or use a SMU to supply zero 
current bias. (See next figure.) 

Figure 788: Three_term_pnpBJT_ICBO pin connection 
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ICEO 
Description: 

Module Name: ICEO 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Emitter cut-off current with the Base opened. 

Pin connections: Use a SMU to force voltage to the Collector.Open the circuit to the Base or use a 
SMU to supply zero current bias.  Connect the Emitter to GND or use a SMU to supply a zero voltage 
bias. (See next figure.) 

Figure 789: Three_term_pnpBJT_ICEO pin connection 
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ICEV 
Description: 

Module Name: ICEV 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Emitter cut off current with the Base voltage biased. 

Pin connections: Use two SMUs to force voltage to the Base and Collector. Connect the Emitter to 
GND or  use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 790: Three_term_pnpBJT_ICEV pin connection 
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IcVcb 
Description: 

Module Name: IcVcb 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector current of the pnpBJT device with a specified Collector voltage 
sweep. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias the 
Emitter. Connect the Base to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 791: Three_term_pnpBJT_IcVcb pin connection 
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IcVce_BiasIb 
Description: 

Module Name: IcVce_BiasIb 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector current based on the Base bias current and Collector sweep 
voltage, and measure the IcVce curve. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias current to 
the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 792: Three_term_pnpBJT_IcVce_BiasIb pin connection 
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IcVce_BiasVb 
Description: 

Module Name: IcVce_BiasVb 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector current based on the Base bias voltage and the Collector sweep 
voltage, and measures the IcVce curve. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to bias voltage to 
the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 793: Three_term_pnpBJT_IcVce_BiasVb pin connection 
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IcVce_StepIb 
Description: 

Module Name: IcVce_StepIb 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector current based on the Base step current and the Collector sweep 
voltage, and measures the series of IcVce curves with a Base current step. 

Pin connections: Use a SMU to apply a sweep voltage to the Collector. Use a SMU to step current to 
the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 794: Three_term_pnpBJT_IcVce_StepIb pin connection 
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IcVce_StepVb 
Description: 

Module Name: IcVce_StepVb 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector current based on Base step and the Collector sweep voltage, and 
measures the series of IcVce curves with at Base voltage step. 

Pin connections:Use a SMU to apply a sweep voltage to the Collector. Use a SMU to apply a step 
voltage to the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See 
next figure.) 

Figure 795: Three_term_pnpBJT_IcVce_StepVb pin connection 
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IEBO 
Description: 

Module Name: IEBO 

DUT: Three-terminal pnpBJT 

Function: Measures the Emitter-Base cut off current with the Collector opened. 

Pin connections: Use a SMU to force voltage to the Emitter. Connect the Base to GND or use a SMU 
to supply a zero voltage bias.Open the circuit to the Collector or use a SMU to supply zero current 
bias. (See next figure.) 

Figure 796: Three_term_pnpBJT_IEBO pin connection 
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IECO 
Description: 

Module Name: IECO 

DUT: Three-terminal pnpBJT 

Function: Measures the Emitter-Collector current with the Base opened. 

Pin connections: Use a SMU to force voltage to the Emitter. Open the circuit to the Base or use a 
SMU to supply zero current bias. Connect the Collector to GND or use a SMU to supply a zero 
voltage bias. (See next figure.) 

Figure 797: Three_term_pnpBJT_IECO pin connection 
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IeVeb 
Description: 

Module Name: IeVeb 

DUT: Three-terminal pnpBJT 

Function: Measures the Emitter current based on the Emitter voltage sweep, and measures the IeVeb 
curves. 

Pin connections: Use a SMU to force voltage to the Emitter. Open the circuit to the Base or use a 
SMU to supply zero current bias. Connect the Collector to GND or use a SMU to supply a zero 
voltage bias. (See next figure.) 

Figure 798: Three_term_pnpBJT_IeVeb pin connection 
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VBCO 
Description: 

Module Name: VBCO 

DUT: Three-terminal pnpBJT 

Function: Measures the Base-Collector voltage of the pnpBJT device with the Emitter opened. 

Pin connections: Use a SMU to apply a bias current to the Base. Open the circuit to the Emitter or 
use a SMU to supply zero current bias. Connect the Collector to GND or use a SMU to supply a zero 
voltage bias. (See next figure.) 

Figure 799: Three_term_pnpBJT_VBCO pin connection 
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VCE 
Description: 

Module Name: VCE 

DUT: Three-terminal pnpBJT 

Function: Measures the Collector-Emitter voltage of the pnpBJT device. 

Pin connections: Use a SMU to apply bias current to the Collector. Use a SMU to apply bias voltage 
to the Base. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next 
figure.) 

Figure 800: Three_term_pnpBJT_VCE pin connection 
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Ccb 
Description: 

Module Name: Ccb 

DUT: Three-terminal pnpBJT 

Function: Measures the capacitance between the Collector and Base terminals with the Emitter 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Emitter. 
Use the Series 2600B to supply zero voltage bias. 

Figure 801: ACS Three_term_pnpBJT_Ccb pin connections 
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Cce 
Description: 

Module Name: Cce 

DUT: Three-terminal pnpBJT 

Function: Measures the capacitance between the Collector and Emitter terminals with the Base 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Emitter. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Base. 
Use the Series 2600B to supply zero voltage bias. 

Figure 802: Three-term pnpBJT Cce pin connections 
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Ceb 
Description: 

Module Name: Ceb 

DUT: Three-terminal pnpBJT 

Function: Measures the capacitance between the Emitter and Base terminals with the Collector 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 803: Three-term pnpBJT Ceb pin connections 
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Cibo 
Description: 

Module Name: Cibo 

DUT: Three-terminal pnpBJT 

Function: Measures the capacitance between the input terminals (Base and Emitter) with the 
Collector terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 804: Three-term pnpBJT Cibo pin connections 
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Cobo 
Description: 

Module Name: Cobo 

DUT: Three-terminal pnpBJT 

Function: Measures the capacitance between the output terminals (Base and Collector) with the 
Emitter terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Open the circuit 
to the Emitter. 

Figure 805: Three-term pnpBJT Cobo pin connections 

 
 

npnPowerBJT library 
This npnPowerBJT parametric test module template is used to test parameters of a npn-type power 
BJT, including leakage, breakdown, gain, on-state, and characteristic curves. 
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BVCBO 
Description: 

Module Name: BVCBO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Base breakdown voltage with the Emitter opened. The voltage is 
measured with a specific Collector current that is given in the data sheet. 

Pin Connections: Use a SMU to force current and make a voltage measurement from the Collector to 
the Base. Connect the Base to GND or use a SMU to supply a zero voltage bias. Open the circuit to 
the Emitter or use a SMU to supply zero current bias. (See next figure.) 

Figure 806: npnPowerBJT BVCBO pin connection 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-79 

 

BVCEO 
Description: 

Module Name: BVCEO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter breakdown voltage with the Base opened. The voltage is 
measured with a specific Collector current that is given in the data sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
Emitter. Connect the Emitter to GND or use a SMU to supply zero current bias. Open the circuit to the 
Base or use a SMU to supply zero current bias. (See next figure.) 

Figure 807: npnPowerBJT BVCEO pin connection 
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BVEBO 
Description: 

Module Name: BVEBO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Emitter-Base breakdown voltage with the Collector opened. The voltage is 
measured with a specific Base current or Emitter current in reverse direction that is given in the data 
sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Base to the 
Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Open the circuit to 
the Collector or use a SMU to supply zero current bias. (See next figure.) 

Figure 808: npnPowerBJT BVEBO pin connection 
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HFE 
Description: 

Module Name: HFE 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter static forward current transfer ratio with the output voltage 
(Vce) held constant (HFE = Ic/Ib). 

Pin Connection: Use one SMU to apply voltage bias and make a current measurement from the 
Collector to the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use 
a SMU to apply a sweep current to the Base. (See next figure.) 

Figure 809: npnPowerBJT HFE pin connection 
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ICBO 
Description: 

Module Name: ICBO 

Test Type: ITM 

Instrument: KI2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Base cut-off current. Measures the current on the Collector with a 
reverse bias on the Collector-Base and with the Emitter opened. 

Pin Connection: One SMU is used. The SMU applies voltage and takes current measurements from 
the Collector to Base. The Emitter is opened or has no current bias from a SMU.  

Figure 810: npnPowerBJT ICBO pin connection 
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ICEO 
Description: 

Module Name:ICEO 

Test Type:ITM 

Instrument:Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter cut-off current with the Base opened.  

Pin Connection: Use a SMU to force voltage and make a current measurement from the Collector to 
the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Open the circuit 
to the Base or use a SMU to supply zero current bias. (See next figure.) 

Figure 811: npnPowerBJT ICEO pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-84 ACS-901-01 Rev. H / December 2014 

 

ICES 
Description: 

Module Name: ICES 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter cut-off current with the Base short-circuited to the Emitter. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Collector to 
the Emitter. Short the Base to the Emitter or use a SMU to supply a zero voltage bias. (See next 
figure.) 

Figure 812: npnPowerBJT ICES pin connection 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-85 

 

ICEV 
Description: 

Module Name: ICEV 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter cut-off current with a reverse bias on the Emitter-Base. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Collector to 
the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use another 
SMU to bias the Base with a specified voltage. (See next figure.) 

Figure 813: npnPowerBJT ICEV pin connection 
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IcVce_StepIb 
Description: 

Module Name: IcVce_StepIb 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a current step at the Base. 

Pin Connection: Use one SMU to apply a voltage sweep and make a current measurement from 
Collector to Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use a 
SMU to apply a current step to the Base. 

Figure 814: npnPowerBJT IcVce_StepIb pin connection 
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IcVce_StepVbe 
Description: 

Module Name: IcVce_StepVbe 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a voltage step at the Base. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from 
Collector to Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use a 
SMU to apply a voltage step to the Base-Emitter junction. (See next figure.) 

Figure 815: npnPowerBJT IcVce_StepVbe pin connection 
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IEBO 
Description: 

Module Name: IEBO 

Test Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Emitter-Base cut-off current. Measures the current on the Emitter with 
reverse bias on the Emitter-Base and with the Collector opened. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Base to the 
Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Open the circuit to 
the Collector or use a SMU to supply zero current bias. (See next figure.) 

Figure 816: npnPowerBJT IEBO pin connection 
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VbeON 
Description: 

Module Name: VbeON 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the on voltage of the Base-Emitter when the BJT is in the active region. The 
voltage is measured with the Base-Emitter forward biased and the Collector-Emitter voltage higher 
than the VceSAT. 

Pin Connection: Use a SMU to apply a current sweep and make a voltage measurement from the 
Base to the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use a 
SMU to apply voltage bias to the Collector. (See next figure.) 

Figure 817: npnPowerBJT VbeON pin connection 
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VbeSAT 
Description: 

Module Name: VbeSAT 

Test Type: ITM 

Instrument: Keithley Instruments Models 2651A, Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Base-Emitter saturation voltage. The voltage is measured at a specific Base 
current and a Collector current that is given in the data sheet to ensure that both the Emitter-Base 
and Collector-Base junctions are forward biased. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Base to the 
Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use one SMU to 
apply current bias to the Collector. (See next figure.) 

Figure 818: npnPowerBJT VbeSAT pin connection 
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VceSAT 
Description: 

Module Name: VceSAT 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter saturation voltage. The voltage is measured at a specific 
Base current and Collector current that is given in the data sheet to ensure that both the Emitter-Base 
and Collector-Base junctions are forward biased. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use a SMU to 
apply a current bias to the Base. (See next figure.) 

Figure 819: npnPowerBJT VceSAT pin connection 
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VCESUS 
Description: 

Module Name: VCESUS 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter sustaining voltage with the Base opened. The voltage is 
measured at a specific Collector current that is given in the data sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Open the circuit 
to the Base or use a SMU to supply zero current bias. (See next figure.) 

Figure 820: npnPowerBJT VCESUS pin connection 
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VceSAT_MIX 
Description: 

Module Name: VceSAT_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter saturation voltage. The voltage is measured at a specific 
Base current and Collector current that is given in the data sheet to ensure that both the Emitter-Base 
and Collector-Base junctions are forward biased. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use a SMU to 
apply current bias to the Base. (See next figure.) 

Figure 821: npnPowerBJT VceSAT_MIX pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-94 ACS-901-01 Rev. H / December 2014 

 

IcVce_StepIb_MIX 
Description: 

Module Name: IcVce_StepIb_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2657A, and Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a current step at the Base. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from the 
Collector to the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use 
a SMU to apply current step to Base. (See next figure.) 

Figure 822: npnPowerBJT IcVce_StepIb_MIX pin connection 
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IcVce_StepVbe_MIX 
Description: 

Module Name: IcVce_StepVbe 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal npnPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a voltage step on the 
Emitter-Base junction. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from the 
Collector to the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Use 
a SMU to apply a voltage step to the Base-Emitter junction. (See next figure.) 

Figure 823: npnPowerBJT IcVce_StepVbe_MIX pin connection 
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Ccb 
Description: 

Module Name: Ccb 

DUT: Three-terminal npnPowerBJT 

Function: Measures the capacitance between the Collector and Base terminals with the Emitter 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Emitter. 
Use the Series 2600B to supply zero voltage bias. 

Figure 824: Three-term npnPowerBJT Ccb pin connections 
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Cce 
Description: 

Module Name: Cce 

DUT: Three-terminal npnPowerBJT 

Function: Measures the capacitance between the Collector and Emitter terminals with the Base 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Emitter. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Base. 
Use the Series 2600B to supply zero voltage bias. 

Figure 825: Three-term npnPowerBJT Cce pin connection 
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Ceb 
Description: 

Module Name: Ceb 

DUT: Three-terminal npnPowerBJT 

Function: Measures the capacitance between the Emitter and Base terminals with the Collector 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 826: Three-term npnPowerBJT Ceb pin connections 
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Cibo 
Description: 

Module Name: Cibo 

DUT: Three-terminal npnPowerBJT 

Function: Measures the capacitance between the input terminals (Base and Emitter) with the 
Collector terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 827: Three-term npnPowerBJT Cibo pin connections 
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Cobo 
Description: 

Module Name: Cobo 

DUT: Three-terminal npnPowerBJT 

Function: Measures the capacitance between the output terminals (Base and Collector) with the 
Emitter terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Open the circuit 
to the Emitter. 

Figure 828: Three- _term npnPowerBJT Cobo pin connections 

 
 

pnpPowerBJT test module template 
The pnpPowerBJT parametric test module template is used to test parameters of a pnp-type power 
BJT, including leakage, breakdown, gain, on-state and characteristic curves. 
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BVCBO 
Description: 

Module Name: BVCBO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector Base breakdown voltage with the Emitter opened. The voltage is 
measured with a specific Collector current that is given in the data sheet. 

Pin Connections: Use a SMU to force current and make a voltage measurement from the Collector to 
Base. Open the circuit to the Emitter or use a SMU to supply zero current bias. Connect the Base to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 829: pnpPowerBJT BVCBO pin connection 
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BVCEO 
Description: 

Module Name: BVCEO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter breakdown voltage with the Base opened. The voltage is 
measured with a specific Collector current that is given in the data sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
Emitter. Open the circuit to the Base or use a SMU to supply zero current bias. Connect the Emitter to 
GND or use a SMU to supply a zero voltage bias. 

Figure 830: pnpPowerBJT BVCEO pin connection 
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BVEBO 
Description: 

Module Name: BVEBO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Emitter-Base breakdown voltage with the Collector opened. The voltage is 
measured with a specific Base current or Emitter current in a reverse direction that is given in the 
data sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Base to the 
Emitter. Open the circuit to the Collector or use a SMU to supply zero current bias. Connect the 
Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 831: pnpPowerBJT BVEBO pin connection 
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HFE 
Description: 

Module Name: HFE 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter static forward current transfer ratio with the output voltage 
(Vce) held constant (HFE = Ic/Ib). 

Pin Connection: Use a SMU to apply voltage bias and make current measurements from the Collector 
to the Emitter. Use another SMU to apply a current sweep at the Base. Connect the Emitter to GND 
or use a SMU to supply a zero voltage bias. 

Figure 832: pnpPowerBJT HFE pin connection 
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ICBO 
Description: 

Module Name: ICBO 

Test Type: ITM 

Instrument: KI2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Base cut-off current. Measures the current on the Collector by 
reverse biasing the Collector-Base and with the Emitter opened. 

Pin Connection: One SMU is used. The SMU applies voltage and takes current measurements from 
the Collector to Base. The Emitter is open. 

Figure 833: pnpPowerBJT ICBO pin connection 
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ICEO 
Description: 

Module Name: ICEO 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter cut-off current with the Base opened.  

Pin Connection: Use a SMU to force voltage and make a current measurement from the Collector to 
the Emitter. Open the circuit to the Base or use a SMU to supply zero current bias. Connect the 
Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 834: pnpPowerBJT ICEO pin connection 
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ICES 
Description: 

Module Name: ICES 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter cut-off current with the Base shorted to the Emitter. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Collector to 
the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. Short the Base 
to the Emitter or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 835: pnpPowerBJT ICES pin connection 
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ICEV 
Description: 

Module Name: ICEV 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter cut-off current with reverse biasing at the Emitter-Base 
junction. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Collector to 
the Emitter. Use a SMU to bias the Base with a specified voltage. Connect the Emitter to GND or use 
a SMU to supply a zero voltage bias. (See next figure.) 

Figure 836: pnpPowerBJT ICEV pin connection 
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IcVce_StepIb 
Description: 

Module Name: IcVce_StepIb 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with the current step at the 
Base. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from the 
Collector to the Emitter. Connect the Emitter to GND or use a SMU to supply a zero voltage bias. 
(See next figure.) 

Figure 837: pnpPowerBJT IcVce_StepIb pin connection 
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IcVce_StepVbe 
Description: 

Module Name: IcVce_StepVbe 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a current step at the Base. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from the 
Collector to the Emitter. Use another SMU to apply a voltage step to the Base-Emitter junction. 
Connect the Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 838: pnpPowerBJT IcVce_StepVbe pin connection 
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IEBO 
Description: 

Module Name: IEBO 

Test Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Emitter-Base cut-off current. Measures the current on the Emitter by reverse 
biasing the Emitter-Base junction with the Collector opened. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Base to 
Emitter. Open the circuit to the Collector or use a SMU to supply zero current bias. Connect the 
Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 839: pnpPowerBJT IEBO pin connection 
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VbeON 
Description: 

Module Name: VbeON 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Base-Emitter junction on voltage when the BJT is in an active region. The 
voltage is measured with the Base-Emitter junction forward biased and the Collector Emitter voltage 
higher than the VceSAT. 

Pin Connection: Use a SMU to apply a sweep current and make a voltage measurement from Base to 
Emitter. Use another SMU to apply a voltage bias to the Collector. Connect the Emitter to GND or use 
a SMU to supply a zero voltage bias. (See next figure.) 

Figure 840: pnpPowerBJT VbeON pin connection 
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VbeSAT 
Description: 

Module Name: VbeSAT 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Base-Emitter saturation voltage. The voltage is measured at a specific Base 
current and Collector current that is given in the data sheet to ensure that both the Emitter-Base and 
Collector-Base junctions are forward biased. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Base to 
Emitter. Use a SMU to apply a current bias to the Collector. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias. 

Figure 841: pnpPowerBJT VbeSAT pin connection 
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VceSAT 
Description: 

Module Name: VceSAT 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter saturation voltage. The voltage is measured at a specific 
Base current and Collector current that is given in the data sheet to ensure that both the Emitter-Base 
and Collector-Base junctions are forward-biased. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
the Emitter. Use another SMU to apply current bias to the Base. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias. 

Figure 842: pnpPowerBJT VceSAT pin connection 
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VCESUS 
Description: 

Module Name: VCESUS 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter sustaining voltage with the Base opened. The voltage is 
measured at a specific Collector current that is given in the data sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
Emitter. Open the circuit to the Base or use a SMU to supply zero current bias. Connect the Emitter to 
GND or use a SMU to supply a zero voltage bias. 

Figure 843: pnpPowerBJT VCESUS pin connection 
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VceSAT_MIX 
Description: 

Module Name: VceSAT_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter saturation voltage. The voltage is measured at a specific 
Base current and at the Collector current that is given in data sheet to ensure that both the Emitter-
Base and Collector-Base junctions are forward biased. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
Emitter. Use another SMU to apply current bias to the Base. Connect the Emitter to GND or use a 
SMU to supply a zero voltage bias. 

Figure 844: pnpPowerBJT VceSAT_MIX pin connection 
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IcVce_StepIb_MIX 
Description: 

Module Name: IcVce_StepIb_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a current step at the Base. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from the 
Collector to the Emitter. Use another SMU to apply a current step to the Base. Connect the Emitter to 
GND or use a SMU to supply a zero voltage bias. 

Figure 845: pnpPowerBJT IcVce_StepIb_MIX pin connection 
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IcVce_StepVbe_MIX 
Description: 

Module Name: IcVce_StepVbe_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the Collector-Emitter output characteristic curve with a voltage step on the 
Emitter-Base junction. 

Pin Connection: Use a SMU to apply a voltage sweep and make a current measurement from the 
Collector to the Emitter. Use a SMU to apply a voltage step to the Base-Emitter junction. Connect the 
Emitter to GND or use a SMU to supply a zero voltage bias. 

Figure 846: pnpPowerBJT IcVce_StepVbe_MIX pin connection 
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Ccb 
Description: 

Module Name: Ccb 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the capacitance between the Collector and Base terminals with the Emitter 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Emitter. 
Use the Series 2600B to supply zero voltage bias. 

Figure 847: Three-term pnpPowerBJT Ccb pin connections 
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Cce 
Description: 

Module Name: Cce 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the capacitance between the Collector and Emitter terminals with the Base 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Emitter. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Base. 
Use the Series 2600B to supply zero voltage bias. 

Figure 848: Three-term pnpPowerBJT Cce pin connection 
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Ceb 
Description: 

Module Name: Ceb 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the capacitance between the Emitter and Base terminals with the Collector 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 849: Three-term pnpPowerBJT Ceb pin connections 
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Cibo 
Description: 

Module Name: Cibo 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the capacitance between the input terminals (Base and Emitter) with the 
Collector terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Emitter. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the 
Collector. Use the Series 2600B to supply zero voltage bias. 

Figure 850: Three-term pnpPowerBJT Cibo pin connections 
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Cobo 
Description: 

Module Name: Cobo 

DUT: Three-terminal pnpPowerBJT 

Function: Measures the capacitance between the output terminals (Base and Collector) with the 
Emitter terminal open. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Base.  Use the Series 2600B to supply zero voltage bias. Open the circuit 
to the Emitter. 

Figure 851: Three-term pnpPowerBJT Cobo pin connections 
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TRIAC test module template 
The TRIAC parametric test module template is used to test parameters of a TRIAC device, including 
leakage, on-state, trigger, latch and hold properties. 

 

IDRM 
Description: 

Module Name: IDRM 

Module Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal TRIAC 

Function: Measures the peak repetitive blocking current. Measures the maximum instantaneous value 
of the off-state current that results from the application of repetitive peak off-state voltage.  

Pin Connection: Use the Model 2657A to apply voltage and measure current between terminals MT2 
(or A2) to MT1 (or A1). Open the circuit to the Gate or use a SMU to supply zero current bias. 

Figure 852: TRIAC IDRM pin connection 
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IGT 
Description: 

Module Name: IGT 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the Gate trigger current. Measures the minimum current required between the 
Gate and cathode (MT1) to turn on the device. 

Pin Connection: Use the Model 2651A to apply the specified voltage and measure the current 
between terminals MT2 (or A2) to MT1 (or A1). Use the Model 2600B SMU to sweep current and 
measure voltage between Gate and cathode MT1. If required, connect a resistance load RL at 
specified value in series with the TRIAC device to achieve a defined on-state current IT. 

Figure 853: TRIAC IGT pin connection 
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IHneg 
Description: 

Module Name: IHneg 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the holding current. Measures the minimum current across the main terminals to 
keep the device in the on-state. 

Pin Connection: Use the Model 2651A SMU to apply current between terminals MT2 (or A2) to MT1 
(or A1). Use the Model 2600B SMU to apply the specified current between Gate and cathode MT1. 

Figure 854: TRIAC IHneg pin connection 
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IHpos 
Description: 

Module Name: IHpos 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the holding current. Measures the minimum current across the main terminals to 
keep the device in the on-state. 

Pin Connection: Use the Model 2651A SMU to apply current between terminals MT2 (or A2) to MT1 
(or A1). Use the Model 2600B SMU to apply the specified current between Gate and cathode MT1. 

Figure 855: TRIAC IHpos pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-128 ACS-901-01 Rev. H / December 2014 

 

ILneg 
Description: 

Module Name: ILneg 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the latching current. Measures the minimum current across the main terminals to 
keep the device in the on-state. This occurs immediately after switching from off-state to on-state and 
the triggering Gate signal has been removed. 

Pin Connection: Use the Model 2651A SMU to apply current between terminals MT2 (or A2) to MT1 
(or A1). Use the Model 2600B SMU to apply the specified current between Gate and cathode MT1. 

Figure 856: TRIAC ILneg pin connection 
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ILpos 
Description: 

Module Name: ILpos 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the latching current. Measures the minimum current across the main terminals to 
keep the device in the on-state. This occurs immediately after switching from off-state to on-state and 
the triggering Gate signal has been removed.  

Pin Connection: Use the Model 2651A SMU to apply current between terminals MT2 (or A2) to MT1 
(or A1). Use the Model 2600B SMU to apply the specified current between Gate and cathode MT1. 

Figure 857: TRIAC ILpos pin connection 
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IRRM 
Description: 

Module Name: IRRM 

Module Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal TRIAC 

Function: Measures the peak repetitive reverse blocking current. Measures the maximum 
instantaneous value of the reverse off-state current that results from the application of repetitive peak 
off-state voltage.  

Pin Connection: Use the Model 2657A SMU to apply voltage and measure current between terminals 
MT2 (or A2) to MT1 (or A1). Connect Gate to GND or use a SMU to supply a zero voltage bias. 

Figure 858: TRIAC IRRM pin connection 
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VGT 
Description: 

Module Name: VGT 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the Gate trigger voltage. Measures the minimum voltage required between the 
Gate and cathode in order to reach the Gate trigger current and then to trigger the device.  

Pin Connection: Use the Model 2651A SMU to apply the specified voltage and measure current 
between terminals MT2 (or A2) to MT1 (or A1). Use the Model 2600B SMU to sweep the current and 
measure voltage between Gate and cathode MT1. Two SMUs are used. One SMU applies a 
specified voltage and measures current between terminals A2 (or MT2) to A1 (or MT1). If required, 
connect a resistance load (RL) at a specified value in series with the TRIAC device to achieve a 
defined on-state current IT. 

Figure 859: TRIAC VGT pin connection 
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VTneg 
Description: 

Module Name: VTneg 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the peak on-state voltage. Measures the maximum voltage drop across the main 
terminals at stated conditions when the devices are in the on-state. Typically measured at a short 
pulse width and low duty cycle to prevent heating of the junction. 

Pin Connection: One or two SMUs are used. One SMU applies a specified current and measures 
voltage between terminals A2 (or MT2) to A1 (or MT1). The other SMU may be required to apply a 
Gate current to turn the device on. The Gate current >= IGT must be applied until the load current is 
>= IL. 

Figure 860: TRIAC VTneg pin connection 
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VTpos 
Description: 

Module Name: VTpos 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal TRIAC 

Function: Measures the peak on-state voltage. Measures the maximum voltage drop across the main 
terminals at stated conditions when the devices are in the on-state. Typically measured at a short 
pulse width and low duty cycle to prevent heating of the junction. 

Pin Connection: One or two SMUs are used. One SMU applies a specified current and measures 
voltage between terminals A2 (or MT2) to A1(or MT1). The other SMU may be required to apply a 
Gate current to turn the device on. The Gate current >= IGT must be applied until the load current is 
>= IL. 

Figure 861: TRIAC VTpos pin connection 

 
 

IGBT library 
The IGBT parametric test module template is used to test parameters of an IGBT device, including 
leakage, breakdown, gain, on-state and characteristic curves. 
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BVCES 
Description:  

Module Name: BVCES 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal IGBT 

Function: Measures the breakdown voltage from the Collector to Emitter. The voltage is measured by 
applying a breakdown current to the Collector and the Gate-Emitter is shorted. 

Pin Connection: Use a Model 2657A to apply current and make a voltage measurement at the 
Colllector. Connect the Gate and Emitter to GND or use a SMU to supply a zero voltage bias. 

Figure 862: IGBT BVCES pin connection 
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ICES 
Description: 

Module Name: ICES 

Test Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal IGBT 

Function: Measures the Collector-Emitter cut-off current with the Gate shorted to the Emitter. 

Pin Connection: Use a Model 2657A to apply voltage and make a current measurement from the 
Colllector to the Emitter. Short the Gate to the Emitter or use a SMU to supply a zero voltage bias. 
(See next figure.) 

Figure 863: IGBT ICES pin connection 
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IcON 
Description: 

Module Name: IcON 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the on-state Collector current. Measures current on the Collector by applying 
voltage to the Collector-Emitter with a specific Gate voltage to turn on the device at a certain Collector 
current value that is given in the data sheet. 

Pin Connection: Use the Model 2651A to force voltage and make a current measurement at the 
Collector. Use the low-power Model 2600B to source sweep voltage at the Gate. Connect the Emitter 
to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 864: IGBT IcON pin connection 
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IcVce_StepVge 
Description: 

Module Name: IcVce_StepVge 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the standard family of IcVce curves. Each time the voltage steps on the Gate-
Emitter, a voltage sweep and a set of current measurements occur on the Collector. 

Pin Connection: Use the Model 2651A to apply a voltage sweep and make a current measurement at 
the Collector. Use the low-power Model 2600B to source a specific voltage at the Gate. Connect the 
Emitter to GND or use a SMU to supply a zero voltage bias. (See next figure.). 

Figure 865: IGBT IcVce_StepVge pin connection 
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IcVge 
Description: 

Module Name: IcVge 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the transfer characteristics of the IGBT with a specific voltage bias from the 
Collector to Emitter. 

Pin Connection: Use the Model 2651A to apply voltage and make current measurements at the 
Collector. Use the low-power Model 2600B to sweep voltage at the Gate. Connect the Emitter to GND 
or use a SMU to supply a zero voltage bias. 

Figure 866: IGBT IcVge pin connection 
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IGESF 
Description: 

Module Name: IGESF 

Test Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the Gate body forward leakage current. Measures current on the Gate at a 
maximum permissible positive voltage from the Gate to Emitter. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Gate to the 
Emitter. Connect the Collector and Emitter to GND or use a SMU to supply a zero voltage bias. (See 
next figure.) 

Figure 867: IGBT IGESF pin connection 
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IGESR 
Description: 

Module Name: IGESR 

Test Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the Gate body reversed leakage current. Measures current on the Gate at a 
maximum permissible negative voltage from the Gate to Emitter. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Gate to the 
Emitter. Connect the Collector to GND or use a SMU to supply a zero voltage bias. 

Figure 868: IGBT IGESR pin connection 
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VceSAT 
Description: 

Module Name: VceSAT 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the Collector-Emitter saturation voltage. The voltage is measured with a specific 
Gate-Emitter voltage and Collector current that is given in the data sheet. 

Pin Connection: Use the Model 2651A to apply current and make voltage measurement from the 
Collector to the Emitter. Use the Model 2600B to apply a voltage bias to the Gate. 

Figure 869: IGBT VceSAT pin connection 
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VF 
Description: 

Module Name: VF 

Test Type: ITM 

Instrument: Keithley Instruments Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the forward voltage of the Emitter-Collector diode with the Gate shorted to the 
Emitter. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
the Emitter. Connect the Gate to GND or use a SMU to supply a zero voltage bias. 

Figure 870: IGBT VF pin connection 
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VgeON 
Description: 

Module Name: VgeON 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the Gate to Emitter on-state voltage. Measures current on the Collector by 
applying a voltage sweep to the Gate-Emitter, applying a specific Collector-Emitter voltage to turn on 
the device at a certain Collector current value that is given in the data sheet, while measuring the 
Collector current. 

Pin Connection: Use a Model 2651A to apply a voltage and make a current measurement at the 
Collector. Use the low-power Model 2600B to sweep voltage at the Gate. Connect the Emitter to GND 
or use a SMU to supply a zero voltage bias. 

 Two SMUs are used. The Model 2651A SMU applies voltage and takes current measurements at the 
Collector. The other SMU sweeps voltage at the Gate. 

Figure 871: IGBT VgeON pin connection 
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VGETH 
Description: 

Module Name: VGETH 

Test Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal IGBT 

Function: Measures the threshold voltage from the Gate to Emitter, which is required to turn on the 
device at a certain Collector current value that is given in the data sheet. 

Pin Connection: Use the Model 2651A to apply voltage and make a current measurement at the 
Collector. Use the low-power Model 2600B to sweep voltage at the Gate. Connect the Emitter to GND 
or use a SMU to supply a zero voltage bias. 

Figure 872: IGBT VGETH pin connection 
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IcVce_StepVge_MIX 
Description: 

Module Name: IcVce_StepVge_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal IGBT 

Function: Measures the standard family of IcVce curves. Each time the voltage steps on the Gate-
Emitter, a voltage sweep and a set of current measurements occur on the Collector. 

Pin Connection: Use the Model 2651A to apply a voltage sweep and make a current measurement at 
the Collector. Use the other SMU to source a specific voltage at the Gate. 

Figure 873: IGBT IcVce_StepVge_MIX pin connection 
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IcVge_MIX 
Description: 

Module Name: IcVge_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal IGBT 

Function: Measures the transfer characteristics of the IGBT with a specific voltage bias from the 
Collector to the Emitter. 

Pin Connection: The Model 2651A SMU applies voltage and makes current measurements at the 
Collector. Use the other SMU to sweep voltage at the Gate. 

Figure 874: IGBT IcVge_MIX pin connection 
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VceSAT_MIX 
Description: 

Module Name: VceSAT 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal IGBT 

Function: Measures the Collector-Emitter saturation voltage. The voltage is measured with a specific 
Gate-Emitter voltage and Collector current that is given in the data sheet. 

Pin Connection: Use a SMU to force current and make a voltage measurement from the Collector to 
the Emitter. Use the other SMU to apply a voltage bias to the Gate. 

Figure 875: IGBT VceSAT_MIX pin connection 
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Cce 
Description: 

Module Name: Cce 

DUT: Three-terminal IGBT 

Function: Measures the capacitance between the Collector and Emitter terminals with the Gate 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Emitter. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Base. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 876: Three-term IGBT Cce pin connections 
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Cgc 
Description: 

Module Name: Cgc 

DUT: Three-terminal IGBT 

Function: Measures the capacitance between the Collector and Gate terminals with the Emitter 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect one 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Emitter. 
Use the Series 2600B to supply zero voltage bias. 

Figure 877: Three-term IGBT Cgc pin connections 
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Cge 
Description: 

Module Name: Cge 

DUT: Three-terminal IGBT 

Function: Measures the capacitance between the Gate and Emitter terminals with the Collector 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Emitter. Use the Series 2600B to supply zero voltage bias. Connect one 
Series 2600B the AC guard of a three-terminal bridge through one remote bias tee to the Collector. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 878: Three-term IGBT Cge pin connections 
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Cies 
Description: 

Module Name: Cies 

DUT: Three-terminal IGBT 

Function: Measures the capacitance between the Gate and Emitter terminals with the Collector 
terminal AC short-circuited to the Emitter terminal. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. AC 
short-circuit the Collector terminal to the Emitter terminal. Connect a Series 2600B and the CVH1 
(HPOT and HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Emitter. Use 
the Series 2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and 
LCUR) terminals of the Model 4200-CVU through one remote bias tee to the Gate. Use the Series 
2600B to supply zero voltage bias. (See next figure.) 

Figure 879: Three-term IGBT Cies pin connections 
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Coes 
Description: 

Module Name: Coes 

DUT: Three-terminal IGBT 

Function: Measures the capacitance between the Collector and Emitter terminals with the Gate 
terminal AC short-circuited to the Emitter terminal. 

Pin connections:  Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage 
bias. AC short-circuit the Gate terminal to the Emitter terminal. Connect a Series 2600B and the 
CVH1 (HPOT and HCUR) terminals of the Model 4200-CVU through one remote bias tee to the 
Emitter. Use the Series 2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 
(LPOT and LCUR) terminals of the Model 4200-CVU through one remote bias tee to the Collector. 
Use the Series 2600B to sweep voltage. (See next figure.) 

Figure 880: Three-term IGBT Coes pin connections 
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Cres 
Description: 

Module Name: Cres 

DUT: Three-terminal IGBT 

Function: Measures the capacitance between the Gate and Collector terminals with the Emitter 
terminal connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Collector. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Emitter. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 881: Three-term IGBT Cres pin connections 

 
 

nPowerMOSFET test module template 
The nPowerMOSFET parametric test module template is used to test some parameters of a n-type 
power MOSFET, including leakage, breakdown, gain, on-state and characteristic curves. 
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BVDSS 
Description: 

Module Name: BVDSS 

Module Type: ITM 

Instrument: Keithley Instruments Model 2657A 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the breakdown voltage from the Drain to the Source. Measures voltage on the 
Drain-Source by applying a breakdown current to the Drain and Gate that is shorted to the Source. 

Pin Connection: Use the Model 2657A instrument to apply current and make a voltage measurement 
at the Drain. Connect the Gate and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 882: nPowerMOSFET_BVDSS pin connection 
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GFS 
Description: 

Module Name: GFS 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the forward transconductance. Measures the current on the Drain by applying a 
voltage sweep from the Gate to the Source and calculates the ratio of change in the Id for a change in 
the Vgs: GFS = delta (Id)/delta(Vgs). 

Pin Connection: Use the Model 2651A to apply voltage and make a current measurement at the 
Drain. Use the low power Model 2600B to sweep voltage at the Gate. Connect the Source to GND or 
use a SMU to supply a zero voltage bias. 

Figure 883: nPowerMOSFET GFS pin connection 
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IdON 
Description: 

Module Name: IdON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the on-state Drain current. Measures the current on the Drain by applying a 
voltage sweep to the Drain-Source with a specific Gate voltage to turn on the device at a specific Id 
current value that is given in the data sheet. 

Pin Connection: Use the Model 2651A to apply a voltage sweep and make a current measurement at 
the Drain. Use the low power Model 2600A to source a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 884: nPowerMOSFET IdON pin connection 
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IDSS 
Description: 

Module Name: IDSS 

Module Type: ITM 

Instrument: Keithley Instruments Model 2657A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the leakage current from the Drain to the Source when the device is off. 
Measures the current on the Drain by applying a maximum permissible voltage between the Drain 
and Source, while the Gate is shorted to the Source. 

Pin Connection: Use the Model 2657A to apply voltage and make a current measurement at the 
Drain. Connect the Gate and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 885: nPowerMOSFET IDSS pin connection 
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IdVd_StepVg 
Description: 

Module Name: IdVd_StepVg 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Drain current at the specified Gate voltage and sweeps the Drain in pulse 
mode. Generates the standard family of IdVd curves. 

Pin Connection: Use the Model 2651A to apply a voltage sweep and make a current measurement at 
the Drain. Use the low power Model 2600A to source a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 886: nPowerMOSFET IdVd_StepVg pin connection 
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IdVg_StepVd 
Description: 

Module Name: IdVg_StepVd 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the transfer characteristic of the device. Each time the voltage steps on the 
Drain-Source, a voltage sweep is performed on the Gate-Source and set of current measurements 
occurs on the Drain. 

Pin Connection: Use the Model 2651A to apply a voltage step and make a current measurement at 
the Drain. Use the low power Model 2600B to sweep voltage at the Gate. Connect the Source to 
GND or use a SMU to supply a zero voltage bias. 

Figure 887: nPowerMOSFET IdVg_StepVd pin connection 
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IGSSF 
Description: 

Module Name: IGSSF 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Gate forward leakage current. Measures the current on the Gate at the 
maximum permissible positive voltage from the Gate to the Source. 

Pin Connection: Use a SMU to force voltage and make a current measurement at the Gate. Connect 
the Drain and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 888: nPowerMOSFET IGSSF pin connection 
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IGSSR 
Description: 

Module Name: IGSSR 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Gate body reversed leakage current. Measures current on the Gate at the 
maximum permissible negative voltage from Gate to Source. 

Pin Connection: Use a SMU to force voltage and make a current measurement from the Gate. 
Connect the Drain and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 889: nPowerMOSFET IGSSR pin connection 
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RdsON 
Description: 

Module Name: RdsON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Drain to Source on-state resistance. Measures resistance by applying a 
current sweep to the Drain with a specific Gate voltage that is calculated by dividing the measured 
Drain voltage by the Sourced current: Rds = Vds/Id. 

Pin Connection: Use the Model 2651A to apply a current sweep and make a voltage measurements 
at the Drain. Use the low-power Model 2600B to force a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 890: nPowerMOSFET RdsON pin connection 
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VdsON 
Description: 

Module Name: VdsON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Drain to Source on-state voltage. Measures voltage on the Drain-Source by 
applying a current sweep to the Drain with a specific Gate voltage to turn on the device at a certain 
resistance value. 

Pin Connection: Use the Model 2651A SMU to apply a current sweep and make a voltage 
measurement at the Drain. Use the low-power Model 2600B to force a specific voltage at the Gate. 
Connect the Source to GND or use a SMU to supply a zero voltage bias. 

Figure 891: nPowerMOSFET VdsON pin connection 
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VgsON 
Description: 

Module Name: VgsON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Gate to Source on-state voltage. Measures current on the Drain by applying 
a voltage sweep to the Gate-Source with a specific Drain to Source voltage to turn on the device to a 
certain Id current value. 

Pin Connection: Use the Model 2651A to apply voltage and make a current measurement at the 
Drain. Use the low-power Model 2600B to sweep voltage at the Gate. Connect Source to GND or use 
a SMU to supply a zero voltage bias. 

Figure 892: nPowerMOSFET VgsON pin connection 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-165 

 

VGSTH 
Description: 

Module Name: VGSTH 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the threshold voltage from the Gate to Source that is required to turn on the 
device at a specific Id current value that is given in the data sheet. 

Pin Connection: Use the Model 2651A SMU to force voltage and make a current measurement at the 
Drain. Use the low-power Model 2600B to sweep voltage at the Gate. Connect the Source to GND or 
use a SMU to supply a zero voltage bias. 

Figure 893: nPowerMOSFET VGSTH pin connection 
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VSD 
Description: 

Module Name: VSD 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the forward voltage drop of the parasitic diode between the Drain and Source. 
Measures current on the Drain by applying a voltage sweep from the Source to Drain with the Gate 
shorted to the Source. 

Pin Connection: Use the Model 2651A SMU to force voltage and make a current measurement at the 
Drain. Connect the Gate and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 894: nPowerMOSFET VSD pin connection 
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IdON_MIX 
Description: 

Module Name: IdON_MIX 

Module Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the on-state Drain current. Measures current on the Drain by applying a voltage 
sweep to the Drain-Source with a specific Gate voltage to turn on the device at a certain Id current 
value that is given in the data sheet. 

Pin Connection: Use the Model 2651A SMU to apply a voltage sweep and make a current 
measurement at the Drain. Use another SMU to force a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 895: nPowerMOSFET IdON_MIX pin connection 
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IdVd_StepVg_MIX 
Description: 

Module Name: IdVd_StepVg_MIX 

Module Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the standard family of IdVd curves. Each time the voltage steps on the Gate-
Source, a voltage sweep and a set of current measurements occur on the Drain. 

Pin Connection: Use the Model 2651A SMU to apply a voltage sweep and make a current 
measurement at the Drain. Use a SMU to force a specific voltage at the Gate. Connect the Source to 
GND or use a SMU to supply a zero voltage bias. 

Figure 896: nPowerMOSFET IdVd_StepVg_MIX pin connection 
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RdsON_MIX 
Description: 

Module Name: RdsON 

Module Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Drain to Source on-state resistance. Measures resistance by applying a 
current sweep to the Drain with a specific Gate voltage that is calculated by dividing the measured 
Drain voltage by the Sourced current: Rds = Vds/Id. 

Pin Connection: Use the Model 2651A SMU to apply a current sweep and make a voltage 
measurement at the Drain. Use a SMU to force specific voltage at the Gate. Connect the Source to 
GND or use a SMU to supply a zero voltage bias. 

Figure 897: nPowerMOSFET RdsON_MIX pin connection 
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VgsON_MIX 
Description: 

Module Name: VgsON 

Module Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the Gate to Source on-state voltage. Measures current on the Drain by applying 
a voltage sweep to the Gate-Source with a specific Drain to Source voltage to turn on the device at a 
certain Id current value. 

Pin Connection: Use the Model 2651A SMU to apply voltage and make a current measurement at the 
Drain. Use the low-power 2600B to sweep voltage at the Gate. Connect the Source to GND or use a 
SMU to supply a zero voltage bias. 

Figure 898: nPowerMOSFET VgsON_MIX pin connection 
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Cds 
Description: 

Module Name: Cds 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Source. Use the Series 2600B to supply zero voltage bias. Connect the 
AC guard of a three-terminal bridge through one remote bias tee to the Gate. 

Figure 899: Three-term nPowerMOSFET Cds pin connections 
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Cgd 
Description: 

Module Name: Cgd 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the capacitance between the Drain and Gate terminals with the Source terminal 
connected to the AC guard of a three-terminal bridge. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
(See next figure.) 

Figure 900: Three-term nPowerMOSFET Cgd pin connections 
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Cgs 
Description: 

Module Name: Cgs 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
connected to the AC guard of a three-terminal bridge. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Source. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Drain. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 901: Three-term nPowerMOSFET Cgs pin connections 
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Ciss 
Description: 

Module Name: Ciss 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
AC short-circuited to the Source terminal. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. AC 
short circuit the Drain to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT and 
HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the Series 
2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to 
supply zero voltage bias. (See next figure.) 

Figure 902: Three-term nPowerMOSFET Ciss pin connections 
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Coss 
Description: 

Module Name: Coss 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
AC short-circuited to the Source terminal. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage 
bias. AC short circuit the Gate to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT 
and HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the 
Series 2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to 
sweep voltage. (See next figure.) 

Figure 903: Three-term nPowerMOSFET Coss pin connections 
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Crss 
Description: 

Module Name: Crss 

DUT: Three-terminal nPowerMOSFET 

Function: Measures the common-source short-circuit input capacitance by testing the capacitance 
between the Drain and Gate terminals with the Source terminal connected to the AC guard of a three-
terminal bridge. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
Use the Series 2600B to supply zero voltage bias.  

Figure 904: Three-term nPowerMOSFET Crss pin connections 

 
 

pPowerMOSFET test module template 
The pPowerMOSFET parametric test module template is used to test parameters of a p-type power 
MOSFET, including leakage, breakdown, gain, on-state and characteristic curves. 
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BVDSS 
Description: 

Module Name: BVDSS 

Module Type: ITM 

Instrument: Keithley Instruments Model 2657A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the breakdown voltage from the Drain to Source. Measures voltage on the Drain-
Source by applying a breakdown current to the Drain and the Gate is shorted to the Source. 

Pin Connection: Use the Model 2657A instrument to apply current and make a voltage measurement 
at the Drain. Connect the Gate and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 905: pPowerMOSFET_BVDSS pin connection 
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GFS 
Description: 

Module Name: GFS 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the forward transconductance. Measures the current on the Drain by applying a 
voltage sweep from the Gate to Source and calculates the ratio of change in Id for a change in the 
Vgs: GFS=delta(Id)/delta(Vgs). 

Pin Connection: Use the Model 2651A to apply voltage and make current measurements at the Drain. 
Use the low-power Model 2600B to sweep voltage at the Gate. Connect the Source to GND or use a 
SMU to supply a zero voltage bias. (See next figure.) 

Figure 906: pPowerMOSFET GFS pin connection 
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IdON 
Description: 

Module Name: IdON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the on-state Drain current. Measures current on the Drain by applying a voltage 
sweep to the Drain-Source with a specific Gate voltage to turn on the device at a certain Id current 
value that is given in the data sheet. 

Pin Connection: Use the Model 2651A to apply a voltage sweep and make a current measurement at 
the Drain. Use the low power Model 2600A to source a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 907: pPowerMOSFET IdON pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-180 ACS-901-01 Rev. H / December 2014 

 

IDSS 
Description: 

Module Name: IDSS 

Module Type: ITM 

Instrument: Keithley Instruments Model 2657A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the leakage current from the Drain to the Source when the device is off. 
Measures the current on the Drain by applying a maximum permissible voltage between the Drain 
and Source, while the Gate is shorted to the Source. 

Pin Connection: Use the Model 2657A to apply voltage and make a current measurement at the 
Drain. Connect the Gate and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 908: pPowerMOSFET IDSS pin connection 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-181 

 

IdVd_StepVg 
Description: 

Module Name: IdVd_StepVg 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Drain current at the specified Gate voltage and sweeps the Drain in pulse 
mode. Generates the standard family of IdVd curves. 

Pin Connection: Use the Model 2651A to apply a voltage sweep and make a current measurement at 
the Drain. Use the low power Model 2600A to source a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 909: pPowerMOSFET IdVd_StepVg pin connection 
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IdVg_StepVd 
Description: 

Module Name: IdVg_StepVd 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the transfer characteristic of the device. Each time the voltage steps on the 
Drain-Source, a voltage sweep is performed on the Gate-Source and set of current measurements 
occurs on the Drain. 

Pin Connection: Use the Model 2651A to apply a voltage step and make a current measurement at 
the Drain. Use the low power Model 2600B to sweep voltage at the Gate. Connect the Source to 
GND or use a SMU to supply a zero voltage bias. 

Figure 910: pPowerMOSFET IdVg_StepVd pin connection 
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IGSSF 
Description: 

Module Name: IGSSF 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Gate body forward leakage current. Measures current on the Gate at the 
maximum permissible negative voltage from the Gate to Source.  

Pin Connection: One or two SMUs are used. One SMU applies voltage and takes current 
measurements at the Gate. The Drain and Source are connected to ground, or has no voltage bias 
from the other SMU.Use a SMU to force voltage and make a current measurement at the Gate. 
Connect the Drain and Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 911: pPowerMOSFET IGSSF pin connection 
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IGSSR 
Description: 

Module Name: IGSSR 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Gate body reversed leakage current. Measures current on the Gate at the 
maximum permissible positive voltage from the Gate to Source.  

Pin Connection: Use a SMU to force voltage and make a current measurement from the Gate. 
Connect the Drain and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 912: pPowerMOSFET IGSSR pin connection 
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RdsON 
Description: 

Module Name: RdsON 

DUT: Four-terminal pPowerMOSFET 

Function: Measures the Drain to Source on-state resistance. Measures resistance by applying a 
current sweep to the Drain with a specific Gate voltage that is calculated by dividing the measured 
Drain voltage by the Sourced current: Rds = Vds/Id. 

Pin Connection: Use the Model 2651A to apply a current sweep and make a voltage measurements 
at the Drain. Use the low-power Model 2600B to force a specific voltage at the Gate. Connect the 
Source to GND or use a SMU to supply a zero voltage bias. 

Figure 913: pPowerMOSFET RdsOn pin connection 
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VdsON 
Description: 

Module Name: VdsON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Drain to Source on-state voltage. Measures voltage on the Drain-Source by 
applying a current sweep to the Drain with a specific Gate voltage to turn on the device at a certain 
resistance value. 

Pin Connection: Use the Model 2651A SMU to apply a current sweep and make a voltage 
measurement at the Drain. Use the low-power Model 2600B to force a specific voltage at the Gate. 
Connect the Source to GND or use a SMU to supply a zero voltage bias. 

Figure 914: pPowerMOSFET VdsON pin connection 
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VgsON 
Description: 

Module Name: VgsON 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Gate to Source on-state voltage. Measures current on the Drain by applying 
a voltage sweep to the Gate-Source with a specific Drain to Source voltage to turn on the device to a 
certain Id current value. 

Pin Connection: Use the Model 2651A to apply voltage and make a current measurement at the 
Drain. Use the low-power Model 2600B to sweep voltage at the Gate. Connect Source to GND or use 
a SMU to supply a zero voltage bias. 

Figure 915: pPowerMOSFET VgsON pin connection 
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VGSTH 
Description: 

Module Name: VGSTH 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the threshold voltage from the Gate to Source that is required to turn on the 
device at a specific Id current value that is given in the data sheet. 

Pin Connection: Use the Model 2651A SMU to force voltage and make a current measurement at the 
Drain. Use the low-power Model 2600B to sweep voltage at the Gate. Connect the Source to GND or 
use a SMU to supply a zero voltage bias. 

Figure 916: pPowerMOSFET VGSTH pin connection 
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VSD 
Description: 

Module Name: VSD 

Module Type: ITM 

Instrument: Keithley Instruments Model 2651A, Series 2600B 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the forward voltage drop of the parasitic diode between the Drain and Source. 
Measures current on the Drain by applying a voltage sweep from the Source to Drain with the Gate 
shorted to the Source. 

Pin Connection: Use the Model 2651A SMU to force voltage and make a current measurement at the 
Drain. Connect the Gate and Source to GND or use a SMU to supply a zero voltage bias. 

Figure 917: pPowerMOSFET VSD pin connection 
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IdVd_StepVg_MIX 
Description: 

Module name: IdVd_StepVg_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Drain current at the specified Gate voltage and sweeps the Drain in pulse 
mode. Generates the standard family of IdVd curves. 

Pin Connection: Use the Model 2651A SMU to apply a voltage sweep and make a current 
measurement at the Drain. Use a SMU to force a specific voltage at the Gate. Connect the Source to 
GND or use a SMU to supply a zero voltage bias. 

Figure 918: pPowerMOSFET IdVd_StepVg_MIX pin connection 
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RdsON_MIX 
Description: 

Module name: RdsOn_MIX 

Test Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Drain to Source on-state resistance. Measures resistance by applying a 
current sweep to the Drain with a specific Gate voltage that is calculated by dividing the measured 
Drain voltage by the Sourced current: Rds = Vds/Id. 

Pin Connection: Use the Model 2651A SMU to apply a current sweep and make a voltage 
measurement at the Drain. Use a SMU to force specific voltage at the Gate. Connect the Source to 
GND or use a SMU to supply a zero voltage bias. 

Figure 919: pPowerMOSFET RdsON_MIX pin connection 
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VgsON_MIX 
Description: 

Module Name: VgsON_MIX 

Module Type: PTM 

Instrument: Keithley Instruments Model 2651A, Series 2600B, Series 2400, Model 4200-SMU 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the Gate to Source on-state voltage. Measures current on the Drain by applying 
a voltage sweep to the Gate-Source with a specific Drain to Source voltage to turn on the device at a 
certain Id current value. 

Pin Connection: Use the Model 2651A SMU to apply voltage and make a current measurement at the 
Drain. Use the low-power 2600B to sweep voltage at the Gate. Connect the Source to GND or use a 
SMU to supply a zero voltage bias. 

Figure 920: pPowerMOSFET VgsON_MIX pin connection 
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Cds 
Description: 

Module Name: Cds 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
connected to the AC guard of a three-terminal bridge. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Source. Use the Series 2600B to supply zero voltage bias. Connect the 
AC guard of a three-terminal bridge through one remote bias tee to the Gate. 

Figure 921: Three-term pPowerMOSFET Cds pin connections 
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Cgd 
Description: 

Module Name: Cgd 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the capacitance between the Drain and Gate terminals with the Source terminal 
connected to the AC guard of a three-terminal bridge. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 

Figure 922: Three-term pPowerMOSFET Cgd pin connections 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-195 

 

Cgs 
Description: 

Module Name: Cgs 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
connected to the AC guard of a three-terminal bridge. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Source. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Drain. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 923: Three-term pPowerMOSFET Cgs pin connections 
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Ciss 
Description: 

Module Name: Ciss 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
AC short-circuited to the Source terminal. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. AC 
short circuit the Drain to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT and 
HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the Series 
2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to 
supply zero voltage bias. (See next figure.) 

Figure 924: Three-term pPowerMOSFET Ciss pin connections 
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Coss 
Description: 

Module Name: Coss 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
AC short-circuited to the Source terminal. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage 
bias. AC short circuit the Gate to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT 
and HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the 
Series 2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to 
sweep voltage. (See next figure.) 

Figure 925: Copy of three-term pPowerMOSFET Coss pin connections 
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Crss 
Description: 

Module Name: Crss 

DUT: Three-terminal pPowerMOSFET 

Function: Measures the common-source short-circuit input capacitance by testing the capacitance 
between the Drain and Gate terminals with the Source terminal connected to the AC guard of a three-
terminal bridge. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
Use the Series 2600B to supply zero voltage bias.  

Figure 926: Three-term pPowerMOSFET Crss pin connections 

 
 

nMOSFET test module template 
The nMOSFET parameter test module template is used to test some parameters of an n-type power 
MOSFET, including leakage, breakdown, gain, on-state and characteristic curves.  

The WLR script library provides certain wafer-level reliability tests on devices with Series 2600B 
instruments, with an XRC GUI. Note that the HCI module is a test script file based on the Series 
2600B LPT library and is available in this library. 
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BVDSS 
Description: 

Module Name: BVDSS 

DUT: Four-terminal nMOSFET 

Function: Measures the drain-Source breakdown voltage of the nMOSFET with the Gate-Source 
shorted. 

Pin connections: Use a SMU to apply a breakdown current on the Drain. Short Gate, Source, and 
Bulk (connect all of them to GND or use a SMU to supply a zero voltage bias). (See next figure.) 

Figure 927: nMOSFET_BVDSS pin connection 

 
 

BVDSV 
Description: 

Module Name: BVDSV 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain-Source breakdown voltage of the nMOSFET with the Gate biased. 

Pin connections: Connect the Source and Bulk to GND or use a SMU to supply a zero voltage bias. 
Use a SMU to bias the Gate. Use a SMU to apply a breakdown current on the Drain. (See next 
figure.) 

Figure 928: Four_term_nMOSFET_BVDSV pin connection 
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BVGSO 
Description: 

Module Name: BVGSO 

DUT: Four-terminal nMOSFET 

Function: Measures the Gate-Source breakdown voltage of the nMOSFET with the Drain opened. 

Pin connections: Use a SMU to apply a breakdown current on the Gate. Open the circuit to the Drain 
or use a SMU to supply zero current bias. Short Bulk and Source to GND or use a SMU to supply a 
zero voltage bias. (See next figure.) 

Figure 929: Four_term_nMOSFET_BVGSO pin connection 
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BVGDS 
Description: 

Module Name: BVGDS 

DUT: Four-terminal nMOSFET 

Function: Measures the Gate-Drain breakdown voltage of the nMOSFET with the Source-Drain 
shorted. 

Pin connections: Connect the Source, Bulk, and Drain to GND or use a SMU to supply a zero voltage 
bias. Use a SMU to apply a breakdown current on the  Gate. (See next figure.) 

Figure 930: Four_term_nMOSFET_BVGDS pin connection 
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BVGDO 
Description: 

Module Name: BVGDO 

DUT: Four-terminal nMOSFET 

Function: Measures the Gate-Drain breakdown voltage of the nMOSFET with the Source opened. 

Pin connections: Use a SMU to apply a breakdown current on the  Gate. Open the circuit to the 
Source or use a SMU to supply zero current bias. Short Bulk and Drain to GND or use a SMU to 
supply a zero voltage bias. (See next figure.) 

Figure 931: Four_term_nMOSFET_BVGDO pin connection 

 
 

IDL 
Description: 

Module Name: IDL 

Function: Measures the Drain leakage current with the Gate-Source shorted. 

Pin connections: Short the Gate and Source. Apply a voltage to the Drain, and connect the bulk, 
Gate, and Source to ground (see next figure). 

Figure 932: Four_term_nMOSFET_IDL pin connection 
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IDS_ISD 
Description: 

Module Name: IDS_ISD 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain-Source and Source-Drain current with the Gate biased. 

Pin connections: Use a SMU to force voltage to the Gate. Use a SMU to force voltage to the Drain. 
Connect Source and Bulk to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 933: Four_term_nMOSFET_IDS_ISD pin connection 
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IdVd_BiasVg 
Description: 

Module Name: IdVd_BiasVg 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current during a specified Drain voltage sweep, and the Drain current 
and the Drain voltage curve. 

Pin connections: Use a SMU to bias voltage to the Gate. Use a SMU to apply a sweep voltage to the 
Drain. Short Bulk and Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 934: Four_term_nMOSFET_IdVd_BiasVg pin connection 
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IdVd_StepVg 
Description: 

Module Name: IdVd_StepVg 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current during a specified Drain voltage sweep, and the series of Drain 
current tests and the Drain voltage curve. 

Pin connections: Use a SMU to sweep the Drain. Use a SMU to step the Gate. Short Bulk and Source 
to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 935: Four_term_nMOSFET_IdVd_StepVg pin connection 
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IdVg_BiasVd 
Description: 

Module Name: IdVg_BiasVd 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current during a specified Gate voltage sweep, and the Drain current 
and the Gate voltage curve. 

Pin connections: Use a SMU to bias voltage to the Drain. Use a SMU to apply a sweep voltage to the 
Gate. Short the Bulk and Source or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 936: Four_term_nMOSFET_IdVg_BiasVd pin connection 
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IdVg_StepVd 
Description: 

Module Name: IdVg_StepVd 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current during a specified Gate voltage sweep with the Drain step, and 
a series of Drain currents and a Gate voltage curve. 

Pin connections: Use a SMU to step the Drain. Use a SMU to sweep the  Gate. Short Bulk and 
Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 937: Four_term_nMOSFET_IdVg_StepVd pin connection 
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IdVg_StepVsub 
Description: 

Module Name:  IdVg_StepVsub 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current during a specified Gate voltage sweep with a bulk step, and a 
series of Drain currents and a Gate voltage curve. 

Pin connections: Use a SMU to step the Bulk. Use a SMU to sweep the Gate. Use a SMU to bias the 
Drain. Connect the Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 938: Four_term_nMOSFET_IdVg_StepVsub pin connection 
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IGL 
Description: 

Module Name: IGL 

DUT: Four-terminal nMOSFET 

Function: Measures the Gate leakage current when the Source and Drain are shorted. 

Pin connections: Use a SMU to force voltage to the Gate. Connect the Source, Drain, and Bulk to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 939: Four_term_nMOSFET_IGL pin connection 
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IgVg 
Description: 

Module Name: IgVg 

DUT: Four-terminal nMOSFET 

Function: Measures the Gate current during a specified Gate voltage sweep when the Drain is 
biased, and the Gate current and Gate voltage curve. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. Short the Bulk and 
Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 940: Four_term_nMOSFET_IgVg pin connection 

 
 

ISL 
Description:  

Module Name: ISL 

DUT: Four-terminal nMOSFET 

Function: Measures the Source leakage current when the Gate-Drain is shorted. 

Pin connections: Use a SMU to force voltage to the Source. Short Bulk, Gate, and Drain to GND or 
use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 941: Four_term_nMOSFET_ISL pin connection 
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Vtci 
Description: 

Module Name:  Vtci 

DUT: Four-terminal nMOSFET 

Function: Measures the constant current threshold voltage of the nMOSFET device, and the Drain 
current and the Gate voltage curve. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. Input Source and Bulk 
voltage when needed. Usually, they are connected to GND for NMOS, and connected to the nominal 
power supply voltage (VDD) for PMOS. (See next figure.) 

Procedure: The constant current threshold voltage: 

Vth_ci=VGS (@ID=1uA.W/L)  -- NMOS 
Vth_ci=VGS (@ID=-0.025uA.W/L)  -- PMOS 

Where W and L are the Gate width and Gate length as printed on the wafer. Set a target Drain 
current Id_tar (Id_tar=1uA.W/L, or -0.025uA.W/L), which is the sign to be near threshold, then search 
the Gate voltage to make the Drain current equal to Id_tar. 

The Four_term_nMOSFET_Vth_ci measurement procedure must determine Vth_ci to within a 1 
mV resolution. If the VGS step size is larger than 1 mV, then a linear interpolation method may be 
used to achieve the 1 mV resolution. 
Typical DC bias voltages for Vth_ci measurements are VDS = VDS_lin, VBS = VBB for linear 
region measurement, or VDS = VDS_sat, (VBS = VBB for saturation region measurement). 
Typically, for PMOS, VDS_lin = -0.1 V(@VDD=5V); for NMOS, VDS_lin=0.1V(@VDD=5V). 

 

Figure 942: Four_term_nMOSFET_Vtci pin connection 
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Vtext 
Description: 

Module Name: Vtext 

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current during a Gate voltage sweep, extracts the trans-conductance 
(Gm) and measure the maximum trans-conductance (Gmmax), measures the extracted threshold 
voltage (Vth_ex), measures the Drain current and the Gate voltage curve, and measures the Gm 
Drain current or the Gm Gate voltage curve. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. Input Source and Bulk 
voltage when needed. Usually, they are connected to GND for NMOS, and connected to the nominal 
power supply voltage (VDD) for PMOS. (See next figure.) 

Procedure: The threshold voltage is extrapolated from the measurement of the maximum slope 
(Gmmax) of the ID-VGS curve: 
            Vth_ex=VGS (@Gmmax)-ID(@Gmmax)/Gmmax 

Where: VGS @Gmmax) is the Gate voltage at the point of the maximum slope of the ID-VGS curve; 
ID(@Gmmax) is the Drain current at the point of the maximum slope of the ID-VGS curve; Gmmax is 
the maximum slope of the ID-VGS curve. 

DC bias voltages for Vth_ex measurements are VDS = VDS_lin, VBS = VBB for linear 
measurement. 

VDS=VDS_sat, VBS=VBB for saturation. Typically, for PMOS, VDS_lin = -0.1 V(@VDD=5V); for 
NMOS, VDS_lin=0.1V(@VDD=5V).  

Figure 943: Four_term_nMOSFET_Vtext pin connection 
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Vtext_llsq 
Description: 

Module Name: Vtext_llsq 

Module Type: Standard STM 

Instrument: Keithley Instruments Series 2600B SMU  

DUT: Four-terminal nMOSFET 

Function: Measures the Drain current at the Gate voltage sweep, extracts the trans-conductance 
(Gm) and extract the maximum trans-conductance (Gmmax), measures the extracted threshold 
voltage (Vth_ex), measure the Drain current and the Gate voltage curve, and measures the Gm Drain 
current or the Gm Gate voltage curve. 

the threshold voltage from the measurement of the slope. In this test, the least-square approximation 
is used as the result. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. If needed, input the 
Source and Bulk voltage. Usually, they are connected to GND for NMOS, and connected to the 
nominal power supply voltage (VDD) for PMOS. (See next figure.) 

Procedure: The threshold voltage is extrapolated from the measurement of the maximum slope 
(Gmmax) of the IDVGS curve: 

Vth_ex=VGS (@Gmmax)-ID(@Gmmax)/Gmmax  

Where: VGS(@Gmmax) is the Gate voltage at the point of the maximum slope of the IDVGS curve; 
ID(@Gmmax) is the Drain current at the point of the maximum slope of the IDVGS curve; Gmmax is 
the maximum slope of the IDVGS curve. 

DC bias voltages for Vth_ex measurements are VDS = VDS_lin, VBS = VBB for linear 
measurement. 

VDS=VDS_sat,VBS = VBB for saturation. Typically, for PMOS, VDS_lin = -0.1 V(@VDD = 5V); 
for NMOS,VDS_lin = 0.1V(@VDD = 5V).  

Figure 944: Four_term_nMOSFET_Vtext_IIsq pin connection 
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Cds 
Description: 

Module Name: Cds 

DUT: Four-terminal nMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
connected to the AC guard of a three-terminal bridge. Short Bulk to Source. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. Short 
Bulk to Source. Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Source. Use the Series 2600B to supply zero voltage 
bias. Connect the AC guard of a three-terminal bridge through one remote bias tee to the Gate. 

Figure 945: Four-term nMOSFET Cds pin connections 
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Cgd 
Description: 

Module Name: Cgd 

DUT: Four-terminal nMOSFET 

Function: Measures the capacitance between the Drain and Gate terminals with the Source terminal 
connected to the AC guard of a three-terminal bridge. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
(See next figure.) 

Figure 946: Four-term nMOSFET Cgd pin connections 
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Cgs 
Description: 

Module Name: Cgs 

DUT: Four-terminal nMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
connected to the AC guard of a three-terminal bridge. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Source. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Drain. 
(See next figure.) 

Figure 947: Four-term nMOSFET Cgs pin connections 
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Ciss 
Description: 

Module Name: Ciss 

DUT: Four-terminal nMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
AC short-circuited to the Source terminal. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. AC 
short circuit the Drain to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT and 
HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the Series 
2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to 
supply zero voltage bias. (See next figure.) 

Figure 948: Four-term nPowerMOSFET Ciss pin connections 
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Coss 
Description: 

Module Name: Coss 

DUT: Four-terminal nMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
AC short-circuited to the Source terminal. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage 
bias. AC short circuit the Gate to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT 
and HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the 
Series 2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to 
sweep voltage. (See next figure.) 

Figure 949: Four-term nMOSFET Coss pin connections 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 16: Test Module Template 
 

ACS-901-01 Rev. H / December 2014 16-219 

 

Crss 
Description: 

Module Name: Crss 

DUT: Four-terminal nMOSFET 

Function: Measures the common-source short-circuit input capacitance by testing the capacitance 
between the Drain and Gate terminals with the Source terminal connected to the AC guard of a three-
terminal bridge. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 950: Four-term nMOSFET Crss pin connections 

 
 

pMOSFET test module template 
The pMOSFET parametric test module template is used to test parameters of a p-type power 
MOSFET, including leakage, breakdown, gain, on-state and characteristic curves. 
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BVDSS 
Description: 

Module Name: BVDSS 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain-Source breakdown voltage of the pMOSFET with the Gate-Source 
shorted. 

Pin connections: Use a SMU to apply a breakdown current on the Drain. Short the Bulk, Gate, and 
Source to GND or use a SMU to supply a zero voltage bias. (See next figure.)  

Figure 951: Four_term_pMOSFET_BVDSS pin connection 

 
 

BVDSV 
Description: 

Module Name: BVDSV 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain-Source breakdown voltage of the pMOSFET with the Gate biased. 

Pin connections: Use a SMU to bias the Gate. Use a SMU to apply a breakdown current on the Drain. 
Connect the Source and Bulk to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 952: Four_term_pMOSFET_BVDSV pin connection 
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BVGSO 
Description: 

Module Name: BVGSO 

DUT: Four-terminal pMOSFET 

Function: Measures the Gate-Source breakdown voltage of the pMOSFET with the Drain opened. 

Pin connections: Use a SMU to apply a breakdown current on the Gate. Open the circuit to the Drain 
or use a SMU to supply zero current bias. Connect the Bulk and Source to GND or use a SMU to 
supply a zero voltage bias. (See next figure.) 

Figure 953: Four_term_pMOSFET_BVGSO pin connection 

 
 



Section 16: Test Module Template ACS Automated Characterization Suite (ACS) Reference Manual 
 

16-222 ACS-901-01 Rev. H / December 2014 

 

BVGDS 
Description: 

Module Name: BVGDS 

DUT: Four-terminal pMOSFET 

Function: Measures the Gate-Drain breakdown voltage of the pMOSFET with the Source-Drain 
shorted. 

Pin connections: Use a SMU to apply a breakdown current on the Gate. Connect the Source, Drain, 
and Bulk to ground or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 954: Four_term_pMOSFET_BVGDS pin connection 
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BVGDO 
Description: 

Module Name: BVGDO 

DUT: Four-terminal pMOSFET 

Function: Measures the Gate-Drain breakdown voltage of the pMOSFET with the Source opened. 

Pin connections: Use a SMU to apply a breakdown current on the Gate. Open the circuit to the 
Source or use a SMU to supply zero current bias. Connect the Bulk and Drain to GND or use a SMU 
to supply a zero voltage bias. (See next figure.) 

Figure 955: Four_term_pMOSFET_BVGDO pin connection 

 
 

IDL 
Description: 

Module Name: IDL 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain leakage current with the Gate-Source shorted. 

Pin connections: Use a SMU to force voltage to the Drain. Connect the Gate, Source, and Bulk to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 956: Four_term_pMOSFET_IDL pin connection 
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IDS 
Description: 

Module Name: IDS  

DUT: Four-terminal pMOSFET 

Function: Measures the Drain-Source and Source-Drain current with the Gate biased. 

Pin connections: Use a SMU to force voltage to the Gate. Use a SMU to force voltage to the Drain. 
Connect Source and Bulk to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 957: Four_term_pMOSFET_IDS pin connection 
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IdVd_BiasVg 
Description: 

Module Name: IdVd_BiasVg 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain current during a specified Drain voltage sweep, and the Drain current 
and Drain voltage curve. 

Pin connections: Use a SMU to bias the Gate. Use a SMU to sweep the Drain. Connect Bulk and 
Source to GND, or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 958: Four_term_pMOSFET_IdVd_BiasVg pin connection 
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IdVd_StepVg 
Description: 

Module Name: IdVd_StepVg 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain current during a specified Drain voltage sweep, and a series of Drain 
currents and the Drain voltage curve. 

Pin connections: Use a SMU to sweep the Drain. Use a SMU to step the Gate. Connect the Bulk and 
Source to ground or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 959: Four_term_pMOSFET_IdVd_StepVg pin connection 
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IdVg_BiasVd 
Description: 

Module Name: IdVg_BiasVd 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain current during a specified Gate voltage sweep, and the Drain current 
value and the Gate voltage curve. 

Pin connections: Use a SMU to bias the the Drain. Use a SMU to sweep the sweep the Gate. 
Connect the Bulk and Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 960: Four_term_pMOSFET_IdVg_BiasVd pin connection 
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IdVg_StepVd 
Description: 

Module Name: IdVg_StepVd 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain current at a specified Gate voltage sweep with a Drain step, and the 
series of Drain currents and Gate voltage curve. 

Pin connections: Use a SMU to step the Drain. Use a SMU to sweep the Gate. Connect the Bulk and 
Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 961: Four_term_pMOSFET_IdVg_StepVd pin connection 
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IGL 
Description: 

Module Name: IGL 

DUT: Four-terminal pMOSFET 

Function: Measures the Gate leakage current when the Source and Drain are shorted. 

Pin connections: Use a SMU to force voltage to the Gate. Connect the Source, Drain, and Bulk to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 962: Four_term_pMOSFET_IGL pin connection 
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IgVg 
Description: 

Module Name: IgVg 

DUT: Four-terminal pMOSFET 

Function: Measures the Gate current at a specified Gate voltage sweep when the Drain is biased, 
and the Gate current and Gate voltage curve. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. Connect the Bulk and 
Source to GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 963: Four_term_pMOSFET_IgVg pin connection 
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ISL 
Description:  

Module Name: ISL 

DUT: Four-terminal pMOSFET 

Function: Measures the Source leakage current when the Gate-Drain is shorted. 

Pin connections: Use a SMU to force voltage to the Source. Connect the Bulk, Gate, and Drain to 
GND or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 964: Four_term_pMOSFET_ISL pin connection 
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IsubVg 
Description: 

Module Name: IsubVg 

DUT: Four-terminal pMOSFET 

Function: Measures the bulk current at a specified Gate voltage sweep, the bulk current and the Gate 
voltage curve, and the maximum bulk current and the corresponding Gate voltage. 

Pin connections: Use a SMU to sweep the Gate. Use a SMU to bias the Drain and Bulk. Connect the 
Source to ground or use a SMU to supply a zero voltage bias. (See next figure.) 

Figure 965: Four_term_pMOSFET_IsubVg pin connection 
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Vtci 
Description: 

Module Name: Vtci 

DUT: Four-terminal pMOSFET 

Function: Measures the constant current threshold voltage of the pMOSFET device, and the Drain 
current and the Gate voltage curve. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. If needed, input 
voltage to Source and Bulk. Usually, they are connected to GND for NMOS, and connected to the 
nominal power supply voltage (VDD) for PMOS. (See next figure.) 

Procedure: The constant current threshold voltage: 

Vth_ci=VGS (@ID=1uA.W/L) -- NMOS 
Vth_ci=VGS (@ID=-0.025uA.W/L) -- PMOS 

Where W and L are the Gate width and Gate length as printed on the wafer. Set a target Drain 
current Id_tar (Id_tar=1uA.W/L, or -0.025uA.W/L), which is the sign to be near threshold, then search 
the Gate voltage to make the Drain current equal to Id_tar. 

The Four_term_pMOSFET_Vth_ci measurement procedure must determine Vth_ci to within a 1 mV 
resolution. If the VGS step size is larger than 1 mV, then a linear interpolation method may be used 
to achieve the 1 mV resolution. 
Typical dc bias voltages for Vth_ci measurements are VDS = VDS_lin, VBS = VBB for linear region 
measurement, or VDS = VDS_sat, (VBS = VBB for saturation region measurement). Typically, for 
PMOS, VDS_lin = -0.1 V(@VDD=5V); for NMOS, VDS_lin=0.1V(@VDD=5V). 

Figure 966: Four_term_pMOSFET_Vtci pn connection 
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Vtext 
Description: 

Module Name: Vtext 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain current at the Gate voltage sweep, extracts the trans-conductance 
(Gm) and measure the maximum trans-conductance (Gmmax), measures the extracted threshold 
voltage (Vth_ex), measures the Drain current and the Gate voltage curve, and measures the Gm and 
the Drain current or the Gm and the Gate voltage curve. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. If needed, input the 
Source and Bulk. Usually, they are connected to GND for NMOS, and connected to the nominal 
power supply voltage (VDD) for PMOS. (See next figure.) 

Procedure: The threshold voltage is extrapolated from the measurement of the maximum slope 
(Gmmax) of the IDVGS curve: 

Vth_ex=VGS (@Gmmax)-ID(@Gmmax)/Gmmax 

VGS (@Gmmax) is the Gate voltage at the point of the maximum slope of the IDVGS curve; 
ID(@Gmmax) is the Drain current at the point of the maximum slope of the IDVGS curve; Gmmax is 
the maximum slope of the IDVGS curve. 

DC bias voltages for the Vth_ex measurements are VDS = VDS_lin, VBS = VBB for linear 
measurement. 

VDS=VDS_sat, VBS=VBB for saturation. Typically, for PMOS, VDS_lin = -0.1 V(@VDD=5V); for 
NMOS, VDS_lin=0.1V(@VDD=5V).  

Figure 967: Four_term_pMOSFET_Vtext pin connection 
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Vtext_llsq 
Description: 

Module Name: Vtext_llsq 

DUT: Four-terminal pMOSFET 

Function: Measures the Drain current at the Gate voltage sweep, extracts the trans-conductance 
(Gm) and measure the maximum trans-conductance (Gmmax), measures the extracted threshold 
voltage (Vth_ex), measures the Drain current and the Gate voltage curve, and measures the Gm and 
the Drain current or the Gm and the Gate voltage curve. 

the threshold voltage from the measurement of the slope. In this test, the least-square approximation 
is used. 

Pin connections: Use a SMU to bias the Drain. Use a SMU to sweep the Gate. If needed, input the 
Source and Bulk voltages. Usually, they are connected to GND for NMOS, and connected to the 
nominal power supply voltage (VDD) for PMOS. (See next figure.) 

Procedure: The threshold voltage is extrapolated from the measurement of the maximum slope 
(Gmmax) of the IDVGS curve: 

Vth_ex=VGS (@Gmmax)-ID(@Gmmax)/Gmmax  

VGS(@Gmmax) is the Gate voltage at the point of the maximum slope of the IDVGS curve; 
ID(@Gmmax) is the Drain current at the point of the maximum slope of the IDVGS curve; Gmmax is 
the maximum slope of the IDVGS curve. 

DC bias voltages for the Vth_ex measurements are VDS = VDS_lin, VBS = VBB for linear 
measurement. 

VDS=VDS_sat,VBS = VBB for saturation. Typically, for PMOS, VDS_lin = -0.1 V(@VDD = 5V); for 
NMOS,VDS_lin = 0.1V(@VDD = 5V).  

Figure 968: Four_term_pMOSFET_Vtext_IIsq pin connection 
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Cds 
Description: 

Module Name: Cds 

DUT: Four-terminal pMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
connected to the AC guard of a three-terminal bridge. Short Bulk to Source. 

Pin connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. Short 
Bulk to Source. Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Source. Use the Series 2600B to supply zero voltage 
bias. Connect the AC guard of a three-terminal bridge through one remote bias tee to the Gate. 

Figure 969: Four-term pMOSFET Cds pin connections 
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Cgd 
Description: 

Module Name: Cgd 

DUT: Four-terminal pMOSFET 

Function: Measures the capacitance between the Drain and Gate terminals with the Source terminal 
connected to the AC guard of a three-terminal bridge. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
(See next figure.) 

Figure 970: Four-term pMOSFET Cgd pin connections 
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Cgs 
Description: 

Module Name: Cgs 

DUT: Four-terminal pMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
connected to the AC guard of a three-terminal bridge. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Source. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Drain. 
(See next figure.) 

Figure 971: Four-term pMOSFET Cgs pin connections 
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Ciss 
Description: 

Module Name: Ciss 

DUT: Four-terminal pMOSFET 

Function: Measures the capacitance between the Gate and Source terminals with the Drain terminal 
AC short-circuited to the Source terminal. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. AC 
short circuit the Drain to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT and 
HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the Series 
2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to 
supply zero voltage bias. (See next figure.) 

Figure 972: Four-term pMOSFET Ciss pin connections 
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Coss 
Description: 

Module Name: Coss 

DUT: Four-terminal pMOSFET 

Function: Measures the capacitance between the Drain and Source terminals with the Gate terminal 
AC short-circuited to the Source terminal. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage 
bias. AC short circuit the Gate to the Source terminal. Connect a Series 2600B and the CVH1 (HPOT 
and HCUR) terminals of the Model 4200-CVU through one remote bias tee to the Source. Use the 
Series 2600B to supply zero voltage bias. Connect a Series 2600B and the CVL1 (LPOT and LCUR) 
terminals of the Model 4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to 
sweep voltage. (See next figure.) 

Figure 973: Four-term pMOSFET Coss pin connections 
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Crss 
Description: 

Module Name: Crss 

DUT: Four-terminal pMOSFET 

Function: Measures the common-source short-circuit input capacitance by testing the capacitance 
between the Drain and Gate terminals with the Source terminal connected to the AC guard of a three-
terminal bridge. Short Bulk to Source. 

Pin Connections: Connect a Series 2600B and the CVH1 (HPOT and HCUR) terminals of the Model 
4200-CVU through one remote bias tee to the Drain. Use the Series 2600B to sweep voltage. 
Connect a Series 2600B and the CVL1 (LPOT and LCUR) terminals of the Model 4200-CVU through 
one remote bias tee to the Gate. Use the Series 2600B to supply zero voltage bias. Connect a 
Series 2600B and the AC guard of a three-terminal bridge through one remote bias tee to the Source. 
Use the Series 2600B to supply zero voltage bias. (See next figure.) 

Figure 974: Four-term pMOSFET Crss pin connections 
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Test and control connections 
Switch matrix connections 
A switch matrix enhances the connectivity of the system by allowing any source measure unit (SMU) 
or other instrument to be connected to any device under test (DUT) pin. 
Switching mainframes 

The following table lists the recommended switching mainframes along with a brief description of 
each. The Keithley Instruments Models 3706, 707A, and 707B hold six matrix cards, while the 
Keithley Instruments Models 708A and 708B hold one matrix card. 

Recommended switching mainframes 

Mainframe Description 
Model 3706 6-slot system switch with DMM 

Model 3706-NFP 6-slot system switch with DMM, without front panel and keypad 

Model 3706-S 6-slot system switch 

Model 3706-SNFP 6-slot system switch, without front panel and keypad 

Model 707A and 707B 6-slot Switching Matrix Mainframe 

Model 708A and 708B Single slot Switching Matrix Mainframe 

Integrated software control for the Keithley Instruments Models 707A, 707B, 708A, 708B and Model 
3706 Switching Matrix is provided by the ACS software. For more information, you can refer to the 
Python user library. 

For additional information about developing user modules and libraries, and to learn the commands, 
you can refer to the LPT library reference. 
Recommended matrix cards 

The following Table summarizes the recommended Keithley Instruments matrix cards, along with a 
brief description of each. Note that a key characteristic of these cards is low offset-current to minimize 
the negative effects of offset currents on low-current measurements. 

Section 17 

ACS Hardware examples 
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Recommended switching matrix cards 

Matrix Card Description 
Model 3730 6x16 matrix, <100 pA offset current 

Model 7072 8x12 matrix, <1 pA offset current 

Model 7172 8x12 matrix, <500 fA offset current 

Model 7174A 8x12 matrix, 100 fA offset current 

Model 9174 8x12 matrix, 100 fA offset current 

Switch mainframe control 
The switch matrix is controlled by the system computer or Model 4200-SCS using the GPIB (IEEE-
488) interface. Refer to IEEE-488 connections in this section for detailed bus connection information. 

 

Typical SMU matrix card connections 

The next Figure shows a typical SMU matrix card connection used in a typical system. This is a 
configuration that includes 8x SMUs and 24x Pins. SMUs are connected to the instrument card. 
There is always one instrument card. Pins are connected to the pin cards. There are 1 to 5 pin cards. 

Figure 975: SMU matrix connection of typical system 

 
 

IEEE-488 connections 
The built-in IEEE-488 interface allows you to connect to the system computer or Model 4200-SCS to 
a variety of GPIB-equipped devices, such as Series 2400 SourceMeter instruments, a capacitance 
voltage (CV) meter or switching matrix. The Model 4200-SCS unit can also be configured as a GPIB 
child and be controlled by an external host computer. 
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IEEE-488 connector 

For GPIB communication, connect an IEEE-488 cable between the computer GPIB port and 
instrument GPIB port. The standard IEEE-488 connectors are shown in the next figure. 

Figure 976: IEEE 488 connector 

 
 

Recommended cables 

To avoid electrical interference, use only shielded IEEE-488 connecting cables such as the Keithley 
Instruments Models 7007-1 and 7007-2. 
Configuring IEEE-488 controller operation 

The Model 4200-SCS can be configured to operate either as a GPIB controller or GPIB child. 

Other test instruments with GPIB connectors can be configured as a GPIB child. The system 
computer with ACS installed and the Model 4200-SCS acts as a GPIB controller when ACS is 
running. When operating as a controller, the Model 4200-SCS reserves primary address 0, making 
that address unavailable to GPIB child devices such as GPIB switch matrices, CV meters, and 
automatic probe stations.  

 

Drivers for these and other instruments, typically integrated into semiconductor test systems, are 
included with ACS.  
Configuring IEEE-488 child operation and control 

The Model 4200-SCS acts as a GPIB child when the Keithley External Control Interface (KXCI) 
software is running. When KXCI is running, the Model 4200-SCS can be controlled by an external 
computer.  

For more information about KXCI, refer to the supplied documentation that is located on the Keithley 
Instruments CD-ROM that was shipped with your purchase. The CD-ROM contains customer 
documentation for the following models: 
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• Model 707A and 707B Switching Matrix 
• Model 708A and 708B Switching Matrix 
• Model 2410 High-Voltage (HV) SourceMeter 
• Series 2600B System SourceMeter 
• Series 3700 System Switch/Multimeter 
• Model 4200-SCS (contains KXCI information) 

You can also visit the Keithley Instruments website at www.keithley.com to search for updated 
information by model number. 

Other instrument’s that are considered a child in the hardware configuration can be controlled by the 
system computer or the Model 4200-SCS using GPIB commands. 

 

RS-232 connections 
The built-in RS-232 port allows you to interface the system computer or Model 4200-SCS to a variety 
of serial devices, such as a serial printer or plotter. It can also be used to control semi-automatic 
probe stations and other serial equipment. 

The next figure shows the location of the RS-232 (COM1) connector, which is a standard DB-9 (9-pin) 
male connector. A 9-pin-to-25-pin adapter may be used, if desired. 

 

Figure 977: RS-232 connector 

 

The following Table gives you a pin number and a description of the RS-232 connector. 

RS-232 connector pin out 

Pin Number Description 
1 Not used 

2 TXD, transmit data 

3 RXD, receive data 

4 Not used 

5 GND, signal ground 

6 Not used 

7 RTS, ready to send 

8 CTS, clear to send 

9 Not used 

Recommended serial cables 

To avoid electrical interference, use only properly-shielded serial cables. Shielded 25-pin cables may 
be used with shielded 25-pin-to-9-pin adapters where needed. 
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TSP-Link™ connections 
The TSP-Link is an expansion interface that allows the instruments to communicate with each other.  
Parent and child instruments 

In a TSP-Link system, one of the nodes (instruments) is the parent and the others are child nodes. 

The parent can control the other nodes (child nodes) in the system. When any node transitions from 
local operation to remote, it becomes the parent of the system; all other nodes also transition to 
remote operation, and become the child nodes. When any node transitions from remote operation to 
local, all other nodes also transition to local operation, and the parent/child relationship between 
nodes is dissolved. 

 

A child is a node that is controlled by the parent. The GPIB and RS-232 command interfaces of the 
child nodes are disabled. 

Connections 
Connections for an expanded system are shown in the next figure. As shown, one unit is optionally 
connected to the system computer using the GPIB or RS-232 interface and all the units in the system 
are daisy-chained together using LAN crossover cables. 

 

The PC or laptop is not needed for standalone systems. Also, there are two TSP-Link connectors on 
the back panel of each Series 2600B instrument. Also, make sure that you use a LAN crossover 
cable for each TSP-Link connector that is type category 5e or higher, and length three meters 
maximum between nodes. 

Figure 978: TSP-Link connections 

 
 

LAN connections 
The Model 4200-SCS can be connected to an Ethernet LAN so that tests and data can be easily 
accessed and archived. From a networking perspective, the Model 4200-SCS operates the same as 
any other personal computer running Windows XP Professional. The following information outlines 
the LAN connections and recommended cables. 
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The drivers for the Model 4200-SCS LAN interface are pre-installed on the system. Contact your 
system administrator before attempting to enable the LAN interface. 

Recommended LAN cables 

For the best results, use only CAT 5 UTP cables equipped with RJ-45 connectors to connect the 
Model 4200-SCS to your LAN. 

 

Basic configuration 
ACS software installations are supported on the following hardware configurations: 

1. On a laptop/desktop for Series 2600B System instruments. 
2. On a laptop/desktop for Series 2600B System instruments and Series 2400 instruments. 
3. On a laptop/desktop for Series 2600B System instruments and Series 3700 instruments. 
4. On a laptop/desktop for Series 2400 instruments and Model 707A/707B/708A/708B instruments. 
5. On a Model 4200-SCS. 
6. On a laptop/desktop for Model 4200-SCS. 
7. On a Model 4200-SCS for Series 2600B instruments. 
8. On the S530 system (there are two different types: High-Voltage; Low-Current). 

Different test modules should be used for each configuration. 
 

Configuration 1, 2 and 3: ACS on a laptop/desktop for Series 2600B 
instruments 

Configuration 2 includes Series 2600B System instruments and Series 2400 instruments. 
Configuration 3 includes Series 2600B System instruments and Series 3700 instruments. 

 ITMs and STMs can be used for this case. They are only used to control Series 2600B 
instruments (and Series 2400 instruments, when part of the configuration). 

 CTMs can be used for this case. They are only used to control certain external instruments, such 
as switch matrices, pulse generators, CV meters, etc. 

 PTMs can also be used to control instruments and process data. 

1. Install a CEC GPIB card (KUSB-488A or KPCI-488) on a system computer with the latest driver. 
2. Connect the master instrument to the system computer/laptop through the GPIB. 
3. Connect the child instruments to the master one-at-a-time using TSP-Link™ (see next figure). 
4. Make sure each group of Series 2600B instruments has a master. The Series 2600B that links to 

the controller (system computer or Model 4200-SCS) with the GPIB cable is the master. 
5. Connect each Series 2600B in the group to the TSP-Link (refer the Series 2600B System 

SourceMeter® User’s Manual for more details). 
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For more information about TSP-Link, refer to the supplied documentation that is located on the 
Keithley Instruments CD-ROM that was shipped with your purchase. 

Figure 979: ACS on a computer for Series 2600A instruments 

 
 

Assigning GPIB addresses 
Each group of Series 2600B instruments should have a unique GPIB address (refer to the Series 
2600B System SourceMeter documentation for more details). 

The master’s GPIB address is the group’s GPIB address. It is not necessary to change all Series 
2600B GPIB addresses to the same number. 

 

Address 21 is reserved for the system controller (GPIB card).  

Assigning node numbers 
 

Each Series 2600B in a group should have a unique node number. You can assign node numbers by 
performing the steps below. 

Node numbers should be assigned sequentially, since the SMU numbers are assigned automatically 
when the system is started and according to the node number sequence. If the node numbers were 
not assigned sequentially, the SMU numbers will not be consistent with the setup. The recommended 
sequence is: 

 

1. Assign the master to Node 1. 
2. Assign the Series 2600B that is linked with the master by TSP-Link to Node 2. 
3. Sequentially assign all other Series 2600B instruments’ node numbers. 
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Checking the node, SMU, and timer numbers 
Follow these steps to check the Node, SMU, and Timer numbers on the Series 2600B instruments’ 
front panels. For a Series 2600B master without Linear Parametric Test (LPT) functions: 

 

• When performing a scan of the ACS hardware configuration, the node numbers, SMU numbers, and 
timer numbers are displayed on each of the Series 2600B instruments’ front panels. 

• For a Series 2600B master with LPT functions installed, each time the master is turned on, the 
information is displayed automatically. 

• Send the string showsmu(10) to a Series 2600B master’s GPIB address by any GPIB communication 
software (for example, the TRTEST.exe of CEC 488). The information is displayed for 10 seconds (note 
this method needs LPT functions). 

 

The next figure shows a typical hardware configuration. 

Figure 980: Typical hardware configuration 

 
 

There are two TSP-Link connectors on the back panel of each Series 2600B instrument. Also, make 
sure that you use a LAN crossover cable for each TSP-Link connector that is type category 5e or 
higher, and length three meters maximum between nodes. 
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Connecting to a computer 
Each Series 2600B master and other GPIB devices should be connected to the computer by a GPIB 
cable. There are no special limits for the topology and the sequence. Follow these steps to connect 
with a computer: 

If only one GPIB card is installed: 

• All GPIB devices (Series 2600B instruments, prober, Model 3401 Pulse Pattern Generator, etc.) should 
all connect to this GPIB card. 

If more than one GPIB card is installed: 

• All Model 4200-SCS related instruments and probers should be connected with GPIB card 0. 
• All Series 2600B groups must be connected with the GPIB card that holds the biggest card number. 

You can check the cards’ assigned number using the TEST488.EXE routine, which is located in 
CEC488 driver folder. 

 

Connecting to the device under test (DUT) 
ACS supports the Model 4200-SCS and Series 2600B instruments. There are no special 
requirements on the DUT connection beyond those described in the customer documentation (refer 
the Series 2600B System SourceMeter User’s Manual and the Model 4200-SCS Semiconductor 
Characterization System Reference Manual for more details). 

 

For more information about the Series 2600B System SourceMeter instruments and the Model 4200-
SCS, refer to the supplied documentation that is located on the Keithley Instruments CD-ROM that 
was shipped with your purchase. 

 

Configuration 4: ACS on a laptop/desktop for Series 2400 instruments and 
Model 707A/707B/708A/708B instruments 
 

ITMs and STMs can be used for this case. They are only used to control Series 2400 instruments. 
 
CTMs can be used for this case. They are only used to control certain external instruments, such as 
switch matrices, pulse generators, CV meters, etc. 
 
PTMs also can be used to control Series 2400 instruments and Model 707A/707B/708A/708B 
instruments, and to control certain external instruments, such as pulse generators and CV meters. 
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Configuration 5: ACS on the Model 4200-SCS only 

ITMs cannot be used for this case. 
 
STMs can only be used for importing KTM files. 
 
CTMs can be used for this case. They are used to control the Model 4200-SCS internal hardware, 
such as the SMU, PGU, PMU, SCP, etc. Also, they can be used to control certain external 
instruments, such as switch matrices, pulse generators, CV meters, etc. 

 

Configuration 5 includes all instruments and equipment that are supported by KITE (see next figure). 

Connect the master instrument to the 4200-SCS using the GPIB interface. 
 

Figure 981: ACS software on Model 4200-SCS 

 
 

Configuration 6: ACS on a laptop/desktop for a Model 4200-SCS only 
 

ITMs can be used for this case. They are only used to control the Model 4200-SCS using an 
Ethernet cable and KXCI interface. 
 
PTMs can be used for CV testing. 
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Configuration 7: ACS on the Model 4200-SCS with Series 2600B instruments 

ITMs cannot be used for this case. They are used to control Series 2600B instruments. 
 
STMs can only be used for this case. They are used to control Series 2600B instruments and for 
importing KTM files. 
 
CTMs can be used for this case. They are used to control the Model 4200-SCS internal hardware, 
such as the SMU, PGU, PMU, SCP, etc. Also, they can be used to control certain external 
instruments, such as switch matrices, pulse generators, CV meters, etc. 

 

ACS supports multigroup Series 2600B units. Each group can include up to 64 Series 2600B System 
SourceMeter source-measure units (SMU) with a maximum of 128 SMUs. 

1. Connect the master instrument to the 4200-SCS using the GPIB interface. 
2. Connect the child instruments one-at-a-time to the master with a TSP-Link. 
3. Make sure each group of Series 2600B instruments has a master. The Series 2600B that links to 

the controller (system computer or Model 4200-SCS) with the GPIB cable is the master. 
4. Connect each Series 2600B in the group to the TSP-Link (refer the Series 2600B System 

SourceMeter User’s Manual for more details). 
 

For more information about TSP-Link, refer to the supplied documentation that is located on the 
Keithley Instruments CD-ROM that was shipped with your purchase. 

The next figure shows an example configuration setup with the Model 4200-SCS connected with a 
GPIB cable to the Series 2600B instruments. 
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The example of the Model 4200-SCS backplane may not be typical for your configuration. The cards 
that are used in the eight slots of the 4200-SCS backplane can be any combination. 

Figure 982: ACS on a Model 4200-SCS with Series 2600A instruments 
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Typical S530 system configuration 
There are two typical ACS system configurations: high-voltage system, and low-current system (for 
more specific configuration information, refer to the S530 Administrative Guide, part number PA-992). 
You can also configure your ACS system to other system formats according to your needs. 

Keithley Instruments’ ACS integrated test systems support the mini-tester architecture through the 
use of the Series 2600B System SourceMeter instruments. By using the proprietary TSP-Link 
extensible virtual backplane technology and embedded script processing, groups of Series 2600B 
units can be formed into mini-testers. 

The next figure shows the communication diagram of these two typical systems. 

Figure 983: S530 Instrument communication diagram 
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System 2: High-voltage (HV) test system configuration 
The next figure shows an example HV system configuration. 

Figure 984: Example HV system configuration 
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For the High-Voltage system, the parameter in the ACS setting file (\\ACS\KATS\ ACS_setting.ini) 
must be set as HV (see next figure). 

Figure 985: Set ACS file for High-Voltage configuration 

 
 

Maximum configuration  

• Three SourceMeters: Model 2636A 
• One HV SourceMeter: Model 2410 
• One Switching Matrix: Model 707A/707B 
• Minimum of two Model 7072-HV cards (up to four cards are possible)  
• One Semiconductor Characterization System: Model 4200-SCS/C with a 4210-CVU card; a CVU option 

with 10 foot long (3 m) cables (four cards installed with the 2-wire option and six cards for the 4-wire 
option) 

• One system computer with two Network Interface Cards (NIC)  
• One power distribution unit: Model 42000-PDU-2K  
• One cabinet, 23 U  
• One keyboard and keyboard arm with tray 
• One monitor and monitor arm 

 

Each SMU has a ground module connector labeled Channel A/B LO. Every Channel A/B LO triax 
connection is connected to the LO Patch Panel. This panel forms the system ground unit. The 
aggregated output of the LO Patch Panel is connected to matrix slot1 column 9. 
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System 3: Low-current test system configuration 
The next figure shows an example of the low-current system configuration. 

Figure 986: Example Low-Current system configuration 
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For the Low-Current system, the parameter in the ACS setting file (\\ACS\KATS\ ACS_setting.ini) 
must be set as SS (see next figure). 

Figure 987: Set ACS file for Low-Current configuration 

 
 

Maximum Configuration  

• Four SourceMeters: Model 2636A  
• One Switching Matrix: Model 707A/707B 
• Minimum of two Model 7174 cards (up to six cards are possible)  
• One Semiconductor Characterization System: Model 4200-SCS/C with 4210-CVU card, CVU option 

with the 10 foot long cable 
• One system computer with two Network Interface Cards (NIC)  
• One power distribution unit: Model 42000-PDU-2K  
• One cabinet, 23 U  
• One keyboard and keyboard arm with tray 
• One monitor and monitor arm 
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VDS breakdown Vds breakdown test module template 
The Vds breakdown test plans use ramped voltage stress (Vds_Vramp), or constant voltage stress 
(Vds_Constant), to characterize the drain-source breakdown properties of a device (usually a power 
device). The test module templates are located in the following folder on your computer: 
C:\ACS\TestModuleTemplate\device\Vds_Reliability. 

To import the test module template, right-click on any device (add a new device if needed) in the 
configuration navigator, and select Import: 

Figure 988: Import a test module template 

 

Section 18 

VDS Sample tests 
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You can import the desired module templates based on the device connection that you have. For 
example, here are all of the folders available that are based on the device connection: 

• SingleDevice 
• MultiDevice_SourceOnly 
• MultiDevice_GateSource 
• MultiDevice_SourceOnly_ComDrain 
• MultiDevice_GateSource_ComDrain 

Import a test plan: 

a. Right-click on any device in the configuration navigator 
b. Click import in the menu 
c. Select the appropriate .xml file in the C:\ACS\TestModuleTemplate\device\Vds_Reliability folder 
Once you have selected the desired test module template, a new device will be added to the 
configuration navigator and is ready to use for testing. 

The Vds breakdown test has five different test options for different device connections (single or 
multiple devices, as well as one or two SMUs for one device). 

1. Single device: One SMU is connected to the drain and measures the Vds stress. Another SMU 
(optional) is connected to the gate to keep the device off. The source can be connected to a SMU 
or ground (GND). 

Figure 989: Single device pin connection 

 

2. Multi-device (source only): One SMU and one device. The gate and source are shorted together, 
and connected to one SMU. The drain is connected to the low terminal. 

Figure 990: Multi-device (source only) pin connection 
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3. Multi-device (gate-source): Two SMUs and one device. The gate and source are connected to the 
SMU individually. The drain is connected to the low terminal. 

Figure 991: Multi-device (gate-source) pin connection 

 

4. Multi-device (source only with a common drain): One SMU with the gate and source shorted 
together. The drain (all devices have a common drain) is connected to another SMU to extend the 
range of the Vds stress. 

Figure 992: Multi-device (source only common drain) pin connection 

 

5. Multi-device (gate-source with a common drain): One SMU with the gate and source are 
connected individually. The drain (all devices have a common drain) is connected to another 
SMU to extend the range of the Vds stress. 

Figure 993: Multi-device (gate-source common drain) pin connection 
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Vds_Vramp test 
The Vds_Vramp test uses a ramped voltage stress on the source-drain for breakdown 
characterization. The next figure indicates how the stress voltage flows during the test: 

Figure 994: Vds_Vramp voltage stress 

 
 

The next figure shows the Vds_Vramp test settings GUI: 

Figure 995: Vds_Vramp test settings 
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Max Time(s): Maximum time for the voltage ramp. When the maximum time is reached, the ramp test 
will end and the device is considered to have passed the test. 

PLC: Number of power line cycles (this parameter is constant and cannot be changed). 

Low Range (A): Lowest current measure range that is used during auto-ranging. 

Real time post data: 

• When deselected, the test module will post all of the data after the entire ramp test is done. 
• When selected, the Time to post(s) and Data points to post options are enabled. The test data will 

post and be sent from the instruments to ACS after every Time to post time interval or after the 
specified number of points, based on the Data points to post setting. These settings are critical 
when the VRamp module is used in a large scale ramp test. If multiple instruments are used in 
one group (for example, up to eight Model 2636B instruments) with an extended ramp test, this 
option is safe for data logging and transferring. 

Figure 996: Real-time post-data diagram 

 
 

Soft Abort/Bias: Enables a sweep process to substitute the start or end of the stress, or the abort 
situation. This function prevents sharp changes in the stress voltage on the device. The soft abort 
function is used to monitor the Pin 3 digital I/O for the abort command input. If the pin electrical level 
is set to low, it will be treated as an abort command and will invoke the soft abort function which will 
abort the whole test. 

Figure 997: Soft bias for stress start and end 
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Breakdown Condition Settings: Click the Breakdown Settings button for the breakdown criteria 
settings. 

Init I(A): Initial current for the Vramp that is used during the pre-ramp and post-ramp testing (see next 
Figure). 

Max I(A): Maximum current that is used during the stress ramp phase. 

Critical I(A): Critical current that is used during the stress ramp phase. If the current exceeds this 
value, more breakdown judgments (Slope x (Pre) and I x (Pre)) will be performed. 

Max Q(Q): Maximum charge quantity used during the stress ramp phase. 

Slope x(Init): Checks the difference between the current and voltage to determine if the time exceeds 
the initial slope. 

I x(Init): Checks to determine if the current exceeds the initial current reading. 

Slope x(Pre): Checks to determine if the current and voltage slope exceeds the previous slope 
reading. 

I x(Pre): Checks to determine if the current exceeds the previous current reading. 

Figure 998: Breakdown settings for Vds_Vramp 
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Device and SMU settings: The device and SMU settings determine the force and measure functions 
for SMUs related to the device terminals (see next Figure). 

W(um), L(um): Determine the MOSFET device dimensions. 

Dev Type: "N" for NMOS and "P" for PMOS. 

Stress Setting: Double-click the cell to open the Ramp Segments Setting dialog box. 

Number of Ramp Segments: One through five can be specified. 
Start (V): Start voltage of the ramp segment. 
Stop (V): Stop voltage of the ramp segment. 
Ramp Rate (V/s): Voltage ramp rate of the ramp segments. Each segment has its own ramp rate. 
Stress Intv (s): Stress interval which is the time between two ramp steps. All of the stress 
intervals are the same for all segments. 
Ramp Step (V): Calculated based on the ramp rate and stress interval. 

Monitor: Monitors the current during each ramp step (this is always selected). 

Vpre: Applied voltage for the pre-ramp test. 

Vpost: Applied voltage for the post-ramp test. 

Vuse: Voltage applied when the Monitor at Vuse is selected. 

Ibox: Enabled when the Output Vbox at Ibox is selected. Logs the Vbox step voltage when the current 
exceeds the value for the first time. 

Compl: Current compliance (limit) value. 

Figure 999: Device and SMU settings for VRamp 
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Vds_Constant test 
The Vds_Constant test uses a constant voltage stress on the source-drain for breakdown 
characterization. See the next figure for an example of the stress voltage flow. 

Figure 1000: Vds_Constant stress voltage test sequence 

 
 

Vds_Constant test settings 

Figure 1001: Vds_Constant test settings 
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PLC: number of power line cycles, 0.001~25. 

Max Time (s): Ending measure phase time. 

Low Range (A): Lowest current measure range that will be used during auto-ranging. 

Monitor: Time settings (defined as current measurements during the stress phase). 

• Sample Interval(s): Time interval between two monitor points. 
• Hold Time(s): Amount of time the stress voltage will be applied before the monitor measurement 

is made (during the stress phase). 

Dynamic limit setting 

The Dynamic Limits Change allows the limit values to vary. The next figure is an example of a 
Dynamic Limits Change with a varying limit. 

Figure 1002: Dynamic limit change 

 
 

The Series 2600B can set the current limits when applying the voltage. The output current will be 
clamped to the set limit to prevent damage to the device under test (DUT). The Dynamic Limit setting 
enables the dynamic limit change feature. When enabled, the limit value will vary according to the 
settings. The limit value can be set as a multiple of the measured current. If the current changes 
smoothly, the limit will not be reached. However, if the current changes suddenly, which indicates a 
breakdown, the output will be clamped to the limit value and protect the DUT from severe damage 
(see next Figure). 

Figure 1003: Dynamic limit settings 
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Lowest Limit(A): Dynamic Limit will not be applied, if the current is lower than this value. 

Trigger Rate(%): Trigger Rate percent as compared to the previous value, the limit value will change, 
if the current changes. 

Limit Percent(%): Limit value will be set as the (100%+Limit Percent) multiplier of the measured 
current. 

Breakdown settings 

When the measured current exceeds the setting limits, the DUT will be treated as breakdown (see 
next Figure). 

Figure 1004: Breakdown settings 

 
 



ACS Automated Characterization Suite (ACS) Reference Manual Section 18: VDS Sample tests 
 

ACS-901-01 Rev. H / December 2014 18-11 

 

Current Limits: Breakdown settings used during current monitoring. If these fields are selected, they 
will be used to evaluate the DUT. 

• Jmax: Maximum current density. The current density is calculated by I/(W×L). The W and L are 
width and length, which is set in the configuration navigator device (for a single sub-device) or 
SMU settings (multiple sub-devices). If the monitor current density exceeds this value, the device 
has failed by definition. 

• J/J0: Current density change ratio compared to the first value. If the monitor current density 
change ratio exceeds this value, the device has failed by definition. 

• qmax: Maximum accumulated charge density. The accumulated charge density is calculated by 
the accumulated charge divided by the area. If it exceeds this value, the device has failed by 
definition. 

• J/Jpre: Current density change ratio compared to the previous value. If the current density 
change ratio exceeds this value, the device has failed by definition. 

• Soft Breakdown Limit: Soft breakdown judgment is made by calculating the current noise using 
the last five measured current values, and then checking if the current noise setting "soft 
breakdown limit" times are larger than the baseline noise. The calculation of the current noise and 
noise baseline is referred to a JEDEC standard, which is described in the JESD92 procedure. 
This procedure is used for characterizing time-dependent dielectric breakdown of ultra-thin gate 
dielectrics (click here for more information www.jedec.org). 

Pre/Post-Test: Breakdown of settings for the Pre-test and Post-test. 

• Jmax: Maximum current density. If the Pre-test current or Post-test current densities exceed this 
value, the device has failed by definition. 

• Jmax: Minimum current density. If the Pre-test current or Post-test current densities are lower 
than this value, the device has failed by definition. 

Soft Abort/Bias: 

Soft bias start and soft bias end enables a sweep process to substitute the start or end of the stress, 
or the abort situation. This function prevents a sharp change to the device stress voltage. The soft 
abort function is used to monitor Pin3 of the digital I/O for the "abort command" input. When the pin 
electrical level is set to low, it will be treated as an abort command and will invoke the soft abort 
function and will abort the whole test (see next Figure). 

Figure 1005: Soft bias stress start and end 
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Data compression setting 

ACS will log the compressed data according to the following settings (see the next figure). This 
function can reduce the total amount of data without losing the parameter change tracking 

information. 

Figure 1006: Data compression setting 

 
 

Current Shift: if the current shifts the "Shift Rate" percentage and this parameter is selected, it will be 
logged. 

• Shift Rate (%): Current measured data change ratio exceeds the Shift Rate percentage, 
compared to the previous logged data (data will be logged). 

• Lowest Line(A): Absolute value of the measured data is lower than this value, the current Shift will 
not be affected. When the current is near the noise level, this function will prevent the measured 
data from being logged. 

Time: Logged data will be time-compressed. Only Linear or Log can be selected. 

• Linear: Constant Time is logged. The data is the mean value of the time period. 
• Log: Points/Decade is logged. The data is the measured value at each time point. 

Start(s): Before the time of stress, the Data Compression will not be affected. The data before this 
time will be logged. 

 

Figure 1007: Data compression diagram 
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Device and SMU settings 

The device and SMU settings are all set at the device level. For example, all of the devices and 
SMUs that are assigned at the device level of the configuration navigator such as, the Group No., 
Dev No., SMU and Terminal, are shown in the next figure. 

W(um), L(um): MOSFET device dimensions. These parameters are used to calculate the current 
density and charge density. 

Compliance: Current compliance (limit) value. 

Stress V: Sets the stress voltage value. 

Pre/Post V: Sets the pre-test and post-test bias voltage values. 

Monitor: Current monitor measurements on the terminal. 

Figure 1008: Device and SMU settings 
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